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Technical Support

Information and technical support for AutoCAD LT is available from several resources: 

CompuServe 
Registered AutoCAD LT customers can participate in and receive information from the Autodesk Retail Products forum 
by logging on to CompuServe, entering GO ARETAIL, and choosing the AutoCAD LT forum section. Other Autodesk 
software users and our forum systems operator will be available to answer your questions. CompuServe subscribers 
pay no additional charge beyond connect-time fees.

Internet 
Browse our World Wide Web site at http://www.autodesk.com for more detailed and up-to-date communications about 
Autodesk, its products, product support, education programs, and other resources.

For additional support, contact your dealer. 



Commands
A-C        D        E-L        M-Q        R-S        T-Z

3DPOLY AUDIT CHANGE
'ABOUT 'BASE CHPROP
APERTURE BHATCH CIRCLE
ARC 'BLIPMODE COLOR
AREA BLOCK COPY
ARRAY BMAKE COPYCLIP
ATTDEF BMPOUT COPYHIST
ATTDISP BOUNDARY COPYLINK
ATTEDIT BREAK CUTCLIP
ATTEXT CHAMFER

Transparent commands are preceded by an apostrophe ( ' ). 



Commands
A-C        D        E-L        M-Q        R-S        T-Z

DDATTDEF 'DDRMODES DIMLINEAR
DDATTE 'DDSELECT DIMORDINATE
DDATTEXT 'DDSTYLE DIMOVERRIDE
DDCHPROP DDUCS DIMRADIUS
DDCOLOR DDUCSP DIMSTYLE
DDEDIT 'DDUNITS DIMTEDIT
'DDEMODES DDVIEW 'DIST
'DDGRIPS 'DELAY DIVIDE
DDIM DIM DLINE
DDINSERT DIMALIGNED DONUT
'DDLMODES DIMANGULAR DSVIEWER
'DDLTYPE DIMBASELINE DTEXT
DDMODIFY DIMCENTER DVIEW
DDOSNAP DIMCONTINUE DXFIN
'DDPTYPE DIMDIAMETER DXFOUT
DDRENAME DIMEDIT

Transparent commands are preceded by an apostrophe ( ' ). 



Commands
A-C        D        E-L        M-Q        R-S        T-Z

ELEV HATCH LENGTHEN
ELLIPSE HATCHEDIT 'LIMITS
END HELP    LINE
ERASE HIDE 'LINETYPE
EXPLODE 'ID LIST
EXPORT IMPORT LOGFILEOFF
EXTEND INSERT LOGFILEON
'FILL INSERTOBJ 'LTSCALE
FILLET 'ISOPLANE
'GRAPHSCR 'LAYER
'GRID LEADER

Transparent commands are preceded by an apostrophe ( ' ). 



Commands
A-C        D        E-L        M-Q        R-S        T-Z

MAKEPREVIEW OFFSET PLINE
MEASURE OLELINKS PLOT
MENULOAD OOPS POINT
MENUUNLOAD OPEN POLYGON
MIRROR 'ORTHO PREFERENCES
MOVE OSNAP PSOUT
MSLIDE PAINTER PSPACE
MSPACE 'PAN PSUPDATE
MTEXT PASTECLIP PURGE
MULTIPLE PASTESPEC QSAVE
MVIEW PEDIT QTEXT
NEW PLAN QUIT

Transparent commands are preceded by an apostrophe ( ' ). 



Commands
A-C        D        E-L        M-Q        R-S        T-Z

RAY RTPAN SHADE
RECOVER RTZOOM SNAP
RECTANG RSCRIPT SOLID
REDO SAVE SPELL
'REDRAW SAVEAS SPLINE
REGEN SCALE SPLINEDIT
REINIT SCRIPT STRETCH
RENAME SELECT STYLE
'RESUME 'SETVAR
ROTATE

Transparent commands are preceded by an apostrophe ( ' ). 



Commands
A-C        D        E-L        M-Q        R-S        T-Z
TABLET UCSICON VSLIDE
TBCONFIG UNDO WBLOCK
TEXT UNLOCK WMFIN
'TEXTSCR 'UNITS WMFOPTS
'TIME 'VIEW WMFOUT
TOLERANCE VIEWTOOLBAR XBIND
TOOLBAR VPLAYER XLINE
TRIM VPOINT XREF
U VPORTS 'ZOOM
UCS

Transparent commands are preceded by an apostrophe ( ' ). 



System Variables
A-C        D        E-L        M-Q        R-S        T-Z
Overview

ACIS15 AUDITCTL CHAMFERC
ACLTPREFIX AUNITS CHAMFERD
ACLTVER AUPREC CHAMMODE
AFLAGS BACKZ CIRCLERAD
ANGBASE BLIPMODE CLAYER
ANGDIR CDATE CMDACTIVE
APERTURE CECOLOR CMDDIA
AREA CELTSCALE CMDNAMES
ATTDIA CELTYPE COORDS
ATTMODE CHAMFERA CVPORT
ATTREQ CHAMFERB



System Variables
A-C        D        E-L        M-Q        R-S        T-Z
Overview

DATE DIMDLI DIMTM
DCTCUST DIMEXE DIMTOFL
DCTMAIN DIMEXO DIMTOH
DIASTAT DIMFIT DIMTOL
DIMALT DIMGAP DIMTOLJ
DIMALTD DIMJUST DIMTP
DIMALTF DIMLFAC DIMTSZ
DIMALTTD DIMLIM DIMTVP
DIMALTTZ DIMPOST DIMTXSTY
DIMALTU DIMRND DIMTXT
DIMALTZ DIMSAH DIMTZIN
DIMAPOST DIMSCALE DIMUNIT
DIMASO DIMSD1 DIMUPT
DIMASZ DIMSD2 DIMZIN
DIMAUNIT DIMSE1 DISTANCE
DIMBLK DIMSE2 DITHER
DIMBLK1 DIMSHO DONUTID
DIMBLK2 DIMSOXD DONUTOD
DIMCEN DIMSTYLE DWGCODEPAGE
DIMCLRD DIMTAD DWGNAME
DIMCLRE DIMTDEC DWGPREFIX
DIMCLRT DIMTFAC DWGTITLED
DIMDEC DIMTIH DWGWRITE
DIMDLE DIMTIX



System Variables
A-C        D        E-L        M-Q        R-S        T-Z
Overview

EDGEMODE GRIDUNIT INSBASE
ELEVATION GRIPBLOCK INSNAME
EXEDIR GRIPCOLOR LASTANGLE
EXPERT GRIPHOT LASTPOINT
EXTMAX GRIPS LENSLENGTH
EXTMIN GRIPSIZE LIMCHECK
FFLIMIT HANDLES LIMMAX
FILEDIA HIGHLIGHT LIMMIN
FILLETRAD HPANG LOCALE
FILLMODE HPDOUBLE LTSCALE
FRONTZ HPNAME LUNITS
GRIDMODE HPSCALE LUPREC

HPSPACE



System Variables
A-C        D        E-L        M-Q        R-S        T-Z
Overview

MAXACTVP PELLIPSE PLOTID
MENUECHO PERIMETER PLOTROTMODE
MIRRTEXT PICKADD PLOTTER
MODEMACRO PICKAUTO POLYSIDES
MTEXTED PICKBOX PROJMODE
OFFSETDIST PICKDRAG PSLTSCALE
ORTHOMODE PICKFIRST PSPROLOG
OSMODE PLINEGEN QTEXTMODE
PDMODE PLINEWID
PDSIZE



System Variables
A-C        D        E-L        M-Q        R-S        T-Z
Overview

RASTERPREVIEW SNAPANG SNAPUNIT
SAVEFILE SNAPBASE SPLFRAME
SAVENAME SNAPISOPAIR SPLINESEGS
SAVETIME SNAPMODE SPLINETYPE
SHADEDGE SNAPSTYL SYSCODEPAGE
SHADEDIF



System Variables
A-C        D        E-L        M-Q        R-S        T-Z
Overview

TABMODE THICKNESS VIEWCTR 
TARGET TILEMODE VIEWDIR
TDCREATE TOOLTIPS VIEWMODE
TDINDWG TRIMMODE VIEWSIZE 
TDUPDATE UCSICON VIEWTWIST
TDUSRTIMER UCSNAME VISRETAIN
TEXTFILL UCSORG VSMAX 
TEXTQLTY UCSXDIR VSMIN 
TEXTSIZE UCSYDIR WORLDVIEW
TEXTSTYLE UNITMODE XREFCTL



transparent command

A command started while another is in progress. Precede transparent commands with an 
apostrophe.





3DPOLY Command
Up a Level          Related Topics

Creates a polyline of line segments in 3D space
 At the Command prompt, enter 3dpoly

From point: Specify a point

Close / Undo / <Endpoint of line>: Specify a point or enter an option



For more information about creating 3D objects, see chapter 11, "Working in Three Dimensions," in the AutoCAD LT User's 
Guide. 

Commands: PEDIT edits polylines and 3D polygon meshes. SPLINE creates a quadratic or cubic spline (NURBS) curve.



Endpoint of Line (3DPOLY)
Up a Level

Draws a straight line from the previous point to the specified new point. The prompt is repeated until you press RETURN to 
end the command. 



Close (3DPOLY)
Up a Level

Draws a closing line from the endpoint back to the first point and ends the command. To be closed, a 3D polyline must 
contain at least two lines.



Undo (3DPOLY)
Up a Level

Deletes the last line created. You can continue drawing from the previous point. 

        

 



'ABOUT Command
Up a Level

Displays information about AutoCAD LT

 
From the Help menu, choose About AutoCAD LT

 
At the Command prompt, enter about

The ABOUT command displays the AutoCAD LT version number, serial number, license information, and the contents of the 
AutoCAD LT message file aclt.msg.

Note: To customize the aclt.msg text file, use any text editor that saves in ASCII format. For example, you can replace the 
contents of the file with a company banner or user instructions, or you can delete the file to display no message.



'APERTURE Command
Up a Level          Related Topics

Controls the size of the object snap target box
 At the Command prompt, enter aperture

Object snap target height (1-50 pixels) <current>: Enter a value (1-50) or press RETURN

The number of pixels controls the size of the object snap box. The higher the number, the larger the target box.

Object snap applies only to objects inside or crossing the target.

The APERTURE command controls the object snap target box, not the pickbox displayed at the Select Objects prompt. The 
object selection pickbox is controlled by the PICKBOX system variable.

      



Commands: DDOSNAP sets the object snap target size with a slider. DDSELECT sets the object selection pickbox size.

System Variables: APERTURE controls the object snap target size. PICKBOX controls the object selection pickbox size.



ARC Command
Up a Level          Related Topics

Creates an arc

 
From the Draw toolbar, choose

  

 
From the Draw menu, choose Arc, then choose
Start, Center, End
Start, Center, Angle
Start, End, Angle
Center, Start, End 
Center, Start, Angle
3 Point 
Continue Line/Arc/Polyline

At the Command prompt, enter arc

Center / <Start point>: Specify a point, enter C, or RETURN to start tangent to last line, arc, or polyline



Tangent To Last Line, Arc, Or Polyline (ARC)
Up a Level

Draws an arc tangent to the last line, arc, or polyline drawn.

End point: Specify a point (1)



Start Point (ARC)
Up a Level

Specifies the starting point of an arc.

Center / End / <Second point>: Specify a point or enter an option



Center

Specifies the center of the circle of which the arc is a part.

Center: Specify a point (2)

Angle / <End point>: Specify a point or enter an option

End Point
Draws an arc counterclockwise from the start point (1) to an endpoint (3) that falls on an imaginary ray drawn from the 
center point (2) through the point you specify.

As shown in the illustration, the arc does not necessarily pass through the point you specify to define the ray.

Angle
Draws an arc counterclockwise from the start point (1) to an endpoint (3), with a specified included angle. If the angle is 
negative, AutoCAD LT draws a clockwise arc.

Included angle: Specify an angle



End

Specifies the endpoint of the arc.

End point: Specify a point

Included angle: Specify an angle



Second Point

Draws an arc using three specified points on the arc's circumference. The first point is the start point (1) and the third is the 
endpoint (3) of the arc. The second point (2) is a point on the circumference of the arc.

End point: Specify a point (3)

You can specify a three-point arc either clockwise or counterclockwise.



Center (ARC)
Up a Level

Specifies the center of the circle of which the arc is a part.

Center: Specify a point

Start point: Specify a point

Angle / <End point>: Specify a point or enter an option



End Point

Using the center point (1), draws an arc counterclockwise from the start point (2) to a point that falls on an imaginary ray 
drawn from the center point through an endpoint (3).



Angle

Draws an arc counterclockwise from the start point (2) using the center point (1) and a specified included angle. If the angle 
is negative, AutoCAD LT draws a clockwise arc.

Included angle: Specify an angle



ARC Command
Up a Level          Related Topics

Creates an arc

 
From the Draw toolbar, choose

  

 
From the Draw menu, choose Arc, then choose
Start, Center, End
Start, Center, Angle
Start, End, Angle
Center, Start, End 
Center, Start, Angle
3 Point 
Continue Line/Arc/Polyline

At the Command prompt, enter arc

Center / <Start point>: Specify a point, enter C, or RETURN to start tangent to last line, arc, or polyline



ARC Command
Up a Level          Related Topics

Creates an arc

 
From the Draw toolbar, choose

  

 
From the Draw menu, choose Arc, then choose
Start, Center, End
Start, Center, Angle
Start, End, Angle
Center, Start, End 
Center, Start, Angle
3 Point 
Continue Line/Arc/Polyline

At the Command prompt, enter arc

Center / <Start point>: Specify a point, enter C, or RETURN to start tangent to last line, arc, or polyline



ARC Command
Up a Level          Related Topics

Creates an arc

 
From the Draw toolbar, choose

  

 
From the Draw menu, choose Arc, then choose
Start, Center, End
Start, Center, Angle
Start, End, Angle
Center, Start, End 
Center, Start, Angle
3 Point 
Continue Line/Arc/Polyline

At the Command prompt, enter arc

Center / <Start point>: Specify a point, enter C, or RETURN to start tangent to last line, arc, or polyline



ARC Command
Up a Level          Related Topics

Creates an arc

 
From the Draw toolbar, choose

  

 
From the Draw menu, choose Arc, then choose
Start, Center, End
Start, Center, Angle
Start, End, Angle
Center, Start, End 
Center, Start, Angle
3 Point 
Continue Line/Arc/Polyline

At the Command prompt, enter arc

Center / <Start point>: Specify a point, enter C, or RETURN to start tangent to last line, arc, or polyline



ARC Command
Up a Level          Related Topics

Creates an arc

 
From the Draw toolbar, choose

  

 
From the Draw menu, choose Arc, then choose
Start, Center, End
Start, Center, Angle
Start, End, Angle
Center, Start, End 
Center, Start, Angle
3 Point 
Continue Line/Arc/Polyline

At the Command prompt, enter arc

Center / <Start point>: Specify a point, enter C, or RETURN to start tangent to last line, arc, or polyline



ARC Command
Up a Level          Related Topics

Creates an arc

 
From the Draw toolbar, choose

  

 
From the Draw menu, choose Arc, then choose
Start, Center, End
Start, Center, Angle
Start, End, Angle
Center, Start, End 
Center, Start, Angle
3 Point 
Continue Line/Arc/Polyline

At the Command prompt, enter arc

Center / <Start point>: Specify a point, enter C, or RETURN to start tangent to last line, arc, or polyline



For more information, see "Drawing Arcs" in chapter 6 of the AutoCAD LT User's Guide. 

Commands: ELLIPSE creates an ellipse or an elliptical arc. DLINE creates a double line using straight line segments and 
arcs.



AREA Command
Up a Level          Related Topics

Calculates the area and perimeter of objects or of defined areas

 
From the Object Properties toolbar, choose

At the Command prompt, enter area

<First point> / Object / Add / Subtract: Specify a point or enter an option

Note: The AREA command will not process multiple objects in a single operation.



For more information, see "Calculating Areas" in chapter 7 of the AutoCAD LT User's Guide. 

Commands: BOUNDARY calculates and displays the area associated with selected objects. LIST displays database 
information for selected objects. 

System Variables: AREA stores the sum of areas collected. PERIMETER displays the perimeter of the object last found by 
AREA. 



First Point (AREA)
Up a Level

Calculates the area and perimeter you define by selecting points. All points must lie in a plane parallel to the XY plane of the 
current UCS. 

Next point: Specify a point (2) or press RETURN

Select points to define a polygon and then press RETURN to complete definition of the perimeter. 

If you do not close the polygon, AutoCAD LT calculates the area as if a line were drawn from the last point entered to the 
first. When calculating the perimeter, AutoCAD LT adds in that line length.

      



Object (AREA)
Up a Level

Calculates the area and perimeter of the selected object. You can calculate the area of circles, ellipses, splines, polylines, 
and polygons.

Select object: Use an object selection method

If you select an open polyline, AutoCAD LT calculates the area as if a line were drawn from the last point entered to the first. 
When calculating the perimeter, however, AutoCAD LT ignore that line.

      

The centerline of a wide polyline is used to make area and perimeter (or length) calculations.



Add (AREA)
Up a Level

Turns on Add mode and keeps a running balance of additions and subtractions. 

<First point> / Object / Subtract: Specify a point (1) or enter an option

      



First Point

Calculates the area and perimeter you define by selecting points. All points must lie in a plane parallel to the XY plane of the 
current UCS.

(ADD mode) Next point: Specify a point (2) or press RETURN

Specify points to define a polygon. Press RETURN and AutoCAD LT calculates the area and perimeter. 

If you do not close the polygon, AutoCAD LT closes it by defining a line from the last point to the first. To calculate the 
perimeter, AutoCAD LT adds in that line length. Further, AutoCAD LT calculates the total of all the areas defined by selecting 
points or objects since Add mode was turned on.



Object

Calculates the area and perimeter of the selected object. 

(ADD mode) Select object: Use an object selection method or press RETURN to end selection

AutoCAD LT calculates the area and perimeter of the object and of all the areas defined by selecting points or objects since 
Add mode was turned on.

If you select an open polyline, AutoCAD LT calculates the area as if a line were drawn from the last point entered to the first. 
When calculating the perimeter, however, AutoCAD LT ignore that line.

For wide lines, or objects with wide lines, the centerline of a wide polyline is used to make area and perimeter calculations. 



Subtract

Turns on Subtract mode and keeps a running balance of subtracted areas and perimeters.



Subtract (AREA)
Up a Level

Similar to the Add option, but subtracts areas and perimeters. All prompts are preceded by (SUBTRACT mode).

      



ARRAY Command
Up a Level          Related Topics

Creates multiple copies of objects in a pattern
Each object in an array can be manipulated independently.

 
From the Modify toolbar, choose 

   From the Modify menu, choose Array, then Rectangular or 
Polar 
At the Command prompt, enter array

If multiple objects are selected when constructing an array, AutoCAD LT counts the objects as one array item.

Select objects: Use an object selection method

Rectangular or Polar array (R/P) <current>: Enter an option or press RETURN



Rectangular (ARRAY)
Up a Level

Creates an array defined by a number of rows and columns of copies of the selected objects.

      

Number of rows (---) <1>: Enter a nonzero integer or press RETURN

Number of columns (|||) <1>: Enter a nonzero integer or press RETURN

If you specify one row, you must specify more than one column and vice versa.

The selected object, or cornerstone element, is assumed to be in the lower-left corner, and the array is generated up and to 
the right. 

Unit cell or distance between rows (---): Specify a distance or two points

To add rows downward, specify a negative value for the distance between rows. AutoCAD LT skips the next prompt if you 
specify two points for the opposite corners of a rectangle.

Distance between columns (|||): Specify a distance

To add columns to the left, specify a negative value for the distance between columns. AutoCAD LT constructs rectangular 
arrays along a baseline defined by the current snap rotation. This angle is normally 0, so the rows and columns are 
orthogonal with respect to the X and Y drawing axes. The Rotate option of the SNAP command changes the angle and 
creates a rotated array. The SNAPANG system variable stores the SNAP rotation angle.



Polar (ARRAY)
Up a Level

Creates an array defined by specifying a center point about which the selected object is replicated.

Center point of array: Specify a point (1)

Number of items: Enter a positive integer or press RETURN

If you enter a value for the number of items, you must specify either the angle to fill or the angle between items. If you press 
RETURN, you must specify both.

Angle to fill (+=ccw, -=cw) <360>: Specify an angle or press RETURN

A positive value specifies counterclockwise (ccw) rotation. A negative value specifies clockwise (cw) rotation. AutoCAD LT 
sees 0 as no response. Entering 0 is permitted only if the number of items was not specified.

If an Angle to fill was specified without providing the number of items, AutoCAD LT prompts as follows:

Angle between items: Specify an angle

If you specified the number of items and entered 0 as the angle to fill or pressed RETURN, AutoCAD LT prompts for a 
positive or negative value to indicate the direction of the array:

Angle between items (+=ccw, -=cw): Specify an angle

AutoCAD LT determines the distance from the array's center point to a reference point on the last object selected. AutoCAD 
LT uses the center point of a circle or arc, the insertion base point of a block or shape, the starting point of text, and one 
endpoint of a line or trace.

Rotate objects as they are copied? <Y>: Enter y or n, or press RETURN

In a polar array, the reference point of the last object in the selection set is used for all objects. If the selection set was 
defined by a window or crossing box, the last object in the selection set is arbitrary. Removing an object from the selection 
set and adding it back forces that object to be the last object selected. The selection set can also be made into a block that 
can be replicated. 



For more information, see "Arraying Objects" in chapter 9 of the AutoCAD LT User's Guide. 

Commands: BLOCK creates blocks from a group of objects. SNAP locks points entered by a pointing device into alignment 
with an imaginary rectangular grid, the rotation and X and Y spacing of which can be changed.

System Variables: SNAPANG stores the snap and grid rotation for the current viewport.



ATTDEF Command
Up a Level          Related Topics

Creates an attribute definition
An attribute is informational text associated with a block. An attribute definition is a template for creating an attribute. Use 
ATTDEF to work on the command line and DDATTDEF to work in the Attribute Definition dialog box.

 At the Command prompt, enter attdef

Attribute Mode
Sets four optional modes. Entering i, c, v, or p toggles between the modes. The AFLAGS system variable stores the current 
mode settings and can be used to set the default modes. 

Enter (ICVP) to change, RETURN when done: Enter i, c, v, or p, or press RETURN
Invisible.  Specifies that attribute values will not appear when you insert the block. The ATTDISP 

command overrides Invisible mode.
Constant. Gives attributes a fixed value for block insertions. 
Verify. Prompts for verification that the attribute value is correct when you insert the block.
Preset. Sets the attribute to its default value when you insert the block. 

Attribute Tag 
Specifies the attribute tag, which identifies each occurrence of an attribute in the drawing. The tag can contain any 
characters except spaces or exclamation marks. AutoCAD LT changes lowercase letters to uppercase.

Attribute Prompt 
Specifies the prompt that is displayed when you insert a block containing this attribute definition. If you press RETURN, 
AutoCAD LT uses the attribute tag as the prompt. If you turn on Constant mode, this prompt is not displayed.

Default Attribute Value 
Specifies the default attribute value. A default value is not required. If Constant mode is turned on, AutoCAD LT skips this 
prompt and displays the Attribute Value prompt instead.

Attribute Value
Specifies the value for a constant attribute.

Justify / Style / <Start Point>: Enter an option or press RETURN 



Commands: DDATTDEF uses dialog boxes to create an attribute definition for text to be associated with a block. ATTDISP 
globally controls the visibility of attributes. DDATTE and ATTEDIT edit attributes independently of the block definition with 
which they're associated. DDATTEXT and ATTEXT extract attribute data.

System Variables: ATTDIA causes the INSERT command to use dialog boxes for entry of attribute values. ATTMODE 
controls the attribute display mode. ATTREQ determines whether the INSERT command uses default attribute settings 
during insertion of blocks.



'ATTDISP Command
Up a Level          Related Topics

Globally controls attribute visibility
An attribute is informational text associated with a block.

 
From the Options menu, choose Display, then Attribute Display

 
At the Command prompt, enter attdisp

Normal / ON / OFF <current>: Enter an option or press RETURN

The drawing regenerates after you change the visibility. AutoCAD LT stores the current settings for visibility of attributes in 
the ATTMODE system variable.

      



Commands: DDATTE and ATTEDIT edit attributes independently of the block definition with which they're associated. 
DDATTEXT and ATTEXT extract attribute data. DDATTDEF and ATTDEF create an attribute definition for text to be 
associated with a block. The Mode option of DDATTDEF and ATTDEF determines the visibility of newly created objects.

System Variables: ATTDIA causes the INSERT command to use dialog boxes for entry of attribute values. ATTMODE 
controls the attribute display mode. ATTREQ determines whether the INSERT command uses default attribute settings 
during insertion of blocks.



Normal

Retains the current visibility of each attribute. Visible attributes are displayed. Invisible attributes are not displayed.



On

Makes all attributes visible.



Off

Makes all attributes invisible.



ATTEDIT Command
Up a Level          Related Topics

Changes attribute information independent of its block definition 

 From the Attribute toolbar, choose 

 From the Modify menu, choose Objects, then Attribute, 
then Global 

 At the Command prompt, enter attedit

Edit attributes one at a time? <Y> Enter y or press RETURN to edit attributes one at a time, or enter n to edit attributes 
globally

Editing attributes globally limits you to replacing a single text string with another text string. If you edit attributes one at a 
time, you can edit any or all of the attributes.



Commands: ATTDISP globally controls the visibility of attributes. DDATTEXT and ATTEXT extract attribute data. ATTDEF 
and DDATTDEF create an attribute definition for text to be associated with a block. DDATTE uses dialog boxes to edit 
attributes independently of the block definition with which they're associated. 

System Variables: ATTDIA causes the INSERT command to use dialog boxes for entry of attribute values. ATTMODE 
controls the attribute display mode. ATTREQ determines whether the INSERT command uses default attribute settings 
during insertion of blocks.



Editing Attributes One at a Time (ATTEDIT)
Up a Level

Attributes to be edited one at a time must be visible and parallel to the current UCS. 

Block name specification <*>: Enter a name list or press RETURN

Attribute tag specification <*>: Enter a name list or press RETURN

Attribute value specification <*>: Enter a name list or press RETURN

Attribute values are case sensitive.

Select Attributes: Select only those attributes parallel to the current UCS

AutoCAD LT marks the first attribute in the selection set with an X. You can change any properties of the attribute you select.

Value / Position / Height / Angle / Style / Layer / Color / Next <N>: Enter the property to change, or press RETURN for 
the next attribute

If the original attribute was defined with aligned or fit text, the prompt does not include Angle. The Height option is omitted for
aligned text.

For each of the options, except Next, AutoCAD LT prompts for a new value. The X remains on the current attribute until you 
move to the next attribute.

      



Editing Attribute Values Globally (ATTEDIT)
Up a Level

Global editing applies to both visible and invisible attributes.

Edit only attributes visible on screen? <Y> Enter y or press RETURN to edit only visible attributes, or enter n to edit all 
attributes

Visible Attributes Only
Block name specification <*>: Enter a name list or press RETURN

Attribute tag specification <*>: Enter a name list or press RETURN

Attribute value specification <*>: Enter a name list or press RETURN

Attribute values are case sensitive. Because null attributes are not visible and cannot be selected for editing, to select null 
attribute values, enter a backslash (\).

Select Attributes: Select only attributes parallel to the current UCS

String to change: Enter string to change or press RETURN

New string: Enter replacement string or press RETURN

Either string can be null. The ? and * characters are interpreted literally, not as wild-cards.

All Attributes
Changes to attributes are not reflected immediately. AutoCAD LT regenerates the drawing at the end of the command unless
REGENAUTO, which controls automatic regeneration, is off.

Block name specification <*>: Enter a name list or press RETURN

Attribute tag specification <*>: Enter a name list or press RETURN

Attribute value specification <*>: Enter a name list or press RETURN

Attribute values are case sensitive. Because null attributes are not visible and cannot be selected for editing, to select null 
attribute values, enter a backslash (\).

String to change: Enter string to change or press RETURN

New string: Enter replacement string or press RETURN

Either string can be null. The ? and * characters are interpreted literally, not as wild-card characters.



Next

Moves to the next attribute in the selection set. If there are no more attribute selected, the ATTEDIT command ends.



Value

Changes or replaces an attribute value.

Change or Replace? <R> Enter c or r, or press RETURN

Change
Modifies a few characters of the attribute value.

String to change: Enter string to change or press RETURN

New string: Enter replacement string or press RETURN

Either string can be null. The ? and * characters are interpreted literally, not as wild-card characters.

Replace
Substitutes a new attribute value for the entire attribute value.

New Attribute value: Enter a new attribute value or press RETURN

If you press RETURN, the attribute value is set to a null string.



Position

Changes the text insertion point.

Enter text insertion point: Specify a point or press RETURN

AutoCAD LT prompts for a new starting, center, or end point, depending on the position of the attribute. If the attribute is 
aligned, AutoCAD LT prompts for both ends of a new text baseline.



Height

Changes the text height.

New height <current>: Enter a value, specify a point, or press RETURN

If you specify a point, the height becomes the distance between the specified point and the start point of the text.



Angle

Changes the rotation angle.

New rotation angle <current>: Enter a value, specify a point, or press RETURN

If you specify a point, the text is rotated along an imaginary line between the specified point and the start point of the text.



Style

Changes the text style.

New style or RETURN for no change: Enter a style name or press RETURN



Layer

Changes the layer of the attributes.

New layer <current>: Enter a layer name or press RETURN



Color

Changes the color of the attribute.

New color <current>: Enter a color or press RETURN

You can enter a color name, a color number between 1 and 255, or bylayer or byblock.



ATTEXT Command
Up a Level          Related Topics

Extracts attribute data
An attribute is informational text associated with a block. Use ATTEXT to extract attribute data at the command line and 
DDATTEXT to extract attribute data using the Attribute Extraction dialog box.

 At the Command prompt, enter attext

CDF, SDF or DXF Attribute extract (or Objects)? <C>: Enter an option or press RETURN



For information about working with attributes, see chapter 14, "Using Blocks, Attributes, and External References, " in the 
AutoCAD LT User's Guide. 

Commands: DDATTEXT uses dialog boxes to extract attribute data. DDATTE and ATTEDIT edit attributes independently of 
their associated block definitions. DDATTDEF and ATTDEF create an attribute definition for text to be associated with a 
block. 

System Variables: ATTDIA causes the INSERT command to use dialog boxes for entry of attribute values. ATTMODE 
controls the attribute display mode. ATTREQ determines whether the INSERT command uses default attribute settings 
during insertion of blocks.



Objects (ATTEXT)
Up a Level

Selects objects whose attributes you want to extract.

Select object: Use an object selection method

CDF, SDF or DXF Attribute extract? <C> Enter an option or press RETURN



CDF: Comma-Delimited File (ATTEXT)
Up a Level

Generates a file containing one record for each block reference in the drawing. Commas separate the fields of each record. 
Single quotation marks enclose the character fields.

In the Select Template File dialog box, enter the name of an attribute template file. 

In the Create Extract File dialog box, enter a name for the output file. AutoCAD LT adds a .txt extension to extraction files in 
CDF or SDF format.



SDF: Space-Delimited File (ATTEXT)
Up a Level

Generates a file containing one record for each block reference in the drawing. The fields of each record have a fixed width; 
therefore, field separators or character string delimiters are not used.

In the Select Template File dialog box, enter the name of an attribute template file. 

In the Create Extract File dialog box, enter a name for the output file. AutoCAD LT adds a .txt extension to extraction files in 
CDF or SDF format.



DXF: Drawing Interchange File (ATTEXT)
Up a Level

Produces a subset of the AutoCAD LT drawing interchange file format containing only block reference, attribute, and end-of-
sequence objects. DXF-format extraction does not require an attribute template. AutoCAD LT adds the file extension .dxx to 
distinguish the output file from normal DXF files.

In the Create Extract File dialog box, enter a name for the output file. AutoCAD LT adds a .txt extension to output files in 
CDF or SDF format.



Select Template File Dialog Box
Up a Level

File Name
Select or enter the name of the file you want to use as a template for the output file. 

List Files of Type
Select the type of files that you want to see listed in the File Name box.

Directories
Select the directory that contains the file you want to use as an attribute template.

Drives
Select the drive that contains the file you want to use as an attribute template.

Find File...
To use search criteria to find attribute template files on multiple drives and directories, choose Find File. The Browse/Search 
dialog box is displayed.

Network
To connect network drives to your computer, choose Network. The Map Network Drive dialog box is displayed. 



Create Extract File Dialog Box
Up a Level

File Name
Select or enter the name of the output file you want to create. 

List Files of Type
Select the type of files that you want to see listed in the File Name box.

Directories
Select the directory in which you want to place the output file.

Drives
Select the drive on which you want to place the output file.

Network
To connect network drives to your computer, choose Network. The Map Network Drive dialog box is displayed. 



AUDIT Command
Up a Level          Related Topics

Evaluates the integrity of a drawing
AUDIT is a diagnostic tool for examining the current drawing and correcting errors. For every error detected, AutoCAD LT 
provides a description of the error and recommends corrective action.

From the File menu, choose Management, then Audit
At the Command prompt, enter audit

Fix any errors detected? <N>: Enter y or n, or press RETURN

For easy access, AUDIT places all objects for which it reports errors in the previous selection set. However, editing 
commands affect only the objects belonging to the current paper space or model space.

When the AUDITCTL system variable is on, AUDIT creates an ASCII file containing a description of the problems and the 
action taken. This report file is placed in the same directory as the current drawing and given the file extension .adt.

If a drawing contains errors that AUDIT can't fix, use the RECOVER command to retrieve the drawing and correct its errors.



Commands: RECOVER repairs a damaged drawing. OPEN alerts you if a drawing is damaged.

System Variables: AUDITCTL controls whether an audit report file is generated.



'BASE Command
Up a Level          Related Topics

Sets the insertion base point for the current drawing
Use BASE if the current drawing is to be inserted into or externally referenced by other drawings and needs a base point 
other than 0,0,0. 

At the Command prompt, enter base

Base point <current>: Specify a point or press RETURN

When you insert or externally reference the current drawing into other drawings, AutoCAD LT uses this base point as the 
insertion base point.



Commands: INSERT inserts a drawing into the current drawing. BLOCK creates a block definition from selected objects 
and sets a base point. XREF links a drawing to the current drawing by creating an external reference to the other drawing.

System Variables: INSBASE stores the insertion base point.



BHATCH Command
Up a Level          Related Topics

Fills an enclosed area with an associative hatch pattern
BHATCH computes a polyline boundary from objects that make up an enclosed area. You can then fill the boundary with an 
associative hatch, a hatch that updates when its boundaries are modified. 

   
From the Draw toolbar, choose 

   From the Draw menu, choose Hatch
 At the Command prompt, enter bhatch

The Boundary Hatch dialog box is displayed.

If you enter -bhatch at the Command prompt, AutoCAD LT presents options on the command line: 

Properties / Select / Remove islands / Advanced / <Internal point>: Specify a point or enter an option



Boundary Hatch Dialog Box
Up a Level

Pattern Type
Specifies a pattern type: Predefined, User-defined, Custom.

Pattern Properties
Sets properties for the chosen pattern: ISO Pen Width, Pattern, Custom Pattern, Scale, Angle, Spacing, Double, Exploded.

Boundary
Defines a boundary: Pick Points, Select Objects, Remove Islands, View Selections, Advanced.

Preview Hatch
Displays the hatching before applying it. The dialog box closes and the selected area is hatched. After viewing the hatch, 
enter the Select option to redisplay the Boundary Hatch dialog box. This option is not available if you do not select an area.

Inherit Properties
Applies the properties of an existing hatch to the current Pattern Type and Pattern Properties options. The Boundary Hatch 
dialog box closes, and you are prompted to select an object.

Select hatch object: Select a hatch block

After you select an object, the Boundary Hatch dialog box is displayed with the hatch pattern properties updated to match 
the hatch pattern settings you selected.

Associative
Controls associative hatching. If you select this option, the new hatch is associative and is updated automatically when its 
boundaries are modified.

Apply
Applies the specified hatching to the drawing. The Apply option is not available when no selection or boundary is made.



For more information, see "Adding Hatch Patterns" in chapter 6 and "Standard Hatch Patterns" in appendix D of the 
AutoCAD LT User's Guide. For information about the aclt.pat file and creating your own hatch patterns, see chapter 20 of the
AutoCAD LT User’s Guide.

Commands: HATCH fills selected objects with a nonassociative hatch pattern. HATCHEDIT modifies an existing associative
hatch block. BOUNDARY creates a polyline from an enclosed area.

System Variables: HPANG sets the hatching angle. HPDOUBLE specifies whether a user-defined hatch is double hatched. 
HPNAME sets the hatch pattern name. HPSCALE sets the hatch pattern scale. HPSPACE sets the spacing of a user-
defined hatch pattern. SNAPBASE specifies the starting point for the hatch pattern.



Predefined

Specifies a pattern from those defined in the aclt.pat or acltiso.pat files.



User-Defined

Defines a pattern of lines using the current linetype.



Custom

Specifies a custom pattern in a .pat file other than the aclt.pat or acltiso.pat files.



ISO Pen Width

Scales an ISO-related pattern based on the selected pen width. This option is available only if a predefined ISO hatch 
pattern is selected.



Pattern

Specifies a predefined pattern name. AutoCAD LT stores the pattern name in the HPNAME system variable. This option is 
not available if User-defined or Custom is selected under Pattern Type.



Custom Pattern

Specifies a custom pattern name. AutoCAD LT stores the pattern name in the HPNAME system variable. This option is 
available only if Custom is selected under Pattern Type.



Scale

Expands or contracts a predefined or custom hatch pattern. AutoCAD LT stores the scale in the HPSCALE system variable. 
This option is not available if User-defined is selected under Pattern Type.



Angle

Specifies an angle for the hatch pattern relative to the X axis of the current UCS. AutoCAD LT stores the angle in the 
HPANG system variable. 



Spacing

Specifies the spacing of lines in a user-defined hatch pattern. AutoCAD LT stores the spacing in the HPSPACE system 
variable. This option is available only if User-defined is selected under Pattern Type.



Double

Specifies a second set of lines to be drawn at 90 degrees to the original lines in a user-defined hatch pattern. AutoCAD LT 
stores this information in the HPDOUBLE system variable. This option is available only if User-defined is selected under 
Pattern Type. 



Exploded

Specifies that the hatch pattern be created from individual line segments rather than as a hatch block. AutoCAD LT stores 
this information by preceding the pattern name with an asterisk in the HPNAME system variable. You can also use the 
EXPLODE command to split hatch blocks into individual line objects. 



Pick Points

Determines a boundary from existing objects that form an enclosed area. If Island Detection is selected in the Advanced 
Options dialog box, AutoCAD LT detects objects within the outermost boundary as islands that are hatched or not hatched 
as specified by the hatch style. The Boundary Hatch dialog box closes, and AutoCAD LT prompts for point specification.

Select internal point: Specify a new point within the area to be hatched

Select internal point: Specify a point, enter u, or press RETURN to end point specification

To undo the last selection, enter u or undo.

      

      



Select Objects

Specifies specific objects for hatching. The Boundary Hatch dialog box closes and AutoCAD LT prompts for object selection.

      

      

When you use the Select Objects option, AutoCAD LT does not detect interior objects automatically. You must select the 
objects within the selected boundary to ensure that those objects are hatched according to the current hatch style.

      

      

Each time you choose Select Objects, AutoCAD LT clears the previous selection set.



Remove Islands

Removes from the boundary objects defined as islands by the Pick Points option. You cannot remove the outer boundary.

      

      



View Selections

Displays the currently defined boundary set. This option is not available when no selection or boundary has been made.



Advanced

Displays the Advanced Options dialog box. In large drawings, the default method of defining a boundary may be slow, 
because AutoCAD LT examines everything visible in the current viewport. To improve the speed of hatching, redefine the 
boundary set in the Advanced Options dialog box.



Advanced Options Dialog Box (BHATCH)
Up a Level

Define Boundary Set
Defines the set of objects analyzed when AutoCAD LT defines a boundary from a specified pick point.

Specifying a boundary set can produce the boundary faster because AutoCAD LT examines fewer objects. When there's no 
existing boundary set, the From Existing Boundary Set option is not available.

Select an option:

From Everything on Screen
From Existing Boundary Set 
Make New Boundary Set 

Style 
Specifies the method used to hatch objects within the outermost hatch boundary, Normal, Outer, or Ignore. If there are no 
internal objects selected, specifying a hatching style has no effect. Because you can define a precise set of boundaries, it's 
often best to use the Normal style.

Note: Hatching concave curves with the Outer and Ignore styles can cause hatching discrepancies.

The image tile to the right of the Style list shows an example of the selected hatching style, a group of four nested objects 
text within a triangle within a square within a circle. For these image tile examples, assume that all these objects are 
boundary objects.

Ray Casting
Controls the way AutoCAD LT defines a hatch boundary. Ray casting is available only if Island Detection is not selected. 
Usually the Nearest option produces a desirable result, however, it may not be satisfactory when the space between two 
possible boundaries is very narrow. You can look for the boundary in a specific direction from the point you select, by 
selecting one of the other options: +X, -X, +Y, -Y  .  

Island Detection
Specifies whether objects within the outermost boundary are used as boundary objects. These internal objects are known as
islands.

Retain Boundaries
Specifies whether the temporary boundary objects will be added to the drawing.



Make New Boundary Set

Selects a set of objects. When you choose Make New Boundary Set, all dialog boxes close to allow object selection. 
AutoCAD LT includes only the hatchable objects you select when it constructs the new boundary set. If there's already a 
boundary set, it's discarded and replaced by the new one. If you do not select any hatchable objects, AutoCAD LT retains 
any current set. Until you exit BHATCH or define a new boundary set, AutoCAD LT uses only the objects you have selected 
to construct boundaries.



From Everything on Screen

Creates a boundary set from everything visible on the screen. Selecting this option when there's a current boundary set 
discards the current set and uses everything visible in the current viewport.



From Existing Boundary Set

Selects the current boundary set.



Normal

Hatches inward from the area boundary. If AutoCAD LT encounters an internal intersection, it turns off hatching until it 
encounters another intersection. Thus, areas separated from the outside of the hatched area by an odd number of 
intersections are hatched, and areas separated by an even number of intersections are not. 



Outer

Hatches inward from the area boundary. AutoCAD LT turns hatching off if it encounters an internal intersection and doesn't 
turn it back on. Because this process starts from both ends of each hatch line, only the outermost level of the structure is 
hatched, and the internal structure is left blank. 



Ignore

Ignores all internal objects and hatches through them.



Nearest

Runs a line from the point you specify to the nearest object and then traces the boundary in a counter-clockwise direction.



+X

Runs a line in the positive X direction from the point you specify to the first object encountered and then traces the boundary
in a counterclockwise direction.

The illustration indicates that the valid internal points for positive X direction ray casting are nearest the right-hand edges of 
the circle. The X indicates the area that causes a boundary definition error.



-X

Runs a line in the negative X direction from the point you specify to the first object encountered and then traces the 
boundary in a counterclockwise direction.

The illustration indicates that the valid internal points for negative X direction ray casting are nearest the left-hand edges of 
the circle. The X indicates the area that causes a boundary definition error.



+Y

Runs a line in the positive Y direction from the point you specify to the first object encountered and then traces the boundary
in a counterclockwise direction.

The illustration indicates that the valid internal points for positive Y direction ray casting are nearest the upper edges of the 
circle. The X indicates the area that causes a boundary definition error.



-Y

Runs a line in the negative Y direction from the point you specify to the first object encountered and then traces the 
boundary in a counterclockwise direction.

The illustration indicates that the valid internal points for negative Y direction ray casting are nearest the lower edges of the 
circle. The X indicates the area that causes a boundary definition error.



Internal Point (BHATCH)
Up a Level

Determines a boundary from existing objects that form an enclosed area. If Island Detection is turned on, AutoCAD LT 
detects objects within the outermost boundary as islands and hatches them or not, depending on the current hatch style. 
Hatching applied is associative.



Properties (BHATCH)
Up a Level

Specifies new hatch pattern properties. For more information, see the HATCH command.

Pattern (? or name / U, style) <current>: Enter a predefined pattern name, enter u, enter ?, or press RETURN

Pattern Name–Predefined

Specifies a predefined pattern or a custom pattern name. Enter the pattern name followed by an optional hatch style code. 
Precede the pattern name with an asterisk (*) to fill the area with individual lines instead of a hatch block.

Scale for pattern <current>: Specify a scale or press RETURN

Angle for pattern <current>: Specify an angle or press RETURN

U–User–Defined Pattern Name

Specifies a user-defined pattern. Enter u, followed by an optional hatch style code. Precede the u with an asterisk (*) to fill 
the area with individual lines instead of a hatch block.

Angle for crosshatch lines <current>: Specify an angle for the pattern or press RETURN

Spacing between lines <current>: Specify the distance between pattern lines or press RETURN

Double hatch area? <current>: Enter y to specify a second set of lines to be drawn at 90 degrees to the original lines, or
press RETURN



Select (BHATCH)
Up a Level

Selects specific objects for hatching.

Select objects: Use an object selection method



Remove Islands (BHATCH)
Up a Level

Removes from the boundary set objects defined as islands by the Internal Point option.

Select island to remove: Select an island



Advanced (BHATCH)
Up a Level

Refines the method AutoCAD LT uses to create the hatch boundary.

Boundary set / Retain boundary / Island detection / Associativity / <eXit>: Enter an option or press RETURN

Exit
Returns to the initial prompt of the BHATCH command.

Boundary Set
Defines the set of objects analyzed when AutoCAD LT defines a boundary from a specified point.

New / <Everything>: Enter an option or press RETURN.

Retain Boundary
Specifies whether or not the derived (temporary) boundary objects will be added to the drawing after hatching is completed.

Retain derived boundaries? <current>: Enter y or n, or press RETURN

Island Detection
Specifies whether objects within the outermost boundary are used as boundary objects.

Do you want island detection? <current>: Enter y or n, or press RETURN

Specifying no island detection prompts for the ray casting method.

Specify ray:

Nearest / +X / -X / +Y / -Y / Angle <current>: Enter an option or press RETURN

Associativity
Specifies that the new hatch pattern updates when its boundaries are modified. Hatching created with BHATCH is, by 
default, associative.

Do you want associativity? <current>: Enter y or n, or press RETURN



Nearest

Runs a line from the point you specify to the nearest object and then traces the boundary in a counter-clockwise direction.



+X

Runs a line in the positive X direction from the point you specify to the first object encountered and then traces the boundary
in a counterclockwise direction.



-X

Runs a line in the negative X direction from the point you specify to the first object encountered and then traces the 
boundary in a counterclockwise direction.

The illustration indicates that the valid internal points for negative X direction ray casting are nearest the left-hand edges of 
the circle. The X indicates the area that causes a boundary definition error.



+Y

Runs a line in the positive Y direction from the point you specify to the first object encountered and then traces the boundary
in a counterclockwise direction.

The illustration indicates that the valid internal points for positive Y direction ray casting are nearest the upper edges of the 
circle. The X indicates the area that causes a boundary definition error.



-Y

Runs a line in the negative Y direction from the point you specify to the first object encountered and then traces the 
boundary in a counterclockwise direction.

The illustration indicates that the valid internal points for negative Y direction ray casting are nearest the lower edges of the 
circle. The X indicates the area that causes a boundary definition error.



Angle

Runs a line at the specified angle from the point you specify to the first object encountered and then traces the boundary in a
counterclockwise direction.

Ray casting angle: Specify an angle



Everything

Creates a boundary set from everything visible on the screen or in the current viewport. Selecting this option when there's a 
current boundary set discards the current set and uses everything visible on the screen or in the current viewport.



New

Creates a boundary from a selection set you define. Selecting this option when there's a current boundary set discards the 
current set and uses everything visible in the current viewport.

Select objects: Use an object selection method



'BLIPMODE Command
Up a Level          Related Topics

Controls the display of marker blips
At the Command prompt, enter blipmode

ON / OFF <current>: Enter on or off, or press RETURN

When Blip mode is on, a temporary mark in the shape of a plus sign (+) appears where you specify a point.

      

To remove marker blips, use REDRAW, REGEN, ZOOM, PAN, or other commands that redraw or regenerate the drawing.



Commands: DDRMODES sets drawing aids, including Blip mode.

System Variables: BLIPMODE stores the Blip mode setting.



BLOCK Command
Up a Level          Related Topics

Creates a block definition from selected objects

At the Command prompt, enter block

Block name ( or ? ): Enter a name or ?

      



Block Name (BLOCK)
Up a Level

Names the block. Block names can be up to 31 characters in length and can contain letters, digits, and the special 
characters dollar sign ($), hyphen (-), and underscore (_). AutoCAD LT converts letters to uppercase. If you enter the name 
of an existing block, AutoCAD LT displays the following prompt:

Redefine it? <N> Enter y or n, or press RETURN

By redefining a block, you automatically update all references to that block.

Insertion base point: Specify a point (1)

The point specified is used as the base point for subsequent insertions of the block. Typically, a base point is the center of 
the block or its lower-left corner. The base point is also the point about which the block can be rotated during insertion. A 
block with 0 rotation is oriented according to the UCS in effect when it was created. Entering a 3D point inserts the block at a
specific elevation. Omitting the Z coordinate uses the current elevation. 

Select objects: Use an object selection method

AutoCAD LT constructs a block using the name provided, the insertion base point, and the objects selected and then erases 
the selected objects from the drawing. You can restore deleted objects by entering the OOPS command immediately. 



?    List Previously Defined Blocks (BLOCK)
Up a Level

Block(s) to list <*>: Enter a name list or press RETURN

Lists the block names in the text window. External references (xrefs) are indicated with the notation Xref: resolved. 
Externally dependent blocks (blocks in an xref) are indicated with the notation xdep:XREFNAME, where XREFNAME is the 
name of an externally referenced drawing. The following terms are used in the list:

User Blocks
Number of user-defined blocks in the list.

External References
Number of xrefs in the list.

Dependent Blocks
Number of externally dependent blocks in the list.

Unnamed Blocks 
Number of unnamed (anonymous) blocks in the drawing.



For more information about blocks, see "Working with Blocks" in chapter 14 of the AutoCAD LT User's Guide. 

Commands: ATTDEF and DDATTDEF create an attribute definition for text to be associated with a block. DDINSERT and 
INSERT place a previously defined block or drawing into the current drawing. OOPS restores erased objects. WBLOCK 
writes selected objects to a new drawing file. XREF controls xrefs (external references).



BMAKE
Up a Level          Related Topics

Defines a block

From the Draw menu, choose Make Block

At the Command prompt, enter bmake

The Block Definition dialog box is displayed.

After specifying the Block, the selected objects are removed from the drawing unless Retain Entities is selected.



Block Definition Dialog Box
Up a Level

Block name
Specifies the name of the block. A block name can be up to 31 characters. You can use letters, numbers, and special 
characters, such as $, -, and _.

Base Point
Indicates where the insertion point for the block is. You can specify a base point by choosing Select Point and selecting a 
point on screen, or you can enter coordinates in the X, Y, and Z text boxes.

Select Objects
Picks the objects to include in the new block. When you have finished selecting objects, press RETURN to display the dialog
box. The objects you select are deleted from the drawing unless you selected Retain Objects.

List Block Names
Lists the blocks currently defined in the drawing. 

Displays the Block Names In This Drawing dialog box. In the Pattern text box, you can enter wild-card characters or names 
of blocks to list.

Retain Objects
Retains objects in your drawing that you have selected to be in the block. If the check box is not checked, AutoCAD LT 
automatically deletes the selected objects after they have been included in the block.



Retain Objects

Retains objects in your drawing that you have selected to be in the block. If the check box is not checked, AutoCAD LT 
automatically deletes the selected objects after they have been included in the block.



For more information on blocks, see "Working with Blocks" in chapter 14 of the AutoCAD LT User's Guide. 

Commands: ATTDEF and DDATTDEF create an attribute definition for text to be associated with a block. DDINSERT and 
INSERT place a previously defined block or drawing in the current drawing. OOPS restores erased objects. WBLOCK writes
selected objects to a new drawing file. XREF controls xrefs (external references).



BMPOUT Command
Up a Level          Related Topics

Saves selected objects to a file in device-independent bitmap format
From the File menu, choose Export

 At the Command prompt, enter bmpout

In the Create BMP File dialog box, enter a file name.

Select objects: Use an object selection method

AutoCAD LT creates a bitmap file.



Create BMP File Dialog Box
Up a Level

File Name
Select or enter the name you want to assign to the bitmap file you want to create. 

List Files of Type
Select the type of files you want to see in the File Name box.

Directories
Select the directory that you want to contain the bitmap file.

Drives
Select the drive that you want to contain the bitmap file.

Network
To connect network drives to your computer so you can access files on those drives, choose Network. The Map Network 
Drive dialog box is displayed. The Network option does not appear if your computer is not connected to a network.



For more information, see "Using Other File Formats," in chapter 17 of the AutoCAD LT User's Guide. 

For more information about saving files in other formats, see "Using Other File Formats" in chapter 14 of the AutoCAD LT 
User's Guide. 

Commands: EXPORT saves objects to other file formats. 



BOUNDARY Command
Up a Level          Related Topics

Creates a polyline from an enclosed area
   

From the Draw toolbar, choose 
   From the Draw menu, choose Boundary
 At the Command prompt, enter boundary

The Boundary Creation dialog box is displayed.

If you enter -boundary at the Command prompt, AutoCAD LT presents options on the command line.

Advanced options / <Internal point>: Specify a point or enter a



Commands: PLINE creates 2D polylines. BHATCH fills an enclosed area with a hatch pattern.



Boundary Creation Dialog Box
Up a Level

Boundary Set
Defines the set of objects that AutoCAD LT uses to define a boundary based on a pick point.

From Everything on Screen
Creates a boundary set from everything visible on the screen. If you select this option when a current boundary set exists, 
AutoCAD LT discards the current set and uses everything visible in the current viewport.

From Existing Boundary Set
Uses the current boundary set. This option is unavailable if a boundary set has not been created using BOUNDARY or 
BHATCH.

Make New Boundary Set
Creates a new boundary set from specific objects in the current drawing. The dialog box closes temporarily so that you can 
select the objects you want to be part of the boundary set. 

Ray Casting
Controls the way a boundary is defined by determining which object is included in the boundary. The boundary is traced in a 
counterclockwise direction around the object found by the method you select. This option is not available when Island 
Detection is selected.

Nearest
+X
-X
+Y
-Y

Island Detection
Uses objects within the outermost boundary as boundary objects.

Boolean Subtract Islands
Deletes islands from the boundary. 

To include Islands in the outer boundary, clear this options.

Pick Points
Accepts all selections in the dialog box. The dialog box close so that you can select the internal points that define the 
boundary object. Press RETURN when you finish selecting internal points.



Advanced Options (BOUNDARY)
Up a Level

Refines the method AutoCAD LT uses to create the boundary.

Boundary set / Island detection / <eXit>: Enter an option or press RETURN



Internal Point (BOUNDARY)
Up a Level

Creates a boundary from existing objects that form an enclosed area.



Exit

Returns to the initial prompt of the BOUNDARY command.



Boundary Set

Defines the set of objects analyzed when AutoCAD LT defines a boundary from a specified point.

New / <Everything>: Enter an option or press RETURN.



Island Detection

Specifies whether objects within the outermost boundary are used as boundary objects.

Do you want island detection? <current>: Enter y or n, or press RETURN

Specifying no island detection prompts for the ray casting method.

Specify ray:

Nearest / +X / -X / +Y / -Y / Angle <current>: Enter an option or press RETURN



BREAK Command
Up a Level          Related Topics

Erases parts of objects or splits an object in two
 

From the Modify toolbar, choose 

From the Modify menu, choose Break 
 At the Command prompt, enter break

Select object: Use an object selection method or specify the first break point (1) on an object

Enter second point (or F for first point): Specify the second break point (2) or enter f

      

AutoCAD LT erases the portion between the first and second points. If the second point is not on the object, AutoCAD LT 
selects the nearest point on the object; therefore, to break off one end of a line, arc, or polyline, specify the second point 
beyond the end to be removed. 

To split an object in two without erasing a portion, enter the same point for both the first and second points. You can do this 
by entering @ to specify the second point. 

If you select an object using a method other than picking, or if you enter f at the prompt for the second point, AutoCAD LT 
prompts:

Enter first point: Specify a point

Enter second point: Specify a point

    

Lines, arcs, circles, polylines, ellipses, splines, donuts, and several other object types can be split into two objects or have 
one end removed. 

AutoCAD LT converts a circle to an arc by removing a piece moving counterclockwise from the first to the second point. 

      



BREAK Command
Up a Level          Related Topics

Erases parts of objects or splits an object in two
 

From the Modify toolbar, choose 

From the Modify menu, choose Break 
 At the Command prompt, enter break

Select object: Use an object selection method or specify the first break point (1) on an object

Enter second point (or F for first point): Specify the second break point (2) or enter f

      

AutoCAD LT erases the portion between the first and second points. If the second point is not on the object, AutoCAD LT 
selects the nearest point on the object; therefore, to break off one end of a line, arc, or polyline, specify the second point 
beyond the end to be removed. 

To split an object in two without erasing a portion, enter the same point for both the first and second points. You can do this 
by entering @ to specify the second point. 

If you select an object using a method other than picking, or if you enter f at the prompt for the second point, AutoCAD LT 
prompts:

Enter first point: Specify a point

Enter second point: Specify a point

    

Lines, arcs, circles, polylines, ellipses, splines, donuts, and several other object types can be split into two objects or have 
one end removed. 

AutoCAD LT converts a circle to an arc by removing a piece moving counterclockwise from the first to the second point. 

      



BREAK Command
Up a Level          Related Topics

Erases parts of objects or splits an object in two
 From the Modify toolbar, choose 

From the Modify menu, choose Break 
 At the Command prompt, enter break

Select object: Use an object selection method or specify the first break point (1) on an object

Enter second point (or F for first point): Specify the second break point (2) or enter f
      

AutoCAD LT erases the portion between the first and second points. If the second point is not on the object, AutoCAD LT 
selects the nearest point on the object; therefore, to break off one end of a line, arc, or polyline, specify the second point 
beyond the end to be removed. 

To split an object in two without erasing a portion, enter the same point for both the first and second points. You can do this 
by entering @ to specify the second point. 

If you select an object using a method other than picking, or if you enter f at the prompt for the second point, AutoCAD LT 
prompts:

Enter first point: Specify a point

Enter second point: Specify a point

    

Lines, arcs, circles, polylines, ellipses, splines, donuts, and several other object types can be split into two objects or have 
one end removed. 

AutoCAD LT converts a circle to an arc by removing a piece moving counterclockwise from the first to the second point. 

      



BREAK Command
Up a Level          Related Topics

Erases parts of objects or splits an object in two
 From the Modify toolbar, choose 

From the Modify menu, choose Break 
 At the Command prompt, enter break

Select object: Use an object selection method or specify the first break point (1) on an object

Enter second point (or F for first point): Specify the second break point (2) or enter f
      

AutoCAD LT erases the portion between the first and second points. If the second point is not on the object, AutoCAD LT 
selects the nearest point on the object; therefore, to break off one end of a line, arc, or polyline, specify the second point 
beyond the end to be removed. 

To split an object in two without erasing a portion, enter the same point for both the first and second points. You can do this 
by entering @ to specify the second point. 

If you select an object using a method other than picking, or if you enter f at the prompt for the second point, AutoCAD LT 
prompts:

Enter first point: Specify a point

Enter second point: Specify a point

    

Lines, arcs, circles, polylines, ellipses, splines, donuts, and several other object types can be split into two objects or have 
one end removed. 

AutoCAD LT converts a circle to an arc by removing a piece moving counterclockwise from the first to the second point. 

      



For more information about modifying objects, see "Removing Parts of Objects" in chapter 10 of the AutoCAD LT User's 
Guide. 



Browse Dialog Box
Up a Level

File Name
Select a preview image or enter the name of the file you want to open. 

Directories
Select the directory that contains the file you want to open.

Drives
Select the drive that contains the file you want to open.

List Files of Type
Select the type of files you want to see listed under File Name.

Network
To connect network drives to your computer, choose Network. The Map Network Drive dialog box is displayed. 



Busy Dialog Box
Up a Level

The source application for this object is busy or unavailable. The source application might be processing another request, or 
it might not be installed properly. 



Change Source Dialog Box
Up a Level

Changes the source file of a linked object.

File Name

Select or enter the name of the drawing file you want to open. 

Note: You can open only a drawing or a DXF file.

List Files of Type
Select the type of files you want to see listed in the File Name box.

Directories
Select the directory that contains the drawing file you want to open.

Drives
Select the drive that contains the drawing file you want to open.

Network
Select a network drive from the list.

Source Item
If the source is a selection within a file, not the entire file, make any necessary changes in the string representing the 
selection.



Pointing Device Button Defaults
Up a Level

This is a list of default commands and macros assigned to the buttons on your pointing device. These assignments are 
defined in the file aclt.mnu. See “Customizing Menus” in AutoCAD LT Help.

Button Action

1 Pick button, enters points, selects menu items, 
and so forth

2 RETURN

SHIFT+2 Displays the cursor menu

3 Displays the cursor menu

4 Cancels the current command

5 Turns SNAP mode on and off

6 Turns ORTHO mode on and off

7 Turns GRID on and off

8 Turns coordinate display

9 Switches isoplane to left, top, right, or on and off

10 Turns TABLET mode on and off

The number of buttons and their placement depends on your pointing device. When Tablet mode is off, the first three buttons
work as mouse buttons 1, 2, and 3. On a three-button pointing device, button 1 is on the left, button 2 is on the right, and 
button 3 is in the middle.



CHAMFER Command
Up a Level          Related Topics

Bevels the edges of objects
If the TRIMMODE system variable is set to 1, CHAMFER trims the intersecting lines to the endpoints of the chamfer line. If 
the selected lines do not intersect, AutoCAD LT extends or trims them so that they do. 

If TRIMMODE is set to 0, the chamfer is created without trimming the selected lines.

   

From the Modify toolbar, choose 

From the Modify menu, choose Chamfer
 At the Command prompt, enter chamfer

Polyline / Distances / Angle / Trim / Method / <Select first line>: Use an object selection method or enter an option

If both objects to be chamfered are on the same layer, AutoCAD LT creates the chamfer on that layer. Otherwise, AutoCAD 
LT creates the chamfer line on the current layer. This is also true for chamfer color and linetype.

 



Select First Line (CHAMFER)
Up a Level

Specifies the first of two edges required to define a 2D chamfer.

Select second line: Use an object selection method

If the two lines you select are polyline segments, they must be adjacent to each other. If they're separated by one line or arc 
segment, AutoCAD LT deletes the segment and replaces it with a chamfer line.



Polyline (CHAMFER)
Up a Level

Chamfers an entire 2D polyline.

Select 2D polyline: Use an object selection method

AutoCAD LT chamfers the intersecting line segments at each vertex of the polyline. Chamfers become new segments of the 
polyline.

If the polyline includes segments that are too short to accommodate the chamfer distance, those segments are not 
chamfered.

      



Distances (CHAMFER)
Up a Level

Sets the distance of the chamfer from the endpoint of the selected edge. 

Enter first chamfer distance <current>: Specify a distance or press RETURN

Enter second chamfer distance <current>: Specify a distance or press RETURN

If you set both distances to zero, AutoCAD LT extends or trims the two lines so that they end at the same point. 

After you specify the chamfer distance, use CHAMFER again to select the lines to chamfer.

      



Angle (CHAMFER)
Up a Level

Sets the chamfer distances using a chamfer distance for the first line and an angle for the second.

Enter first chamfer distance <current>: Specify a distance or press RETURN

Enter angle from the first line <current>: Specify an angle or press RETURN

          



Trim (CHAMFER)
Up a Level

Controls whether AutoCAD LT trims the selected edges to the chamfer line endpoints.

Trim / No Trim <current>: Enter an option or press RETURN



Method (CHAMFER)
Up a Level

Controls whether AutoCAD LT uses two distances or a distance and an angle to create the chamfer.

Distance / Angle / <current>: Enter an option or press RETURN



For more information about beveling the edges of objects, see "Chamfering Objects" in chapter 10 of the AutoCAD LT User's
Guide. 

Commands: FILLET rounds and fillets the edges of objects. 

System Variables: CHAMFERA sets the first chamfer distance. CHAMFERB sets the second chamfer distance. 
CHAMFERC sets the chamfer length. CHAMFERD sets the chamfer angle. CHAMMODE controls whether CHAMFER uses 
two distances or a distance and an angle to create a chamfer. TRIMMODE controls whether selected edges are trimmed to 
the endpoints of the chamfer line. 



CHANGE Command
Up a Level          Related Topics

Changes the properties of existing objects
The UCS must be aligned with the object you want to change.

 At the Command prompt, enter change

Select objects: Use an object selection method 

If you select lines and other changeable objects in the same selection set, you get varying results depending upon the object
selection sequence. Selecting lines only in a selection set, or selecting objects other than lines in a selection set, is the 
easiest way to use CHANGE.

Properties / <Change point>: Specify a new point (1), enter p, or press RETURN



Change Point (CHANGE)
Up a Level

Lines Only

When you specify a new endpoint for a line or a group of lines, the endpoints of the selected lines closest to the Change 
Point move to the new point unless Ortho mode is on. If Ortho mode is on, AutoCAD LT modifies the selected lines so that 
they become parallel to either the X or the Y axis, rather than moving their endpoints to the specified coordinate.

Objects Other than Lines
AutoCAD LT displays different prompts depending on the objects you selected.

Attribute Definitions
Blocks
Circles
Text



Properties (CHANGE)
Up a Level

Modifies the properties of existing objects. Use DDLMODES, DDEMODES, LAYER, LINETYPE, DDLTYPE, COLOR, or 
ELEV to specify the current drawing properties.

Change what property (Color / Elev / LAyer / LType / LtScale / Thickness)? Enter an option

If you select several objects with different values for the property you want to change, Varies is displayed as the current 
value.

You can change several properties. AutoCAD LT redisplays the Change What Property prompt after each option is 
completed.



Commands: CHPROP, DDCHPROP, and DDMODIFY change the properties of existing objects but do not require that the 
UCS be aligned with the object you want to change. They cannot be used to change the elevation of an object.



Circles

Changes the circle radius. 

Enter circle radius: Specify the new radius or press RETURN

If more than one circle was selected, AutoCAD LT moves on to the next circle and repeats the prompt.



Text

Changes text content and properties.

Enter text insertion point: Specify a point or press RETURN

Specifying a new location repositions the text. Pressing RETURN leaves the text in its original position.

Text style: <current>

New style or RETURN for no change: Enter a name or press RETURN

If the text has a fixed height, AutoCAD LT skips the next prompt.

New height <current>: Specify a height or press RETURN

New rotation angle <current>: Specify an angle or press RETURN

New text <current>: Enter text or press RETURN

AutoCAD LT highlights the next object and displays the prompts relating to it.



Attribute Definitions

Changes the text and text properties of an attribute.

Enter text insertion point: Specify a point or press RETURN

Specifying a new location repositions the text. Pressing RETURN leaves the text at its original position.

Text style: <current>

New style or RETURN for no change: Enter a name or press RETURN

If the text has a fixed height, AutoCAD LT skips the next prompt.

New height <current>: Specify a height or press RETURN

New rotation angle <current>: Specify an angle or press RETURN

New text <current>: Enter text or press RETURN

New tag <current>: Enter a tag or press RETURN

New prompt <current>: Enter a prompt or press RETURN

New default value <current>: Enter the value or press RETURN



Blocks

Changes the location or rotation of a block. 

Enter block insertion point: Specify a point (1) or press RETURN

Specifying a new location repositions the block. Pressing RETURN leaves the block in its original position.

New rotation angle <current>: Enter an angle, or press RETURN 

AutoCAD LT rotates the block about its insertion point to the specified angle.



Color

Changes the color of the selected objects. 

New color <current>: Enter a color name or number (1255) enter bylayer or byblock or press RETURN 

For example, to change a color to red, enter red or 1. If you enter bylayer, the object assumes the color of the layer on 
which it is located. If you enter byblock, the object inherits the color of the block of which it is a component.



Elev

Changes a 2D object's Z axis elevation.

New elevation <current>: Enter a numeric value 

You can change the elevation of an object only if all its points have the same Z value.



Layer

Changes the layer of the selected objects. 

New layer <current>: Enter a layer name or press RETURN



Ltype

Changes the linetype of the selected objects.
New linetype <current>: Enter a linetype name or press RETURN

If the linetype you enter is not loaded, AutoCAD LT tries to load it from the standard linetype library file, aclt.lin. If this 
procedure fails, use the LINETYPE command to load the linetype.



LtScale

Changes the linetype scale factor of the selected objects.
New linetype scale <current>: Specify a scale or press RETURN



Thickness

Changes a 2D object's Z direction thickness. 

New thickness <current>: Enter a distance or press RETURN

Changing the thickness of a 3D polyline, dimension, or floating viewport object has no effect.



Change Icon Dialog Box
Up a Level

Changes the icon that represents an embedded or linked object in an AutoCAD LT drawing.

Icon

Select an icon to represent an embedded or linked object.

Current specifies the currently selected icon. Default specifies the default source application icon. 

Select From File to specify an icon from a file with an extension such as .exe, .dll, or .ico.

Label

Specify a caption for the icon. AutoCAD LT displays the file type unless you specify otherwise.

Browse

Select an icon from a file in the Browse dialog box.



CHPROP Command
Up a Level          Related Topics

Changes the color, layer, linetype, linetype scale factor, and thickness of an existing object
 At the Command prompt, enter chprop

Select objects: Use an object selection method

Change what property (Color / LAyer/ LType / ltScale / Thickness)? Enter an option

If you select several objects with different values for the property you want to change, varies is displayed as the current 
value. 



Commands: The CHANGE command changes elevation as well as other properties and requires that the UCS be aligned 
with the object to change. CHPROP, DDCHPROP , and DDMODIFY do not have this restriction.    Use other commands 
(DDLMODES, DDEMODES, or LAYER, LINETYPE, LTSCALE, COLOR, and ELEV) to set the properties of new objects.



Color (CHPROP)
Up a Level

Changes the color of the selected objects. 

New color <current>: Enter a color name or number (1255) enter bylayer or byblock or press RETURN 

For example, to change a color to red, enter red or 1. If you enter bylayer, the object assumes the color of the layer on 
which it is located. If you enter byblock, the object inherits the color of the block of which it is a component.



Layer (CHPROP)
Up a Level

Changes the layer of the selected objects.

New layer <current>: Enter a layer name or press RETURN



Ltype (CHPROP)
Up a Level

Changes the linetype of the selected objects.

New linetype <current>: Enter a linetype name or press RETURN

If the linetype you enter is not loaded, AutoCAD LT tries to load it from the standard linetype library file, aclt.lin. If this 
procedure fails, use the LINETYPE command to load the linetype.



Ltscale (CHPROP)
Up a Level

Changes the linetype scale factor of the selected objects.

New linetype scale <current>: Specify a scale or press RETURN



Thickness (CHPROP)
Up a Level

Changes a 2D object's Z direction thickness. 

New thickness <current>: Enter a distance or press RETURN

Changing the thickness of a 3D polyline, dimension, or floating viewport object has no effect.



CIRCLE Command
Up a Level          Related Topics

Creates a circle
You can create a circle by beginning with the center point or one of three points on the circumference, or you can select 
objects to which the circle is tangent.

 

From the Draw toolbar, choose 
 From the Draw menu, choose Circle

At the Command prompt, enter circle

3P / TTR /<Center point>: Enter an option or specify a point 



Center Point (CIRCLE)
Up a Level

Draws a circle based on a center point and a diameter or a radius. 

Diameter / <Radius><current>: Specify a point, enter a value, enter d, or press RETURN



For more information about circles, see "Drawing Circles" in chapter 6 of the AutoCAD LT User's Guide. 

Commands: The Isocircle option of the ELLIPSE command draws an isometric circle.

System Variables: CIRCLERAD stores the default value for a circle radius.



Radius

Defines the circle's radius. Enter a value or specify a point (2). The distance between this point and the center point 
determines the radius of the circle.

 



Diameter

Draws a circle using the center point and a specified distance for the diameter.

Diameter <current>: Specify a point (1), enter a value, or press RETURN



3P (CIRCLE)
Up a Level

Draws a circle based on three points on the circumference.

First point: Specify a point (1) or enter a value

Second point: Specify a point (2) or enter a value

Third point: Specify a point (3) or enter a value



TTR    Tangent, Tangent, Radius (CIRCLE)
Up a Level

Draws a circle with a specified radius that is tangent to two objects.

Enter Tangent spec: Select the first object

Enter second Tangent spec: Select the second object

Radius <current>: Specify a distance or press RETURN

Sometimes more than one circle matches the criteria specified. AutoCAD LT draws the circle of the specified radius whose 
tangent points are closest to the object selection points, as shown below.

          



'COLOR Command
Up a Level          Related Topics

Sets the color for new objects
 At the Command prompt, enter color

New object color <current>: Enter a value (1255), a color name, byblock, or bylayer

Enter the color number, or enter a standard color name: yellow, green, cyan, blue, magenta, and white.

If you enter byblock, AutoCAD LT draws new objects in the default color (white or black, depending on your configuration) 
until they are grouped into a block. When the block is inserted in the drawing, the objects in the block inherit the current 
setting of the COLOR command.

Warning: If you used a mixture of color methods to draw the objects that make up a block, inserting that block or changing 
its color produces complex results.

If you enter bylayer, new objects assume the color of the layer upon which they are drawn. See the LAYER command for 
information about assigning a color to a layer.



Commands: CHANGE, DDCHPROP, and CHPROP change the color of    an existing objects. DDEMODES sets color 
properties for new objects. DDMODIFY displays object properties. DDLMODES controls layers. The Color option of the 
LAYER command controls the color associated with specific layers.

System Variables: CECOLOR sets the color for new objects.



Convert Dialog Box
Up a Level

Specifies a different source application for an embedded object.

Current Type

Displays the type of object you are converting or activating.

Object Type

Displays a list of available object types. Select a new type for the embedded object.

Convert To

Converts the embedded object to the type specified under Object Type.

Activate As

Opens the embedded object in the type selected under Object Type but returns the object to its current type after editing.

Display as Icon

Displays the source application's icon in the AutoCAD LT drawing. 

Change Icon

Displays the Change Icon dialog box. This option is not available unless you selected Display As Icon.

Result

Describes the result of the selected options.



Map Network Drive Dialog Box
Up a Level

Drive
Displays the first available drive letter for the connection. You can select another drive letter.

Path

Specifies the network path for the connection. You can select a previous network path from the Path box, select a new 
network path from the Shared Directories list, or enter the name of a computer and shared directory in the Path box.

Connect As (Windows NT only)
Specifies a different user name than your logon name. By default you are connected as the user name you used to log on.

Reconnect at Logon

Connects you to the shared directory each time you log on.

Expand by Default (Windows NT only)

Automatically expands the Shared Directories list.

Shared Directories (Windows NT only)

Displays a list of shared directories. Select the directory you want to place in the Path box.

Note: The Windows NT dialog box is titled “Connect Network Drive.”



COPY Command
Up a Level          Related Topics

Duplicates objects 
 

From the Modify toolbar, choose 

From the Modify menu, choose Duplicate

 At the Command prompt, enter copy

Select objects: Use an object selection method

<Base point or displacement>/Multiple: Specify a point or enter m

          

          



Base Point or Displacement (COPY)
Up a Level

Second point of displacement: Specify a point or press RETURN

If you specify two points, AutoCAD LT uses the first point as a base point and places a single copy relative to that base point.
The two points you specify define a displacement to determine how far the selected objects are moved and in what direction.

If you press RETURN at the second point, the first point is interpreted as relative X, Y, Z displacement. In this case, the first 
point is usually entered at the keyboard.

Note: The @ symbol should not be entered as part of this displacement coordinate.



Multiple (COPY)
Up a Level

Makes multiple copies using one COPY command. AutoCAD LT prompts for an insertion base point for the selection object.
Base point: Specify a point

Second point of displacement: Specify a point or press RETURN

If you specify a point, AutoCAD LT places a copy at that point relative to the base point. The Second point of displacement 
prompt is repeated, for placement of multiple copies of the object. If you press RETURN, the command ends.



Commands: ARRAY creates multiple copies of objects in a rectangular or polar pattern.

System Variables: GRIPS controls the grips used to manipulate objects. COPYCLIP copies objects to the Windows 
clipboard.



COPYCLIP Command
Up a Level          Related Topics

Copies objects to the Windows Clipboard
 

From the Standard toolbar, choose 
   From the Edit menu, choose Copy

 At the Command prompt, enter copyclip

Select objects: Use an object selection method

AutoCAD LT saves a copy of the selected objects to the Clipboard in all available formats.



For more information, see "Copying Objects," in chapter 9 of the AutoCAD LT User's Guide.

Commands: BMPOUT saves selected objects to a file in device-independent bitmap format. COPYLINK copies the current 
viewport for linking to other OLE applications. CUTCLIP copies selected objects to the Windows Clipboard and erases the 
objects from the drawing. WMFOUT saves selected objects to a Windows metafile. COPY duplicates objects.



COPYLINK Command
Up a Level          Related Topics

Copies the current view to the Windows Clipboard for linking to other OLE applications
   From the Edit menu, choose Copy Link

 At the Command prompt, enter copylink

AutoCAD LT copies the current view to the Clipboard. The contents of the Clipboard can be pasted into a document as an 
OLE object.



For more information, see "Copying Objects," in chapter 9 of the AutoCAD LT User's Guide. 

Commands: COPYCLIP copies objects to the Windows Clipboard. CUTCLIP copies selected objects to the Windows 
Clipboard and erases the objects from the drawing. OLELINKS edits links, updates objects, and changes source files. 
PASTESPEC inserts data from the Windows Clipboard and controls the format of the data.



COPYHIST Command
Up a Level          Related Topics

Copies the text in the command line history window to the Clipboard
The command line history window is the window above the command line. You can use its scroll bars to view the contents. 
You can set this window to display from zero to three lines while the graphics window is active by using the PREFERENCES
command.

 At the Command prompt, enter copyhist

AutoCAD LT copies the text to the Clipboard.



For more information, see "The Command Window" in chapter 2 of the AutoCAD LT User's Guide. 

Commands: The PREFERENCES command customizes the AutoCAD LT environment settings.



CUTCLIP Command
Up a Level          Related Topics

Copies objects to the Windows Clipboard and erases the objects from the drawing
   From the Standard toolbar, choose 

   From the Edit menu, choose Cut
 At the Command prompt, enter cutclip

Select objects: Use an object selection method

AutoCAD LT copies the current selection set to the Clipboard and removes the objects from the drawing. CUTCLIP does not 
create Paste Link information.



For more information, see "Copying Objects," in chapter 9 of the AutoCAD LT User's Guide.

Commands: COPYCLIP copies objects to the Windows Clipboard. COPYLINK copies the current view to the Windows 
Clipboard for linking to other OLE applications.



DDATTDEF Command
Up a Level          Related Topics

Creates an attribute definition
An attribute is informational text associated with a block. An attribute definition specifies an attribute’s properties and which 
prompts appear when the block is inserted.

 

From the Attribute toolbar, choose 

From the Draw menu, choose Define Attribute
At the Command prompt, enter ddattdef

The Attribute Definition dialog box is displayed.

After you complete the Attribute Definition dialog box, the attribute tag appears in the drawing. AutoCAD LT erases the 
attribute tag from the drawing when the attribute tag is included in a block definition using the BMAKE or BLOCK command. 
When you insert the block, AutoCAD LT displays the attribute value at the same location in the block with the same text style
and alignment.



For more information, see "Working with Attributes" in chapter 14 of the AutoCAD LT User's Guide. 

Commands: ATTDEF creates attributes on the command line. ATTDISP overrides the visibility of attributes. ATTEDIT edits 
attributes on the command line. CHANGE modifies an attribute definition. DDATTE edits a block's variable attributes. 
DDATTEXT extracts attribute data. DDEDIT edits text and attribute definitions. 

System Variables: AFLAGS stores the Mode settings. 



Attribute Definition Dialog Box
Up a Level

Mode
Sets options for attribute values associated with a block when you insert the block in a drawing.

Note: These options are stored in the AFLAGS system variable.

Invisible. Makes the attribute value invisible. The attribute value is not displayed or printed.
Note: To display invisible attributes, use the ATTDISP command.

Constant. Assigns a fixed attribute value. The attribute value is inserted automatically into the drawing when the 
block is inserted.

Verify. Instructs AutoCAD LT to prompt you to verify that the attribute value is correct before the block is inserted in
the drawing.

Preset. Sets the attribute to its default value when you insert a block containing a preset attribute.

Attribute
Sets attribute data.

Tag. Identifies each occurrence of an attribute in the drawing. Enter the attribute tag using any combination of 
characters, except spaces.

Prompt. Enter the prompt that you want displayed when you insert the block containing this attribute definition. If 
you do not enter a prompt, the attribute tag is used as a prompt. To create a leading blank for the value, start the text string 
with a backslash (\). To use a backslash as the first character, enter two backslashes.

Note: This text box is unavailable if you select Constant in the Mode area.

Value. Enter the default attribute value (maximum of 256 characters). To create a leading blank for the value, start 
the text string with a backslash (\). To use a backslash as the first character, enter two backslashes.

Insertion Point
Specifies the location of the attribute when the block is inserted in a drawing. Select a point in the drawing or enter X, Y, and 
Z coordinate values.

Pick Point. Choose Pick Point to close the dialog box so that you can select an insertion point with the mouse. 
After you select a point, the dialog box is redisplayed.

X. Enter the X value for the insertion point. 
Y. Enter the Y value for the insertion point.
Z. Enter the Z value for the insertion point.

Text Options
Sets the justification, style, height, and rotation of the attribute text.

Justification. Select the justification for the attribute text.
Text Style. Select the text style for the attribute text. Currently loaded text styles are displayed. To load or create a 

text style, see DDSTYLE.
Height. Enter a value for the height of the attribute text. Alternatively, choose Height to specify a height with your 

pointing device. The height is measured from the origin to the location you pick using your pointing device. After you specify 
a height, the dialog box is redisplayed.
Note: The Height and Rotation options are not available for all justification settings. 

Rotation. Enter a value for the rotation angle of the attribute text. Alternatively, choose Rotation to specify a 
rotation angle with your pointing device. The rotation angle is measured from the origin to the location you pick using your 
pointing device. After you specify a rotation, the dialog box is redisplayed.
To specify a rotation angle on the screen, choose Rotation. The rotation angle is measured from the origin to the location of 
the cursor when you push the mouse button. 
Note: The Height and Rotation options are not available for all justification settings. 

Align Below Previous Attribute
Select to place the attribute tag directly below the latest defined attribute.



Select to place the attribute tag directly below the latest defined attribute.

Note: If you have not previously defined an attribute definition, this check box is unavailable.



DDATTE Command
Up a Level          Related Topics

Edits the variable attributes of a block
An attribute is informational text associated with a block. DDATTE edits individual, nonconstant attribute values that are 
associated with a specific block. ATTEDIT edits attribute values and properties individually or globally, independent of the 
block.

 

From the Attribute toolbar, choose 

From the Modify menu, choose Objects. Then 
choose Attribute and then Single 
At the Command prompt, enter ddatte

Select block: Select a block with attributes

The Edit Attributes dialog box is displayed. 

To change attribute properties such as position, height, and style, use ATTEDIT.



For more information, see "Editing Attributes Attached to Blocks" in chapter 14 of the AutoCAD LT User's Guide. 

Commands: DDATTDEF and ATTDEF create attributes. ATTDISP controls attribute visibility. ATTEDIT edits attribute values
or properties independently of the block definition with which they are associated. DDEDIT edits text and attribute 
definitions. DDATTEXT and ATTEXT extract attribute data.

System Variables: ATTMODE sets the current attribute display mode. ATTREQ disables the prompts for attribute values.



Edit Attributes Dialog Box
Up a Level

Block Name
Displays the name of the selected block.

Edit Fields
Enter new values for all defined attributes.



DDATTEXT Command
Up a Level          Related Topics

Extracts attribute data
An attribute is informational text associated with a block. Use DDATTEXT to extract attribute data from a drawing into a 
separate file.

At the Command prompt, enter ddattext

The Attribute Extraction dialog box is displayed.



For more information, see "Extracting Attribute Information for Parts Lists" in chapter 14 of the AutoCAD LT User's Guide. 

Commands: ATTEXT extracts attribute data on the command line. DDATTDEF and ATTDEF create attributes. ATTDISP 
controls attribute visibility. DDATTE and ATTEDIT edit attributes. DDEDIT edits text and attribute definitions. EXPORT saves
objects to other file formats. 

System Variables: ATTDIA controls the display of attribute dialog boxes. ATTMODE sets the current attribute display mode.
ATTREQ enables and disables the prompts for attribute values.



Attribute Extraction Dialog Box (DDATTEXT)
Up a Level

File Format
Select the file format for the attribute data extracted from the current drawing.

Comma Delimited File (CDF)
Space Delimited File (SDF)
Drawing Interchange File (DXF)

Select Objects
Selects objects from which to extract attribute data. When you are finished selecting objects, the Attribute Extraction dialog 
box is redisplayed.

Attribute Template File
Specifies the file to use as a template for the output extract file in CDF and SDF formats. Enter the path and file name to 
use, or choose Attribute Template File to display the Attribute Template File dialog box.

Note: If you selected Drawing Interchange File in File Format, Attribute Template File is unavailable.

Output File
Specifies the file name and location for the extracted attribute data. Enter the path and file name for the extracted attribute 
data, or choose Output File to display the Output File dialog box.



Comma Delimited File (CDF)

Generates a file containing one record for each block reference. Character fields are enclosed in single quotation marks and
separated by commas.



Space Delimited File (SDF)

Generates a file containing one record for each block reference. Character fields of each record have a fixed width. Field 
separators are not used.



Drawing Interchange File (DXF)

Produces a subset of the drawing interchange file format containing only block reference, attribute, and end-of-sequence 
objects. No attribute template file is required. The output file has a .dxx extension to distinguish it from normal DXF files.



Attribute Template File Dialog Box
Up a Level

File Name
Select or enter the name of the file you want to use as a template for the output file. 

List Files of Type
Select the type of files you want displayed in the File Name list box.

Directories
Select the directory for the attribute template file.

Drives
Select the drive for the attribute template file.

Find File...
To use search criteria to find attribute template files on multiple drives and directories, choose Find File. The Browse/Search 
dialog box is displayed.



Output File Dialog Box
Up a Level

File Name
Select or enter the name for the output file. 

List Files of Type
Select the type of files you want displayed in the File Name list box.

Directories
Select the directory for the output file.

Drives
Select the drive for the output file.



DDCHPROP Command
Up a Level          Related Topics

Changes the color, layer, linetype, linetype scale factor, and thickness of an object
 At the Command prompt, enter ddchprop

Select objects: Use an object selection method

The Change Properties dialog box is displayed.



Change Properties Dialog Box
Up a Level

Color
Changes the color of the selected objects with the Select Color dialog box.

Layer
Changes the layer of the selected objects with the Layer Control dialog box.

Linetype
Changes the linetype of the selected objects with the Select Linetype dialog box.

Linetype Scale
Changes the value for the linetype scale factor of the selected objects.

Thickness
Changes the value for the distance to extrude the selected object or objects. Entering a positive value extrudes the objects 
above their current elevation. Entering a negative value extrudes objects below their current elevation.



Extrude

Extruding an object gives it a width in the Z direction. The resulting object has a surface useful for 3D viewing and the HIDE 
and SHADE operations.



For more information, see “Changing Layers, Colors, and Linetypes” in chapter 10 of the AutoCAD LT User's Guide.

Commands: CHANGE and CHPROP change an object's properties on the command line. LAYER creates and names 
drawing layers and assigns properties to them. LINETYPE loads linetypes on the command line.



DDCOLOR Command
Up a Level          Related Topics

Sets the color for new objects
   

From the Object Properties toolbar, choose 
 From the Format menu, choose Color
 At the Command prompt, enter ddcolor

The Select Color dialog box is displayed.



Select Color Dialog Box
Up a Level

Standard Colors
To select a standard color, choose a tile.

Gray Shades
To select a shade of gray, choose a tile.

Logical Colors
Determines how color assignments are made.

BYLAYER. Causes all new objects to assume the color of the layer upon which they are drawn.
BYBLOCK. Causes all new objects to assume the color of any block into which they are grouped. Before the new 

objects are grouped into a block, they are drawn in the default color (white or black).

Full Color Palette
To select a color from the full color palette, choose a tile. Full Color Palette displays the number of colors available to your 
display device. 

Color 
Displays the name of the selected color. You can enter a AutoCAD Color Index number from 1 through 255 to select a new 
color.



For more information, see "Assigning a Color to an Object" in chapter 10 of the AutoCAD LT User's Guide.

Commands: CHANGE, CHPROP, and DDCHPROP set the color of existing objects. COLOR sets the color for new objects 
from the command line. 

System Variables: CECOLOR sets the color for new objects.



DDEDIT Command
Up a Level          Related Topics

Edits line text, paragraph text, dimension text, and attribute definitions
Using DDEDIT, you can edit text in a dialog box. One of three dialog boxes will be displayed depending on the type of text 
you select.

   

From the Modify toolbar, choose 

From the modify menu, choose Objects, then Edit Text
 At the Command prompt, enter ddedit

<Select an annotation object> / Undo: Select text, select an attribute definition, or enter u

      



Select an Annotation Object (DDEDIT)
Up a Level

If you select text created using TEXT or DTEXT (line text), AutoCAD LT displays the Edit Text dialog box.

If you select text created using MTEXT (paragraph text), AutoCAD LT displays the Edit MTEXT dialog box.

If you select an attribute definition, AutoCAD LT displays the Edit Attribute Definition dialog box.

DDEDIT continues to prompt for an annotation object after each edit operation. To end the command, press RETURN.



Edit Text Dialog Box
Up a Level

Text
Modify the existing text or enter the new text you want to appear in the drawing.



Edit Attribute Definition Dialog Box
Up a Level

Tag
Enter a new value for the tag of the attribute definition.

Prompt
Enter a new value for the prompt of the attribute definition.

Default
Enter a new default value for the attribute definition.



Undo (DDEDIT)
Up a Level

Returns the text or attribute definition to its previous value. You can use this option immediately after completing an edit.



For more information, see "Editing Attribute Definitions" in chapter 14 of the AutoCAD LT User's Guide. 

Commands: DDATTE edits a block's variable attributes. ATTEDIT edits attributes independently of the block definition with 
which they're associated.



'DDEMODES Command
Up a Level          Related Topics

Sets properties for new objects
   

From the Object Properties toolbar, choose 
 From the Format menu, choose Current Properties
 At the Command prompt, enter ddemodes

The Current Properties dialog box is displayed.

Note: When you use DDEMODES transparently, the new settings might not affect the current command.



Current Properties Dialog Box
Up a Level

Color
Sets the color of all new objects with the Select Color dialog box.

Layer
Makes changes to layers with the Layer Control dialog box.

Linetype
Sets the linetype of all new objects using the Select Linetype dialog box. This selection overrides the linetype assigned to 
the layer of the new object.

Text Style
Sets the text style with the Text Style dialog box.

Linetype Scale
Enter a value for the linetype scale factor for new objects.

Elevation
Enter the Z value of the XY plane on which new objects are drawn.

Thickness
Enter a value for the distance you want a new object to be extruded above or below its elevation.



For more information, see "Assigning a Color to an Object" in chapter 10 of the AutoCAD LT User's Guide.

Commands: DDCHPROP and CHPROP and CHANGE can change an existing object's color, layer, linetype, and thickness.
DDCOLOR and COLOR set the color of new objects. DDLMODES and LAYER control layer settings. DDLTYPE loads and 
sets linetypes. ELEV sets elevation and extrusion thickness of new objects. LINETYPE loads, sets, and creates linetypes. 
STYLE creates text styles and changes existing style settings. 

System Variables: CECOLOR sets the color of new objects. CELTSCALE sets the current linetype scale factor of new 
objects. CELTYPE sets the linetype of new objects. CLAYER sets the current layer. ELEVATION stores the current 3D 
elevation. TEXTSTYLE sets the current text style. THICKNESS sets the current 3D thickness. 



'DDGRIPS Command
Up a Level          Related Topics

Enables grips and sets their color
 From the Options menu, choose Grips

At the Command prompt, enter ddgrips

The Grips dialog box is displayed.



System Variables: GRIPS activates grips. GRIPBLOCK assigns grips to objects within blocks. GRIPCOLOR changes the 
color of unselected grips. GRIPHOT changes the color of selected grips. GRIPSIZE changes the size of grips.



Grips Dialog Box
Up a Level

Select Settings
Sets the display of grips.

Enable Grips. Enables grips. This setting is stored in the GRIPS system variable.
Enable Grips Within Blocks. Enables grips within blocks. Grips will be displayed on objects within a selected 

block. If this option is not selected, the block is assigned one grip at its insertion point. This setting is stored in the 
GRIPBLOCK system variable.

Grip Colors
Sets the color of grips.

Unselected. Sets the color of unselected (unfilled) grips with the Select Color dialog box. This value is stored in 
the GRIPCOLOR system variable.

Selected. Sets the color of selected (filled) grips with the Select Color dialog box. This value is stored in the 
GRIPHOT system variable.

Grip Size
Sets the size of grips. To adjust the size of grips, move the slider box to the left or right. This value is stored in the GRIPSIZE
system variable.



DDIM Command
Up a Level          Related Topics

Creates and modifies dimension styles
A dimension style is a saved set of dimension settings that determines the appearance of the dimension. By creating 
dimension styles, you can set all relevant dimensioning system variables and control the layout and appearance of any 
dimension.

Dimension styles can have families of settings. For example, within a dimension style you may create a variation for radial 
dimensions and another variation for angular dimensions. AutoCAD LT uses the appropriate dimension style family member 
for the type of dimension you create. If there are no differences in settings for a dimension type, the parent dimension style 
settings are used.

   

From the Dimensioning toolbar, choose 
 From the Format menu, choose Dimension Style
 At the Command prompt, enter ddim

The Dimension Styles dialog box is displayed.



Dimension Styles Dialog Box
Up a Level

You can define all dimension style settings in this dialog box except the settings saved in the DIMSHO and DIMASO system 
variables. 

Dimension Style
Use the options under Dimension Style to load, save, add, rename, or make current a dimension style. 

Current. Displays the name of the current dimension style. From the list, select the name of a dimension style to 
make it the current style. 
Note: This list also displays the names of dimension styles associated with external references. To make changes to an 

externally referenced dimension style, you must copy the style and give it a new name.

Name. Displays the name of the selected dimension style. Enter a new name when renaming a style or creating a 
new style.
Note: You cannot change or rename the STANDARD dimension style.

Save. Saves a new or changed dimension style with the name entered in Name.
Rename. Renames the dimension style selected in Current to the name entered in Name.

Family
Select the family type for the selected dimension style. To set variables for a specific family member, use the family type 
using the Geometry, Format, and Annotation dialog boxes.

Parent. Changes all dimension style family types.
Linear. Changes the linear family type.
Radial. Changes the radial family type.
Angular. Changes the angular family type.
Diameter. Changes the diameter family type.
Ordinate. Changes the ordinate family type.
Leader. Select to make changes to the leader family type.

Geometry
Defines the appearance of lines, arrowheads, and center marks, and changes the overall scale of the dimension with the 
Geometry dialog box.

Format
Defines the location of dimension text, arrowheads, leader lines, and the dimension line with the Format dialog box.

Annotation
Defines the appearance of dimension text with the Annotation dialog box.



Geometry Dialog Box
Up a Level

Controls the appearance of the geometry and overall scale of the dimension. 

Dimension Line 
Extension Line 
Arrowheads 
Center 
Scale 



Dimension Line (Geometry Dialog Box)
Up a Level

Controls the appearance of the dimension line.

Suppress
Suppresses the display of dimension lines when they continue outside the extension lines.

1st. Suppresses the display of the first dimension line. The DIMSD1 system variable is set to On.
2nd. Suppresses the display of the second dimension line. The DIM    system variable is set to On.

Extension
Sets the distance to extend the dimension line past the extension line when oblique strokes (tick marks) are set as the 
arrowheads of the dimension. The value is stored in the DIMDLE system variable.

Spacing
Sets the spacing between the dimension lines of a baseline dimension. The value is stored in the DIMDLI system variable.

Color
Sets the color of the dimension line with the Select Color dialog box. The value is stored in the DIMCLRD system variable.



Extension Line (Geometry Dialog Box)
Up a Level

Controls the appearance of the extension lines.

Suppress
Suppresses the display of extension lines.

1st. Suppresses the display of the first extension line. The DIMSE1 system variable is set to On.
2nd. Suppresses the display of the second extension line. The DIMSD2 system variable is set to On.

Extension
Sets the distance to extend the extension lines above the dimension line. The value is stored in the DIMEXE system 
variable.

Origin Offset
Sets the distance to offset the extension lines from the points on the drawing that define the dimension. The value is stored 
in the DIMEXO system variable.

Color
Sets the color of the extension line with the Select Color dialog box. The value selected is stored in the DIMCLRE system 
variable.



Arrowheads (Geometry Dialog Box)
Up a Level

Controls the appearance of the arrowheads in a dimension. 

1st
Select the type of arrowhead for the first arrowhead. The value is stored in the DIMBLK system variable. If you select a 
different type of arrowhead in 2nd, this value is stored in DIMBLK1.

Note: To select a user-created block as the arrowhead, choose User Arrow. The User Arrow dialog box is displayed.

2nd
Select the type of arrowhead for the second arrowhead. If you selected a different type of arrowhead in 1st, this value is 
stored in the DIMBLK2 system variable.

Note: To select a user-created block as the arrowhead, choose User Arrow. The User Arrow dialog box is displayed.

Size
Enter a value for the size of the arrowheads. The value is stored in the DIMASZ system variable.



Center (Geometry Dialog Box)
Up a Level

Controls the appearance of center marks and lines for diameter and radial dimensions.

Mark
Creates a center mark.

Line
Creates a center line.

None
Does not create a center mark or center line.

Size
Specifies a value for the size of the center mark or center line. This value is stored in the DIMCEN system variable.



Scale (Geometry Dialog Box)
Up a Level

Sets the dimension scale in the drawing.

Overall Scale
Enter a value for the scale factor for all dimensioning that specifies sizes, distances, and spacing. The scale factor affects 
text and arrowhead sizes, but does not affect tolerances, measured lengths, coordinates, or angles. The value is stored in 
the DIMSCALE system variable.

Scale to Paper Space
Determines a scale factor based on the scaling between the current model space viewport and paper space. The 
DIMSCALE system variable is set to 0.

If the TILEMODE system variable is set to 1 or if you are working in paper space but not a model space viewport, the 
DIMSCALE system variable is set to the default value of 1.0.



User Arrow Dialog Box
Up a Level

Arrow Name
Enter the name of the alternate block you want to use as the arrowhead for the dimension.



Format Dialog Box
Up a Level

User Defined
Select to have AutoCAD LT prompt you for the dimension text position when you create a dimension. AutoCAD LT ignores 
any horizontal justification setting. The DIMUPT system variable is set to 1.

If this option is not selected, AutoCAD LT uses the settings under Horizontal Justification to determine the location of 
dimension text. The DIMUPT system variable is set to 0.

Force Line Inside
Select to have AutoCAD LT dimension lines between the measured points of the dimension even when arrowheads are 
placed outside the measured points. The DIMTOFL system variable is set to 1.

Fit
Controls the placement of text and arrowheads inside or outside the extension lines based on the space available between 
the extension lines. If space is available, text and arrows are placed inside the extension lines. 

Text and Arrows
Text Only
Arrows Only
Best Fit
Leader
No Leader

Horizontal Justification
Controls the horizontal justification of dimension text along the dimension line and the extension line.

Centered
1st Extension Line
2nd Extension Line
Over 1st Extension Line
Over 2nd Extension Line

Text
Controls the position of dimension text inside and outside the extension lines.

Inside Horizontal
Outside Horizontal

Vertical Justification
Controls the vertical justification of dimension text along the dimension line.

Centered
Above
Outside
JIS



Text and Arrows

Places the text and arrows outside the extension lines, if they will not fit between the extension lines. When you move the 
dimension text, the dimension line moves with it.



Text Only

Places the arrows inside and the text outside the extension lines , if they will not both fit between the extension lines. If there
is still not enough space for the text, it is placed outside the extension lines with the arrowheads. When you move the 
dimension text, the dimension line moves with it.



Arrows Only

Places the text inside and the arrowheads outside the extension lines if they will not both fit between the extension lines. If 
there is still not enough space for the text, it is placed outside the extension lines with the arrowheads. When you move the 
dimension text, the dimension line moves with it.



Best Fit

Places the text, arrowheads, or text and arrowheads inside the extension lines if space is available. When you move the 
dimension text, the dimension line moves with it.



Leader

Creates a leader line to the text if it does not fit between the extension lines. When you move the dimension text, it is 
independent of the dimension line.



No Leader

Places text above the dimension line without a leader line if it does not fit between the extension lines. When you move the 
dimension text, it is independent of the dimension line.



Centered

Centers the dimension text along the dimension line between the extension lines.



1st Extension Line

Left-justifies the dimension text with the first extension line along the dimension line. The offset distance between the 
extension line and the dimension text is twice the arrowhead size plus the text gap value.



2nd Extension Line

Right-justifies the dimension text with the second extension line along the dimension line. The offset distance between the 
extension line and the dimension text is twice the arrowhead size plus the text gap value.



Over 1st Extension Line

Positions the dimension text over or along the first extension line.



Over 2nd Extension Line

Positions the dimension text over or along the second extension line.



Inside Horizontal

Places text that is between extension lines in a horizontal position. The DIMTIH system variable is set to On.

To align text with the dimension line, clear this option. The DIMTIH system variable is set to Off.



Outside Horizontal

Places text that is outside the extension lines in a horizontal position. The DIMTOH system variable is set to On.

To align text with the dimension line, clear this option. The DIMTOH system variable is set to Off.



Centered

Centers the dimension text between the extension lines. The DIMTAD system variable is set to 0.



Above

Places the dimension text above the dimension line. The DIMTAD system variable is set to 1.



Outside

Places the dimension text on the side of the dimension line farthest from the first defining point. The DIMTAD system 
variable is set to 2.



JIS

Places the dimension text in conformance to a Japanese Industrial Standards (JIS) representation. The DIMTAD system 
variable is set to 3.



Annotation Dialog Box
Up a Level

Controls the appearance of dimension text.

Primary Units 
Tolerance 
Alternate Units 
Text 
Round Off 



Primary Units (Annotation Dialog Box)
Up a Level

Controls the display of the primary measurement units of dimension text.

Units
Specifies the primary measurement units with the Primary Units dialog box.

Prefix
Enter the characters of the prefix for the dimension text. You can use control codes to add special symbols to the prefix. For 
a list of available control codes, see DTEXT. The prefix you enter is displayed instead of any default prefixes. This setting is 
stored in the DIMPOST system variable.

Suffix
Enter the characters of the suffix for the dimension text. You can use control codes to add special symbols to the suffix. For 
a list of available control codes, see DTEXT. If you specify tolerances for the dimension, the suffix is added to the tolerance. 
This setting is stored in the DIMPOST system variable.



Tolerance (Annotation Dialog Box)
Up a Level

Creates tolerances for dimension text

Method
Select the type of tolerance you want to add to the dimension text.

None. Does not add a tolerance. The DIMTOL system variable is set to 0.
Symmetrical. Adds a plus/minus expression of tolerance in which a single value of variation is applied to the 

dimension measurement. A ± symbol followed by a tolerance value is displayed after the dimension.    Enter the tolerance 
value in Lower Value. The DIMTOL system variable is set to 1. The DIMLIM system variable is set to 0.

Deviation. Adds a plus/minus expression of tolerance in which different plus and minus values of variation are 
applied to the dimension measurement. A + symbol is added to the tolerance value entered in Upper Value and a - symbol is
added to the tolerance value entered in Lower Value.    The DIMTOL system variable is set to 1. The DIMLIM system variable
is set to 0.

Limits. Creates a limit dimension in which a maximum and a minimum value are displayed, one over the other. 
The maximum value is the dimension value plus the value entered in Upper Value. The minimum value is the dimension 
value minus the value entered in Lower Value. The DIMTOL system variable is set to 0. The DIMLIM system variable is set 
to 1.

Basic. Creates a basic dimension in which a box is drawn around the full extents of the dimension. The distance 
between the text and the box is stored as a negative value in the DIMGAP system variable.

Upper Value
Enter the maximum or upper tolerance value. This value is stored in the DIMTP system variable.

Lower Value
Enter the minimum or lower tolerance value. This value is stored in the DIMTM system variable.

Justification
Select an option to set the text justification of symmetrical and deviation tolerances.

Top. Aligns the tolerance value with the top of the dimension text. The DIMTOLJ system variable is set to 2.
Middle. Aligns the tolerance value with the middle of the dimension text. The DIMTOLJ system variable is set to 1.
Bottom. Aligns the tolerance value with the bottom of the dimension text. The DIMTOLJ system variable is set to 

0.

Height
Enter the value for the ratio of the height of the tolerance text to the height of the dimension text. For example, if you enter 
0.75, the height of the tolerance text is three-quarters the height of the dimension text. This value is stored in the DIMTFAC 
system variable. 



Alternate Units (Annotation Dialog Box)
Up a Level

Controls the display of the alternate measurement units of dimension text. You cannot add alternate measurement units to 
the Angular dimension style family.

Enable Units
Adds alternate measurement units to dimension text. 

Units
Specifies the alternate measurement units with the Alternate Units dialog box.

Prefix
Enter the characters of the prefix for the alternate dimension text. You can use control codes to add special symbols to the 
prefix. For a list of available control codes, see DTEXT. The prefix you enter is displayed instead of any default prefixes. This
setting is stored in the DIMAPOST system variable.

Suffix
Enter the characters of the suffix for the alternate dimension text. You can use control codes to add special symbols to the 
suffix. For a list of available control codes, see DTEXT. If you specify tolerances for the dimension, the suffix is added to the 
tolerance. This setting is stored in the DIMAPOST system variable.



Text (Annotation Dialog Box)
Up a Level

Controls the properties of dimension text.

Style
Select the text style for the dimension text. To create or change text styles, see DDSTYLE. This value is stored in the 
DIMTXSTY system variable.

Height
Enter the value for the size of the dimension text. This value is stored in the DIMTXT system variable.

Gap
Enter the value for the size of the gap that separates the dimension text from the dimension lines. This value is stored in the 
DIMGAP system variable.

Color
Sets the color of the dimension text with the Select Color dialog box. The value is stored in the DIMCLRT system variable.



Round Off (Annotation Dialog Box)
Up a Level

Enter the value to which you want round off the dimension values. For example, if you enter a value of 0.25, the dimension 
values are rounded to the nearest 0.25 unit. This value is stored in the DIMRND system variable.

Note: You cannot round off angular dimensions.



Primary Units Dialog Box
Up a Level

Controls the primary measurement units.

Units 
Dimension 
Angles 
Tolerance 
Scale 



Units (Primary Units Dialog Box)
Up a Level

Select the unit format in which you want dimension values displayed. This values is stored in the DIMUNIT system variable. 
You cannot set the dimension units for the Angular family member. 



Dimension (Primary Units Dialog Box)
Up a Level

Controls the precision and suppression of zeros for the dimension.

Precision
Select a value for the number of decimal places of precision measured for the dimension. When the Parent dimension family
member is selected, the precision is based on the units or angle format you selected.

Zero Suppression

Controls the display of leading and trailing zeros and zero feet and inches. This value is stored in the DIMZIN system 
variable.

Leading. Eliminates display of leading zeros in all decimal dimensions. For example, the value 0.500 
becomes .500. 

Trailing. Eliminates display of trailing zeros in all decimal dimensions. For example, the value 12.500 becomes 
12.5 and the value 30.00 becomes 30.

0 Feet. Does not display a foot value of zero when the dimension is less than 1 foot in length. For example, the 
value 0'-6 1/2" becomes 6 1/2".

0 Inches. Does not display an inch value of zero when the dimension is an integral number of feet. For example, 
the value 1'-0" becomes 1'.



Angles (Primary Units Dialog Box)
Up a Level

Select the unit format for angular dimension values. This value is stored in the DIMAUNIT system variable.    



Tolerance (Primary Units Dialog Box)
Up a Level

Controls the precision and suppression of zeros for tolerance text.

Precision
Select a value for the number of decimal places of precision measured for the tolerance text. When the Parent dimension 
family member is selected, the precision is based on the units or angle format you selected. This value is stored in the 
DIMTDEC system variable.

Zero Suppression
Controls the display of leading and trailing zeros, and zero feet and inches. This value is stored in the DIMTZIN system 
variable.

Leading. Eliminates display of leading zeros in all decimal dimensions. For example, the value 0.500 
becomes .500. 

Trailing. Eliminates display of trailing zeros in all decimal dimensions. For example, the value 12.500 becomes 
12.5 and the value 30.00 becomes 30.

0 Feet. Does not display a foot value of zero when the dimension is less than 1 foot in length. For example, the 
value 0'-6 1/2" becomes 6 1/2".

0 Inches. Does not display an inch value of zero when the dimension is an integral number of feet. For example, 
the value 1'-0" becomes 1'.



Scale (Primary Units Dialog Box)
Up a Level

Controls the global scale factor for linear dimension measurements.

Linear
Enter a value for the global scale factor for linear dimension measurements. All linear distances measured by dimensions 
are multiplied by this value. Angular dimensions and tolerances are not multiplied by this value. This value is stored in the 
DIMLFAC system variable.

Paper Space Only
Applies the value entered in Linear only to dimensions created in paper space. This sets the length scale factor for objects in
a model space viewport. This option is not available when the Leader or Angular family member types are selected. 



Alternate Units Dialog Box
Up a Level

Controls the alternate measurement units.

Units 
Dimension 
Angles 
Tolerance 
Scale 



Units (Alternate Units Dialog Box)
Up a Level

Select the unit format for alternate dimension values. This value is stored in the DIMALTU system variable. You cannot set 
the dimension units for the Angular family member. 



Dimension (Alternate Units Dialog Box)
Up a Level

Controls the precision and suppression of zeros for the dimension.

Precision
Select a value for the number of decimal places of precision measured for the dimension. When the Parent dimension family
member is selected, the precision is based on the units or angle format you selected. This value is stored in the DIMALTD 
system variable.

Zero Suppression
Controls the display of leading and trailing zeros and zero feet and inches. This value is stored in the DIMALTZ system 
variable. 

Leading. Eliminates display of leading zeros in all decimal dimensions. For example, the value 0.500 
becomes .500. 

Trailing. Eliminates display of trailing zeros in all decimal dimensions. For example, the value 12.500 becomes 
12.5 and the value 30.00 becomes 30.

0 Feet. Does not display a foot value of zero when the dimension is less than 1 foot in length. For example, the 
value 0'-6 1/2" becomes 6 1/2".

0 Inches. Does not display an inch value of zero when the dimension is an integral number of feet. For example, 
the value 1'-0" becomes 1'.



Angles (Alternate Units Dialog Box)
Up a Level

You cannot specify alternate units for angular dimensions.



Tolerance (Alternate Units Dialog Box)
Up a Level

Controls the precision and suppression of zeros for tolerance text.

Precision
Select a value for the number of decimal places of precision measured for the tolerance text. When the Parent dimension 
family member is selected, the precision is based on the units or angle format you selected. This value is stored in the 
DIMALTTD system variable.

Zero Suppression
Controls the display of leading and trailing zeros and zero feet and inches. This value is stored in the DIMALTZ system 
variable.

Leading. Eliminates display of leading zeros in all decimal dimensions. For example, the value 0.500 
becomes .500. 

Trailing. Eliminates display of trailing zeros in all decimal dimensions. For example, the value 12.500 becomes 
12.5 and the value 30.00 becomes 30.

0 Feet. Does not display a foot value of zero when the dimension is less than 1 foot in length. For example, the 
value 0'-6 1/2" becomes 6 1/2".

0 Inches. Does not display an inch value of zero when the dimension is an integral number of feet. For example, 
the value 1'-0" becomes 1'.



Scale (Alternate Units Dialog Box)
Up a Level

Controls the global scale factor for linear dimension measurements.

Linear
Enter a value for the global scale factor for linear dimension measurements. All linear distances measured by dimensions 
are multiplied by this value. Angular dimensions and tolerances are not multiplied by this value. This value is stored in the 
DIMALTF system variable.

Paper Space Only
Applies the value entered in Linear only to dimensions created in paper space. This sets the length scale factor for objects in
a model space viewport. This option is not available when the Leader or Angular family member types are selected.



For more information, see chapter, 13 “Dimensioning and Tolerancing,” in the AutoCAD LT User's Guide. 

Commands: DIMSTYLE creates and modifies dimension styles at the Command prompt. For creating and modifying 
dimension objects, refer to the dimensioning commands, which begin with the prefix DIM. LIST lists database information for
selected objects. You can use it to query the overridden dimensioning system variables. 



DDINSERT Command
Up a Level          Related Topics

Inserts a block or another drawing
   

From the Draw toolbar, choose 
 From the Draw menu, choose Insert Block 
 At the Command prompt, enter ddinsert

The Insert dialog box is displayed.

The last block you inserted during the current editing session becomes the default block for subsequent DDINSERT 
commands. The position of the inserted block depends on the orientation of the UCS. 



Insert Dialog Box
Up a Level

Block
Specifies the name of a block you want to insert in the drawing or the name of a file you want to insert in the drawing as a 
block.

Block. Enter the name of the block you want to insert. Choose Block to select from a list of defined blocks using 
the Defined Blocks dialog box.

File. Enter the name of a drawing file you want to insert as a block. Choose File to select from a list of available 
drawing files using the Select Drawing File dialog box.
Note: You can create a block from the drawing file you select by entering a block name in the Block text box. The drawing in 

the drawing file is copied to a new block with the name you entered. The drawing file remains unchanged. To do this, 
Explode must be off. You can use this method to rename a file whose name contains embedded space.

Options
Specifies options for inserting the block.

Specify Parameters on Screen. Select to use the pointing device to define the insertion point, scale, and rotation 
angle of the block on screen.

Clear to set the insertion point, scale, and rotation angle with the options that follow.
Insertion Point. Specifies the X,Y,Z coordinate location of the insertion point of the block. The Z box displays the 

current elevation. 
Scale. Specifies the X, Y, and Z scale factors of the inserted block. Entering negative values inserts a mirror image

of a block.
Rotation. Specifies the rotation angle for the block in the current UCS.

Explode
Select to insert the block or file as the individual objects that make up the block or file. Component objects of a block drawn 
on layer 0 remain on that layer. Objects having color BYBLOCK are white. Objects with linetype BYBLOCK have continuous 
lines.

Note: When Explode is selected, you can specify a uniform scale factor only.



Defined Blocks Dialog Box
Up a Level

Pattern
Displays the names of blocks in the current drawing. Use letters and wild-card characters to sort the list of block names in 
the current drawing.

Selection
Enter the name of the block you want to insert in the drawing, or select the block from the Pattern list box.



For more information, see "Inserting Blocks" in chapter 14 of the AutoCAD LT User's Guide.

Commands: INSERT places a named block or drawing into the current drawing. EXPLODE breaks a compound object into 
its component objects.

System Variables: INSNAME stores the name of the most recently inserted block.



'DDLMODES Command
Up a Level          Related Topics

Manages layers
 

From the Object Properties toolbar, choose 
   From the Format menu, choose Layers

At the Command prompt, enter ddlmodes

The Layer Control dialog box is displayed. 



Layer Control Dialog Box
Up a Level

In the Layer Control dialog box, you can make a layer current, add new layers to the Layer Name list, and rename an 
existing layer. You can turn layers on and off, freeze and thaw layers, and lock and unlock layers globally or by viewport.

Current Layer
Displays name of the current layer. To select a different layer, select one in Layer Name and then select Current.

Layer Name
Lists all layers in the drawing with their names, current states, colors, and linetypes. 

Select All
Selects all layers in Layer Name.

Clear All
Clears all layers in Layer Name.

New
Creates one or more layers. Enter the names of the new layers, separated by commas, in the text box below New, then 
choose New. Use up to 31 characters for each layer name. Do not use wild-cards or enter existing layer names. 

Each new layer is turned on and assigned the color white and the CONTINUOUS linetype. 

Current
Makes the selected layer the current layer. If you select a layer that is turned off, AutoCAD LT automatically turns that layer 
on.

Rename
Renames a selected layer. Enter the new name in the text box below Current, then choose Current.

Off
Turns the selected layers off, making them invisible in the drawing. If you turn the current layer off, all objects you create will 
not be visible until you turn the layer on.

On
Turns the selected layers on, making them visible in the drawing.

Freeze
Freezes the selected layers. The objects on these layers will not be displayed or regenerated, and they cannot be plotted. 
The letter F is displayed in the State column in Layer Name for all frozen layers.

Thaw
Thaws the selected layers. The objects on these layers will be regenerated and made visible. 

Lock
Locks the selected layers. The objects on these layers cannot be edited. You can still create new objects on locked layers. 
The letter L is displayed in the State column in Layer Name for all locked layers.

Unlock
Unlocks the selected layers. The objects on these layers can be edited. 



Cur VP
In model space, the Cur VP options freeze or thaw selected layers in the current model space viewport only. The layers may 
be visible in other viewports and paper space.

In paper space, the Cur VP options freeze or thaw selected layers in paper space. These changes do not affect layers in 
viewports.

The global settings, Off and Freeze, take precedence over the layer settings in the current viewport. 

Thw
Frz

New VP
The New VP options freeze or thaw selected layers for all new viewports. Both Cur VP and New VP are checked for each 
selected layer in the new viewport. The global settings, Off and Freeze, take precedence over the layer settings in the 
current viewport. 

Thw
Frz

Set Color
Sets the color of the selected layers with the Select Color dialog box.

Set LType
Sets the linetype of the selected layers with the Select Linetype dialog box.

Filters
Specifies that only layers with specific characteristics be displayed. You can display layers based on their state, name, color,
and linetype by setting up a layer filter. 

Set. Specifies a sorting filter for the layers displayed in Layer Name with the Set Layer Filters dialog box.
On. Select to use the sorting filter. Clear to display all layers in Layer Name.



Thw

Select to thaw the selected layer or layers frozen in the current viewport only. 



Frz

Freezes the selected layer or layers in the current viewport. The letter C is displayed in the State column in Layer Name for 
all layers frozen in the current viewport.



Thw

Thaws the selected layer or layers for all new viewports.



Frz

Freezes the selected layer or layers for all new viewports. The letter N is displayed in the State column in Layer Name for all 
layers that will be frozen in new viewports.



Set Layer Filters Dialog Box
Up a Level

On/Off
Both. Displays layers that are on or off.
On. Displays only layers that are currently on.
Off. Displays only layers that are currently off.

Freeze/Thaw
Both. Displays layers that are frozen or thawed.
Frozen. Displays only layers that are currently frozen.
Thawed. Displays only layers that are currently thawed.

Lock/Unlock
Both. Displays layers that are locked or unlocked.
Locked. Displays only layers that are currently locked.
Unlocked. Displays only layers that are currently unlocked.

Current Vport
Both. Displays layers that are frozen or thawed in the current viewport.
Frozen. Displays only layers that are frozen in the current viewport.
Thawed. Displays only layers that are thawed in the current viewport.

New Vports
Both. Displays layers that are frozen or thawed in new viewports.
Frozen. Displays only layers that are frozen in new viewports.
Thawed. Displays only layers that are thawed in new viewports.

Layer Names
Displays layers with a specific name only. Enter characters, including wild-cards, of the layer names. 

Use the default value (*) to not sort the list of layers by name.

Colors
Displays layers that are assigned a specific color. Enter characters, including wildcards, of the layer name or the AutoCAD 
Color Index number of the colors assigned to the layers.

Use the default value (*) to not sort the list of layers by color.

Ltypes
Displays layers that are assigned a specific linetype. Enter characters, including wildcards, of the linetype names for the 
layers.

Use the default value (*) to not sort the list of layers by linetype.

Reset
Resets all values to the default values.



For more information, see "Creating and Naming Layers" in chapter 4 of the AutoCAD LT User's Guide. 

Commands: COLOR and DDCOLOR set the color for new objects. DDEMODES sets properties for new objects, including 
color, layer, linetype, text style, elevation, and thickness. LAYER is the command line equivalent of DDLMODES. DDLTYPE 
loads and sets linetypes. LINETYPE and DDLTYPE create, load, and set linetypes. VPLAYER sets viewport visibility for new
and existing layers. 

System Variables: CLAYER stores the name of the current layer.



DDMODIFY Command
Up a Level          Related Topics

Controls object properties
DDMODIFY controls properties of existing objects.

    
From the Object Properties toolbar, choose 

    From the Edit menu, choose Properties
 At the Command prompt, enter ddmodify

Select object to modify: Use an object selection method

AutoCAD LT displays the appropriate dialog box for the type of object you selected:

Arc MText
Associative Hatch Point
Attribute Definition Polyline
Block Insertion Ray
Circle Solid
Dimension Spline
Ellipse Text
External Reference Tolerance
Leader Viewport
Line Xline

For more information, see "Changing Text" in chapter 12 of the AutoCAD LT User's Guide. 

Commands: DDCHPROP and CHPROP change an existing object's color, layer, linetype, and thickness. DDCOLOR and 
COLOR set the color of new objects. DDLMODES and LAYER control layer settings. DDLTYPE loads and sets linetypes. 
ELEV sets elevation and extrusion thickness of new objects. LINETYPE loads, sets, and creates linetypes. STYLE creates 
text styles and changes existing style settings. 

System Variables: CECOLOR sets the color of new objects. CELTSCALE sets the current linetype scale factor of new 
objects. CELTYPE sets the linetype of new objects. CLAYER sets the current layer. ELEVATION stores the current 3D 
elevation. THICKNESS sets the current 3D thickness.



Modify Arc Dialog Box
Up a Level

Properties

Controls the properties of the arc.

Color. Changes the color of the arc with the Select Color dialog box.
Layer. Changes the layer of the arc with the Layer Control dialog box.
Linetype. Changes the linetype of the arc with the Select Linetype dialog box.
Handle. Displays the handle of the selected arc. You cannot change this value with DDMODIFY.
Thickness. Specifies the thickness of the arc.
Linetype Scale. Specifies the linetype scale factor for the arc.

Center
Controls the location of the center point of the arc.

Pick Point. Closes the dialog box so that you can define a new center point for the arc on the screen. After you 
select a new center point, the Modify Arc dialog box is redisplayed.

X. Specifies the X value for the coordinate of the center point.
Y. Specifies the Y value for the coordinate of the center point.
Z. Specifies the Z value for the coordinate of the center point.

Radius
Specifies the radius of the arc.

Start Angle
Specifies the start angle of the arc.

End Angle
Specifies the end angle of the arc.

Total Angle
Displays the total angle of the arc.

Arc Length
Displays the total length of the arc.



Modify Associative Hatch Dialog Box
Up a Level

Properties
Controls the properties of the associative hatch.

Color. Changes the color of the associative hatch with the Select Color dialog box.
Layer. Changes the layer of the associative hatch with the Layer Control dialog box.
Linetype. Changes the linetype of the associative hatch with the Select Linetype dialog box.
Handle. Displays the handle of the selected associative hatch. You cannot change this value with DDMODIFY.
Thickness. Specifies the thickness of the associative hatch.
Linetype Scale. Specifies the linetype scale factor for the associative hatch.

Hatch Edit
Changes the appearance of the hatch with the Hatch Edit dialog box.



Modify Attribute Definition Dialog Box
Up a Level

Properties
Controls the properties of the attribute definition.

Tag
Displays the current tag of the attribute definition. You can enter a new tag.

Prompt
Displays the current prompt of the attribute definition. You can enter a new prompt.

Default
Displays the current default value of the attribute definition. You can enter a new value.

Origin
Controls the location of the origin of the attribute definition

Height
Specifies the height of the text in the attribute definition.

Note: Changing this value affects only the selected attribute definition, not the default height defined in the text style. To 
revert to the default value, select the original style in the Style list box.

Rotation
Specifies the rotation of the text in the attribute definition.

Width Factor
Specifies the width factor for the text in the attribute definition. A value greater than 1 expands the width of each character in 
the font. A value less than 1 compresses the width of each character in the font.

Note: Changing this value affects only the selected attribute definition, not the default width factor defined in the text style. 
To revert to the default value, select the original style in the Style list box.

Obliquing
Specifies the angle that you want to oblique (italicize) the text in the attribute definition.

Note: Changing this value affects only the selected text object, not the default obliquing value defined in the text style. To 
revert to the default value, select the original style in the Style list box.

Justify
Specifies the justification for the selected text object. For a description of each justification setting, see DTEXT.

Note: Changing this value affects only the selected text object only, not the default justification defined in the text style. To 
revert to the default value, select the original style in the Style list box.

Style
Specifies the style for the selected attribute definition. All settings changed previously will be set to the default values of this 
style.

Upside Down
Causes the text to be displayed upside down.



Note: Changing this value affects only the selected text object, not the default value defined in the text style. To revert to the 
default value, select the original style in the Style list box.

Backward
Causes the text to be displayed backward (reversed).

Note: Changing this value affects only the selected text object, not the default value defined in the text style. To revert to the 
default value, select the original style in the Style list box.

Invisible
Makes the attribute value invisible. The attribute value is not displayed or printed.

Constant
Assigns a fixed attribute value. The attribute value is inserted automatically into the drawing when the block is inserted.

Verify
Causes AutoCAD LT to prompt you to verify that an attribute value is correct before the block is inserted in the drawing.

Preset
Sets the attribute to its default value when you insert a block containing a preset attribute.



Properties
Up a Level

Color
Changes the color of the attribute definition with the Select Color dialog box.

Layer
Changes the layer of the attribute definition with the Layer Control dialog box.

Linetype
Changes the linetype of the attribute definition with the Select Linetype dialog box.

Handle
Displays the handle of the selected attribute definition. You cannot change this value with DDMODIFY.

Thickness
Specifies the thickness of the attribute definition.

Linetype Scale
Specifies the linetype scale factor for the attribute definition.



Origin
Up a Level

Pick Point

Closes the dialog box so you can define a new origin for the attribute definition. After you select a new origin, the Modify 
Attribute Definition dialog box is redisplayed.

X
Specifies the X value for the coordinate of the origin.

Y
Specifies the Y value for the coordinate of the origin.

Z
Specifies the Z value for the coordinate of the origin.



Modify Block Insertion Dialog Box
Up a Level

Properties

Controls the properties of the block insertion.

Color. Changes the color of the block insertion with the Select Color dialog box.
Layer. Changes the layer of the block insertion with the Layer Control dialog box.
Linetype. Changes the linetype of the block insertion with the Select Linetype dialog box.
Handle. Displays the handle of the selected block insertion. You cannot change this value.
Thickness. Specifies the thickness of the block insertion.
Linetype Scale. Specifies the linetype scale factor for the block insertion.

At

Controls the location of the insertion point of the block insertion.

Pick Point. Closes the dialog box so you can define a new insertion point for the block insertion. After you select a 
new insertion point, the Modify Block Insertion dialog box is redisplayed.

X. Specifies the X value for the coordinate of the insertion point.
Y. Specifies the Y value for the coordinate of the insertion point.
Z. Specifies the Z value for the coordinate of the insertion point.

X-scale
Specifies the scale factor for the block insertion in the X (horizontal) direction.

Y-scale
Specifies the scale factor for the block insertion in the Y (vertical) direction.

Z-scale
Specifies the scale factor for the block insertion in the Z direction.

Rotation
Specifies the rotation angle for the block insertion.

Attributes
Displays the attributes of the block insertion.



Modify Circle Dialog Box
Up a Level

Properties
Controls the properties of the circle.

Color. Changes the color of the circle with the Select Color dialog box.
Layer. Changes the layer of the circle with the Layer Control dialog box.
Linetype. Changes the linetype of the circle with the Select Linetype dialog box.
Handle. Displays the handle of the selected circle. You cannot change this value with DDMODIFY.
Thickness. Specifies the thickness of the circle.
Linetype Scale. Specifies the linetype scale factor for the circle.

Center
Pick Point. Closes the dialog box so you can define a new center point for the circle on screen. After you select a 

new center point, the Modify Circle dialog box is redisplayed.
X. Specifies the X value for the coordinate of the center point.
Y. Specifies the Y value for the coordinate of the center point.
Z. Specifies the Z value for the coordinate of the center point.

Radius
Enter the radius of the circle.

Diameter
Displays the value of the diameter of the circle based on the radius you enter.

Circumference
Displays the value of the circumference of the circle based on the radius you enter.

Area
Displays the value of the area of the circle based on the radius you enter.



Modify Dimension Dialog Box
Up a Level

Properties
Controls the properties of the dimension.

Color. Changes the color of the dimension with the Select Color dialog box.
Layer. Changes the layer of the dimension with the Layer Control dialog box.
Linetype. Changes the linetype of the dimension with the Select Linetype dialog box.
Handle. Displays the handle of the selected dimension. You cannot change this value with DDMODIFY.
Thickness. You cannot change the thickness of a dimension.
Linetype Scale. Specifies the linetype scale factor for the dimension.

Edit
Modifies the dimension text with the Edit MText dialog box.

Style
Specifies a text style to apply to the dimension text.



Modify Ellipse Dialog Box
Up a Level

Properties
Controls the properties of the ellipse.

Color. Changes the color of the ellipse with the Select Color dialog box.
Layer. Changes the layer of the ellipse with the Layer Control dialog box.
Linetype. Changes the linetype of the ellipse with the Select Linetype dialog box.
Handle. Displays the handle of the selected ellipse. You cannot change this value with DDMODIFY.
Thickness. Specifies the thickness of the ellipse.
Linetype Scale. Specifies the linetype scale factor for the ellipse.

Center
Controls the location of the center point of the ellipse.

Pick Point. Closes the dialog box so you can define a new center point for the ellipse on the screen. After you 
select a new center point, the Modify Ellipse dialog box is redisplayed.

X. Specifies the X value for the coordinate of the center point.
Y. Specifies the Y value for the coordinate of the center point.
Z. Specifies the Z value for the coordinate of the center point.

Major Radius
Specifies the major radius of the ellipse.

Minor Radius
Specifies the minor radius of the ellipse.

Radius Ratio
Specifies the major radius to the minor radius.

Start Angle
Specifies the start angle of the ellipse.

End Angle
Specifies the end angle of the ellipse.

Major Axis Vector
Displays the X, Y, and Z values of the vector that defines the major axis direction of the ellipse.

Area
Displays the area of the ellipse.



Modify External Reference Dialog Box
Up a Level

Properties
Controls the properties of the external reference.

Color. Changes the color of the external reference with the Select Color dialog box.
Layer. Changes the layer of the external reference with the Layer Control dialog box.
Linetype. Changes the linetype of the external reference with the Select Linetype dialog box.
Handle. Displays the handle of the selected external reference. You cannot change this value with DDMODIFY.
Linetype Scale. Specifies the linetype scale factor for the external reference.

At
Controls the location of the insertion point of the external reference.

Pick Point. Closes the dialog box so you can define a new insertion point for the external reference. After you 
select a new insertion point, the Modify External Reference dialog box is redisplayed.

X. Specifies the X value for the coordinate of the insertion point.
Y. Specifies the Y value for the coordinate of the insertion point.
Z. Specifies the Z value for the coordinate of the insertion point.

X-scale
Specifies the scale factor for the external reference in the X (horizontal) direction.

Y-scale
Specifies the scale factor for the external reference in the Y (vertical) direction.

Z-scale
Specifies the scale factor for the external reference in the Z direction.

Rotation
Specifies the rotation angle for the external reference.



Modify Leader Dialog Box
Up a Level

Properties
Controls the properties of the leader.

Color. Changes the color of the leader with the Select Color dialog box.
Layer. Changes the layer of the leader with the Layer Control dialog box.
Linetype. Changes the linetype of the leader with the Select Linetype dialog box.
Handle. Displays the handle of the selected leader. You cannot change this value with DDMODIFY.
Linetype Scale. Specifies the linetype scale factor for the leader.

Edit
Modifies the text in the leader with the Edit MText dialog box.

Note: If the text in the leader was not selected, this option is not available.

Style
Applies a text style to the text in the leader.

Type
Specifies the leader type.

Straight. Makes the leader a straight line.
Spline. Makes the leader a spline.

Arrow
Displays arrows on the leader.

Note: To modify the text in a leader, use DDMODIFY and select the text rather than the leader line. The Edit Mtext dialog 
box is displayed.



Modify Line Dialog Box
Up a Level

Properties
Controls the properties of the line.

Color. Changes the color of the line with the Select Color dialog box.
Layer. Changes the layer of the line with the Layer Control dialog box.
Linetype. Changes the linetype of the line with the Select Linetype dialog box.
Handle. Displays the handle of the selected line. You cannot change this value.
Thickness. Specifies the thickness of the line.
Linetype Scale. Specifies the linetype scale factor for the line.

From Point
Controls the location of the From (first) point of the line.

Pick Point. Closes the dialog box so you can define a new From point for the line on the screen. After you select a
new From point, the Modify Line dialog box is redisplayed.

X. Specifies the X value for the coordinate of the From point.
Y. Specifies the Y value for the coordinate of the From point.
Z. Specifies the Z value for the coordinate of the From point.

To Point
Controls the location of the To (second) point of the line.

Pick Point. Closes the dialog box so you can define a new From point for the line on the screen. After you select a
new From point, the Modify Line dialog box is redisplayed.

X. Specifies the X value for the coordinate of the From point.
Y. Specifies the Y value for the coordinate of the To point.
Z. Specifies the Z value for the coordinate of the To point.

Delta XYZ
Displays the change in coordinate values from the start point to the end point of the line.

Length
Displays the length of the line.

Angle
Displays the angle of the line.



Modify MText Dialog Box
Up a Level

Properties
Controls the properties of the mtext object.

Color. Changes the color of the mtext object with the Select Color dialog box.
Layer. Changes the layer of the mtext object with the Layer Control dialog box.
Linetype. This option is unavailable.
Handle. Displays the handle of the selected mtext object. You cannot change this value.
Thickness. This option is unavailable.
Linetype Scale. This option is unavailable.

Insertion Point
Controls the location of the insertion point of the mtext object.

Pick Point. Closes the dialog box so you can define a new insertion point for the mtext object. After you select a 
new insertion point, the Modify MText dialog box is redisplayed.

X. Specifies the X value for the coordinate of the insertion point.
Y. Specifies the Y value for the coordinate of the insertion point.
Z. Specifies the Z value for the coordinate of the insertion point.

Contents
Displays the current contents of the mtext object.

Edit Contents
Edits the contents of the mtext object with the Edit MText dialog box.

Edit Properties
Edits the properties of the mtext object. 



Modify Point Dialog Box
Up a Level

Properties
Controls the properties of the point.

Color. Changes the color of the point with the Select Color dialog box.
Layer. Changes the layer of the point with the Layer Control dialog box.
Linetype. Changes the linetype of the point with the Select Linetype dialog box.
Handle. Displays the handle of the selected point. You cannot change this value.
Thickness. Specifies the thickness of the point.
Linetype Scale. Specifies the linetype scale factor for the point.

Location
Controls the location of the point.

Pick Point. Closes the dialog box so you can define a new location on the screen for the point. After you select a 
new location, the Modify Point dialog box is redisplayed.

X. Specifies the X value for the coordinate of the point.
Y. Specifies the Y value for the coordinate of the point.
Z. Specifies the Z value for the coordinate of the point.



Modify Polyline Dialog Box
Up a Level

Properties
Controls the properties of the polyline.

Color. Changes the color of the polyline with the Select Color dialog box.
Layer. Changes the layer of the polyline with the Layer Control dialog box.
Linetype. Changes the linetype of the polyline with the Select Linetype dialog box.
Handle. Displays the handle of the selected polyline. You cannot change this value with DDMODIFY.
Thickness. Specifies the thickness of the polyline.
Linetype Scale. Specifies the linetype scale factor for the polyline.

Polyline Type
Displays the polyline type of the selected polyline.

Vertex Listing
Displays the X, Y, and Z coordinates for each vertex in the polyline.

Vertex. Displays the number of the vertex for which the X, Y, Z coordinate is displayed.
Next. Displays the values for the next vertex.

Fit/Smooth
Specifies the type of line curve fitting.

None. Does not apply line fitting.
Quadratic. Applies quadratic line fitting.
Cubic. Applies cubic line fitting.
Curve Fit. Applies curve fitting.

Polyline
Controls the appearance of the polyline.

Closed. Closes the ends of the polyline. 
LT Gen. Controls how linetype patterns are assigned to a 2D polyline. If LT Gen is selected, the linetype pattern is 

maintained across vertices rather than beginning and ending at each vertex with a down stroke (dash). This is especially 
important if vertices are close together. 

          

Note: On splined or curved polylines with short segments, the linetype may appear continuous because the pattern cannot 
be fully displayed between the vertices.



Modify Ray Dialog Box
Up a Level

Properties
Controls the properties of the ray.

Color. Changes the color of the ray with the Select Color dialog box.
Layer. Changes the layer of the ray with the Layer Control dialog box.
Linetype. Changes the linetype of the ray with the Select Linetype dialog box.
Handle. Displays the handle of the selected ray. You cannot change this value.
Thickness. Thickness is not defined for rays.
Linetype Scale. Specifies the linetype scale factor for the ray.

Start Point
Controls the location of the Start point of the ray.

Pick Point. Closes the dialog box so you can specify a new Start point for the on screen for the ray. After you 
select a new Start point, the Modify Ray dialog box is redisplayed.

X. Specifies the X value for the coordinate of the Start point.
Y. Specifies the Y value for the coordinate of the Start point.
Z. Specifies the Z value for the coordinate of the Start point.

Second Point
Controls the location of the Second point of the ray, which defines the angle at which the ray travels.

Pick Point. Closes the dialog box so you can specify a new Second point for the on screen for the ray. After you 
select a new Second point, the Modify Ray dialog box is redisplayed.

X. Specifies the X value for the coordinate of the Second point.
Y. Specifies the Y value for the coordinate of the Second point.
Z. Specifies the Z value for the coordinate of the Second point.

Direction Vector
Displays the relative change in the X, Y, Z, coordinate values from any point on the ray to another point on the ray.



Modify Solid Dialog Box
Up a Level

Properties
Controls the properties of the solid.

Color. Changes the color of the solid with the Select Color dialog box.
Layer. Changes the layer of the solid with the Layer Control dialog box.
Linetype. Changes the linetype of the solid with the Select Linetype dialog box.
Handle. Displays the handle of the selected solid. You cannot change this value with DDMODIFY.
Thickness. Specifies the thickness of the solid.
Linetype Scale. Specifies the linetype scale factor for the solid.

Point #
Controls the location of each point of the solid. For each point, enter new X, Y, and Z values.

Pick Point. Closes the dialog box so you can specify a new point. After you select a new point, the Modify Solid 
dialog box is redisplayed.

X. Specifies the X value for the coordinate of the point.
Y. Specifies the Y value for the coordinate of the point.
Z. Specifies the Z value for the coordinate of the point.



Modify Spline Dialog Box
Up a Level

Properties
Controls the properties of the spline.

Color. Changes the color of the spline with the Select Color dialog box.
Layer. Changes the layer of the spline with the Layer Control dialog box.
Linetype. Changes the linetype of the spline with the Select Linetype dialog box.
Handle. Displays the handle of the selected spline. You cannot change this value with DDMODIFY.
Thickness. This option is not available.
Linetype Scale. Specifies the linetype scale factor for the spline.

Control Points
Displays the X, Y, Z coordinate and the weight of each control point on the spline. Additional weight assigned to a control 
point reduces the distance between the spline and that control point.

Vertex. Displays the number of the vertex for which the X, Y, Z coordinate is displayed.
Next. Displays values for the next vertex.

Degree
Displays the degree of the spline curve.

Properties
Displays the properties of the spline curve.

Data Points
Displays the X, Y, Z coordinate of each data point on the spline.

Vertex. Displays the number of the vertex for which the X, Y, Z coordinate is displayed.
Next. Displays the values for the next vertex.



Modify Text Dialog Box
Up a Level

Properties
Controls the properties of the text object.

Color. Changes the color of the text object with the Select Color dialog box.
Layer. Changes the layer of the text object with the Layer Control dialog box.
Linetype. Changes the linetype of the text object with the Select Linetype dialog box.
Handle. Displays the handle of the selected text object. You cannot change this value with DDMODIFY.
Thickness. Specifies the thickness of the text object.
Linetype Scale. Specifies the linetype scale factor for the text object.

Text
Displays the current text. Edit the text or enter new text.

Origin
Controls the location of the origin of the text object.

Pick Point. Closes the dialog box so you can specify a new origin for the text object on screen. After you select a 
new origin, the Modify Text dialog box is redisplayed.

X. Specifies the X value for the coordinate of the origin.
Y. Specifies the Y value for the coordinate of the origin.
Z. Specifies the Z value for the coordinate of the origin.

Height
Specifies the height of the text.

Note: Changing this value affects only the selected text object, not the default height defined in the text style. To revert to the
default value, select the original style in the Style list box.

Rotation
Specifies the rotation of the text.

Width Factor
Specifies the width factor for the text. A value greater than 1 expands the width of each character in the font. A value less 
than 1 compresses the width of each character in the font.

Note: Changing this value affects only the selected text object, not the default width factor defined in the text style. To revert 
to the default value, select the original style in the Style list box.

Obliquing
Specifies the angle that you want to oblique (italicize) the font.

Note: Changing this value affects only the selected text object, not the default obliquing value defined in the text style. To 
revert to the default value, select the original style in the Style list box.

Justify
Specifies the justification for the selected text object. For a description of each justification setting, see DTEXT.

Note: Changing this value affects only the selected text object, not the default justification defined in the text style. To revert 
to the default value, select the original style in the Style list box.

Style
Specifies the style for the selected text object. All settings changed previously will be set to the default values.



Upside Down
Causes the text to be displayed upside down.

Note: Changing this value affects only the selected text object, not the default defined in the text style. To revert to the 
default value, select the original style in the Style list box.

Backward
Causes the text to be displayed backward (reversed).

Note: Changing this value affects only the selected text object, not the default defined in the text style. To revert to the 
default value, select the original style in the Style list box.



Modify Tolerance Dialog Box
Up a Level

When you select a geometric tolerance, AutoCAD LT displays the Modify Tolerance dialog box.

Properties 

Controls the properties of the tolerance object.

Color. Changes the color of the tolerance symbol with the Select Color dialog box.
Layer. Changes the layer of the tolerance symbol with the Layer Control dialog box.
Linetype. Changes the linetype of the tolerance symbol with the Select Linetype dialog box.
Handle. Displays the handle of the selected tolerance symbol. You cannot change this value with DDMODIFY.
Thickness. This option is not available.
Linetype Scale. Specifies the linetype scale factor for the tolerance symbol.

Edit

Displays the tolerance symbols and text. You can enter new symbols and text.

Style

Specifies a text style for the tolerance symbols and text.



Modify Viewport Dialog Box
Up a Level

Properties
Controls the properties of the floating viewport.

Color. Changes the color of the floating viewport with the Select Color dialog box.
Layer. Changes the layer of the floating viewport with the Layer Control dialog box.
Linetype. This option is not available.
Handle. Displays the handle of the selected floating viewport. You cannot change this value with DDMODIFY.
Thickness. This option is not available.
Linetype Scale. This option is not available.



Modify Xline Dialog Box
Up a Level

Properties
Controls the properties of the xline.

Color. Changes the color of the xline with the Select Color dialog box.
Layer. Changes the layer of the xline with the Layer Control dialog box.
Linetype. Changes the linetype of the xline with the Select Linetype dialog box.
Handle. Displays the handle of the selected xline. You cannot change this value with DDMODIFY.
Thickness. This option is not available.
Linetype Scale. Specifies the linetype scale factor for the xline.

Root Point
Controls the location of the root point of the xline.

Pick Point. Closes the dialog box so you can specify a new root point for the xline. After you select a new root 
point, the Modify Xline dialog box is redisplayed.

X. Specifies the X value for the coordinate of root point.
Y. Specifies the Y value for the coordinate of the root point.
Z. Specifies the Z value for the coordinate of the root point.

Second Point
Controls the location of the second point of the xline.

Pick Point. Closes the dialog box so you can specify a new second point for the xline. After you select a second 
root point, the Modify Xline dialog box is redisplayed.

X. Specifies the X value for the coordinate of second point.
Y. Specifies the Y value for the coordinate of the second point.
Z. Specifies the Z value for the coordinate of the second point.

Direction Vector
Displays the relative change in the X, Y, Z coordinate values from any point on the xline to another point on the xline.



Modify AutoCAD Object Dialog Box
Up a Level

Several types of objects can be created in AutoCAD that cannot be created in AutoCAD LT for Windows 95. However, these 
AutoCAD objects can be displayed, edited, and saved in AutoCAD LT:

3D faces
3D meshes
3D (ACIS) solids
Bodies
Multilines
Pface (polygon) meshes
Regions
Shapes
TracesProperties

Controls the properties of the AutoCAD objects. Not all properties are available for modification with some AutoCAD objects.

Color. Changes the color of the AutoCAD object with the Select Color dialog box.
Layer. Changes the layer of the AutoCAD object with the Layer Control dialog box.
Linetype. Changes the linetype of the AutoCAD object with the Select Linetype dialog box.
Handle. Displays the handle of the AutoCAD object. You cannot change this value.
Thickness. Specifies the thickness of the AutoCAD object.
Linetype Scale. Specifies the linetype scale factor for the AutoCAD object.



Modify AutoCAD Object Dialog Box
Up a Level

Several types of objects can be created in AutoCAD that cannot be created in AutoCAD LT for Windows 95. However, these 
AutoCAD objects can be displayed, edited, and saved in AutoCAD LT:

3D faces
3D meshes
3D (ACIS) solids
Bodies
Multilines
Pface (polygon) meshes
Regions
Shapes
Traces

Properties

Controls the properties of the AutoCAD objects. Not all properties are available for modification with some AutoCAD objects.

Color. Changes the color of the AutoCAD object with the Select Color dialog box.
Layer. Changes the layer of the AutoCAD object with the Layer Control dialog box.
Linetype. Changes the linetype of the AutoCAD object with the Select Linetype dialog box.
Handle. Displays the handle of the AutoCAD object. You cannot change this value.
Thickness. Specifies the thickness of the AutoCAD object.
Linetype Scale. Specifies the linetype scale factor for the AutoCAD object.



Modify AutoCAD Object Dialog Box
Up a Level

Several types of objects can be created in AutoCAD that cannot be created in AutoCAD LT for Windows 95. However, these 
AutoCAD objects can be displayed, edited, and saved in AutoCAD LT:

3D faces
3D meshes
3D (ACIS) solids
Bodies
Multilines
Pface (polygon) meshes
Regions
Shapes
Traces

Properties
Controls the properties of the AutoCAD objects. Not all properties are available for modification with some AutoCAD objects.

Color. Changes the color of the AutoCAD object with the Select Color dialog box.
Layer. Changes the layer of the AutoCAD object with the Layer Control dialog box.
Linetype. Changes the linetype of the AutoCAD object with the Select Linetype dialog box.
Handle. Displays the handle of the AutoCAD object. You cannot change this value.
Thickness. Specifies the thickness of the AutoCAD object.
Linetype Scale. Specifies the linetype scale factor for the AutoCAD object.



Modify AutoCAD Object Dialog Box
Up a Level

Several types of objects can be created in AutoCAD that cannot be created in AutoCAD LT for Windows 95. However, these 
AutoCAD objects can be displayed, edited, and saved in AutoCAD LT:

3D faces
3D meshes
3D (ACIS) solids
Bodies
Multilines
Pface (polygon) meshes
Regions
Shapes
Traces

Properties

Controls the properties of the AutoCAD objects. Not all properties are available for modification with some AutoCAD objects.

Color. Changes the color of the AutoCAD object with the Select Color dialog box.
Layer. Changes the layer of the AutoCAD object with the Layer Control dialog box.
Linetype. Changes the linetype of the AutoCAD object with the Select Linetype dialog box.
Handle. Displays the handle of the AutoCAD object. You cannot change this value.
Thickness. Specifies the thickness of the AutoCAD object.
Linetype Scale. Specifies the linetype scale factor for the AutoCAD object.



Modify AutoCAD Object Dialog Box
Up a Level

Several types of objects can be created in AutoCAD that cannot be created in AutoCAD LT for Windows 95. However, these 
AutoCAD objects can be displayed, edited, and saved in AutoCAD LT:

3D faces
3D meshes
3D (ACIS) solids
Bodies
Multilines
Pface (polygon) meshes
Regions
Shapes
Traces

Properties

Controls the properties of the AutoCAD objects. Not all properties are available for modification with some AutoCAD objects.

Color. Changes the color of the AutoCAD object with the Select Color dialog box.
Layer. Changes the layer of the AutoCAD object with the Layer Control dialog box.
Linetype. Changes the linetype of the AutoCAD object with the Select Linetype dialog box.
Handle. Displays the handle of the AutoCAD object. You cannot change this value.
Thickness. Specifies the thickness of the AutoCAD object.
Linetype Scale. Specifies the linetype scale factor for the AutoCAD object.



Modify AutoCAD Object Dialog Box
Up a Level

Several types of objects can be created in AutoCAD that cannot be created in AutoCAD LT for Windows 95. However, these 
AutoCAD objects can be displayed, edited, and saved in AutoCAD LT:

3D faces
3D meshes
3D (ACIS) solids
Bodies
Multilines
Pface (polygon) meshes
Regions
Shapes
Traces

Properties

Controls the properties of the AutoCAD objects. Not all properties are available for modification with some AutoCAD objects.

Color. Changes the color of the AutoCAD object with the Select Color dialog box.
Layer. Changes the layer of the AutoCAD object with the Layer Control dialog box.
Linetype. Changes the linetype of the AutoCAD object with the Select Linetype dialog box.
Handle. Displays the handle of the AutoCAD object. You cannot change this value.
Thickness. Specifies the thickness of the AutoCAD object.
Linetype Scale. Specifies the linetype scale factor for the AutoCAD object.



Modify AutoCAD Object Dialog Box
Up a Level

Several types of objects can be created in AutoCAD that cannot be created in AutoCAD LT for Windows 95. However, these 
AutoCAD objects can be displayed, edited, and saved in AutoCAD LT:

3D faces
3D meshes
3D (ACIS) solids
Bodies
Multilines
Pface (polygon) meshes
Regions
Shapes
Traces

Properties

Controls the properties of the AutoCAD objects. Not all properties are available for modification with some AutoCAD objects.

Color. Changes the color of the AutoCAD object with the Select Color dialog box.
Layer. Changes the layer of the AutoCAD object with the Layer Control dialog box.
Linetype. Changes the linetype of the AutoCAD object with the Select Linetype dialog box.
Handle. Displays the handle of the AutoCAD object. You cannot change this value.
Thickness. Specifies the thickness of the AutoCAD object.
Linetype Scale. Specifies the linetype scale factor for the AutoCAD object.



Modify AutoCAD Object Dialog Box
Up a Level

Several types of objects can be created in AutoCAD that cannot be created in AutoCAD LT for Windows 95. However, these 
AutoCAD objects can be displayed, edited, and saved in AutoCAD LT:

3D faces
3D meshes
3D (ACIS) solids
Bodies
Multilines
Pface (polygon) meshes
Regions
Shapes
Traces

Properties

Controls the properties of the AutoCAD objects. Not all properties are available for modification with some AutoCAD objects.

Color. Changes the color of the AutoCAD object with the Select Color dialog box.
Layer. Changes the layer of the AutoCAD object with the Layer Control dialog box.
Linetype. Changes the linetype of the AutoCAD object with the Select Linetype dialog box.
Handle. Displays the handle of the AutoCAD object. You cannot change this value.
Thickness. Specifies the thickness of the AutoCAD object.
Linetype Scale. Specifies the linetype scale factor for the AutoCAD object.



Modify AutoCAD Object Dialog Box
Up a Level

Several types of objects can be created in AutoCAD that cannot be created in AutoCAD LT for Windows 95. However, these 
AutoCAD objects can be displayed, edited, and saved in AutoCAD LT:

3D faces
3D meshes
3D (ACIS) solids
Bodies
Multilines
Pface (polygon) meshes
Regions
Shapes
Traces

Properties

Controls the properties of the AutoCAD objects. Not all properties are available for modification with some AutoCAD objects.

Color. Changes the color of the AutoCAD object with the Select Color dialog box.
Layer. Changes the layer of the AutoCAD object with the Layer Control dialog box.
Linetype. Changes the linetype of the AutoCAD object with the Select Linetype dialog box.
Handle. Displays the handle of the AutoCAD object. You cannot change this value.
Thickness. Specifies the thickness of the AutoCAD object.
Linetype Scale. Specifies the linetype scale factor for the AutoCAD object.



DDOSNAP Command
Up a Level          Related Topics

Sets running Object Snap modes and changes the target box size
With Object Snap modes you can specify a point at an exact location on an object. Each mode determines location. You can
use this command to set running object snap modes that stay in effect until you turn them off.

   From the standard toolbar, choose

   From the Options menu, choose Running Object Snap
 At the Command prompt, enter ddosnap

The Running Object Snap dialog box is displayed.

You can turn object snap modes on and off by double-clicking OSNAP on the status bar. If no running object snaps have 
been specified, double-clicking OSNAP will display the Running Object Snap dialog box.



For more information, see "Setting Running Object Snaps" in chapter 7 of the AutoCAD LT User's Guide. 

Commands: APERTURE controls the size of the object snap target box. OSNAP sets running Object Snap modes on the 
command line. 

System Variables: OSMODE sets Object Snap modes using bit codes. 



Endpoint

Snaps to the closest endpoint of an solid, elliptical solid, line, polyline segment, ray, or to the closest corner of a 2D solid.



Midpoint

Snaps to the midpoint of an arc, ellipse, elliptical arc, line, polyline segment, 2D solid, spline, or xline.



Center

Snaps to the center of an arc, circle, ellipse, or elliptical arc. 



Node

Snaps to a point object.



Quadrant

Snaps to a quadrant point of an arc, circle, ellipse, or elliptical arc.



Intersection

Snaps to the intersection of an arc, circle, ellipse, elliptical arc, line, polyline, ray, spline, or xline.

      



Insertion

Snaps to the insertion point of an attribute, a block, or text.



Perpendicular

Snaps to a point perpendicular to an arc, circle, ellipse, elliptical arc, line, polyline, ray, 2D solid, spline, or xline.



Tangent

Snaps to the tangent of an arc, circle, ellipse, or elliptical arc.

      



Nearest

Snaps to the nearest point on an arc, circle, ellipse, elliptical arc, line, point, polyline, spline, or xline. 



Clear All

Turns off all Running Object Snap modes. 



Running Object Snap Dialog Box 
Up a Level

Select Settings

Specifies the running Object Snap modes. Select one or more options.

Endpoint
Midpoint
Center
Node
Quadrant
Intersection
Insertion
Perpendicular
Tangent
Nearest
Clear All

Aperture Size

Specifies the size of the target box aperture. The maximum size is 20 pixels using the Running Object Snap dialog box. The 
slider bar moves between Min and Max. The sample target box changes to show the new size. 



DDLTYPE Command
Up a Level          Related Topics

Loads and sets linetypes
DDLTYPE loads linetype definitions from a linetype library file (LIN) or sets a current linetype, object linetype scale factor, or 
ISO pen width.

   
From the Object Properties toolbar, choose 

   From the Format menu, choose Linetype
 At the Command prompt, enter ddltype

The Select Linetype dialog box is displayed.



Select Linetype Dialog Box
Up a Level

Loaded Linetypes
Displays the names of all linetypes currently available. To assign a linetype to the selected layer or layers, select it from the 
list.

ISO Pen Width
Specifies the pen width, defined in millimeters, for ISO linetypes.

Linetype Scale
Specifies the linetype scale factor for new objects.

Linetype
Displays the name of the linetype selected in Loaded Linetypes. You can also enter a linetype name to select that linetype.

Load
Displays additional linetypes in Loaded Linetypes with the Load or Reload Linetypes dialog box.



Load or Reload Linetypes Dialog Box
Up a Level

File
Displays the name of the current linetype library (LIN) file. 

To display the linetypes available in another linetype library file, enter the path and file name or select File to display the 
Select Linetype File dialog box. 

Available Linetypes
Displays all linetypes currently available in the selected linetype library file.

Select All
Selects all linetypes displayed in Available linetypes.

Clear All
Clears all linetypes displayed in Available linetypes.



Select Linetype File Dialog Box
Up a Level

File Name
Select or enter the name of the linetype library file (file extension .lin) you want to load. 

List Files of Type
Select the type of files you want displayed in the File Name list box.

Directories
Select the directory for the linetype library file.

Drives
Select the drive that contains the linetype library file.

Find File...
To find linetype library files on multiple drives and directories, select Find File. The Browse/Search dialog box is displayed.



For more information, see "Setting Up Linetypes" in chapter 4 of the AutoCAD LT User's Guide.

Commands: LTSCALE sets the global linetype scale factor for all objects in the drawing.

System Variables: CELTSCALE sets the current linetype scale factor for new objects. LTSCALE stores the global linetype 
scale factor for all objects. PSLTSCALE controls paper space linetype scaling. 



'DDPTYPE Command
Up a Level          Related Topics

Specifies the display mode and size of point objects

From the Format menu, choose Point Style

At the Command prompt, enter ddptype

Point Display Mode and Size

The Point Style dialog box shows the current point display mode and size. Change the point display mode by selecting an 
icon. The specified appearance of existing points changes the next time AutoCAD LT regenerates the drawing.

Appearance of Point Objects

The PDMODE and PDSIZE system variables control the appearance of point objects. PDMODE values 0, 2, 3, and 4 select 
a figure to draw through the point. A value of 1 selects nothing to be displayed. 

Adding 32, 64, or 96 to the values above selects a shape to draw around the point in addition to the figure drawn through it:

PDMODE values

PDSIZE controls the size of the point figures, except for PDMODE values 0 and 1. A 0 setting generates the point at 5 
percent of the graphics area height. A positive PDSIZE value specifies an absolute size for the point figures. A negative 
value is interpreted as a percentage of the viewport size. The size of all points is recalculated when the drawing is 
regenerated.

After you change PDMODE and PDSIZE, the appearance of existing points changes the next time AutoCAD LT regenerates 
the drawing.



Point Style Dialog Box
Up a Level

Point Display Mode

Select the icon image of the point display mode you want to use. The point display mode is stored in the PDMODE system 
variable.

Point Size
Enter the value for the point display size. The point display size is stored in the PDSIZE system variable. Subsequent point 
objects you draw use the new value. The next regeneration updates existing point objects.

Set Size Relative to Screen
Select to set the point display size as a percentage of the screen size. The point display does not change when you zoom in 
or out.

Set Size in Absolute Units
Select to set the point display size as the actual units you specified in the Point Size text box. The point display enlarges or 
reduces when you zoom in or out.



For more information, see "Creating Point Objects" in chapter 6 of the AutoCAD LT User's Guide. 

Commands: POINT creates point objects. DIVIDE uses points as markers in an object it has divided into equal parts. 
MEASURE places markers on an object at specified intervals.

System Variables: PDMODE sets the point display mode. PDSIZE sets the point display size.



DDRENAME Command
Up a Level          Related Topics

Changes the names of named objects
Blocks, layers, linetypes, and other special objects are stored by name and called named objects. Use DDRENAME to 
change the names of these objects. You can also use DDRENAME to view a list of all blocks and symbol table entries in the 
current drawing.

 From the Format menu, choose Rename
 At the Command prompt, enter ddrename

The Rename dialog box is displayed.

You can use the wild-card characters * and ? to rename groups of objects. You can't rename some standard objects, such as
layer 0 and the CONTINUOUS linetype. 



Rename Dialog Box
Up a Level

Named Objects
Displays the types of named objects. When you select an object type, a list of objects by that type will be displayed in Items.

Items
Displays named objects of the type specified in Named Objects. Select the name you want to change.

Old Name
Displays the name you selected in Items. You can also enter the name of an object here.

Rename To
Enter the new name you want to assign. Then choose Rename To to update the Items list. 



For more information, see "Renaming a Text Style" in chapter 12 of the AutoCAD LT User's Guide. 

Commands: RENAME performs the same operations from the command line.



'DDRMODES Command
Up a Level          Related Topics

Sets drawing aids
DDRMODES controls the settings for AutoCAD LT drawing aids including grid and snap. 

   From the Options menu, choose Drawing Aids
 At the Command prompt, enter ddrmodes

The Drawing Aids dialog box is displayed.



Drawing Aids Dialog Box
Up a Level

Modes
Controls several drawing modes.

Ortho. Turns Orthogonal mode on and off. Cursor input is restricted to either horizontal or vertical locations relative
to the previous point. See ORTHO.

Solid Fill. Turns Fill mode on and off. Fill mode controls the solid filling of wide polylines, donuts, and 2D solids. 
See FILL.

Quick Text. Turns on Quick Text mode. Quick Text mode displays text and attributes as simple rectangles. See 
QTEXT.

Blips. Turns Blip mode on and off. Blip mode controls the display of marker blips on the screen. See BLIPMODE.
Highlight. Turns highlighting of selected objects on and off. See also HIGHLIGHT.

Snap
Controls Snap mode settings.

On. Turns Snap mode on and off.
X Spacing. Enter a value for the snap spacing in the X direction.
Y Spacing. Enter a value for the snap spacing in the Y direction.
Snap Angle. Enter a value by which you want to rotate the snap grid.
X Base. Enter a value for the X basepoint for the snap grid.
Y Base. Enter a value for the Y basepoint for the snap grid.

Grid
Controls Grid mode settings.

On. Turns Grid mode on and off.
X Spacing. Enter a value for the grid spacing in the X direction.
Y Spacing. Enter a value for the grid spacing in the Y direction.

Isometric Snap/Grid
Controls ISO mode settings.

On. Changes the Snap and grid orientation to isometric. This setting facilitates drawing a 2D representation of a 
3D isometric view of an object using Snap, Grid, and the Isocircle option of the ELLIPSE command. 

Left. Select a simulated XY plane.
Top. Select a simulated XZ plane.
Right. Select a simulated YZ plane.



For more information, see "Changing the Snap Angle and Base Point" in chapter 7 of the AutoCAD LT User's Guide. 

Commands: BLIPMODE controls the display of marker blips. FILL controls the filling of traces, solids, and wide polylines. 
GRID displays a dot grid at the specified spacing(s). ISOPLANE selects the current isometric plane. ORTHO constrains 
cursor movement to the horizontal or vertical directions. QTEXT displays text and attributes as simple rectangles. SNAP 
restricts cursor movement to specific intervals.

System Variables: HIGHLIGHT controls object selection highlighting. 



'DDSELECT Command
Up a Level          Related Topics

Sets object selection modes
DDSELECT controls the settings for object selection modes, pickbox size, and object sorting criteria for overlapping objects.

 From the Options menu, choose Selection
At the Command prompt, enter ddselect

The Object Selection Settings dialog box is displayed.



Object Selection Settings Dialog Box (DDSELECT)
Up a Level

Selection Modes

Sets the selection mode. Select any combination of the options.

Noun/Verb Selection. 

With Noun/Verb selection on, you can select objects before entering a command. This setting is stored in the 
PICKFIRST system variable. If either GRIPS or Noun/Verb Selection is enabled, the graphics cursor changes to a 
combination of the pickbox and crosshairs.

You can use the following commands to edit objects with noun/verb selection:

ARRAY DDMODIFY MOVE

BLOCK DVIEW ROTATE

CHANGE ERASE SCALE

CHPROP EXPLODE STRETCH

COPY LIST WBLOCK

DDCHPROP MIRROR

Use Shift to Add
Press and Drag 
Implied Windowing 
Default Selection Modes

Pickbox Size

Adjusts the size of the pickbox using a slider bar. This setting is stored in the PICKBOX system variable.

Object Sort Method

Displays the Object Sort Method dialog box.



Use Shift to Add

Controls how you add objects to a selection set. With this option turned on, hold down SHIFT to add more objects to the 
selection set. If you do not hold down SHIFT when selecting and object, you will overwrite the old selection set rather than 
adding to it. This setting is store in the PICKADD system variable.

To clear a selection set quickly, draw a selection window in a blank area of the drawing. If Use Shift to Add is cleared, objects
are added to the selection set as you select them. In either case, to remove objects, hold down SHIFT while selecting them 
again. 



Press and Drag

Controls how you draw a selection window or crossing window. This setting is store in the PICKDRAG system variable. With 
this option turned on, hold down the pick button and drag the cursor diagonally to create a selection window. Release the 
button to complete the window's opposite corner.

If Press and Drag is cleared, two separate points are required to define the selection window. 



Implied Windowing 

Creates a selection window.    With this option turned on, you pick the first corner point in an empty area of the screen and 
AutoCAD LT prompts for the other corner point. Specifying the selection window from left to right selects objects that are 
completely inside the window's boundaries. Drawing from right to left selects objects within and crossing the window's 
boundaries. 

If Implied Windowing is off, picking an empty area of the screen will not result in an automatic window or crossing selection. 
Instead, AutoCAD LT reports that no objects were found. You can override this selection setting by using the Window, 
Crossing, or Auto options at the Select options prompt. Implied windowing can also be set using the PICKAUTO system 
variable.



Default Selection Modes

Resets the selection modes to their default settings (Noun/Verb Selection and Implied Windowing turned on).



Commands: SELECT builds a selection set.

System Variables: PICKADD controls additive selection of objects. PICKAUTO controls automatic windowing selection. 
PICKBOX sets the object selection target box size. PICKDRAG controls the method of drawing a selection window. 
PICKFIRST lets you select an object then use a command. 



Object Sort Method Dialog Box (DDSELECT)
Up a Level

Provides options for processing overlapping objects in the order in which they were created in the drawing. You can use 
these options if your drawing or application depends on the order in which objects were created. Selecting additional sorting 
methods can increase processing time, which is related to performance enhancements for object selection in large 
drawings.

Object Selection. Causes objects that are selected with a windowing method to be placed in the selection set in 
reverse order from which they were created.

Object Snap. Causes Object Snap mode to select objects in the order in which they were created, from last to 
first.

Redraws. Causes REDRAW to draw objects in their order in the drawing database, from last to first.
Slide Creation. Causes MSLIDE to draw objects in their order in the drawing database, from last to first.
Regens. Causes REGEN to draw objects in their order in the drawing database, from last to first.
Plotting. Causes PLOT to process objects in their order in the drawing database, from last to first.
PostScript Output. Causes PSOUT to process objects in their order in the drawing database, from last to first.



'DDSTYLE Command
Up a Level          Related Topics

Creates named text styles
AutoCAD LT provides one standard text style. Use DDSTYLE if you want to create a new style or modify an existing style. 
DDSTYLE also determines the current style used for subsequent TEXT, DTEXT, and MTEXT commands.

If you change the orientation or font file of an existing text style, all text objects with that style will use the new values once 
the drawing is regenerated.

   From the Format menu, choose Text Style
 At the Command prompt, enter ddstyle

The Text Style dialog box is displayed.



Text Style Dialog Box
Up a Level

Styles
Displays the name of existing styles. Select the style you want to modify, rename, or delete or enter a new style name in the 
text box.

New. Creates a new text style. Enter the name in Styles, and then select New.
Rename. Renames the selected style. Enter the name in Styles, and then select Rename.
Delete. Deletes the text style selected in Styles.

Character Preview
Displays a preview of the selected text style.

Preview. To preview several characters in the selected text style, enter the characters in the text box to the left of 
the Preview button and press Preview.

Char. Set. To display a preview of the entire character set of the selected text style, select Char. Set.

Font
Controls the font or BigFont associated with the selected text style.

Font File. Specify the name of the font file you want to use with the selected text style.
Browse. Click Browse, the Select Font File dialog box is displayed, select a font file to use with the selected text 

style.
BigFont. Enter the name of the BigFont file you want to use with the selected text style.

Note: BigFonts are used for Asian language fonts.

Browse. Click Browse, the Select Font File dialog box is displayed, select a BigFont file to use with the selected 
text style.

Effects
Controls the appearance of the text in the selected text style.

Upside Down. Causes text to be displayed upside down. This option does not affect paragraph text.
Backwards. Causes text to be displayed backwards. The option does not affect paragraph text.
Vertical. Causes text to be displayed vertically.
Height. Enter a value for the height of the text. if you enter 0, you will be prompted for a text height each time you 

create a text object.
Width Factor. Specifies the width factor for the text. A value greater than 1 expands the width of each character in 

the font. A value less than 1 compresses the width of each character in the font.
Oblique Angle. Specifies the angle that you want to oblique (italicize) the font.

Apply 
Applies all changes to the selected text style.

Close
Closes the dialog box.



Select Font File Dialog Box
Up a Level

File Name
Select or enter the name of the font file you want to use with the text style. 

List Files of Type
Select the type of files you want displayed in the File Name list box.

Look In
Select the drive and directory that contains the font file you want to use.



For more information about working with text, see "Working with Styles" in chapter 12 of the AutoCAD LT User's Guide.

Commands: DDEDIT edits text and attribute definitions. DDRENAME and RENAME change the names of objects. DTEXT 
creates text on the screen as you enter the text. MTEXT creates a paragraph that fits within a specified area. STYLE creates
named text styles from the command line. TEXT enters a single line of text.

System Variables: TEXTFILL controls the filling of Bitstream, True Type, and Adobe Type 1 fonts. TEXTQLTY sets the 
resolution of Bitstream, True Type, and Adobe Type 1 fonts. TEXTSIZE sets the default height for new text objects drawn 
with the current text style. TEXTSTYLE contains the name of the current text style. 



DDUCS Command
Up a Level          Related Topics

Manages defined User Coordinate Systems
The primary function of DDUCS is to restore saved UCS's.

   From the Standard toolbar, choose

   From the View menu, choose SetUCS, then named UCS
 At the Command prompt, enter dducs

The UCS Control dialog box is displayed.



UCS Control Dialog Box
Up a Level

UCS Names
Displays the names of defined and saved coordinate systems. Select a coordinate system to view information about that 
system or to restore, delete, or rename it.

*WORLD* indicates the World Coordinate System. 

*PREVIOUS* indicates the previous coordinate system. 

*WORLD* Coordinate System (WCS) is always the first entry. If you define other coordinate systems during the current 
editing session, a *PREVIOUS* entry appears next. You can step back through these coordinate systems by selecting 
*PREVIOUS* and OK repeatedly. If you don't name the current coordinate system, *NO NAME* is the next entry.

The current coordinate system is identified by the word, Current, displayed to the right of the system name.

Current
Restores the selected coordinate system. Makes the selected coordinate system current. To add a UCS name to this list, 
use the Save option of the UCS command.

Delete 
Deletes a user-defined coordinate system. To delete the selected coordinate system, select Delete. You cannot delete the 
entries *WORLD* or *PREVIOUS*.

List...
Lists a coordinate system's origin point and the direction of its X, Y, and Z axes relative to the current UCS. Select a UCS 
name and choose List.

Rename To
Renames a coordinate system. To rename the selected coordinate system, enter the new name in the Rename To text box. 
Then, select Rename To. You cannot rename the entries *WORLD* or *PREVIOUS*.



World Coordinate System

A fixed coordinate system used as the basis of reference for objects in the drawing database and the user coordinate 
systems.



Commands: UCS defines or modifies the current user coordinate system. DDUCSP selects a preset user coordinate 
system.

System Variables: UCSICON controls visibility and placement of the UCS icon in viewports. UCSNAME displays the name 
of the current coordinate system. UCSORG displays the origin point of the current coordinate system for the current space. 
UCSXDIR displays the X direction of the current UCS for the current space. UCSYDIR displays the Y direction of the current
UCS for the current space. 



DDUCSP Command
Up a Level          Related Topics

Selects a preset user coordinate system
A user coordinate system (UCS) is a user-controlled coordinate system for convenient placement of objects. DDUCSP 
provides choices among preset UCS orientations.

   From the Standard toolbar, choose

   From the View menu, choose Set UCS, then Preset UCS
At the Command prompt, enter dducsp

The UCS Orientation dialog box is displayed. The image tiles illustrate the ways you can change the current UCS. After you 
select an image tile, AutoCAD LT changes the current UCS based on the setting of the Relative to Current UCS or Absolute 
to WCS options. Relative to Current UCS and Absolute to WCS is not used if you restore the UCS to the WCS (World 
Coordinate System), the previous UCS, or set the UCS to the current view.



UCS Orientation Dialog Box
Up a Level

Images of Preset User Coordinate Systems

To change the position of the UCS, select an image of a preset user coordinate system (UCS). The orientation of the ucs is 
determined by the following:

Relative to Current UCS. Select to reorient the UCS relative to the current UCS orientation.
Absolute to WCS. Select to reorient the UCS relative to the fixed World Coordinate System (WCS).



Commands: DDUCS renames, restores, deletes, or lists defined coordinate systems. UCS defines or modifies the current 
user coordinate system. 

System Variables: UCSICON controls visibility and placement of the UCS icon viewports. UCSNAME displays the name of 
the current coordinate system. USORG displays the origin point of the current coordinate system for the current space. 
UCSXDIR displays the X direction of the current UCS of the current space. UCSYDIR displays the Y direction of the current 
UCS for the current space. 



'DDUNITS Command
Up a Level          Related Topics

Controls coordinate and angle display formats and determines precision
From the Format menu, choose Units
At the Command prompt, enter ddunits

The Units Control dialog box is displayed.



Units Control Dialog Box 
Up a Level

Units
Specifies the display format for units of measure.

Scientific. Displays units of measure in scientific format.
Decimal. Displays units of measure in decimal format.
Engineering. Displays units of measure in engineering format. When you select Engineering, each drawing unit 

represents one inch.
Architectural. Displays units of measure in architectural format. When you select Architectural, each drawing unit 

represents one inch.
Fractional. Displays units of measure in fractional format.

Precision
Specifies the number of decimal places or fractional size displayed for linear measurements.

Angles
Specifies the display format for angular measurements.

Decimal Degrees. Displays angular measurements in decimal degrees. Angular measurements are displayed as 
decimal numbers.

Deg/Min/Sec. Displays angular measurements in degrees, minutes, and seconds. Angular measurements are 
displayed with the letter “d” appearing after the degree measurement, an apostrophe (') symbol appearing after the minute 
measurement, and a quotation mark (") appearing after the second measurement. For example, a measurement of 123 
degrees, 45 minutes, and 56.7 seconds is entered and displayed as 123d45'56.7".

Grads. Displays angular measurements in grads. The letter g appears after the measurement.
Radians. Displays angular measurements in radians. The letter r appears after the measurement.
Surveyor. Displays angular measurements in surveyor units. 

Precision
Specifies the number of decimal places displayed for angular measurements.

Direction
Sets the direction of angles in measurements. Displays the Direction Control dialog box.



For more information, see "Setting Units Style" in chapter 4 of the AutoCAD LT User's Guide. 

Commands: UNITS sets coordinate and angle display formats and precision from the command line.

System Variables: ANGBASE stores the angle 0 direction, with respect to the current UCS. ANGDIR stores the setting for 
clockwise or counterclockwise direction, with respect to the current UCS. AUNITS stores the Angular Units mode. AUPREC 
stores the number of decimal places for angular units. LUNITS stores the setting for Linear Units mode. LUPREC stores the 
number of decimal places or the denominator for linear units. UNITMODE stores the setting for fractional, feet and inches, 
and surveyor's angles as previously set or in input format.



Direction Control Dialog Box
Up a Level

The Direction Control settings determine what orientation is defined as angle 0 and in which direction, clockwise or counter-
clockwise, positive angles are measured when entered.

When AutoCAD LT prompts for an angle, you can locate a point in the desired direction or enter an angle.

Angle 0 Direction

Sets the direction of the zero angle. The following options affect the entry of angles, the display format, and the entry of 
polar, cylindrical, and spherical coordinates.

East. Specifies the compass direction East. 
North. Specifies the compass direction North. 
West. Specifies the compass direction West. 
South. Specifies the compass direction South. 
Other. Specifies a direction different from the points of the compass.

Angle. Specifies a value for the zero angle. You can specify the angle by entering a value. 

Pick. Defines the angle in the graphics area based on the angle of an imaginary line that connects any two points 
you specify. 

Counter-Clockwise

Sets the positive angle direction to counterclockwise. This option affects the entry of angles and the display format.

Clockwise

Sets the positive angle direction to clockwise. This option affects the entry of angles and the display format.

Note: Clockwise and Counter-Clockwise control the direction of positive and negative angles. The default direction for 
positive angles is counterclockwise. Selecting Clockwise reverses the positive and negative angles in arcs, rotation, 
and polar arrays.



DDVIEW Command
Up a Level          Related Topics

Saves and restores views by name
   From the Standard toolbar, choose

   From the View menu, choose Named Views
At the Command prompt, enter ddview

The View Control dialog box is displayed.



View Control Dialog Box
Up a Level

Views
Lists the *CURRENT* view name and any other views you have named. Views in model space are indicated by the word 
MSPACE to the right. Views in paper space are indicated by PSPACE. Select the view that you want to restore, delete, or list
information about and use one of the following options:    

Restore
Redisplays the selected view in the graphics area.

Note: To restore model or paper space views, you must be in the space in which the view was created.

New
Defines a new view with the Define New View dialog box.

Delete
Deletes the selected view.

Description
Lists information about the selected view. The View Description dialog box is displayed.



Define New View Dialog Box
Up a Level

New Name
Enter the name of the view you want to save.

Current Display
Defines the current display in the graphics area as the new view.

Define Window
Uses the values displayed in First Corner and Other Corner to define the view window. 

Window. Closes the dialog box so you can define a new window size. This option is available only if you select 
Define Window.

First Corner. Displays the X and Y coordinate values for the first corner of the view window.
Other Corner. Displays the X and Y coordinate values for the corner diagonally opposite the first corner of the 

view window.

Save View
Saves the view and redisplays the View Control dialog box.



For more information, see "Using Named Views" in chapter 8 of the AutoCAD LT User's Guide. 

Commands: MSPACE switches from a paper space to a model space viewport. PSPACE switches from a model space 
viewport to a paper space viewport. VIEW saves and restores named views on the command line.

System Variables: TILEMODE enables or disables paper space.



'DELAY Command
Up a Level        

Provides a timed pause within a script
At the Command prompt, enter delay

Delay time in milliseconds: Enter a value

Entering delay 1000 in your script delays the start of execution of the next command for about one second. The maximum 
delay is 32767, slightly less than 33 seconds.



DIM or DIM1 Command
Up a Level

Accesses Dimensioning mode
Using DIM and DIM1 sets the command line in Dimensioning mode and enables you to use the dimensioning subcommands
from earlier releases of AutoCAD LT. In this release of AutoCAD LT, you can use the dimensioning commands at the 
Command prompt. DIM and DIM1 are provided only for compatibility with previous releases.

To remain in Dimensioning mode after you use a dimensioning command, use DIM. To execute a dimensioning command 
and return immediately to the command line, use DIM1.

At the Command prompt, enter dim or dim1

Dim: Enter a Dimensioning mode command

The Dim prompt indicates you're in Dimensioning mode, in which a special set of dimensioning commands replaces most of 
the AutoCAD LT dimensioning commands. To exit Dimensioning mode, enter e or exit or press ESCAPE.



Dimensioning Mode Commands (DIM)
Up a Level

The following commands are available from the DIM prompt:

Command Description
EXIT or ESCAPE Exits Dimensioning mode and returns you to 

normal command mode

REDRAW Redraws the current viewport

STYLE Changes the current text style

UNDO or U Erases the most recently produced dimension 
objects and cancels any new dimension system 
variable setting

When you exit from dimensioning mode, UNDO 
reverses the effects of the entire dimensioning 
session

The following table shows which AutoCAD LT commands are equivalent to the rest of the Dimensioning mode commands. 
For more information, see the equivalent AutoCAD LT command. 

Dimensioning 
mode command

Equivalent
AutoCAD LT command

ALIGNED DIMALIGNED

ANGULAR DIMANGULAR

BASELINE DIMBASELINE

CENTER DIMCENTER

CONTINUE DIMCONTINUE

DIAMETER DIMDIAMETER

HOMETEXT DIMEDIT Home

HORIZONTAL DIMLINEAR Horizontal

LEADER LEADER

NEWTEXT DIMEDIT Text

OBLIQUE DIMEDIT Oblique

ORDINATE DIMORDINATE

OVERRIDE DIMOVERRIDE

RADIUS DIMRADIUS

RESTORE DIMSTYLE Restore

ROTATED DIMLINEAR

SAVE DIMSTYLE Save

STATUS DIMSTYLE  Status

TEDIT DIMTEDIT

TROTATE DIMEDIT Rotate

UPDATE DIMSTYLE Apply

VARIABLES DIMSTYLE Variables

VERTICAL DIMLINEAR Vertical



DIMALIGNED Command
Up a Level          Related Topics

Creates an aligned linear dimension
 

From the Dimensioning toolbar, choose 
 From the Dimension menu, choose Aligned

At the Command prompt, enter dimaligned

First extension line origin or RETURN to select: Specify a point for manual extension lines, or press RETURN for 
automatic extension lines



Object SelectionAutomatic Extension Lines (DIMALIGNED)
Up a Level

Automatically determines the origin points of the first and second extension lines.

Select object to dimension: Select an object

For polylines, only the individual line and arc segments are dimensioned. You cannot select objects in a nonuniformly scaled
block reference.

If you select a line or an arc, its endpoints are used as the origins of the extension lines, which are offset by the distance 
specified under Origin Offset in the DDIM Geometry dialog box. AutoCAD LT stores this value in the DIMEXO system 
variable.

      

 

If you select a circle, the endpoints of its diameter are used as the origins of the extension line. The point used to select the 
circle defines the origin of the first extension line.



Point SelectionManual Extension Lines (DIMALIGNED)
Up a Level

After you specify the first extension line origin point, AutoCAD LT prompts for the origin point of the second extension line.

Second extension line origin: Specify a point (2)

After the origin points of the extension lines have been established, AutoCAD LT displays the following prompt:

Dimension line location (Text / Angle): Specify a point or enter an option

      

 

Point Specification
If you specify a point, AutoCAD LT uses the point to locate the dimension line and determines the direction to draw the 
extension lines. After you specify the location, the DIMALIGNED command ends.

Text
Enables you to customize the text. AutoCAD LT measures the distance and displays the dimension text as angle brackets (<
>) in the Edit MText dialog box. Enter or delete characters for customized text, or choose OK to accept the default measured
length.

If you edit the text, you can use Unicode character strings to express special characters. Enclose format strings for alternate 
units in square brackets ([ ]). Strings for prefixes and suffixes should precede or follow angle brackets (< >). AutoCAD LT 
draws the dimension measurement in place of the < > characters. 

The units settings and current text style determine the appearance of the dimension text. After you specify the text, AutoCAD
LT displays the Dimension Line Location prompt.

Angle
Changes the angle of the dimension text.

Enter text angle: Specify an angle



After you specify the angle, AutoCAD LT displays the Dimension Line Location prompt.

 



For more information, see "Parts of a Dimension" in chapter 13 of the AutoCAD LT User's Guide. For more information about
adding a prefix or suffix, "Dimension Text" in chapter 13 of the AutoCAD LT User's Guide.

Commands: DDIM controls dimension styles and settings such as units and style. 

System Variables: DIMEXO stores the dimension extension line offset. 



DIMANGULAR Command
Up a Level          Related Topics

Creates an angular dimension
 

From the Dimensioning toolbar, choose 
 From the Dimension menu, choose Angular

At the Command prompt, enter dimangular

Select arc, circle, line, or RETURN: Select an arc, circle, or line object, or press RETURN to specify three points

Dimension line location (Text / Angle): Specify a point or enter an option

Point Specification
If you specify a point, AutoCAD LT uses the point to locate the dimension line and determine the direction to draw the 
extension lines. After you specify the location, the DIMANGULAR command ends.

Text
Enables you to customize the text. AutoCAD LT measures the distance and displays the dimension text as angle brackets (<
>) in the Edit MText dialog box.

Enter or delete characters for customized text, or choose OK to accept the default measured length.
If you edit the text, you can use Unicode character strings to express special characters. Enclose format strings for alternate 
units in square brackets ([ ]). Strings for prefixes and suffixes should precede or follow angle brackets (< >). AutoCAD LT 
draws the dimension measurement in place of the < > characters. 

The units settings and current text style determine the appearance of the dimension text. Alternate units have no effect on 
angular dimensions.

After you specify the text, AutoCAD LT redisplays the Dimension Line Location prompt.

Angle
Changes the angle of the dimension text.

Enter text angle: Specify an angle

After you specify the angle, AutoCAD LT redisplays the Dimension Line Location prompt.



RETURN–Three Point Specification (DIMANGULAR)
Up a Level

Angle vertex: Specify a point (1)

First angle endpoint: Specify a point (2)

Second angle endpoint: Specify a point (3)

The angle vertex can be the same as one of the angle endpoints. If you need extension lines, the endpoints are used as 
origin points.

      

 

AutoCAD LT draws the dimension line as an arc between the extension lines. The extension lines are drawn from the angle 
endpoints to the intersection of the dimension line.



Arc Selection (DIMANGULAR)
Up a Level

If you select an arc, AutoCAD LT determines the defining points for a three-point angular dimension. The center of the arc is 
the angle vertex. The arc endpoints become the origin points of the extension lines.

AutoCAD LT draws the dimension line as an arc between the extension lines. The extension lines are drawn from the angle 
endpoints to the intersection of the dimension line.



Circle Selection (DIMANGULAR)
Up a Level

If you select a circle, the selection point is used as the origin of the first extension line. The center of the circle is the angle 
vertex.

Second angle endpoint: Specify a point (2)

The second angle endpoint is the origin of the second extension line and does not have to lie on the circle. 
AutoCAD LT draws the dimension line as an arc between the extension lines. The extension lines are drawn from the angle 
endpoints to the intersection of the dimension line.



Line Selection (DIMANGULAR)
Up a Level

If you select a line, you must select a second line to determine the angle between them.

Second line: Select a line

AutoCAD LT determines the angle by using each line as a vector for the side of the angle and the intersection of the lines for
the angle vertex. The dimension line spans the angle between the two lines. If the dimension line doesn't intersect a line or 
lines being dimensioned, AutoCAD LT adds extension lines as needed to extend one or both lines. The arc is always less 
than 180 degrees.

        



For more information, see "Creating Angular Dimensions" in chapter 13 of the AutoCAD LT User’s Guide. For more 
information about adding a prefix or suffix, see "Dimension Text," in chapter 13 of the AutoCAD LT User's Guide. 

Commands: DDIM controls dimension styles and settings such as units and style. To modify the appearance of a dimension
and the dimension text, use DDEDIT, DIMEDIT, and DIMEDIT. 



DIMBASELINE Command
Up a Level          Related Topics

Continues a linear, angular, or ordinate dimension from the baseline of the previous or selected dimension
DIMBASELINE creates a series of related dimensions measured from the same baseline. AutoCAD LT uses a baseline 
increment value to offset each new dimension line and to avoid overlaying the previous dimension line. The baseline 
increment value is specified under Dimension Line in the DDIM Geometry dialog box and stored in the DIMDLI system 
variable. Baseline dimensioning is also called parallel dimensioning.

      

   
From the Dimensioning toolbar, choose 

   From the Dimension menu, choose Baseline
 At the Command prompt, enter dimbaseline

The prompts that follow depend on the most recent dimension created in the current session of AutoCAD LT: no prior 
dimension, linear, ordinate, or angular.



No Prior Dimension (DIMBASELINE)
Up a Level

If no dimension was created in the current session, AutoCAD LT prompts you to select a linear, ordinate, or angular 
dimension to use as the base for the baseline dimension.

Select base dimension: Select a linear, ordinate, or angular dimension

After you select a base dimension, AutoCAD LT displays additional prompts depending on the type of dimension you select: 
linear, ordinate, or angular. To end the command, press RETURN or ESCAPE. The units settings, tolerance settings, and 
current text style determine the appearance of the text.



Linear Dimension (DIMBASELINE)
Up a Level

If the previous dimension was linear, AutoCAD LT prompts

Second extension line origin or RETURN to select: Specify a point or press RETURN to select a base dimension

AutoCAD LT uses the first extension line origin of the base dimension for the first extension line origin of the baseline 
dimension. After you specify a point, AutoCAD LT draws the baseline dimension and redisplays the Second Extension Line 
Origin prompt. To end the command, press ESCAPE.

If you press RETURN at the Second Extension Line Origin prompt, AutoCAD LT prompts you to select a linear, ordinate, or 
angular dimension to use as the basis for the baseline dimension.

Select base dimension: Select a linear, ordinate, or angular dimension

After you select a base dimension, AutoCAD LT redisplays the Second Extension Line Origin prompt. To end the command, 
press ESCAPE. The units settings, tolerance settings, and current style determine the appearance of the text.



Ordinate or Angular Dimension (DIMBASELINE)
Up a Level

If the previous dimension was angular or ordinate, AutoCAD LT prompts

Select next feature or RETURN to select: Specify a point, snap to an object, or press RETURN to select a base 
dimension

AutoCAD LT uses the first extension line origin of the base dimension for the first extension line origin of the baseline 
dimension. After you specify a point, AutoCAD LT draws the baseline dimension and redisplays the Select next feature 
prompt. 

If you press RETURN at the Select next feature prompt, AutoCAD LT prompts you to select a linear, ordinate, or angular 
dimension to use as the basis for the baseline dimension.

Select base dimension: Select a linear, ordinate, or angular dimension

After you select a base dimension, AutoCAD LT redisplays the Select next feature prompt. To end the command, press 
ESCAPE. The units settings, tolerance settings, and the current text style determine the appearance of the text.



For more information, see "Creating Linear Dimensions" in chapter 13 of the AutoCAD LT User's Guide. 

Commands: DDIM controls dimension styles and settings such as units and style. To modify the appearance of dimension 
and the dimension text use DDEDIT, DIMEDIT, and DIMEDIT.

System Variables: DIMDLI specifies a distance for spacing between dimension lines of a baseline dimension. 



DIMCENTER Command
Up a Level          Related Topics

Creates the center mark or the center lines of circles and arcs
 

From the Dimensioning toolbar, choose 
 From the Dimension menu, choose Center Mark

At the Command prompt, enter dimcenter

Select arc or circle: 

You can choose between center marks and center lines and specify their size in the Geometry dialog box of the DDIM 
command. To do this at the Command prompt, use the DIMCEN dimensioning system variable.

        



For more information, see "Controlling Dimension Geometry" in chapter 13 of the AutoCAD LT User's Guide. 

Commands: DDIM controls dimension styles and settings such as center marks and center lines.

System Variables: DIMCEN stores the value and controls the generation of center marks or center lines.



DIMCONTINUE Command
Up a Level          Related Topics

Continues a linear, angular, or ordinate dimension from the second extension line of the previous or a 
selected dimension

From the Dimensioning toolbar, choose 

From the Dimension menu, choose Continue
At the Command prompt, enter dimcontinue

The prompts that follow depend on the most recent dimension created in the current session of AutoCAD LT: no prior 
dimension, linear, ordinate, or angular.



No Prior Dimension (DIMCONTINUE)
Up a Level

If no dimension was created in the current session, AutoCAD LT prompts you to select a linear, ordinate, or angular 
dimension to use as the basis for the continued dimension.

Select continued dimension: Select a linear, ordinate, or angular dimension

After you select a continued dimension, AutoCAD LT displays additional prompts depending on the type of dimension you 
select: linear, ordinate, or angular. To end the command, press RETURN or ESCAPE. The units settings, tolerance settings, 
and current text style determine the appearance of the text.



Linear Dimension (DIMCONTINUE)
Up a Level

If the previous dimension was linear, AutoCAD LT prompts

Second extension line origin or RETURN to select: Specify a point (1) or press RETURN to select a continued 
dimension

AutoCAD LT uses the first extension line origin of the continued dimension for the first extension line origin of the next 
dimension. After you specify a point, AutoCAD LT draws the dimension and redisplays the Second Extension Line Origin 
prompt. To end the command, press ESCAPE.

If you press RETURN at the Second Extension Line Origin prompt, AutoCAD LT prompts you to select a linear, ordinate, or 
angular dimension to use as the continued dimension.

Select continued dimension: Select a linear, ordinate, or angular dimension

After you select a continued dimension, AutoCAD LT redisplays the Second Extension Line Origin prompt. To end the 
command, press ESCAPE. The units settings, tolerance settings, and current style determine the appearance of the text.

        

      



Ordinate or Angular Dimension (DIMCONTINUE)
Up a Level

If the previous dimension was angular or ordinate, AutoCAD LT prompts

Select next feature or RETURN to select: Specify a point, snap to an object, or press RETURN to select a continued 
dimension

AutoCAD LT uses the first extension line origin of the continued dimension for the first extension line origin of the next 
dimension. After you specify a point, AutoCAD LT draws the dimension and redisplays the Select Next Feature prompt. 

If you press RETURN at the Select Next Feature prompt, AutoCAD LT prompts you to select a linear, ordinate, or angular 
dimension to use as the continued dimension.

Select continued dimension: Select a linear, ordinate, or angular dimension

After you select a continued dimension, AutoCAD LT redisplays the Select Next Feature prompt. To end the command, press
ESCAPE. The units settings, tolerance settings, and current text style determine the appearance of the text.



For more information, see "Creating Linear Dimensions" in chapter 13 of the AutoCAD LT User's Guide. 

Commands: DDIM controls dimension styles and settings such as units and style. DDEDIT controls how single line text is 
displayed. To modify the appearance of dimension and the dimension text use DDEDIT, DIMEDIT, and DIMEDIT.

System Variables: DIMFIT controls how the dimension line, text, and arrowheads are positioned within the measured 
points. 



DIMDIAMETER Command
Up a Level          Related Topics

Creates diameter dimensions for circles and arcs
DIMDIAMETER creates different types of diameter dimensions depending on the size of the circle or arc, the options in the 
DDIM Format dialog box, and the position of the cursor. AutoCAD LT stores the values of the options in the dimensioning 
system variables DIMUPT, DIMTOFL, DIMFIT, DIMTIH, DIMTOH, DIMJUST, and DIMTAD. 

   

From the Dimensioning toolbar, choose 
   From the Dimension menu, choose Radial, then Diameter
 At the Command prompt, enter dimdiameter

Select arc or circle: Select an arc or a circle 

The position of the cursor determines the location of the dimension line. As you move the cursor, the dimension moves 
around or inside the circle or arc. For horizontal dimension text, if the angle of the diameter line is greater than 15 degrees 
from horizontal and is outside the circle or arc, AutoCAD LT draws a hook line, also called a landing or dogleg, that is one 
arrowhead long (as shown in the first two illustrations).

        

Different types of diameter dimensions 

AutoCAD LT measures the diameter and displays the text with an Æ symbol in front of it. The next prompt is

Dimension line location (Text / Angle): Specify a point or enter an option

If you specify a point, AutoCAD LT uses the point to locate the dimension line. After you specify the location, DIMDIAMETER
ends.

Center Marks and Center Lines
You control center marks or lines with the options in the DDIM Geometry dialog box. When a dimension line is drawn inside 
the arc or circle, AutoCAD LT does not create a center mark or line. AutoCAD LT stores the value in the DIMCEN 
dimensioning system variable.





For more information, see "Creating Radial Dimensions" in chapter 13 of the AutoCAD LT User's Guide. 

Commands: DDIM controls dimension styles and settings such as units and style. To modify the appearance of dimension 
and the dimension text use DDEDIT, DIMEDIT, and DIMEDIT.

System Variables: DIMCEN controls the creation of center marks and lines. DIMFIT controls how text fits within the 
extension lines. DIMJUST controls the horizontal justification of dimension text. DIMTAD controls the vertical justification of 
dimension text. DIMTIH and DIMTOH control the position of dimension text inside and outside the extension lines. DIMTOFL
controls drawing a dimension line between the extension lines even when the text is placed outside the extension lines. 
DIMUPT controls user-positioned text. 



Text (DIMDIAMETER)
Up a Level

Customizes the dimension text. AutoCAD LT measures the diameter and displays the dimension text as angle brackets (< >)
in the Edit MText dialog box. 

For customized text enter or delete characters. To accept the default measured length, choose OK.

If you edit the text, you can use Unicode character strings to express special characters. Enter strings for prefixes and 
suffixes before or after angle brackets (< >). Enclose format strings for alternate units in square brackets ([ ]). AutoCAD LT 
draws the dimension measurement in place of the < > characters.

The units settings and current text style determine how the text is displayed.

After you specify the text, AutoCAD LT displays the Dimension Line Location prompt.



Angle (DIMDIAMETER)
Up a Level

Changes the angle of the dimension text.

Enter text angle: Specify an angle

After you specify the angle, AutoCAD LT redisplays the Dimension Line Location prompt.



DIMEDIT Command
Up a Level          Related Topics

Edits dimensions
DIMEDIT affects dimension text and extension lines on one or more dimension objects. The Home, New, and Rotate options
affect dimension text. The Oblique option controls the angle of extension lines. 

 At the Command prompt, enter dimedit

Dimension Edit (Home / New / Rotate / Oblique) <Home>: Enter an option or press RETURN



Home (DIMEDIT)
Up a Level

Moves dimension text back to its default position.

Select objects: Select one or more dimension objects

      



New (DIMEDIT)
Up a Level

Changes dimension text using the Edit MText dialog box. 

      

Enter the new dimension text, or choose OK to accept the default measured length.

You can use Unicode character strings to express special characters. Enclose format strings for alternate units in square 
brackets ([ ]). Strings for prefixes and suffixes should precede or follow angle brackets (< >). AutoCAD LT draws the 
dimension measurement in place of the < > characters. Accepting the default (< >) for the new text string uses the actual 
dimension measurement as the text. 

Select objects: Select one or more dimension objects

AutoCAD LT changes the original dimension text to the text you entered in the Edit MText dialog box.



Rotate (DIMEDIT)
Up a Level

Rotates dimension text. This option is similar to the Angle option of the DIMTEDIT command.

Enter text angle: Specify an angle

To place the text in its default orientation, enter an angle of zero. The default orientation of the dimension text is determined 
by the Inside horizontal and Outside horizontal settings in the Format dialog box of DDIM or alternately the DIMTIH and 
DIMTOH dimensioning system variables.

Select objects: Select one or more dimension objects



Oblique (DIMEDIT)
Up a Level

Adjusts the obliquing angle of the extension lines for linear dimensions. AutoCAD LT creates linear dimensions with 
extension lines perpendicular to the direction of the dimension line. This option is useful when extension lines conflict with 
other features of the drawing.

Select objects: Select one or more dimension objects



For more information, see "Editing Dimension Text" in chapter 13 of the AutoCAD LT User's Guide. 

Commands: DIMTEDIT repositions and rotates text in a dimension without affecting other dimension subobjects. DDEDIT 
modifies the contents of dimension text.    

System Variables: DIMTIH and DIMTOH control the position of dimension text inside and outside the extension lines. 



DIMLINEAR Command
Up a Level          Related Topics

Creates linear dimensions
   

From the Dimensioning toolbar, choose 
 From the Dimension menu, choose Linear
 At the Command prompt, enter dimlinear

First extension line origin or RETURN to select: Specify a point (1) or press RETURN for automatic extension lines

Point Specification
If you specify a point for the first extension line, AutoCAD LT prompts for the second extension line origin.

Second extension line origin: Specify a point (2)

      

Object SelectionAutomatic Extension Lines
If you press RETURN and select an object, AutoCAD LT automatically determines the origin points of the first and second 
extension lines.

For polylines and other explodable objects, only the individual line and arc segments are dimensioned. You cannot select 
objects in a nonuniformly scaled block reference.

If you select a line or an arc, its endpoints are used as the origins of the extension lines. The extension lines are offset from 
the endpoints by the distance specified under Extension in the DDIM Geometry dialog box. 

      



If you select a circle, the endpoints of its diameter are used as the origin points. When the point used to select the circle is 
close to the north or south quadrant point, AutoCAD LT draws a horizontal dimension. When the point used to select the 
circle is close to the east or west quadrant point, AutoCAD LT draws a vertical dimension.

After the origin points of the extension lines have been specified, the next prompt is

Dimension line location (Text / Angle / Horizontal / Vertical / Rotated): Specify a point (3) or enter an option

If you specify a point, AutoCAD LT uses the point to locate the dimension line and determine the direction to draw the 
extension lines. After you specify the location, AutoCAD LT draws the dimension.



Object Selection, Text (DIMLINEAR)
Up a Level

Customizes the text. AutoCAD LT measures the coordinate and displays the dimension text as angle brackets (< >) in the 
Edit MText dialog box. 

To customize the text enter or delete characters. To accept the default measured length, choose OK.

If you edit the text, you can use Unicode character strings to express special characters. Enter strings for prefixes and 
suffixes before or after angle brackets (< >). Enclose format strings for alternate units in square brackets ([ ]). AutoCAD LT 
draws the dimension measurement in place of the < > characters.

      

The units settings, tolerance settings, and current text style determine how the text is displayed.

After you specify the text, AutoCAD LT redisplays the Dimension Line Location prompt.



Object Selection, Angle (DIMLINEAR)
Up a Level

Changes the angle of the dimension text.

Enter text angle: Specify an angle

      

After you specify the angle, the Dimension Line Location prompt is redisplayed.



Object Selection, Horizontal (DIMLINEAR)
Up a Level

Creates horizontal linear dimensions.

Dimension line location (Text / Angle): Specify a point or enter an option

If you specify a point, AutoCAD LT draws the dimension. For information on the options, see Text and Angle.



Object Selection, Vertical (DIMLINEAR)
Up a Level

Creates vertical linear dimensions.

Dimension line location (Text / Angle): Specify a point or enter an option

If you specify a point, AutoCAD LT draws the dimension. For information on the options, see Text and Angle.



Object Selection, Rotated (DIMLINEAR)
Up a Level

Creates rotated linear dimensions.

Dimension line angle <current>: Specify an angle or press RETURN

After you specify the angle, AutoCAD LT redisplays the Dimension Line Location prompt.



For more information, see "Creating Linear Dimensions" in chapter 13 of the AutoCAD LT User's Guide. For more 
information about how text is oriented and placed, see chapter 12, "Adding Text to Drawings" in the AutoCAD LT User's 
Guide.  For more information about adding a prefix or suffix, see "Creating Radial Dimensions" in chapter 13 of the AutoCAD
LT User's Guide.

Commands: DDIM controls dimension styles and settings such as units and style. To modify the appearance of dimension 
and the dimension text use DDEDIT, DIMEDIT, and DIMEDIT. 

System Variables: DIMEXO stores the dimension extension line offset. 



DIMORDINATE Command
Up a Level          Related Topics

Creates ordinate point dimensions
Ordinate point dimensions, also known as datum dimensions, display the X or Y coordinate of a feature along with a simple 
leader line. AutoCAD LT uses the current UCS to determine the measured X or Y coordinate, then it draws the leader line in 
a direction orthogonal to the coordinate axes of the current UCS. The absolute value of the coordinate is used according to 
the prevailing standards for ordinate point dimensions. When creating ordinate point dimensions, it's recommended that you 
turn on Ortho mode.

   
From the Dimensioning toolbar, choose 

 From the Dimension menu, choose Ordinate
 At the Command prompt, enter dimordinate

Select feature: Specify a point or snap to an object

AutoCAD LT uses the point as the start point of the leader line and then prompts for the endpoint.

Leader endpoint (Xdatum / Ydatum / Text): Specify a point or enter an option

If you specify a point, AutoCAD LT uses the difference between the feature location and the leader endpoint to determine 
whether it is an X or Y ordinate dimension. If the difference in the Y coordinate is greater, the dimension measures the X 
coordinate. Otherwise, it measures the Y coordinate.



For more information, see "Creating Ordinate Dimensions" and "Creating Radial Dimensions" in chapter 13 of the AutoCAD 
LT User's Guide.

Commands: DDIM controls dimension styles and settings such as units and style. To modify the appearance of dimension 
and the dimension text use DDEDIT, DIMEDIT, and DIMEDIT. ORTHO constrains cursor movement to the horizontal or 
vertical directions or aligns movement with the current grid rotation angle. 



Xdatum (DIMORDINATE)
Up a Level

Measures the X coordinate and determines the orientation of the leader line and dimension text. AutoCAD LT then prompts 
for the endpoint.

Leader endpoint: Specify a point

AutoCAD LT draws the dimension.



Ydatum (DIMORDINATE)
Up a Level

Measures the Y coordinate and determines the orientation of the leader line and dimension text. AutoCAD LT then prompts 
for the endpoint.

Leader endpoint: Specify a point

AutoCAD LT draws the dimension.



Text (DIMORDINATE)
Up a Level

Customizes the text. AutoCAD LT measures the coordinate and displays the dimension text as angle brackets (< >) in the 
Edit MText dialog box. 

To customize the text, enter or delete characters. To accept the default measured length, choose OK.

If you edit the text, you can use Unicode character strings to express special characters. Enter strings for prefixes and 
suffixes before or after angle brackets (< >). Enclose format strings for alternate units in square brackets ([ ]). AutoCAD LT 
draws the dimension measurement in place of the < > characters. 

The units settings and current text style determine how the text is displayed. The text aligns with the leader line, regardless 
of the alignment settings for dimension text.

After you specify the text, AutoCAD LT prompts for the endpoint of the leader line.

Leader endpoint: Specify a point

AutoCAD LT draws the dimension.



DIMOVERRIDE Command
Up a Level          Related Topics

Overrides dimension system variables
DIMOVERRIDE overrides dimensioning system variable settings that are associated with a dimension object but doesn't 
affect the current dimension style.

 At the Command prompt, enter dimoverride

Dimension variable to override (or Clear to remove overrides): Enter a variable name or c



For more information, see "Using Style Overrides," in chapter 13 of the AutoCAD LT User's Guide. 

Commands: DDIM controls dimension styles and settings such as units and style. 



Dimension Variable to Override (DIMOVERRIDE)
Up a Level

Overrides the value for the dimensioning system variable that you specify.

Current value <current> New value: Enter a value or press RETURN

Dimension variable to override: Enter a name or press RETURN

If you enter a dimensioning system variable name, AutoCAD LT redisplays the Current Value <current> New Value prompt. 

If you enter a new value, AutoCAD LT displays the Dimension variable to override prompt.

If you press RETURN, AutoCAD LT prompts

Select objects: Select one or more dimension objects

AutoCAD LT applies the overrides to the selected dimension object.



Clear to Remove Overrides (DIMOVERRIDE)
Up a Level

Clears any overrides on a dimension object.

Select objects: Select one or more dimension objects

AutoCAD LT clears the overrides, and the dimension object returns to the settings defined by its dimension style.



DIMRADIUS Command
Up a Level          Related Topics

Creates radial dimensions for circles and arcs
A radial dimension consists of a radius dimension line with an arrowhead at the arc or circle end. AutoCAD LT draws a 
center mark if the center mark value for extension lines is not zero.

DIMRADIUS draws a radial dimension depending on the size of the circle or arc, the options in the DDIM Format dialog box,
and the position of the cursor. AutoCAD LT stores the values of the options in the dimensioning system variables DIMUPT, 
DIMTOFL, DIMFIT, DIMTIH, DIMTOH, DIMJUST, and DIMTAD. 

   

From the Dimensioning toolbar, choose 
 From the Dimension menu, choose Radial, then Radius
 At the Command prompt, enter dimradius

Select arc or circle: Select an arc or a circle

The position of the cursor determines the location of the text. As you move the cursor, the dimension moves around or inside
the circle or arc. 

For horizontal dimension text, if the angle of the radius dimension line is greater than 15 degrees from horizontal, AutoCAD 
LT draws a hook line, also called a dogleg, or a landing, that is one arrowhead long.

AutoCAD LT measures the radius and displays the text with the letter R in front of it. 

Dimension line location (Text / Angle): Specify a point or enter an option

If you specify a point, AutoCAD LT uses the point to locate the dimension line. After you specify the location, AutoCAD LT 
draws the dimension.

Center Marks and Center Lines
You control center marks or lines with the options in the DDIM Geometry dialog box. When a dimension line is drawn inside 
the arc or circle, AutoCAD LT does not create a center mark or line. AutoCAD LT stores the value of center marks and lines 
in the DIMCEN dimensioning system variable.



For more information, see "Creating Radial Dimensions" and "Controlling Dimension Text," in chapter 13 of the AutoCAD LT 
User's Guide. 

Commands: DDIM controls dimension styles and settings such as units and style. To modify the appearance of dimension 
and the dimension text use DDEDIT, DIMEDIT, and DIMEDIT.    

System Variables: DIMCEN controls the creation of center marks and lines. DIMFIT controls how text fits within the 
extension lines. DIMJUST controls the horizontal justification of dimension text. DIMTAD controls the vertical justification of 
dimension text. DIMTIH and DIMTOH control the position of dimension text inside and outside the extension lines. DIMTOFL
controls drawing a dimension line between the extension lines even when the text is placed outside the extension lines. 
DIMUPT controls user-positioned text. 



Text (DIMRADIUS)
Up a Level

Customizes the text. AutoCAD LT measures the coordinate and displays the dimension text as angle brackets (< >) in the 
Edit MText dialog box. 

To customize the text, enter or delete characters. To accept the default measured length, choose OK.

If you edit the text, you can use Unicode character strings to express special characters. Enter strings for prefixes and 
suffixes before or after angle brackets (< >). Enclose format strings for alternate units in square brackets ([ ]). AutoCAD LT 
draws the dimension measurement in place of the < > characters.

The units settings, tolerance settings, and current text style determine how the text is displayed.

After you specify the text, AutoCAD LT redisplays the Dimension Line Location prompt.



Angle (DIMRADIUS)
Up a Level

Changes the angle of the dimension text.

Enter text angle: Specify an angle

After you specify the angle, AutoCAD LT redisplays the Dimension Line Location prompt.



DIMSTYLE Command
Up a Level          Related Topics

Creates and modifies dimension styles on the command line
A dimension style is a saved set of dimension settings that determines the appearance of a dimension. By creating a 
dimension style, you can set relevant dimensioning system variables and control the layout and appearance of any 
dimension. You can create and modify dimension styles using a set of dialog boxes associated with DDIM.

 At the Command prompt, enter dimstyle

dimension style: stylename

dimension style overrides: variable value

Dimension Style Edit (Save / Restore / STatus / Variables / Apply / ? ) <Restore>: Enter an option or press RETURN



For more information, see "Working with Dimension Styles" in chapter 13 of the AutoCAD LT User's Guide. 

Commands: DDIM controls dimension styles and settings such as units and style. 

System Variables: DIMSTYLE stores the name of the current dimension style. 



Restore (DIMSTYLE)
Up a Level

Restores dimensioning system variable settings to those of an existing dimension style.

? / Enter dimension style name or RETURN to select dimension: Enter ?, enter a name, or press RETURN



?List Dimension Styles

Lists the named dimension styles in the active drawing.

Dimension style(s) to list <*>: Enter a name list or press RETURN

After listing the dimension styles, AutoCAD LT returns to the ?/Enter Dimension Style Name prompt.



Dimension Style Name

Sets the named dimension style you enter as the current dimension style. The style remains current until you change any 
dimensioning system variables or save or restore another style.

To display the difference between the dimension style name you enter and the current style, enter a tilde (~) followed by a 
style name, as in the following example:.

? / Enter dimension style name or RETURN to select dimension: ~standard

Differences between STANDARD and current settings:

STANDARD Current Settings

DIMBLK1 _OBLIQUE

DIMBLK2 _OBLIQUE

DIMSAH Off On

After displaying the differences, AutoCAD LT redisplays the ?/Enter Dimension Style Name prompt.



Select a Dimension

Makes the dimension style of the dimension object you select the current dimension style. The style remains current until 
you change any dimensioning system variables or save or restore another style.



Save (DIMSTYLE)
Up a Level

Saves the current settings of dimensioning system variables to a dimension style.

? / Name for new dimension style: Enter ? or enter a name



?List Dimension Styles

Lists the named dimension styles in the active drawing.

Dimension style(s) to list <*>: Enter a name list or press RETURN

After listing the named dimension styles, AutoCAD LT returns to the ?/Name for New Dimension Style prompt.



New Dimension Style

Saves the current settings of dimensioning system variables to a new dimension style using the name you enter. The new 
dimension style becomes the current one and remains current until you change any dimensioning system variables or until 
you save or restore another style.

If you enter the name of an existing dimension style, AutoCAD LT prompts.

That name is already in use, redefine it? <N> Enter y or press RETURN

If you enter y, AutoCAD LT regenerates associative dimensions that use the redefined dimension style.

To display the difference between the dimension style name you enter and the current style, enter a tilde (~) followed by a 
style name, as in the following example:.

? / Name for new dimension style: ~standard

Differences between STANDARD and current settings:

STANDARD Current Settings

DIMBLK1 _OBLIQUE

DIMBLK2 _OBLIQUE

DIMSAH Off On

After displaying the differences, AutoCAD LT redisplays the ?/Name for New Dimension Style prompt.



Status (DIMSTYLE)
Up a Level

Displays the current values of all dimensioning system variables.



Variables (DIMSTYLE)
Up a Level

Lists the dimensioning system variable settings for a dimension style without modifying the current settings.

? / Enter dimension style name or RETURN to select dimension: Enter ?, enter a name, or press RETURN to select a 
dimension



?List Dimension Styles

Lists the named dimension styles in the active drawing.

Dimension style(s) to list <*>: Enter a name list or press RETURN

After listing the dimension styles, AutoCAD LT returns to the ?/Enter Dimension Style Name prompt.



Dimension Style Name

Lists the settings of dimensioning system variables for the dimension style name you entered. After listing the variables, 
DIMSTYLE ends.

To display the difference between the dimension style name you enter and the current style, enter a tilde (~) followed by the 
style name, as in the following example:

? / Name for new dimension style: ~standard

Differences between STANDARD and current settings:

STANDARD Current Settings

DIMBLK1 _OBLIQUE

DIMBLK2 _OBLIQUE

DIMSAH Off On

After showing the differences, AutoCAD LT returns to the ?/Name for New Dimension Style prompt.



Select a Dimension

Lists the settings of dimensioning system variables for the dimension object you select.

Select dimension: Select a dimension object

You can choose the dimension style by name or by selecting a dimension that refers to the style.



Apply (DIMSTYLE)
Up a Level

Updates the selected dimension objects so that they use the current dimensioning system variables settings, including the 
dimension style and any overrides.

Select objects: Select one or more dimension objects 

Note: Any references to dimension styles in the dimension objects you select are lost.

If you use the Apply option after changing the spacing for baseline dimensions (DIMDLI variable), the spacing between 
dimension lines of existing dimensions is not affected.



? -- List Dimension Styles (DIMSTYLE)
Up a Level

Lists the named dimension styles in the active drawing.

Dimension style(s) to list <*>: Enter a name list or press RETURN



DIMTEDIT Command
Up a Level          Related Topics

Moves and rotates dimension text 
   

From the Dimensioning toolbar, choose 
 From the Dimension menu, choose Align Text
 At the Command prompt, enter dimtedit

Select dimension: Select a dimension object

After you select a single associative dimension, AutoCAD LT prompts for the new location of the dimension text.

Enter text location (Left / Right / Home / Angle): Specify a point or enter an option

If you move the cursor to position the dimension text and DIMSHO is on, the dimension updates dynamically as it drags. 
Vertical placement is set in the DDIM Format dialog box and determines whether text appears above, below, or in the middle
of the dimension line. See vertical justification.

    

    



For more information, see "Editing Dimension Text" in chapter 13 of the AutoCAD LT User's Guide.

Commands: DDIM controls dimension styles and settings such as units and style.

System Variables: DIMSHO controls redefinition of dimensions while dragging.



Left

Left justifies the dimension text along the dimension line. This option works only with linear, radial, and diameter dimensions.

Before Left After Left



Right

Right justifies the dimension text along the dimension line. This option works only with linear, radial, and diameter 
dimensions.

Before Right After Right



Home

returns the dimension text to its default position.

Before Home After Home



Angle

Changes the angle of the dimension text.

Text angle: Specify an angle

Before Angle After Angle 90
The center point of the text doesn't change. If the text moves or the dimension regenerates, AutoCAD LT keeps the 
orientation set by the text angle. If you enter an angle of 0 degrees, the text returns to its default orientation. When the Inside
Horizontal option is selected for text in the DDIM Format dialog box, the dimension text aligns with the dimension line. The 
Inside Horizontal option has no effect on dimension text when the angle you specify is other than 0.



Direct Distance Entry
Up a Level      Related Topics

Accepts a distance in the direction of the current location of your cursor
 At a prompt to locate a point, enter a numeric value

With direct distance entry, you can quickly specify a point relative to the last point you entered. At any AutoCAD LT prompt 
for a point location, you first locate the cursor to specify the direction and then enter a numeric distance. 

LINE From point: Specify a point

To point:    Move cursor in the direction of the point and enter 5

To point:

In this example, the second point for the line will be located 5 units toward the direction of your cursor.

The direct distance that you enter is measured along the path from the last point to the current location of the cursor.

This feature is usually used with Ortho or Snap mode turned on.



For more information, see “Using Direct Distance Entry” in chapter 5 of the AutoCAD LT User’s Guide.

Commands: TRACKING locates a point from a series of temporary points.



'DIST Command
Up a Level          Related Topics

Measures the distance and angle between two points
   

From the Object Properties toolbar, choose 
 At the Command prompt, enter dist

First point: Specify a point

Second point: Specify another point

Distance = <calculated distance>

Angle in XY plane = <angle > Angle from XY plane = <angle>

Delta X = <change in X>, Delta Y = <change in Y>, Delta Z = <change in Z>

With DIST, AutoCAD LT reports the true 3D distance between points. The angle in the UCS XY plane is relative to the 
current UCS X axis. The angle from the UCS XY plane is relative to the current XY plane. DIST assumes the current 
elevation value if the Z coordinate is omitted from the first point or second point.

The distance is displayed using the current units format.



For more information, see "Calculating Distance and Angle" in chapter 7 of the AutoCAD LT User's Guide. 

Commands: DDUNITS and UNITS set drawing units.

System Variables: DISTANCE stores the last distance measured by the DIST command.



DIVIDE Command
Up a Level          Related Topics

Places evenly spaced point objects or blocks along the length or perimeter of an object
   

From the Draw toolbar, choose 
   From the Draw menu, choose Point, then Divide
 At the Command prompt, enter divide

Select object to divide: Select an object

<Number of segments> / Block: Enter a value (2-32767) or b



Number of Segments (DIVIDE)
Up a Level

For a closed polyline, the first dividing point is at its initial vertex and there are the same number of segments and dividing 
points. For an open polyline, the first dividing point is after the first segment along the polyline and there is one more 
segment than there are dividing points. For a circle, the first dividing point is normally just right of its center, on its 
circumference. 

The point objects or blocks are placed in the Previous selection set. To select them all, enter p at the next Select Objects 
prompt.

AutoCAD LT places markers in the plane of the object being divided. For 3D polylines, it places markers in the XY plane of 
the current UCS.

The illustration shows a polyline divided into five parts. Point Display mode (PDMODE) has been set such that the points 
can be seen.

      



Block (DIVIDE)
Up a Level

Places blocks at a specified interval along the selected object.

Block name to insert: Enter the name of a block currently defined in the drawing

The block you specify must be defined within the current drawing.

Align block with object? <Y>: Enter n or press RETURN

Entering y specifies that the X axes of the inserted blocks be tangent to, or colinear with, the divided object at the dividing 
points. Entering n specifies that the blocks are to be aligned according to their normal orientation. 

Number of segments. Enter a value (2-32767)

The illustration shows an arc divided into five equal parts using a block containing a vertically-oriented ellipse.

      



See "Dividing Objects Into Segments," in chapter 7 of the AutoCAD LT User's Guide.

Commands: POINT creates a point object.

System Variables: PDMODE and PDSIZE values control the appearance of point objects.



DLINE
Up a Level        

Draws a double line using straight line segments and arcs
 

From the Draw toolbar, choose 

From the Draw menu, choose Double Line
At the Command prompt, enter dline or dl

Break / Caps / Dragline / Offset / Snap / Undo / Width / <start point>: Specify a point, enter an option, or press 
RETURN



Break

Determines whether AutoCAD LT creates a gap at the intersection of two double lines.

Break Dline’s at start and end points? OFf/<ON>: Enter an option or press RETURN



Caps

Specifies the type of endcaps of a double line.

Draw which endcaps? Both / End / None / Start / <Auto>: Enter an option or press RETURN

AutoCAD LT caps the specified ends whether or not they snap to an object.



Dragline

Draws a double line by locating points centered on or offset from the double line. You can also draw along the left and right 
legs of the double line.

Set dragline position to the Left / Center / Right / <Offset from center=current>: Enter an option or press RETURN

A negative value offsets the double line to the left of the located points, the rubber band line. A positive number offsets the 
double line to the right of the located points.



Offset

This option locates the start of a double line at a specified distance and angle from a base point. First, you locate the base 
point, then a point to define the direction of the offset, and finally, the offset distance.

Offset from: Locate a point

Offset toward: Locate a point

Enter the offset distance: Enter a distance value or locate a point 



Snap

This option starts or ends a double line by snapping to an existing object. When Snap is on, the Break option determines 
whether to break the object at the intersection of the double line.

Set snap size or snap On / Off. Size / OFF / <ON>: Enter an option or press RETURN

The Size option specifies the size of a search area, in pixels. The double line starts or terminates by snapping to the object it
finds within the search area and adjusts each of its legs to form a clean junction with the object.

Selecting the Size option displays the following prompt:

New snap size (1-10) <current>: Enter a number from 1 through 10



Undo

This option removes, in reverse order the points located for the current double line. A closed double line cannot be undone 
with this option. You can use the UNDO command to undo each segment individually.



Width

This option sets the width of a double line. The width is the perpendicular distance from one leg of the double line to the 
other.

New DLINE width <current width>: Enter a width value or locate two points



DONUT Command
Up a Level          Related Topics

Draws filled circles and rings
Donuts are constructed of a closed polyline composed of wide arc segments. The current setting of the FILL command 
determines how the interior of a donut is filled.

 

From the Draw toolbar, choose 

From the Draw menu, choose Circle, then Donut
At the Command prompt, enter donut

Inside diameter <current>: Specify a diameter distance, or press RETURN

If you specify an inside diameter of zero, the donut is a filled circle.

Outside diameter <current>: Specify a distance, or press RETURN

Center of doughnut: Specify a point (1)

      

AutoCAD LT sets the location of the donut based on the center point. After you specify the diameters, AutoCAD LT prompts 
for the locations of the donuts and draws a donut at each point specified. Press RETURN to end the command.



For more information, see "Drawing Donuts" in chapter 6 of the AutoCAD LT User's Guide. 

Commands: FILL controls the filling of traces, solids, and wide polylines.

System Variables: FILLMODE stores the FILL command setting.



DSVIEWER Command
Up a Level          Related Topics

Opens the Aerial View window
The Aerial View window is a navigation tool that displays a view of the drawing in a separate window. With the Aerial View 
window open, you can quickly locate and move to a specific area, and you can zoom and pan without choosing a menu 
option or entering a command. 

Aerial View is not available in paper space or during the DVIEW command. 

   From the standard toolbar, choose

   From the View menu, choose Aerial View
 At the Command prompt, enter dsviewer

The Aerial View window opens and displays the entire drawing.

Aerial View Menus
View
Mode
Options

Locator Tool    
Specifies an area on the drawing to be displayed in the Aerial View window. When you choose Locator from the toolbar, the 
cursor becomes a circle with a cross through it, like a target. To select an area, to be displayed in the Aerial View window, 
hold down the pick button and drag the cursor to the area. 



View Menu (Aerial View)
Up a Level

Changes the magnification by zooming in and out of the drawing or by displaying the entire view of the image within the 
Aerial View window.

Zoom In. Increases the magnification of the drawing. 
Zoom Out. Decreases the magnification of the drawing. 
Global. Displays the entire image of the drawing in the Aerial View window. 



Mode Menu (Aerial View)
Up a Level

Switches between Pan and Zoom modes. 

Pan. Switches to Pan mode. In Pan mode, you can move the view box without changing the size or the 
magnification of the area in the Aerial View window. You can also use the AutoCAD LT scroll bars to pan.

Zoom. Switches to Zoom mode. Zoom mode changes the magnification of the view. To define the rectangular area
for the new view, click on two points in the Aerial View window.



Options Menu (Aerial View)
Up a Level

Locates a specific area of the drawing, displays information on the display-list driver, provides toggles for automatic viewport
display, updates the drawing dynamically, and sets the Aerial View magnification.

Auto Viewport. When Auto Viewport is on and you change viewports, the Aerial View window automatically 
displays the view in the current viewport. When Auto Viewport is off, AutoCAD LT updates the view to match the active 
viewport only when you click on the title bar of the Aerial View window. 

Dynamic Update. Controls whether AutoCAD LT updates the view in the Aerial View window when you edit the 
drawing.

Locator Magnification. Displays the Magnification dialog box, in which you can increase magnification up to 32 
times the area under the cursor. This feature is used with the Locator tool.
In the Magnification dialog box, choose + or - to increase or decrease the magnification value. You can also enter a 
magnification value in the text box.

Display Statistics. Displays the Display Driver Info dialog box.



For more information, see "Using Aerial View to Change Views" in chapter 8 of the AutoCAD LT User's Guide.



DVIEW Command
Up a Level          Related Topics

Defines parallel projection or perspective views
To help you view a model from any point in space, DVIEW uses a camera-target metaphor. The line of sight, or viewing 
direction, is the line between the camera and the target.

DVIEW uses objects you select or a special block named DVIEWBLOCK to display a preview image. The preview image 
shows the changes you make in the view. When you end the command, AutoCAD LT regenerates the drawing based on the 
view you set.

Transparent ZOOM, DSVIEWER, PAN, and scrollbars are not available in DVIEW. When you define a perspective view, 
ZOOM and PAN along with transparent ZOOM, DISVIEWER, PAN, and scrollbars are not available while that view is 
current.

   From the View menu, choose 3D Dynamic View
 At the Command prompt, enter dview

Select objects: Select objects or press RETURN

After you've selected objects or pressed RETURN to use DVIEWBLOCK, AutoCAD LT prompts 

CAmera / TArget / Distance / POints / PAn / Zoom / TWist / CLip / Hide / Off / Undo / <eXit>: Specify a point with your 
pointing device, enter an option, or press RETURN

      



Select Objects (DVIEW)
Up a Level

When you select objects, they are dragged in the preview image as you change views. Selecting too many objects slows 
image dragging and updating.



Preview with DVIEWBLOCK (DVIEW)
Up a Level

If you press RETURN at the Select Objects prompt, AutoCAD LT uses DVIEWBLOCK for the preview image. You can create
your own DVIEWBLOCK block in a 1x1x1-unit area, with its origin at the lower-left corner. The following illustration shows an
example of using the default DVIEWBLOCK to set the view (moving the graphics cursor adjusts the view).



Exit (DVIEW)
Up a Level

Ends DVIEW.



Point Specification (DVIEW)
Up a Level

Rolls the view under the camera. The point you select with your pointing device is a starting point for the dragging operation.
Your viewing direction changes about the target point as you move the cursor.

Enter direction and magnitude angles: Enter angles from 0360 degrees or specify a point with your pointing device

Enter both angles, separated by a comma. The angles must be positive. The direction angle indicates the front of the view, 
and the magnitude angle determines how far the view rolls.



Camera (DVIEW)
Up a Level

Specifies a new camera position by rotating the camera about the target point. Two angles determine the amount of rotation.

Toggle angle in / Enter angle from XY plane <current>: Enter t, enter an angle, or press RETURN

After you've toggled the angle input mode or specified the angle from the XY plane, AutoCAD LT prompts:

Toggle angle from / Enter angle in XY plane from X axis <current>: Enter t, enter an angle, or press RETURN

The illustrations show how the camera rotates to the left from its initial position, leaving its angle from the XY plane 
unchanged.



Toggle Angle In

Switches between two angle input modes. Entering an angle on the command line locks the cursor movement so you see 
only the positions available for that angle. The toggle option unlocks the cursor movement for the angle, and you can use the
cursor to rotate the camera.



Enter Angle from the XY Plane

Sets the camera's position at an angle above or below the XY plane. An angle of 90 degrees looks down from above, and an
angle of -90 looks up from below. A camera angle of 0 degrees places the camera parallel to the XY plane of the UCS.



Toggle Angle From

Switches between two angle input modes. Entering an angle on the command line locks the cursor movement so you see 
only the positions available for that angle. The toggle option unlocks the cursor movement for the angle, and you can use the
cursor to rotate the camera.



Enter Angle in XY Plane from X Axis

Sets the camera's position at an angle in the XY plane relative to the X axis of the current UCS. This angle measures from -
180 to 180 degrees. With rotation angle of zero degrees, you look down the X axis of the UCS toward the origin.



Target (DVIEW)
Up a Level

Specifies a new position for the target by rotating it around the camera. The effect is like turning your head to see different 
views of the drawing from one vantage point. Two angles determine the amount of rotation.

Toggle angle in / Enter angle from XY plane <current>: Enter t, enter an angle, or press RETURN

After you've toggled the angle input mode or specified the angle from the XY plane, AutoCAD LT prompts:

Toggle angle from / Enter angle in XY plane from X axis <current>: Enter t, enter an angle, or press RETURN

The following illustrations show the effect of rotating the target point from left to right, leaving its angle from the XY plane 
unchanged.



Enter Angle from XY Plane

Sets the target's position at an angle above or below the XY plane. An angle of 90 degrees looks down from above, and an 
angle of -90 looks up from below. A target angle of 0 degrees places the target parallel to the XY plane of the UCS.



Enter Angle in XY Plane from X Axis

Sets the target's position at an angle of rotation in the XY plane relative to the X axis of the current UCS. This angle 
measures from -180 to 180 degrees. With rotation angle of zero degrees, you look down the X axis of the UCS toward the 
origin.



Distance (DVIEW)
Up a Level

Moves the camera in or out along the line of sight relative to the target. This option turns on perspective viewing, which 
causes objects farther from the camera to appear smaller than those closer to the camera. A special perspective icon 
replaces the coordinate system icon. AutoCAD LT prompts for the new camera-to-target distance.

New camera / target distance <current>: Enter a distance or press RETURN

A slider bar is displayed along the top of the graphics window and is labeled from 0x to 16x, with 1x representing the current 
distance. Move the slider bar cursor to the right to increase the distance between the camera and target. Move the cursor to 
the left to decrease that distance. To turn off perspective viewing, use the Off option. 

If the target and camera points are close together, or if you specify a long focal-length lens, you might see very little of your 
drawing when you specify a new distance. If you see little or none of your drawing, try the maximum scale value (16x) or 
enter a large distance. To magnify the drawing without turning perspective viewing on, use the DVIEW Zoom option.

The illustration shows the effect of moving the camera along the line of sight relative to the target, where the field of view 
remains constant.

Camera-to-target distance



Points (DVIEW)
Up a Level

Locates the camera and target points using X,Y,Z coordinates. You can use XYZ point filters. You must specify these points 
in a nonperspective view. If perspective viewing is on, AutoCAD LT turns it off while you specify new camera and target 
locations and then redisplays the preview image in perspective view.

Enter target point <current>: Specify a point or press RETURN

To help you define a new line of sight, AutoCAD LT draws a rubber-band line from the current camera position to the 
crosshairs. Then AutoCAD LT prompts you for a new camera location.

Enter camera point <current>: Specify a point, enter direction and magnitude angles, or press RETURN

A rubber-band line connects the target point to the crosshairs to help you place the camera relative to the target. The 
illustration shows the change in view as the camera and target points are swapped. Lens and distance settings are the same
in each case.

Swapping camera and target points

For information on entering direction and magnitude angles, see Point Specification.



Pan (DVIEW)
Up a Level

Shifts the image without changing the level of magnification.

Displacement base point: Specify a point

Second point: Specify a point



Zoom (DVIEW)
Up a Level

If perspective viewing is off, Zoom dynamically increases or decreases the apparent size of objects in the current viewport.

Adjust zoom scale factor <current>: Specify a scale or press RETURN

A slider bar is displayed along the top of the graphics window and labeled from 0x to 16x, with 1x representing the current 
scale. Move the slider bar cursor to the right to increase the scale. Move the cursor to the left to decrease the scale.

If perspective viewing is on, Zoom adjusts the camera lens length, which changes the field of view and causes more or less 
of the drawing to be visible at a given camera and target distance. The default lens length is 50mm, simulating what you 
would see with a 35mm camera and a 50mm lens. Increasing the lens length is similar to switching to a telephoto lens. 
Decreasing the lens length widens the field of view, as with a wide-angle lens.

Adjust lenslength <current>: Specify a value or press RETURN

A slider bar is displayed along the top of the graphics window and labeled from 0x to 16x, with 1x representing the current 
lens length. Move the slider bar cursor to the right to increase the lens length. Move the cursor to the left to decrease the 
lens length.



Twist (DVIEW)
Up a Level

Twists or tilts the view around the line of sight. AutoCAD LT measures the twist angle counterclockwise, with 0 degrees to 
the right.

New view twist <current>: Specify a value or press RETURN



Clip (DVIEW)
Up a Level

Clips the view, obscuring portions of the drawing that are behind or in front of the front clipping plane. The front and back 
clipping planes are invisible walls that you can position perpendicular to the line of sight between the camera and target.

Back / Front / <Off>: Enter an option or press RETURN

Off
Disables front and back clipping. If perspective viewing is on, front clipping remains on at the camera position.

Back
Obscures objects located behind the back clipping plane.

ON / OFF / <Distance from target> <current>: Specify a distance, enter an option, or press RETURN

Front
Obscures objects located between the camera and the front clipping plane.

Eye / ON / OFF / <Distance from target> <current>: Specify a distance, enter an option, or press RETURN



Distance from Target

Positions the back clipping plane and turns on back clipping. A positive distance places the clipping plane between the target
and the camera. A negative distance places it beyond the target. Use the slider bar to drag the clipping plane.



On

Turns on back clipping at the current clipping distance.



Off

Turns off back clipping.



Distance from Target

Positions the front clipping plane and turns on front clipping. A positive distance places the clipping plane between the target 
and the camera. A negative distance places it beyond the target. Use the slider bar to drag the clipping plane.



Eye

Positions the front clipping plane at the camera.



On

Turns on front clipping. This option is available only when perspective viewing is off.



Off

Turns off front clipping. This option is available only when perspective viewing is off.



Hide (DVIEW)
Up a Level

Performs hidden line suppression on the selected objects to aid visualization. Circles, 2D solids, wide polyline segments, 
and extruded objects have opaque surfaces and can hide other objects. This hidden line suppression is quicker than that 
performed by HIDE, but it can't be plotted. 



Off (DVIEW)
Up a Level

Turns off perspective viewing. The Distance option turns on perspective viewing.



Undo (DVIEW)
Up a Level

Reverses the effects of the last DVIEW operation. You can undo multiple DVIEW operations.



For more information, see "Viewing in 3D" in chapter 11 of the AutoCAD LT User's Guide.

Commands: BLOCK creates a block definition from a group of objects. You can use it to create an alternate DVIEWBLOCK.
HIDE regenerates a 3D model with hidden lines removed. PAN moves the drawing display in the current viewport. ZOOM 
increases or decreases the apparent size of objects in the current viewport. DSVIEWER opens the Aerial View window.



DTEXT Command
Up a Level          Related Topics

Displays text on screen as it is entered
AutoCAD LT can create text with a variety of character patterns, or fonts. These fonts can be stretched, compressed, 
obliqued, mirrored, or aligned in a vertical column by applying a style to the font. Text can be rotated, justified, and made any
size.

With DTEXT, you can enter several lines of text and BACKSPACE to edit the text. The prompts are the same as those for 
the TEXT command, except that you can enter several lines without restarting the command. To end a line, press RETURN 
after entering characters at the Text prompt. To end DTEXT, press RETURN at the Text prompt. Each line of text is a 
separate object.

 

From the Draw toolbar choose 

From the Draw menu, choose Text, then Line Text
At the Command prompt, enter dtext

Justify / Style / <Start point>: Specify a point or enter an option 

If DTEXT was the last command entered, and you press RETURN at the Justify/Style/<Start point> prompt, AutoCAD LT 
skips the prompts for height and rotation angle and immediately displays the Text prompt. The text is placed directly beneath
the previous line of text. The point specified at the Start Point prompt is stored as the Insertion Point object snap.

See Also:
Special Unicode Characters
Control Codes and Special Characters



For more information, see "Creating Line Text" in chapter 12 of the AutoCAD LT User's Guide. 

Commands: DDEDIT edits text content. DDSTYLE or STYLE creates text styles. MTEXT creates a multiple-line paragraph 
object that fits within a specified area. SPELL checks the spelling of text. TEXT creates single-line text. 



Start Point (DTEXT)
Up a Level

Justifies text along its baseline from a specified start point.

Height <current>: Specify a point (1), enter a value, or press RETURN

The Height prompt is displayed only if the current text style doesn't have a fixed height.

Rotation angle <current>: Specify a point, enter a value, or press RETURN

Text: Enter characters or press RETURN



Justify (DTEXT)
Up a Level

Controls text justification.

Align / Fit/ Center / Middle / Right: Enter an option

You can also enter any of these Justify options at the Justify/Style/<Start point> prompt.



Align
Up a Level

Specifies both text height and text orientation by designating the endpoints of the baseline. 

First text line point: Specify a point (1)

Second text line point: Specify a point (2)

Text: Enter characters or press RETURN

The longer the text string, the shorter the characters. The size of the characters adjusts in proportion to their height.



Fit
Up a Level

Specifies that text will fit within an area and at an orientation defined with two points and a height.

First text line point: Specify a point (1)

Second text line point: Specify a point (2)

Height <current>: Specify a height or press RETURN

Text: Enter characters or press RETURN

The height is the distance in drawing units that the uppercase letters extend from the baseline. Designated text height is the 
distance between the start point and a point you specify. The longer the text string, the narrower the characters. The height 
of the characters remains constant. 

The Fit option is available only for horizontally oriented text.



Center
Up a Level

Aligns text from the horizontal center of the baseline, which you specify with a point.

Center point: Specify a point (1)

Height <current>: Specify a height or press RETURN

Rotation angle <current>: Specify an angle or press RETURN

Text: Enter characters or press RETURN

The rotation angle specifies the orientation of the text baseline with respect to the center point. You can designate the angle 
by specifying a point. The text baseline runs from the start point toward the specified point. If you specify a point to the left of
the center point, AutoCAD LT draws the text upside down.



Middle
Up a Level

Aligns text at the horizontal center of the baseline and the vertical center of the height you specify with a point. Middle-
aligned text does not rest on the baseline.

Middle point: Specify a point (1)

Height <current>: Specify a height or press RETURN

Rotation angle <current>: Specify an angle or press RETURN

Text: Enter characters or press RETURN

Right
Up a Level

Right-justifies the text at the baseline of a specified point.

End point: Specify a point (1)

Height <current>: Specify a height or press RETURN

Rotation angle <current>: Specify an angle or press RETURN

Text: Enter characters or press RETURN

Style (DTEXT)
Up a Level

Sets the text style, which determines the appearance of the text characters. Text you enter uses the current text style.

Style name (or ?) <current>: Enter an existing text style name, enter ?, or press RETURN

To view a list of the current text styles, associated font files, height, and other parameters, enter ?.



DXFIN Command
Up a Level          Related Topics

Imports a drawing interchange file
 At the Command prompt, enter dxfin

The Select DXF File dialog box is displayed.

Full DXFIN
To load a complete DXF file, use DXFIN in an empty drawing. To create an empty drawing, use the NEW command with the 
Start from Scratch option in the Create New Drawing dialog box.

If AutoCAD LT detects any errors during input, the new drawing is discarded.

Partial DXFIN
If the current drawing isn't empty, DXFIN loads only the ENTITIES section of the DXF file, adding the objects to the current 
drawing.

If AutoCAD LT detects errors during partial DXF input, the drawing returns to the state it was in before the DXFIN command.

Auditing DXF Files
To guard against importing corrupt data, you can have AutoCAD LT perform an audit after importing DXF files into your 
drawing.

The audit only displays the errors AutoCAD LT finds; it doesn't correct them. To correct problems, use the AUDIT command 
or edit the DXF file manually.



Select DXF File Dialog Box
Up a Level

File Name
Select or enter the name of the drawing interchange file (DXF) you want to import. 

List Files of Type
Select the type of files you want displayed in the File Name list box.

Directories
Select the directory that contains the DXF file you want to import.

Drives
Select the drive that contains the DXF file you want to import.

Find File
To find DXF files on multiple drives and directories, choose Find File. The Browse/Search dialog box is displayed.

Network
To connect network drives to your computer, choose Network. The Map Network Drive dialog box is displayed. 



For more information, see "Using Other File Formats" in chapter 17 of the AutoCAD LT User's Guide. 

Commands: AUDIT examines the integrity of a drawing. DXFOUT creates a drawing interchange file. IMPORT imports 
various file formats into AutoCAD LT.



DXFOUT Command
Up a Level          Related Topics

Creates a drawing interchange file of the current drawing
 At the Command prompt, enter dxfout

The Create DXF File dialog box is displayed. In the Create DXF File dialog box, enter a file name and choose OK.

AutoCAD LT prompts for the precision of floating-point numbers. 

Enter decimal places of accuracy (0 to 16) / Objects / Binary <6>: Enter an option, enter a value, or press RETURN



Create DXF File Dialog Box
Up a Level

File Name
Select or enter the name you want to assign to the DXF file. 

List Files of Type
Select the type of files you want displayed in the File Name list box.

Directories
Select the directory that you want to contain the DXF file.

Drives
Select the drive that you want to contain the exported DXF file.

Network
To connect network drives to your computer, choose Network. The Map Network Drive dialog box is displayed. 



Enter Decimal Places of Accuracy (DXFOUT)
Up a Level

Saves the file using the specified number of bits of precision. Enter a value from 0 to 16 to save the file that level of 
precision.



Objects (DXFOUT)
Up a Level

Selects the objects to export.

Select objects: Select one or more objects

The output file includes only selected objects and the block reference portions of any included blocks. The block symbol 
tables aren't included.

Enter decimal places of accuracy (0 to 16) / Binary <6>: Enter b, enter a value, or press RETURN



Binary (DXFOUT)
Up a Level

Saves the file in binary format.

Binary format files contain all of the information of an ASCII DXF file but in a more compact form. Binary format files can also
be read and written faster.



For more information, see "Using Other File Formats" in chapter 17 of the AutoCAD LT User's Guide.

The DXFIX utility converts DXF files to earlier release formats.

Commands: DXFIN converts a drawing interchange file to an AutoCAD LT drawing. EXPORT saves objects to other file 
formats.



To display the toolbar described in this 
command, choose Toolbar from the View 
menu. Select the toolbar from the Toolbars 
dialog box and choose OK.



'ELEV Command
Up a Level          Related Topics

Sets elevation and extrusion thickness of new objects
Sets the default Z value for all point prompts. The current elevation is maintained separately in model space and paper 
space.

At the Command prompt, enter elev

New current elevation <current>: Specify a distance or press RETURN

New current thickness <current>: Specify a distance or press RETURN

Thickness is the distance that a 2D object is extruded above or below its elevation. A positive value extrudes along the 
positive Z axis; a negative value extrudes along the negative Z axis.

      



Commands: DDUCS and UCS control construction plane orientation, elevation, and extrusion direction.

System Variables: ELEVATION sets the current elevation. THICKNESS sets the current extrusion thickness.



ELLIPSE Command
Up a Level          Related Topics

Creates an ellipse or an elliptical arc
   

From the Draw toolbar, choose 
   From the Draw menu, choose Ellipse, then one of the 

options
 At the Command prompt, enter ellipse

Arc / Center / Isocircle / <Axis endpoint 1>: Specify a point (1) or enter an option

Note: The Isocircle option is not available, if the Isometric option of SNAP is Off.

Axis Endpoint 1
Defines the first axis by its two endpoints. The angle of the first axis determines the angle of the ellipse. The first axis can by 
either the major or the minor axis of the ellipse.

Axis endpoint 2: Specify a point (2)

<Other axis distance> / Rotation: Specify a distance by entering a value or locating a point (3), or enter r

Arc
Creates an elliptical arc. The angle of the first axis determines the angle of the elliptical arc. The first axis can be either the 
major or the minor axis of the elliptical arc.

<Axis endpoint 1> / Center/ Isocircle: Specify a point or enter c or i

Center
Creates an ellipse by starting at a specified center point.

Center of ellipse: Specify a point (1)

Axis endpoint: Specify a point (2)

<Other axis distance / Rotation: Specify a distance by entering a value or locating a point (3), or enter r

Isocircle
Creates an isometric circle in the current isometric drawing plane.

Center of circle: Specify a point

<Circle radius> / Diameter: Specify a distance or enter d



For more information, see "Drawing Ellipses" in chapter 6, of the AutoCAD LT User's Guide. The next release of AutoCAD 
LT will not support a polyline representation of an ellipse.

System Variables: PELLIPSE creates a polyline ellipse if set to 1 or a true ellipse if set to 0.



Other Axis Distance (ELLIPSE, Axis Endpoint 1)
Up a Level

Defines the second axis using the distance from the midpoint of the first axis to the endpoint of the second axis (3).

      



Rotation (ELLIPSE, Axis Endpoint 1)
Up a Level

Creates the ellipse with the appearance of rotating a circle about the first axis.

Rotation around major axis: Specify a point (1) or enter an angle value (0-89.4)

Move the crosshairs around the center of the ellipse and pick a point. If you enter a value, the higher the value, the greater 
the eccentricity of the ellipse. Entering 0 defines a circular ellipse. 

        



Axis Endpoint 1 (ELLIPSE, Arc)
Up a Level

Defines the endpoint of the first axis.

Axis endpoint 2: Specify a point (2)

<Other axis distance> / Rotation: Specify a point (3) or enter r

Other Axis Distance
Defines the second axis using the distance from the midpoint of the first axis to the endpoint of the second axis.

Parameter / <start angle>: Specify a point (1) or enter p

Specifying a point determines the start angle of the elliptical arc.

Parameter / Included / <end angle>: Specify a point (2) or enter an option

Specifying a point for the end angle creates the elliptical arc.

The Included option defines an included angle beginning at the start angle.

Included angle <current>: Specify an angle or press RETURN

Rotation
Creates the ellipse with the appearance of rotating a circle about the first axis.

Rotation around major axis: Specify a point or enter an angle value

Parameter / <start angle>: Specify a point or enter p

Move the crosshairs around the center of the ellipse and pick a point. If you enter a value, the higher the value, the greater 
the eccentricity of the ellipse. Entering 0 defines a circle.

Specifying a point determines the start angle of the elliptical arc.

Parameter / Included / <end angle>: Specify a point or enter an option

Specifying a point for the end angle creates the elliptical arc.

The Included option defines an included angle beginning at the start angle.

Included angle <current>: Specify an angle or press RETURN



Parameter

Parameter requires the same input as Start Angle, but AutoCAD LT creates the elliptical arc using the following parametric 
vector equation:

p(u) = c + a* cos(u) + b* sin(u)

where c is the center of the ellipse and a and b are its major and minor axes, respectively.



Isocircle (ELLIPSE, Arc)
Up a Level

Creates an isometric circle in the current isometric drawing plane.

Center of circle: Specify a point

<Circle radius> / Diameter: Specify a point or enter d



Center (ELLIPSE, Arc)
Up a Level

Creates the elliptical arc by a specified center point.

Center of ellipse: Specify a point 

Axis endpoint: Specify a point

<Other axis distance> / Rotation: Specify a point or enter r

Other Axis Distance
Defines the second axis using the distance from the midpoint of the first axis to the endpoint of the second axis.

Parameter / <start angle>: Specify a point or enter p

Specifying a point determines the start angle of the elliptical arc.

Parameter / Included / <end angle>: Specify a point or enter an option

Specifying a point for the end angle creates the elliptical arc.

The Included option defines an included angle beginning at the start angle

Included angle <current>: Specify an angle

Rotation
Creates the ellipse with the appearance of rotating a circle about the first axis.

Rotation around major axis: Specify a point or enter an angle value

Parameter / <start angle>: Specify a point or enter p

Move the crosshairs around the center of the ellipse and pick a point. If you enter a value, the higher the value, the greater 
the eccentricity of the ellipse. Entering 0 defines a circle.

Specifying a point determines the start angle of the elliptical arc.

Parameter / Included / <end angle>: Specify a point or enter an option

Specifying a point for the end angle creates the elliptical arc.

The Included option defines an included angle beginning at the start angle.

Included angle <current>: Specify an angle or press RETURN



Other Axis Distance

Defines the second axis using the distance from the midpoint of the first axis to the endpoint of the second axis (3).

      



Rotation

Creates the ellipse by rotating a circle about the first axis.

Rotation around major axis: Specify a point or enter an angle value

Parameter / <start angle>: Specify a point or enter p

Move the crosshairs perpendicular to the first axis to rotate the circle. If you enter a value, the higher the value, the greater 
the ratio of minor to major axis. Entering 0 defines a circle.

Specifying a point determines the start angle of the elliptical arc.

Parameter/ Included / <end angle>: Specify a point or enter an option

Specifying a point for the end angle creates the elliptical arc.

The Included option defines an included angle beginning at the start angle.

Included angle <current>: Specify an angle or press RETURN



Circle Radius

Creates a circle using the specified radius.



Diameter

Creates a circle using the specified diameter.

Circle diameter: Specify a distance 



END Command
Up a Level          Related Topics

Saves the drawing and exits AutoCAD LT
At the Command prompt, enter end

AutoCAD LT renames the previously saved copy of the drawing by changing its extension from .dwg to .bak (overwriting any
previous backup file) and then saves your drawing with the .dwg extension.

If you have not named the current drawing, AutoCAD LT displays a dialog box where you name the drawing before exiting.

If the drawing is set to read-only mode, the END command fails. You can use SAVEAS to save the drawing to a different file 
name before quitting.



For more information, see "Exiting AutoCAD LT" in chapter 2 of the AutoCAD LT User's Guide. 

Commands: QUIT exits AutoCAD LT and saves any modifications to the current drawing. QSAVE saves the current drawing
to a file name. SAVE saves the current drawing to a file name. SAVEAS renames the current drawing. 



ERASE Command
Up a Level          Related Topics

Removes objects from a drawing
 

From the Modify toolbar, choose 
 From the Edit menu, choose Clear

At the Command prompt, enter erase

Select objects: Use an object selection method

AutoCAD LT removes the objects from the drawing.

      



For more information, see "Erasing Objects" in chapter 9 of the AutoCAD LT User's Guide. 

Commands: OOPS restores previously erased objects. U reverses the effect of the previous command. UNDO reverses the
effect of multiple commands and provides control over the undo feature. REDO reverses the immediately previous UNDO or 
U command.



EXPLODE Command
Up a Level          Related Topics

Breaks a compound object into its component objects
A compound object comprises more than one AutoCAD LT object. For example, a block is a compound object. You can 
explode blocks, dimensions, and polylines.

 
From the Modify toolbar, choose 

From the Modify menu, choose Explode 
 At the Command prompt, enter explode

Select objects: Use an object selection method

The color and linetype of any exploded object might change. Other results depend on the type of compound object you're 
exploding: 

2D polyline
3D polyline
Arc
Block
Circle

Unless an exploded block reference was inserted in paper space, in floating viewports block definitions cannot be turned on 
after being exploded. 



For more information, see "Exploding Blocks" in chapter 14 of the AutoCAD LT User's Guide. 

Commands: BLOCK creates a block from a group of objects. LIST displays the properties of objects.



Block

AutoCAD LT removes one grouping level at a time. If a block contains a polyline or a nested block, exploding the block 
exposes the polyline or nested block object, which must then be exploded to expose its individual objects.

Blocks with equal X, Y, and Z scales explode into their component objects. Blocks with unequal X, Y, and Z scales 
(nonuniformly scaled blocks) might explode into unexpected objects. 

Exploding a block that contains attributes deletes the attribute values and redisplays the attribute definitions.

Blocks inserted with external references and their dependent blocks cannot be exploded. 



2D Polyline

AutoCAD LT discards any associated width or tangent information and places the resulting lines and arcs along the center of
the polyline.

      



Circle

If within a nonuniformly scaled block, a circle explodes into ellipses.



Arc

If within a nonuniformly scaled block, an arc explodes into elliptical arcs.



3D Polyline

A 3D polyline explodes into lines. Although the linetype of a 3D polyline has no effect on the polyline, it does affect the 
resulting line objects.



EXPORT Command
Up a Level          Related Topics

Saves objects to other file formats
   From the File menu, choose Export
 At the Command prompt, enter export

The Export Data dialog box is displayed. In the Save Files As Type list, select the format type to export objects to. In the File 
Name box, enter the name of the file to create.

AutoCAD LT exports the objects to the specified file format using the specified file name.

Note: The DXX file format available from this command creates an abbreviated DXF file format identical to that generated by
DDATTEXT. For more information on exporting attribute data from a drawing, see “Creating an Attribute Extraction Template 
File” in chapter 14 of the AutoCAD LT User’s Guide.



Export Data Dialog Box
Up a Level

File Name
Select or enter the name you want to assign to the exported file. 

Save Files as Type
Select the type of file to which you want to export the objects.

Directories
Select the directory you want to contain the exported file.

Drives
Select the drive you want to contain the exported file.

Network
To connect network drives to your computer, select Network. The Map Network Drive dialog box is displayed. 



Commands: IMPORT imports various file formats into AutoCAD LT.



EXTEND Command
Up a Level          Related Topics

Extends an object to meet another object
Objects that can be extended include arcs, elliptical arcs, lines, open 2D and 3D polylines, and rays.

   

From the Modify toolbar, choose 
   From the Modify menu, choose Extend 
 At the Command prompt, enter extend

Select boundary edges: (Projmode = UCS, Edgemode = No extend)

Select objects: Use an object selection method or press RETURN

Select the objects that define the boundary edges to which you want to extend the object or press RETURN to select all 
objects as potential boundaries. Valid boundary objects include 2D and 3D polylines, arcs, circles, ellipses, floating 
viewports, lines, rays, regions, splines, text, and xlines. 

If you select a 2D polyline as a boundary object, AutoCAD LT ignores its width and extends objects to the center line of the 
polyline.
Extending a spline-fit polyline adds a new vertex to the control frame for the polyline. 

If you extend a tapered polyline segment, AutoCAD LT corrects the width of the extended end to continue its original taper to
the new endpoint. If this causes the segment to have a negative ending width, the ending width becomes zero.

      

            

<Select object to extend> / Project / Edge / Undo: Select an object, enter an option, or press RETURN



For more information, see "Extending Objects" in chapter 10 of the AutoCAD LT User's Guide. 

Commands: LENGTHEN lengthens an object. TRIM trims objects at a specified cutting edge. 

System Variables: EDGEMODE determines whether an object is extended to another object's implied edge or only to an 
object that intersects it in 3D space. PROJMODE specifies the Projection method AutoCAD LT uses when extending objects.



Select Object to Extend (EXTEND)
Up a Level

Specifies the object to extend. AutoCAD LT repeats the prompt so that you can extend multiple objects. Pressing RETURN 
ends the command.



Project (EXTEND)
Up a Level

Specifies the projection method AutoCAD LT uses when extending objects.

None / Ucs / View <current>: Enter an option or press RETURN

None

Specifies no projection. AutoCAD LT extends only objects that would intersect the boundary edge in 3D space.

UCS

Specifies projection onto the XY plane of the current UCS. AutoCAD LT extends objects that do not intersect with the 
boundary objects in 3D space.

View

Specifies projection along the current view direction.



Edge (EXTEND)
Up a Level

Determines whether the object is extended to the implied edge of a boundary object or only to an object that would actually 
intersect it in 3D space.

Selected boundary Object to extend

Extend/ No extend<current>: Enter an option or press RETURN

Extend

Extends the boundary object along its natural path to intersect another object or its implied edge in 3D space.

Result: Extend

No extend

Specifies that the object is to extend only to a boundary object that actually intersects it in 3D space.

Result: No extend



Undo (EXTEND)
Up a Level

Reverses the most recent changes made by the EXTEND command. 



'FILL Command
Up a Level          Related Topics

Controls the filling of 2D solids, and wide polylines
Some displays and plotters take a long time to fill the interior of objects; turn off Fill mode to improve performance. 

From the Options menu, choose Display, then Solid 
Fill
At the Command prompt, enter fill

ON / OFF <current>: Enter on or off

          

ON
Turns on Fill mode. For the filling of an object to be visible, its extrusion direction must be parallel to the current viewing 
direction, and hidden lines must not be suppressed.

OFF
Turns off Fill mode. Only the outlines of objects are displayed and plotted. Changing Fill mode affects existing objects after 
the drawing is regenerated.



For more information, see "Fill Mode and Text Display" in chapter 8 of the AutoCAD LT User's Guide. 

Commands: DDRMODES sets Fill mode and other drawing aids.

System Variables: FILLMODE stores the FILL command setting.



FILLET Command
Up a Level          Related Topics

Rounds and fillets the edges of objects
The FILLET command rounds the edges of two arcs, circles, elliptical arcs, lines, polylines, rays, splines, or xlines with an 
arc of a specified radius. FILLET also rounds the edges of solids.

If the TRIMMODE system variable is set to 1, FILLET trims the intersecting lines to the endpoints of the fillet arc. If the 
selected lines do not intersect, AutoCAD LT extends them so that they do. 

      

If both objects are on the same layer, AutoCAD LT creates the fillet on that layer. Otherwise, AutoCAD LT creates the fillet 
line on the current layer. The same applies to fillet color and linetype.

You cannot fillet line segments that intersect outside the drawing limits when limits checking is on.    

   

From the Modify toolbar, choose 
 From the Modify menu, choose Fillet
 At the Command prompt, enter fillet

Polyline / Radius / Trim / <Select first object>: Use an object selection method or enter an option



Select First Object (FILLET)
Up a Level

Selects the first of two objects required to define a 2D fillet.

Select second object: Use an object selection method

    

If you select lines or arcs, AutoCAD LT extends then until they intersect, or trims them at the intersection. 

If the selected objects are straight line segments of a 2D polyline, they must be adjacent or separated by only one other 
segment. If they are separated, FILLET deletes the segment that separates them and replaces it with an arc. 

More than one fillet can exist between arcs and circles. AutoCAD LT chooses the fillet with endpoints closest to the object 
selection points.

Circles are not trimmed; the fillet arc meets the circle smoothly.

You can fillet two lines with different extrusion directions only if the Z values of the endpoints of both lines are equal in the 
current UCS.



Polyline (FILLET)
Up a Level

Inserts fillet arcs at each vertex of a 2D polyline where two line segments meet. 

Select 2D polyline: Use an object selection method

If one arc segment separates two line segments that converge as they approach the arc segment, the arc segment is 
removed and replaced by a fillet arc.

      

Note: You cannot fillet polyline segments from different polylines.



Radius (FILLET)
Up a Level

Defines the radius of the fillet arc.

Enter fillet radius <current>: Specify a distance or press RETURN

The value you enter becomes the current radius for subsequent FILLET commands. Changing this value does not affect 
existing fillet arcs.



Trim (FILLET)
Up a Level

Controls whether AutoCAD LT trims the selected edges to the fillet arc endpoints.

Trim / No Trim <current>: Enter an option or press RETURN

Trim
Trims the selected edges to the fillet arc endpoints.

No Trim
Does not trim the selected edges.



For more information, see "Filleting Objects" in chapter 10 of the AutoCAD LT User's Guide.

Commands: CHAMFER bevels the edges of objects.

System Variables: FILLETRAD stores the current fillet radius. TRIMMODE controls whether selected lines are trimmed to 
the fillet arc endpoints.



From
Related Topics

Locates a point offset from a reference point within a command

From the cursor menu, choose From
 At a prompt to locate a point, enter from

At an AutoCAD LT prompt for locating a point, you can enter FROM and then a temporary reference or base point from 
which you can specify an offset to locate the next point. You can enter the offset location from this base point as a relative 
coordinate, or you can use direct distance entry.

Note: You cannot use this method during dragging in commands such as MOVE and COPY. Specifying an absolute 
coordinate, either by keyboard entry or with a pointing device, essentially cancels the FROM method.



For more information, see chapter 7 of the AutoCAD LT User’s Guide.

Commands: TRACKING locates a point from a series of temporary points. Direct distance entry locates a point using a 
value and the direction you move your cursor. Point filters combine X, Y, and Z values from different points to specify a 
single point. Relative coordinate entry locates a point relative to the last point entered (see How to Enter Coordinate 
Loactions).



'GRAPHSCR Command
Up a Level          Related Topics

Switches from the text screen to the graphics screen
At the Command prompt, enter graphscr

This command is ignored on dual-screen systems.



Commands: TEXTSCR changes from the graphics to the text display.



'GRID Command
Up a Level          Related Topics

Displays a dot grid
The grid is used only for visual reference. It is not plotted, nor is it considered to be part of the drawing.

 On the status bar, double-click Grid
At the Command prompt, enter grid

Grid spacing(X) or ON / OFF / Snap / Aspect <current>: Specify a value or enter an option

      

      



Grid spacing(X)

Sets the spacing of the dots. If you specify a value of 0, the grid spacing is set to the snap interval. Entering x after a value 
sets the spacing to a multiple of the snap interval.



On

Turns on the grid at the current spacing.



Off

Turns off the grid.



Snap

Sets the grid spacing to the current snap interval as set by the SNAP command.



Aspect

Sets the grid to different spacing in the X and Y directions.

Horizontal spacing(X) <current>: Enter a value or press RETURN

Vertical spacing(X) <current>: Enter a value or press RETURN

Entering x following either value sets spacing to a multiple of the snap interval.

The Aspect option is not available when Isometric object snap is turned on.



For more information on using grids, see "Setting the Grid" in chapter 4 of the AutoCAD LT User's Guide. 

Commands: SNAP specifies a minimum interval for point entry.

System Variables: GRIDMODE turns the grid on or off in the current viewport. GRIDUNIT sets the grid spacing in the 
current viewport. DDRMODES sets drawing aids.



HATCH Command
Up a Level          Related Topics

Fills an area with a nonassociative hatch pattern
A nonassociative hatch is not updated when its boundaries are modified. A hatch boundary consists of an object or objects 
that completely enclose an area. If the boundary is made up of multiple objects, their endpoints must coincide for the hatch 
to be created properly. You can also define a polyline hatch boundary with the direct hatch option. 

Unless you specify otherwise, HATCH combines the lines that make up the hatch into a block. 

 At the Command prompt, enter hatch

Pattern (? or name / U,style) <current>: Enter the name of a predefined pattern, enter u, or press RETURN



For more information, see chapter 6, "Drawing Geometry," and chapter 8, "Controlling the Drawing Display," in the AutoCAD 
LT User's Guide. For standard hatch patterns, see appendix D, "Standard Libraries." For information about the aclt.pat file 
and creating your own hatch patterns, see chapter 20 of the AutoCAD LT User’s Guide.

Commands: BHATCH fills an enclosed area with an associative hatch pattern. PLINE creates two-dimensional polylines. 

System Variables: HPANG sets the hatching angle. HPDOUBLE specifies whether a user-defined hatch is double-hatched. 
HPNAME sets the hatch pattern name. HPSCALE sets the hatch pattern scale. HPSPACE sets the spacing of a user-
defined hatch pattern. SNAPBASE specifies the starting point of the hatch pattern. 



Pattern Name–Predefined (HATCH)
Up a Level

Specifies a pattern defined in the aclt.pat and acltiso.pat files. Enter the name followed by an optional hatch style code. 
Precede the name with an asterisk (*) to fill the area with individual lines instead of a hatch block. 

Scale for pattern <current>: Specify a value or press RETURN 

      

If the drawing is in model space and you enter a scale factor followed by xp, AutoCAD LT calculates a scale factor relative to
paper space. 

Angle for pattern <current>: Specify an angle or press RETURN 

Select hatch boundaries or RETURN for direct hatch option, 

Select objects: Select objects or press RETURN to define a polyline boundary 

      

Select Objects
Select objects that define the boundary of the hatching area and objects internal to the hatching boundary. Selecting part of 
a block for hatching selects the entire block.

      

Direct Hatch
Specify points that define the boundary of the hatching area.

Retain polyline? <current>: Enter y to retain the hatching boundary after the area is hatched or n to discard it 

From point: Specify a start point for the polyline boundary 

Arc / Close / Halfwidth / Length / Undo / Width / <Endpoint of line>: Specify a point, enter an option, or press RETURN 

      

      



These options are also found in the PLINE command. When you've completed the polyline boundary, HATCH prompts to 
create additional polyline boundaries.

From point or RETURN to specify hatch: Specify a point or press RETURN 

If you specify a point, AutoCAD LT prompts for additional points. Pressing RETURN ends the command and creates the 
hatch. 



U–User-Defined Pattern Name (HATCH)
Up a Level

Specifies a pattern of lines using the current linetype. Enter u, followed by an optional hatch style code. Precede the u with 
an asterisk (*) to fill the area with individual lines instead of a hatch block.

Angle for crosshatch lines <current>: Specify an angle or press RETURN 

Spacing between lines <current>: Specify the distance between the lines or press RETURN 

Double hatch area? <current>: Enter y to specify a second set of lines to be drawn at 90 degrees to the original lines or 
press RETURN 

Select hatch boundaries or RETURN for direct hatch option, 

Select objects: Select objects or press RETURN to define a polyline boundary 

Select Objects
Select objects that define the boundary of the hatching area and objects internal to the hatching boundary. Selecting part of 
a block for hatching selects the entire block.

      

Direct Hatch 
Specify points that define the boundary of the hatching area.

Retain polyline? <current>: Enter y to retain the hatching boundary after the area is hatched or n to discard it 

From point: Specify a start point for the polyline boundary 

Arc / Close / Length / Undo / <Next point>: Specify a point, enter an option, or press RETURN 

      

      

These options are also found in the PLINE command. When you've completed the polyline boundary, HATCH prompts to 
define additional polyline boundaries.

From point or RETURN to apply hatch: Specify a point or press RETURN 

If you specify a point, AutoCAD LT prompts for additional points. Pressing RETURN ends the command and creates the 
hatch. 



List Pattern Names (HATCH)
Up a Level

Lists and provides a brief description of the hatch patterns defined in the aclt.pat and acltiso.pat files. 

Pattern(s) to list <*>: Enter a name list or press RETURN 



Hatch Style Codes (HATCH)
Up a Level

Hatching styles control the method that AutoCAD LT uses to hatch internal boundary objects. Specify a hatch style by 
following the pattern name with a comma and the hatch style code. You can list the hatch style codes by the pattern name, a
comma and ? (question mark). 

To hatch only the outermost area of a structure with several internal boundaries using the MUDST pattern, enter mudst,o at 
the Pattern prompt. To opt for a user-defined pattern and use the Ignore style, enter u,i. AutoCAD LT stores the style by 
adding the comma and code to the pattern name in the HPNAME system variable. 

n (Normal) Hatches inward from the outermost area boundary. If 
and when it encounters an internal boundary, turns off 
hatching until it encounters another boundary. Thus, 
areas separated from the outside of the hatched area 
by an odd number of boundaries are hatched, while 
areas separated by an even number of boundaries are
not.

o (Outer) Fills outermost areas only. This style also hatches 
inward from the area boundary, but it turns off 
hatching if it encounters an internal boundary and 
does not turn it back on again. Because this process 
starts from both ends of each hatch line, only the 
outermost area of the structure is hatched, and the 
internal structure is left blank.

i (Ignore) Ignores internal structure. This style hatches through 
all internal objects.

? (List Styles) Lists hatch styles. 

Note: Hatching concave curves using the Outer and Ignore style options can cause discrepancies.    



HATCHEDIT Command
Up a Level          Related Topics

Modifies an existing associative hatch block
   

From the Modify toolbar, choose 
   From the Modify menu, choose Objects, then Edit Hatch
 At the Command prompt, enter hatchedit

Select associative hatch: Use an object selection method

The Hatchedit dialog box is displayed.

If you enter -hatchedit at the Command prompt, HATCHEDIT displays presents options: 

Disassociate / <Properties>: Enter an option or press RETURN



Hatchedit Dialog Box
Up a Level

Pattern Type
Displays a list of pattern types.

Predefined
User-defined
Custom

Pattern Properties
Sets properties specific to the chosen pattern type. For an explanation of the pattern properties, see the Boundary Hatch 
dialog box.

Advanced
Displays the Advanced Options dialog box. You can change the hatch style code (Normal, Outer, or Ignore) under Style. 

Inherit Properties
Applies the properties of an existing associative hatch to the current Pattern Type and Pattern Properties options. The 
Hatchedit dialog box closes, and AutoCAD LT prompts you to select an object. 

Select hatch object: Use an object selection method

After you select an object, the Hatchedit dialog box is displayed with the hatch pattern properties updated to match the 
settings you selected.

Associative
Controls associative hatching. If you select this option, the new hatch is associative, updated automatically when its 
boundaries are modified.

Apply
Applies the modifications to the hatch.

Exploded
Explodes hatching into individual line segments.



Predefined

Lists patterns from those defined in the aclt.pat or acltiso.pat files.



User-Defined

Defines a pattern of lines using the current linetype.



Custom

Lists custom patterns in .pat files other than the aclt.pat or acltiso.pat files.



For more information, see "Editing Hatch Patterns" in chapter 10 of the AutoCAD LT User's Guide.

Commands: BHATCH fills an enclosed area with an associative hatch pattern. HATCH fills an area with a nonassociative 
hatch pattern.

System Variables: HPANG sets the hatching angle. HPDOUBLE specifies whether a user-defined hatch is double-hatched. 
HPNAME sets the hatch pattern name. HPSCALE sets the hatch pattern scale. HPSPACE sets the spacing of a user-
defined hatch pattern. SNAPBASE specifies the starting point of the hatch pattern.



Properties

Specifies new hatch properties for the selected hatch. For an explanation of setting pattern properties on the command line, 
see BHATCH.



Disassociate

Removes the associative quality from an associative hatch.



'HELP Command
Up a Level

Displays on-line help
 

From the Standard Toolbar, choose 

From the Help Menu, choose AutoCAD LT Help
At the Command prompt, enter help or ? or press F1

To display help for a pull-down menu, select the menu name to open the menu, and then press F1.

Pressing F1 or entering 'help while a command is active displays help for that command. Choosing the Help button in a 
dialog box displays help for that dialog box.



HIDE Command
Up a Level          Related Topics

Regenerates a 3D model with hidden lines suppressed
When you use the VPOINT, DVIEW, or VIEW command to create a 3D view of your drawing, AutoCAD LT produces a wire-
frame display in the current viewport. All lines are present, including those hidden by other objects. The HIDE command 
eliminates the hidden lines from the screen. 

 From the View menu, choose Hide
 At the Command prompt, enter hide

The HIDE command treats circles, 2D solids, wide polyline segments, and the extruded edges of objects with nonzero 
thickness as opaque surfaces that hide objects. If extruded, circles, 2D solids, and wide polyline segments are treated as 
solid objects with top and bottom faces. HIDE does not affect objects on layers that have been frozen or turned off.

      



Commands: DVIEW defines parallel projection or perspective views on the screen as you change views. VIEW saves and 
restores named views. VPOINT sets the viewing direction for a 3D visualization of the current drawing.



'ID Command
Up a Level          Related Topics

Displays the coordinates of a location
   

From the Object Properties toolbar, choose 
 

At the Command prompt, enter id

Point: Specify a point

AutoCAD LT displays the UCS coordinates of the location on the command line.

ID lists the X, Y, and Z values of the specified point and stores the coordinate of the specified point as the last point. You can
reference the last point by entering @ at the next prompt that requests a point. 

The ID command is a good way to determine the coordinate values of a feature.



For more information, see "Displaying Coordinates and Locating Points," in chapter 7 of the AutoCAD LT User's Guide. 

System Variables: LASTPOINT stores coordinate information about the last point specified.



IMPORT Command
Up a Level          Related Topics

Imports various file formats into AutoCAD LT
   From the File menu, choose Import
 At the Command prompt, enter import

The Import File dialog box is displayed. Select the format type you want to import and the name of the file.

AutoCAD LT imports the file into the AutoCAD LT drawing.



Import File Dialog Box
Up a Level

File Name
Select or enter the name of the file you want to import. 

List Files of Type
Select the type of file you want to import.

Directories
Select the directory that contains the file you want to import.

Drives
Select the drive that contains the file you want to import.

Preview
Preview the selected drawing.

Find File...
To use search criteria to find the files you want to import on multiple drives and directories, choose Find File. The 
Browse/Search dialog box is displayed.

Network
To connect network drives to your computer, choose Network. The Map Network Drive dialog box is displayed. 



Commands: EXPORT saves objects to other file formats.



INSERT Command
Up a Level          Related Topics

Places a named block or drawing into the current drawing
At the Command prompt, enter insert

Block name (or ?) <current>: Enter a name, enter, ?, or ~, or press RETURN

Entering ? lists the currently defined block definitions in the drawing. Entering a tilde (~) displays the Select Drawing File 
dialog box. Preceding the name of the block with an asterisk (*) separates the block's objects during insertion. Use the 
EXPLODE command to separate the objects in a block after it has been inserted.

If you enter a block name without a path name or drive letter, AutoCAD LT searches for a currently defined block by that 
name. If no such block definition exists in the current drawing, AutoCAD LT searches the library path for a file of the same 
name. If AutoCAD LT finds such a file, the file name is used for the block name when AutoCAD LT inserts the block. 
AutoCAD LT uses the same block definition for subsequent insertions of that block. 

If you load a file as a block, you can give the block a new name:

Block name (or ?) <current>: block name=file name

The name of the last block inserted during the editing session appears as the current block.

Insertion point: Specify a point or enter an INSERT option

The INSERT options preset the scale and rotation of a block before you specify its position. This is useful when you are 
dragging a block, when you normally use a scale factor of 1 and a rotation of 0.

Scale PScale
Xscale PXscale
Yscale PYscale
Zscale PZscale
Rotate PRotate

After you specify a point or enter an option at the Insertion point prompt, AutoCAD LT prompts as follows: 

X scale factor <1> / Corner/ XYZ: Enter a value or an option, or press RETURN to confirm an X scale factor of 1

Draws a copy of the block with its base point at the specified insertion point and AutoCAD LT rotates the block by the 
rotation angle, using the insertion point as the center of rotation.



Scale

Sets the scale factor for the X, Y, and Z axes. The scale for the Z axis is the absolute value of the specified scale factor.



Xscale

Sets the X scale factor.



Yscale

Sets the Y scale factor.



Zscale

Sets the Z scale factor.



Rotate

Sets the rotation angle.



PScale

Sets the scale factor for the X, Y, and Z axes of a block that is to be dragged into position.



PXscale

Sets the scale factor for the X axis of a block that is to be dragged into position.



PYscale

Sets the scale factor for the Y axis of a block that is to be dragged into position.



PZscale

Sets the scale factor for the Z axis of a block that is to be dragged into position.



PRotate

Sets the rotation angle of the block as it is dragged into position.



X scale factor (INSERT)
Up a Level

Multiplies the X dimensions of the block by the scale factor supplied.

Y scale factor (default=X): Specify a scale or press RETURN

Rotation angle <0>: Specify an angle or press RETURN



Corner (INSERT)
Up a Level

Defines the X and Y scales at the same time, using the insertion point and another point as the corners of a box. The X and 
Y dimensions of the box become the X and Y scale factors. 

The insertion point is the first corner.

Other corner: Specify a point

Rotation angle <0>: Specify an angle or press RETURN



XYZ (INSERT)
Up a Level

Scales the block in all three dimensions.

X scale factor <1> / Corner: Specify a scale, enter c, or press RETURN

X scale factor
Defines X, Y, and Z scale factors for the block. 

Y scale factor <default=X>: Specify a scale or press RETURN

Z scale factor <default=X>: Specify an angle or press RETURN

Rotation angle <0>: Specify an angle or press RETURN

Corner
Defines the X and Y scales at the same time, using the insertion point and another point as the corners of a box, and then 
defines the Z scale.

Other corner: Specify a point

Z scale factor (default = X): Specify a scale or press RETURN

Rotation angle <0>: Specify an angle or press RETURN



For more information about inserting blocks and drawings, see chapter 14, "Using Blocks, Attributes, and External 
References," in the AutoCAD LT User's Guide.

Commands: BASE specifies a base insertion point in drawings that will be inserted as blocks into other drawings. BLOCK 
creates a named set of objects that can be inserted into a drawing. DDINSERT inserts a block into a drawing by use of a 
dialog box. EXPLODE separates the objects in a block. WBLOCK creates a drawing from a block. XREF attaches a drawing
to the current drawing and reflects updates made to the attached drawing.

System Variables: INSNAME stores the current block name used by the DDINSERT and INSERT commands.



INSERTOBJ Command
Up a Level          Related Topics

Inserts a linked or embedded object 
AutoCAD LT supports the Windows feature object linking and embedding (OLE). For more information about OLE, see 
chapter 17, "Managing Files and Other Formats," in the AutoCAD LT User's Guide.

A linked object remains associated with its source. When you edit a linked object in AutoCAD LT, the source file changes. 
When you edit the object in the source file, the linked AutoCAD LT object changes.

An embedded object is no longer associated with its source. You edit the embedded data from inside the AutoCAD LT 
drawing by using the original application. This editing does not change the original file. 

Linked or embedded objects appear on the screen in AutoCAD LT and can be printed or plotted using Windows system 
drivers. 

If you open an AutoCAD LT drawing that contains an embedded object, the Save option on the File menu is replaced by 
Update. Choosing Update inserts the object into the drawing or updates it. 

   From the Edit menu, choose Insert Objects
 

At the Command prompt, enter insertobj

AutoCAD LT displays the Insert Object dialog box.



Insert Object Dialog Box
Up a Level

Create New
Opens the application that's highlighted in the Object Type box so that you can create a new object to insert. 

Create from File
Inserts as an object the contents of the file you select under File. To link the object to AutoCAD LT, select Link.

Object Type
Lists applications on your system that support OLE. To create an object to embed, double-click a listed application. 



Display as Icon

Displays the source application's icon in the AutoCAD LT drawing. 



For more information about OLE, see "Embedding Objects in AutoCAD LT Drawings" in chapter 17 of the AutoCAD LT 
User's Guide.

Commands:  COPYLINK copies the current view of the AutoCAD LT drawing to the Clipboard. OLELINKS updates, 
modifies, and cancels existing links. PASTECLIP inserts data from the Windows Clipboard into a drawing. PASTESPEC 
inserts data from the Windows Clipboard and controls the format of the pasted data.



'ISOPLANE Command
Up a Level          Related Topics

Specifies the current isometric plane
At the Command prompt, enter isoplane

Left / Top / Right / <Toggle>: Enter an option or press RETURN

The isometric plane affects the cursor movement keys only when Snap mode is on and the snap style is Isometric. If the 
snap style is Isometric, Ortho mode uses the appropriate axis pair even if Snap mode is off. The current isometric plane also
determines the orientation of isometric circles drawn by ELLIPSE.



Toggle

Switches to the next plane in a clockwise fashion from left, to top, to right using the cursor movement keys.



Left

Selects the left-hand plane, defined by the 90-degree and 150-degree axis pair. 

 



Top

Selects the top face of the cube, called the top plane, defined by the 30-degree and 150-degree axis pair. 

 



Right

Selects the right-hand plane, defined by the 90-degree and 30-degree axis pair. 

 



Commands: DDRMODES sets drawing aids, including the current drawing plan. SNAP sets the Isometric snap style. You 
can cycle through the isometric planes by pressing CTRL+E or F2.

System Variables: SNAPISOPAIR stores the current isometric plane setting.



'LAYER Command
Up a Level          Related Topics

Manages layers
LAYER creates new layers, makes a layer current, sets the color and linetype for designated layers, turns layers on and off, 
locks or unlocks layers, freezes or thaws layers, and lists defined layers. 

At the Command prompt, enter layer

? / Make / Set / New  / ON      / OFF / Color/ Ltype / Freeze / Thaw / LOck / Unlock: Enter an option



?–List Layers (LAYER)
Up a Level

Displays a list of the currently defined layers, showing their names, states, color numbers,and    linetypes, and whether any 
are externally dependent.

Layer name(s) to list <*>: Enter a name list or press RETURN



Make (LAYER)
Up a Level

Creates a layer and makes it current. New objects are placed on the current layer as they are drawn.

New current layer <current>: Enter a name or press RETURN

If no layer exists for the name you enter, AutoCAD LT creates a new layer by that name. That layer is turned on and is 
assigned color number 7 and the CONTINUOUS linetype. If the layer exists but is turned off, AutoCAD LT turns it on.



Set (LAYER)
Up a Level

Makes a new layer current but does not create the layer if it doesn't already exist. If the layer exists but is turned off, 
AutoCAD LT turns it on and makes it current.

New current layer <current>: Enter a name



New (LAYER)
Up a Level

Creates one or more layers. You can create two or more layers by entering names separated by commas.

New layer name(s): Enter a name list



On (LAYER)
Up a Level

Makes selected layers visible and available for plotting.

Layer name(s) to turn On: Enter a name or a list of names separated by commas



Off (LAYER)
Up a Level

Makes selected layers invisible and excludes them from plotting.

Layer name(s) to turn Off: Enter a name or a list of names separated by commas



Color (LAYER)
Up a Level

Changes the color associated with a layer.

Color: Enter a color name or a color number 1-255

AutoCAD LT prompts for layer names to which the color should be applied. 

Layer name(s) for color n <current>: Enter a name or a list of names separated by commas, or press RETURN

The layers are turned on. To assign a color but turn off the layer, precede the color with a minus sign (-).



Ltype (LAYER)
Up a Level

Changes the linetype associated with a layer.

Linetype (or ?) <CONTINUOUS>: Enter a currently loaded linetype name, enter ?, or press RETURN

If you enter ?, AutoCAD LT prompts for the linetypes to list.

Linetype(s) to list <*>: Enter a wild-card pattern or press RETURN to list all names in the drawing

If you enter a linetype name or press RETURN, AutoCAD LT prompts for a list of layers to which the linetype should be 
applied.

Layer name(s) for linetype xxx <current>: Enter a wild-card pattern, a name, or a list of names separated by commas, 
or press RETURN



Freeze (LAYER)
Up a Level

Freezes layers, making them invisible and excluding them from regeneration and plotting.

Layer name(s) to Freeze: Enter a name or a list of names separated by commas 



Thaw (LAYER)
Up a Level

Thaws frozen layers, making them visible and available for regeneration and plotting. 

Layer name(s) to Thaw: Enter a name or a list of names separated by commas 



Lock (LAYER)
Up a Level

Locks layers, preventing editing on those layers.

Layer name(s) to Lock: Enter a name or a list of names separated by commas



Unlock (LAYER)
Up a Level

Unlocks selected locked layers, permitting editing on those layers.

Layer name(s) to Unlock: Enter a name or a list of names separated by commas



For more information, see “Using Two Dimensional Coordinates Systems and Layers” in chapter 5 of the AutoCAD LT 
User’s Guide.

Commands: DDLMODES is the dialog box equivalent of LAYER. DDLTYPE loads and sets linetypes. LINETYPE creates, 
loads, and sets linetypes. VPLAYER sets viewport visibility for new and existing layers. DDEMODES sets properties for new 
objects.

System Variables: CLAYER stores the name of the current layer.



LEADER Command
Up a Level          Related Topics

Creates a line that connects annotation to a feature
A leader is an object that can be composed of an arrowhead attached to splines or straight line segments. In some cases, a 
short horizontal line, called a hook line, dogleg, or landing, connects text and feature control frames to the leader line.

You can use various dimensioning system variables to control the appearance of leader lines, such as placing the text above
the hook line with DIMTAD.

      

The LEADER command creates complex leader lines. DIMDIAMETER and DIMRADIUS create simple automatic leader 
lines for circle and arc dimensions.

   From the Dimensioning toolbar, choose

   From the Dimension menu, choose Leader
 At the Command prompt, enter leader

From point: Specify a point or use an Object Snap mode to attach the leader line to an object

To point: Specify a point

AutoCAD LT draws a leader line segment to the point specified and continues to prompt for other points and options.

To point (Format / Annotation / Undo) <Annotation>: Specify a point, enter an option, or press RETURN



For more information, see "Creating Leader Lines with Annotation" in chapter 13 of the AutoCAD LT User's Guide. 

Commands: DDIM creates and modifies dimension styles. DIMDIAMETER creates diameter dimensions for circles or arcs. 
DIMRADIUS dimensions the radius of a circle or arc, with an optional center mark or centerline. MTEXT creates paragraphs.
SPLINE creates a spline (NURBS) curve. TOLERANCE creates geometric tolerances to control form, profile, orientation, 
location, and runout of a feature.

System Variables: DIMASZ controls the size of arrowheads. DIMBLK defines the block for arrowheads. DIMBLK1 defines 
the block for the first arrowhead. DIMCLRD controls the color of the dimension line. DIMGAP controls the size of the text 
gap. DIMSCALE controls the overall scale of dimension objects. DIMTAD controls the vertical justification of dimension text. 



To Point (LEADER)
Up a Level

Draws a leader line segment to the point specified and continues to prompt for points and options.



Annotation (LEADER)
Up a Level

Inserts annotation at the end of the leader line, such as line text, paragraph text, a feature control frame containing 
geometric tolerances, or a block.

Annotation (or RETURN for options): Enter text or press RETURN

When you press RETURN AutoCAD LT places the text you enter at the end of the leader line and ends the command. 
Pressing RETURN without entering text displays the following prompt.

Tolerance / Copy / Block / None / <Mtext>: Enter an option or press RETURN



Mtext

Creates paragraphs of text using the Edit MText dialog box. Enter the text. Strings for prefixes should precede and for 
suffixes should follow, angle brackets (< >). Enclose format strings for alternate units in square brackets ([]). 

The units settings and the current text style determine the appearance of the text. The paragraph of text is vertically 
centered, and it's horizontally aligned according to the X axis direction of the last two vertices of the leader line. 

The text is offset from the hook line by the distance specified under Gap in the DDIM Annotation dialog box. If the offset 
specified is negative, the paragraph text is enclosed in a box as a basic dimension.

After you enter the text, the LEADER command ends.



Tolerance

Creates a feature control frame containing geometric tolerances using the Geometric Tolerance dialog boxes. For a 
complete description, see TOLERANCE.

You can create datum indicators and basic dimension notation in these dialog boxes. After you specify the geometric 
tolerance, the LEADER command ends.



Copy

Copies text, paragraph text, a feature control frame with geometric tolerances, or a block and connects the copy to the end 
of the leader line. The copy is associated with the leader line. The display of the hook line depends on the object copied.

Select an object: Use an object selection method

AutoCAD LT places the object and ends the LEADER command. The text is inserted at a location determined by the value of
the current text gap (see the DDIM command or the DIMGAP dimensioning system variable). Any blocks or feature control 
frames with geometric tolerances are attached to the end of the leader line.



Block

Inserts a block at the end of the leader line. AutoCAD LT uses the same prompts as the INSERT command. The block 
reference is inserted at an offset from the end of the leader line and is associated to the leader line. No hook line is 
displayed.



None

Ends the command without adding any annotation to the leader line.



Format (LEADER)
Up a Level

Controls the way the leader is drawn and whether it has an arrowhead.

Spline / STraight / Arrow / None / <Exit>: Enter an option or press RETURN

After each option, AutoCAD LT returns to the To Point (Format / Annotation / Undo) <Annotation> prompt.



Spline

Draws the leader line as a spline. The vertices of the leader are the control points, each of equal weight. 



Straight

Draws the leader line as a set of straight line segments.



Arrow

Draws an arrowhead at the start point of the leader line.



None

Draws a leader line with no arrowhead at the start point.



Exit

Exits the Format option.



Undo (LEADER)
Up a Level

Undoes the last vertex point on the leader line. AutoCAD LT redisplays the To Point (Format / Annotation / Undo) 
<Annotation> prompt.



Controlling the Appearance of Leader Lines (LEADER)
Up a Level

Leader lines are planar 2D objects similar to dimension objects. The appearance of the leader line is controlled by a 
dimension style.

Any units or text style settings defined in the dimension style are applied to the annotation whenever possible.

Leader line feature Controlled by System variable

Color of leader line 
and arrowhead

Color option for dimension line in
the DDIM Geometry dialog box

DIMCLRD

Arrowhead type 1st option for arrowheads in the 
DDIM Geometry dialog box

DIMBLK or 
DIMBLK1 when 
the arrowheads 
vary

Arrowhead and 
hook line size (hook
lines are one 
arrowhead long)

Size option for arrowheads in the
DDIM Geometry dialog box

DIMASZ

Gap between 
annotation and hook
line

Gap option for text in the DDIM 
Annotation dialog box

DIMGAP

Scale Overall Scale option in the DDIM
Geometry dialog box

DIMSCALE

Basic dimension 
notationboxed text

Basic option for dimension 
tolerance in the DDIM Annotation
dialog box

DIMGAP
(negative value)

Hook Lines (LEADER)
Up a Level

AutoCAD LT automatically includes a hook line if the angle of the leader line is greater than 15 degrees from horizontal.

      

To position text above the hook line, as it is in JIS (Japanese Industrial Standards), select the Outside Horizontal option for 
text and the Above option for vertical justification options in the DDIM Format dialog box. AutoCAD LT stores these values in 
the DIMTOH and DIMTAD variables, respectively. For more information, see chapter 13, "Dimensioning and Tolerancing," in 
the AutoCAD LT User's Guide.



LENGTHEN Command
Up a Level          Related Topics

Changes the length of objects and the included angle of arcs. 
The LENGTHEN command does not affect closed objects. 

   

From the Modify toolbar, choose 
 From the Modify menu, choose Lengthen
 At the Command prompt, enter lengthen

DElta / Percent / Total / DYnamic / <Select object>: Select one object or enter an option



For more information about changing the length of objects and the angle of arcs, see "Resizing Objects" in chapter 10 of the 
AutoCAD LT User's Guide.

Commands: EXTEND extends an object to meet another object. TRIM trims objects at a cutting edge defined by one or 
more objects.



Select Object (LENGTHEN)
Up a Level

Displays the length, and where applicable, the included angle of the object.

Current length: <current>, included angle    <current>



Delta (LENGTHEN)
Up a Level

Changes the length of an object by a specified increment, measured from the endpoint of the selected object closest to the 
pick point. 

The Delta option changes the angle of an arc by a specified increment measured from the endpoint of the arc. A positive 
value extends the objects, a negative value trims it.

Angle / <Enter delta length (current)>: Specify a distance, enter a, or press RETURN



Enter Delta Length
Up a Level

Changes the length of the object by the specified increment.

<Select object to change> / Undo: Select one object or enter u

This prompt is repeated until you press RETURN to end the command.

    



Angle
Up a Level

Changes the included angle of the selected arc by the specified angle value.

Enter delta angle <current>: Specify an angle or press RETURN

<Select object to change> / Undo: Select one object or enter u

This prompt is repeated until you press RETURN to end the command.

      



Select Object to Change

Specifies the object to change. Then select the object near the end you want to change.



Undo

Reverses the most recent change made by the LENGTHEN command. 



Percent (LENGTHEN)
Up a Level

Sets the length of an object by a specified percentage of its total length. The Percent option changes the angle of an arc by 
a specified percentage of the total included angle of the arc. 

Enter percent length <current>: Enter a positive nonzero value or press RETURN

<Select object to change> / Undo: Select one object or enter u

This prompt is repeated until you press RETURN to end the command.



Total (LENGTHEN)
Up a Level

Sets the length of a selected object by specifying the total absolute length from the fixed endpoint. The Total option sets the 
included angle of a selected arc by a specified total angle.

      

Angle / <Enter total length (current)>: Specify a distance, enter a positive nonzero value, enter a, or press RETURN



Enter Total Length
Up a Level

Lengthens the object to the specified value from the endpoint nearest the selection point.

<Select object to change> / Undo: Select one object or enter u

This prompt is repeated until you press RETURN to end the command.



Angle
Up a Level

Sets the included angle of the selected arc to a specified value.

Enter total angle <current>: Specify an angle or press RETURN

<Select object to change> / Undo: Select one object or enter u

This prompt is repeated until you press RETURN to end the command.

      



Undo

Reverses the most recent change made by LENGTHEN. 

This prompt is repeated until you press RETURN to end the command.



Dynamic (LENGTHEN)
Up a Level

Turns on Dynamic Dragging mode. You change the length of a selected object by dragging one of its endpoints. The other 
end remains fixed. 

<Select object to change> / Undo: Select one object or enter u

This prompt is repeated until you press RETURN to end the command.



Undo

Reverses the most recent change made by LENGTHEN. 



'LIMITS Command
Up a Level          Related Topics

Sets and controls the drawing boundaries and grid display
The drawing limits are 2D points in the World Coordinate System that represent the lower-left and upper-right boundaries. 
You cannot impose limits in the Z direction. 

When turned on, the drawing limits restrict the coordinates you can enter, to within the rectangular area. Drawing limits also 
determine the area of the drawing that can display grid dots, the area displayed by one of the scale options of the ZOOM 
command, and the minimum area displayed with a ZOOM All command.

   From the Format menu, choose Drawing Limits
 

At the Command prompt, enter limits

ON / OFF / <Lower left corner> <current>: Specify a point, enter on, or off, or press RETURN



LowerLeft corner

Specifies the lower-left corner for the drawing limits.

Upper right corner <current>: Specify a point or press RETURN



On

Turns on limits checking. With limits checking on, AutoCAD LT rejects attempts to enter points outside the drawing limits. 
Because limits checking tests only points that were entered, portions of objects such as circles can extend outside the limits.



Off

Turns off limits checking but maintains the current values for the next time limits checking is turned on.



For more information, see "Setting a Drawing Boundary" in chapter 4 of the AutoCAD LT User's Guide. 

System Variables: LIMCHECK turns limits checking on and off for the current space. LIMMIN stores lower-left drawing 
limits for the current space. LIMMAX stores upper-right drawing limits for the current space.



LINE Command
Up a Level          Related Topics

Creates straight line segments
You can specify the endpoints of lines using 2D or 3D coordinates. 

 

From the Draw toolbar, choose 
 From the Draw menu, choose Line 

At the Command prompt, enter line

From point: Specify a point or press RETURN to continue the line or arc

To point: Specify a point

To point: Specify a point, enter u, c, or press RETURN

AutoCAD LT draws a line segment and continues to prompt for points. You can draw a continuing series of line segments 
but, each line segment is a separate object. Press RETURN to end the command.

For example, the following command sequence draws a single line segment.

Command: line

From point: Specify a point (1)

To point: Specify a point (2)

To point: Press RETURN

For more information about drawing lines, see "Drawing Line Objects" in chapter 6 of the AutoCAD LT User's Guide. 

Commands: PLINE creates 2D polylines. XLINE creates an infinite line. RAY creates a semi-infinite line. DLINE creates a 
double line using straight line segments and arcs.



RETURN–Continue a Line or Arc (LINE)
Up a Level

Continues a line from the endpoint of the most recently drawn line. Press RETURN at the From Point prompt to define the 
starting point of the line. 

      

If you drew an arc most recently, its endpoint defines the starting point of the line, and the line is drawn tangent to the arc.

      



 Undo a Line (LINE)
Up a Level

At the To Point prompt, erases the most recent segment of a line sequence. 

      

Entering u more than once backtracks through line segments in the order they were created.



 Close a Series of Line Segments
Up a Level

After a series of two or more segments are drawn, the last line segment ends at the beginning of the first line segment, 
which forms a closed loop of line segments.

Enter c or close at the To Point prompt to form a closed polygon from a sequence of lines. 

      



'LINETYPE Command
Up a Level          Related Topics

Creates, loads, and sets linetypes
The LINETYPE command defines line characteristics consisting of combinations of dashes, dots, and spaces. LINETYPE 
can either load linetype definitions from a library file or add new definitions to a library file.

At the Command prompt, enter linetype

? / Create / Load / Set: Enter an option



For more information about creating linetypes, see chapter 20 of the AutoCAD LT User's Guide.

Commands: LTSCALE sets the linetype scale factor.

System Variables: LTSCALE stores the global linetype scale factor. PSLTSCALE controls linetype scaling in paper space. 



?List Linetypes (LINETYPE)
Up a Level

Lists the linetypes available in a file.

The Select Linetype File dialog box is displayed. Enter the name of a linetype file.



Create (LINETYPE)
Up a Level

Creates a new linetype and stores it in a library (.lin) file.

Name of linetype to create: Enter a name

AutoCAD LT displays the Create or Append Linetype File dialog box. Specify the file to which you want the linetype added.

Descriptive text: Enter optional descriptive text

Enter a linetype description up to 47 characters long. The description can be a comment or a series of underscores, dots, 
dashes, and spaces to show a simple representation of the linetype pattern.

Enter pattern (on next line)

A, Enter pattern definition as a series of numbers separated by commas.

Enter positive values to specify lengths of dashes and negative values to specify lengths of spaces. Use a zero to represent 
a dot.

The A, in the pattern definition prompt specifies the pattern alignment used at the ends of individual lines, circles, and arcs. 
AutoCAD LT supports A-type alignment only. With A-type alignment, AutoCAD LT guarantees that lines and arcs start and 
end with a dash. The A is automatically included in the definition. If you use a text editor to create a linetype, you must enter 
a, at the beginning of the definition.

After creating a linetype, you must load it to make it accessible.



Load (LINETYPE)
Up a Level

Loads a linetype whose definition exists in a file. The aclt.lin file contains the standard linetypes supplied by AutoCAD LT.

Linetype(s) to load: Enter a name or a list of names separated by commas

AutoCAD LT displays the Select Linetype File dialog box. Enter or select the file name in which the linetype is stored.



Set (LINETYPE)
Up a Level

Sets the current linetype for subsequently drawn objects. You can control the linetype of objects individually or by layer.

New object linetype (or ?) <current>: Enter a linetype name, ?, bylayer, or byblock, or press RETURN

The linetype you enter becomes the current linetype. AutoCAD LT draws all new objects with this linetype, regardless of the 
current layer. 

If the linetype you request is not loaded, AutoCAD LT searches for its definition in aclt.lin. If the linetype is neither loaded nor 
in aclt.lin, AutoCAD LT reports this and returns to the ? / Create / Load /Set prompt.

Enter ? to list all loaded linetype names. If you enter bylayer, new objects inherit the linetype associated with the layer on 
which the object is drawn. If you enter byblock, new objects are drawn using the CONTINUOUS linetype until they are 
grouped into a block. Whenever you insert that block, the objects inherit the linetype of the block.



LIST Command
Up a Level

Displays database information for selected objects
 

From the Object Properties toolbar, choose 
At the Command prompt, enter list

Select objects: Use an object selection method

AutoCAD LT lists object type, object layer, X,Y,Z position relative to the current UCS, and whether the object is in model 
space or paper space. 

The LIST command reports color and linetype information if these items are not set to BYLAYER. The thickness of an object 
is displayed if it is not zero. Z coordinate information defines the elevation. If the extrusion direction of the entry differs from 
the Z axis (0,0,1) of the current UCS, LIST also reports the extrusion direction in UCS coordinates. 

LIST reports additional information related to the specific object selected. 



LOGFILEOFF Command
Up a Level          Related Topics

Closes the log file opened by LOGFILEON
 From the Tools menu, choose Preferences. On the Work 

Space tab, clear the Log File box.    
 At the Command prompt, enter logfileoff

AutoCAD LT stops recording the text window contents and closes the log file.

You can turn off the log file in the Preferences dialog box under Work Space. The log file name is aclt.log.

A new log session begins each time you start AutoCAD LT. Sessions in the log file are separated by dashed lines. The log 
file continues to grow with each session and therefore needs to be periodically deleted or edited.



For more information about the log file, see "Using the Log File" in chapter 17 of the AutoCAD LT User's Guide. 

Commands: LOGFILEON writes to a file everything that appears in the text window. PREFERENCES sets AutoCAD LT 
environment settings.



LOGFILEON Command
Up a Level          Related Topics

Writes the text window contents to a file
 From the Tools menu, choose Preferences. On the Work 

Space tab, select the Log File box.
 At the Command prompt, enter logfileon

AutoCAD LT records the text window contents the log file until you exit AutoCAD LT or use the LOGFILEOFF command. 

The log file name is aclt.log. A new log session begins each time you start AutoCAD LT. Sessions in the log file are 
separated by dashed lines. The log file continues to grow with each session and therefore needs to be periodically deleted 
or edited.



For more information about the log file, see "Using the Log File" in chapter 17 of the AutoCAD LT User's Guide. 

Commands: LOGFILEOFF closes the log file. PREFERENCES sets AutoCAD LT environment settings, including the log 
file.



Long File Names
Up a Level 

In Windows 95, you can use file names of up to 256 characters. You can use this many characters because Windows 95 
extends the MS-DOS FAT file system to maintain existing hard drive formats so you won’t have to reformat the hard drive. 
Floppy diskettes also support long file names. 

Use caution when you mix operating system environments that support long file names with systems that limit support to 
11=character file names (8 characters, a period, and 3=characters extension). If you save a long file name in an environment
that does not support long file names, the filename is abbreviated. 



'LTSCALE Command
Up a Level          Related Topics

Sets the global linetype scale factor
Use the LTSCALE command to change the scale factor of linetypes for all objects in a drawing.

 From the Options menu, choose Linetypes, then Global
Linetype Scale

 At the Command prompt, enter ltscale

New scale factor <current>: Enter a positive real value or press RETURN

Changing the global linetype scale factor causes the drawing to regenerate. Linetype scale can also be set for individual 
objects using DDMODIFY.



System Variables: LTSCALE stores the global linetype scale factor. PSLTSCALE controls linetype scaling in paper space. 
CELTSCALE stores the current linetype scale factor for new objects.

Commands: DDMODIFY can change the linetype scale factor for individual objects. DDLTYPE can set the object linetype 
scale factor for new objects.



MAKEPREVIEW Command
Up a Level    

Creates a preview image of the current view
This release of AutoCAD LT creates a preview image automatically each time you use the SAVE or SAVEAS command.

You can use the MAKEPREVIEW command when you want a preview image of a drawing that was created in a previous 
release of AutoCAD LT but don't want to save the drawing to the LT for Windows and Windows NT file format. After you use 
MAKEPREVIEW, AutoCAD LT and third-party viewer applications can display a preview image of the drawing.

 At the Command prompt, enter makepreview

MAKEPREVIEW creates a compressed bitmap file of the current view and places the file in the same directory as the 
drawing file. If this bitmap file and the drawing file reside in the same directory, when you use the OPEN command, the 
Select File dialog box displays the image in the Preview area.



MEASURE Command
Up a Level          Related Topics

Places point objects or blocks at measured intervals on an object
 

From the Draw toolbar, choose 
 From the Draw menu, choose Point, then Measure
 At the Command prompt, enter measure

Select object to measure: Use an object selection method

<Segment length> / Block: Specify a distance

The points or blocks drawn by the MEASURE command are placed in the Previous selection set, so you can choose them 
all by entering p at the next Select Objects prompt. Use Node object snap to snap to the point objects. 



For more information, see "Specifying Measured Intervals on Objects” in chapter 7 of the AutoCAD LT User's Guide. 

Commands: BLOCK creates a block definition from selected objects. DIVIDE places evenly spaced point objects or blocks 
along the length or perimeter of an object.

System Variables: PDMODE controls the appearance of point objects, PDSIZE controls the display size of point objects.



Segment Length (MEASURE)
Up a Level

If you enter a distance or specify two points, AutoCAD LT places point objects at the specified interval along the selected 
object, starting at the endpoint closest to the point you used to select the object.    

Measurement of closed polylines starts at their initial vertex (the first one drawn).

Measurement of circles starts at the angle from the center set as the current snap rotation angle. If the snap rotation angle is
zero, then the measurement of the circle starts to the right of center, on its circumference. 

The following illustration shows how MEASURE marks 0.5-unit distances along a polyline, with the PDMODE system 
variable set to 35.



Block (MEASURE)
Up a Level

Places blocks at a specified interval along the selected object.

Block name to insert: Enter the name of a block currently defined in the drawing

Align block with object? <Y> Enter y or n or press RETURN

Indicate whether or not the block is to be rotated about its insertion point so that its horizontal lines are aligned with, and 
drawn tangent to, the object being measured. If you enter n, the block is always inserted with a 0 rotation angle. 

Segment length: Specify a distance

After you specify the segment length, AutoCAD LT inserts the block at the specified interval. If the block has variable 
attributes, these attributes are not included.

AutoCAD LT places the markers in the UCS of the object being measured (except 3D polylines in the current UCS). Markers
are always placed on the object, regardless of the elevation settings.



MENULOAD Command
Up a Level          Related Topics

Loads partial menu files
The MENULOAD command displays the Menu Customization dialog box, in which you can add partial menu files to an 
existing base menu file, such as aclt.mnu. Each menu file (base and partial) has an associated menu group name. From 
each menu group, you can access each pull-down menu that resides in the associated menu file.

After you load the partial menus, you can customize the AutoCAD LT menu bar by adding or deleting pull-down menus.
From the Tools menu, choose Customize Menus

 At the Command prompt, enter menuload

The Menu Customization dialog box is displayed.

Command Line Usage
When the FILEDIA system variable is set to 0 (off), AutoCAD LT displays the following prompt on the command line.

Enter name of menu file to load: Enter a name



For more information, see "Pull-Down Menus," in chapter 2 of the AutoCAD LT User's Guide. 

Commands: MENUUNLOAD unloads partial menu files.



Menu Customization Dialog Box (MENULOAD)
Up a Level

Menu Groups
Menu Groups. Lists the currently loaded menu files.
File Name. Specifies the file to load when you choose Load. You can either enter the file name manually or use 

the Browse option to select a file from the Open dialog box.
Replace All. Removes all existing menu groups from the Menu Groups list when you load a new file menu.
Unload. Unloads the menu group highlighted in the Menu Groups.
Load. Loads the file specified in the File Name box.
Browse. Displays the Select Menu File dialog box. Select a menu file to load.

Menu Bar
Menu Group. Displays a selected menu file in the Menu Groups list.
Menus. Lists all the menus defined in the menu group specified in the Menu Group list.
Menu Bar. Lists all the pull-down menus loaded in the AutoCAD LT application window. The menu at the top of the

list corresponds to the left-most pull-down menu on the menu bar in the AutoCAD LT window. The menu at the bottom of the 
list corresponds to the right-most pull-down menu.

Insert. Inserts the menu highlighted in the Menus list above the highlighted menu in the Menu Bar list. If no menu 
is highlighted in the Menu Bar list, the highlighted menu in the Menus list is inserted at the top of the Menu Bar list.

Remove. Removes the menu highlighted in the Menu Bar list.
Remove All. Removes all menus from the menu bar in the AutoCAD LT window.



Select Menu File Dialog Box
Up a Level

Specifies a menu file name.

File Name
Select or enter the name of the drawing file you want to open. 

Note: You can open only a file with the .mns or .mnc extension.

List Files of Type
Select the type of files you want to see in the File Name list.

Directories
Select the directory that contains the file you want to open.

Drives
Select the drive that contains the file you want to open.



MENUUNLOAD Command
Up a Level          Related Topics

Unloads partial menu files
From the Tools menu, choose Customize Menus

 At the Command prompt, enter menuunload

The Menu Customization dialog box is displayed.

When the FILEDIA system variable is set to 0 (off), AutoCAD LT displays the following prompt on the command line.

Enter the name of the MENUGROUP to unload: Enter a name



Commands: MENULOAD loads partial menu files.



MIRROR Command
Up a Level          Related Topics

Creates a mirror image copy of objects
 

From the Modify toolbar, choose 
 From the Modify menu, choose Mirror 

At the Command prompt, enter mirror

Select objects: Use an object selection method

First point of mirror line: Specify a point (1)

Second point: Specify a point (2)

      

 

The two specified points become the endpoints of a line about which the selected objects are reflected. In 3D, this line 
orients a mirroring plane perpendicular to the XY plane of the UCS containing the mirror line.

Delete old objects? <N>  Enter y or n, or press RETURN

Entering n or pressing RETURN places the reflected image into the drawing and retains the original objects. Entering y 
places the reflected image into the drawing and deletes the original objects.

      

 

To manage the reflection properties of text objects, see the MIRRTEXT system variable. The default setting of MIRRTEXT is 
on (1), which causes a text object to be mirrored just like any other object. When MIRRTEXT is off (0), text is not mirrored.

    

    

 



For more information, see "Mirroring Objects" in chapter 9 of the AutoCAD LT User's Guide. 

System Variables: MIRRTEXT controls whether text is reflected with the MIRROR command.



MOVE Command
Up a Level          Related Topics

Displaces objects a specified distance in a specified direction
 

From the Modify toolbar, choose 
 From the Modify menu, choose Move

At the Command prompt, enter move

Select objects: Use an object selection method

Base point or displacement: Specify a base point (1)

Second point of displacement: Specify a point (2) or press RETURN

      

      

The two points you specify define a displacement vector that indicates how far the selected objects are to be moved and in 
what direction. If you press RETURN at the second point, the first point is interpreted as relative X,Y,Z displacement.



For more information, see "Moving Objects" in chapter 9 of the AutoCAD LT User's Guide. 

Commands: COPY duplicates objects.



MSLIDE Command
Up a Level          Related Topics

Creates a slide file of the current viewport 
A slide file is a raster image of a viewport.

From the File menu, choose Slide, then Create
 At the Command prompt, enter mslide

The Create Slide File dialog box is displayed.

Off-screen portions of the drawing, or layers that are off or frozen, are not included in the slide.



For more information, see "Creating Slides" in chapter 21 of the AutoCAD LT User's Guide. 

Commands: VSLIDE displays slide files in the current view. 

Utilities: SLIDELIB creates slide libraries (file extension .slb). This utility is found in the AutoCAD LT support directory. 



Create Slide File Dialog Box
Up a Level

File Name
Enter the name of the slide file (extension .sld) you want to create. 

List Files of Type
Select the type of files you want to see in the File Name list.

Directories
Select the directory you want to contain the slide file.

Drives
Select the drive you want to contain the slide file.

Network
To connect network drives to your computer, choose Network. The Map Network Drive dialog box is displayed. 



MSPACE Command
Up a Level          Related Topics

Switches from paper space to a model space viewport
AutoCAD LT operates in either model space or paper space. You use model space to do drafting and design work. You use 
paper space to create a finished layout of a drawing for printing or plotting.

Before you use the MSPACE command, the TILEMODE system variable must be set to 0 (off), and floating viewports must 
be created using MVIEW. If TILEMODE is on when you choose Model Space (floating) from the View menu, AutoCAD LT 
prompts you to create a floating viewport.

 

From the Space toolbar, choose 

From the View menu, choose Tiled Model Space or 
Floating Model Space
At the Command prompt, enter mspace

AutoCAD LT switches to model space. If at least one viewport is on and active, AutoCAD LT switches to the last active 
viewport.

      



For more information about using model space and paper space, see chapter 15 of the AutoCAD LT User's Guide. 

Commands: PSPACE switches from model space to paper space. MVIEW creates new viewports and turns on existing 
viewports. VPLAYER sets the visibility for layers in specific viewports. ZOOM XP scales each view relative to paper space 
units. 

System Variables: TILEMODE controls paper space access and viewport behavior. PSLTSCALE controls paper space 
linetype scaling. VISRETAIN specifies precedence of settings for xref layers. MAXACTVP specifies the maximum number of 
viewports to regenerate. DIMLFAC controls scaling for linear dimensions. 



MULTIPLE Command
Up a Level

Repeats the next command until canceled
At the Command prompt, enter multiple

AutoCAD LT repeats the command you enter until you press ESC. Because the MULTIPLE command repeats only the 
command name, any parameters must be specified each time. 

MULTIPLE does not work with dialog box commands. You cannot use MULTIPLE as an argument to the AutoLISP command 
function.



MTEXT Command
Up a Level          Related Topics

Creates paragraph text
The paragraphs that the MTEXT command creates fit within a boundary. You define the text boundary, which specifies the 
width and alignment of the paragraph. Each paragraph is a single object, regardless of the number of lines it contains. The 
text boundary, though not plotted or printed, remains part of the object's framework. The MText Editor does not recognize 
rich text format (RTF). Text from other programs with embedded formatting will lose that formatting when imported or pasted 
into the MText Editor.

   

From the Draw toolbar, choose 

From the Draw menu, choose Text, then Paragraph Text
 At the Command prompt, enter mtext

Justify / Style / Height / <Insertion point>: Specify a point or enter an option

The Edit Mtext dialog box is displayed.

If you enter -mtext at the Command prompt, Autocad LT will not display the Edit Mtext dialog box but presents options at the
Command prompt where you also enter text.

You can overscore and underscore text and insert special characters. See Special Unicode Characters and Control Codes 
and Special Characters.

You can specify a different paragraph editing tool by changing the system variable, MTEXTED.

Note: The automatic word wrap may not be the same in a text object as it is in the Edit MText dialog box. Word wrap 
depends on the text font used. Pressing a RETURN will always terminate a line of text.



Special Unicode Characters
Up a Level

MTEXT

When using paragraph text (MTEXT), you can create special characters, including the degree symbol, the plus/minus 
tolerance symbol, and the diameter symbol by entering the following Unicode character strings:

%\U+00B0 Degrees symbol (°)

%\U+00B1 Tolerance symbol (±)

%\U+2205 Diameter symbol (Ø)

-MTEXT (Command prompt)

When using paragraph text (-mtext) from the command prompt, you can also enter Unicode strings but you don’t need to 
include the leading percent character (%).

\U+00B0 Degrees symbol (°)

\U+00B1 Tolerance symbol (±)

\U+2205 Diameter symbol (Ø)

DTEXT and TEXT

When using line text (DTEXT and TEXT), you can also enter Unicode strings but you don’t need to include the leading 
percent character (%).

\U+00B0 Degrees symbol (°)

\U+00B1 Tolerance symbol (±)

\U+2205 Diameter symbol (Ø)



Control Codes and Special Characters
Up a Level

When using line text (DTEXT and TEXT), you can specify special characters by including control information in the text 
string. Use a pair of percent signs to introduce each control sequence. 

In the Edit Mtext dialog box, you can specify only the special characters %%d (degrees symbol), %%p (plus/minus tolerance
symbol), and %%c (circle diameter dimensioning symbol). To include other formatting such as underscoring, see 
“Formatting Paragraph Text on the Command Line” in chapter 12 of the AutoCAD LT User’s Guide.

This control code works with standard AutoCAD LT text fonts and PostScript fonts:

%%nnn Draws character number nnn.

These control codes work with standard AutoCAD LT text fonts only:

%%o Toggles overscore mode on/off.

%%u Toggles underscore mode on/off.

%%d Draws degrees symbol (°).

%%p Draws plus/minus tolerance symbol (±).

%%c Draws circle diameter dimensioning symbol (Ø).

%%% Draws a single percent sign.

Overscore and underscore modes can be in effect at the same time. Both modes turn off automatically at the end of the text 
string.

You can use the %%nnn control sequence to display special characters using the PostScript fonts. However, if you use 
PSOUT to create a PostScript file containing characters created with this method, the characters appear as outlines.



For more information about paragraph text, see chapter 12, "Adding Text to Drawings," in the AutoCAD LT User's Guide. 

Commands: DDEDIT edits text and attribute definitions. DDMODIFY moves or modifies paragraph text. DTEXT creates text
on the screen as you enter it. MTPROP changes paragraph text properties. PREFERENCES specifies the text editor you 
want to use to create paragraph text. SPELL checks the spelling of text. STYLE creates text styles. TEXT creates single-line
text. 

System Variables: MTEXTED specifies the name of a third-party ASCII text editor you want to use to create paragraph text.
Alternatively, you can enter internal to use AutoCAD LT's internal text editor.



Insertion Point (MTEXT)
Up a Level

Specifies a corner of the text boundary. This point is also the text insertion point.

Justify / Width / 2Points / <Other corner>: Specify a point or enter an option

Other corner
Specifies the diagonally opposite corner of the text boundary.

Height <current>: Specify a point or enter a value

AutoCAD LT displays the Edit MText dialog box. 

Justify
Controls which part of the text boundary aligns at the insertion point. The option you select determines both text justification 
and text spill in relation to the text boundary. Justification controls whether text is aligned on the left, right, or center of the 
text boundary. Text spill controls how excess text flows from the insertion point. 

<TL> / TC / TR / ML / MC / MR / BL / BC / BR: Enter an option or press RETURN

For a complete description of each attachment option, see Justify (mtext).

AutoCAD LT returns to the previous prompt.

Width
Specifies the width of the text boundary.

Object width: Specify a point or enter a value

AutoCAD LT displays the Edit MText dialog box. 

2Points
First point: Specify a point

Second point: Specify a point

AutoCAD LT displays the Edit MText dialog box. 



Justify (MTEXT)
Up a Level

Controls which part of the text boundary aligns at the insertion point. The option you select determines both text justification 
and text spill in relation to the text boundary. Justification controls whether text is aligned on the left, right, or center of the 
text boundary. Text spill controls how excess text flows out of the text boundary. 

TL / TC / TR / ML / MC / MR / BL / BC / BR: Enter an option or press RETURN

AutoCAD LT returns to the previous prompt.

TL-Top Left TC-Top Center

TR-Top Right ML-Middle Left

MC-Middle Center MR-Middle Right



BL-Bottom Left BC-Bottom Center

BR-Bottom Right



Edit MText Dialog Box
Up a Level

Text 
Enter the text you want to appear in the drawing.

Justification
To change which part of the text boundary aligns at the insertion point, select a justification option. For more information, see
Justify (MTEXT).

Import
To import text from a text file, choose Import to display the Import Text File dialog box.



Style (MTEXT)
Up a Level

Specifies the txt style to use for paragraph text.

Style name (or ?) <current>: Enter a name, or enter a question mark (?), or press RETURN

AutoCAD LT returns to the previous prompt.

For more information on specifying a text style on the command line, see STYLE.



Height (MTEXT)
Up a Level

Specifies the text height.

Height <current>: Specify a point or enter a value

AutoCAD returns to the previous prompt.



Import Text File Dialog Box
Up a Level

File Name
Select or enter the name of the file that contains the text you want to import. 

List Files of Type
Select the type of files you want to see in the File Name box.

Directories
Select the directory that contains the text file you want to import.

Drives
Select the drive that contains the text file you want to import.

Network
To connect network drives to your computer, choose Network to display the Map Connections dialog box. 



Insertion point (MTEXT Command Line)
Up a Level

Specifies a corner of the text boundary. This point is also the text insertion point.

Justify / Width / 2Points / <Other corner>: Specify a point or enter an option



Other Corner

Specifies the diagonally opposite corner of the text boundary.

MText: Enter characters or press RETURN

AutoCAD LT wraps text within the text boundary. You can end a line of text at a specific point by typing the text and pressing 
RETURN. To end the command, press RETURN at the MText prompt.



Justify

Controls which part of the text boundary aligns at the insertion point. The option you select determines both text justification 
and text spill in relation to the text boundary. Justification controls whether text is aligned on the left, right, or center of the 
text boundary. Text spill controls how excess text flows from the insertion point. 

TL / TC / TR / ML / MC / MR / BL / BC / BR: Enter an option or press RETURN

For a complete description of each attachment option, see Justify (MTEXT). 

AutoCAD LT returns to the previous prompt.



Width

Specifies the width of the text boundary.

Object width: Specify a point or enter a value

MText: Enter characters or press RETURN 

AutoCAD LT wraps text within the text boundary. You can end a line of text at a specific point by typing the text and pressing 
RETURN. To end the command, press RETURN at the MText prompt.



2Points

Specifies the width of the text boundary using two points rather than a rectangular area.

First point: Specify a point

Second point: Specify a point

MText: Specify a point or enter a value

AutoCAD LT wraps text within the text boundary. You can end a line of text at a specific point by typing the text and pressing 
RETURN. To end the command, press RETURN at the MText prompt.



MVIEW Command
Up a Level          Related Topics

Creates floating viewports and turns on existing floating viewports 
When the TILEMODE system variable is set to 0 (off), the MVIEW command controls the creation and display of floating 
viewports.

 From the View menu, choose Floating Viewports
At the Command prompt, enter mview

ON / OFF / Hideplot / Fit / 2 / 3 / 4 / Restore / <First Point>: Enter an option or specify a point

In paper space, you can create as many viewports as desired, but only up to 15 viewports can be active. Objects in model 
space are visible only in active viewports. Viewports that are not active are blank. Use the On and Off options to control 
whether viewports are active or not.



For more information about using model space and paper space, see chapter 15, "Designing the Drawing Layout," in the 
AutoCAD LT User's Guide.

Commands: HIDE eliminates hidden lines from a 3D view of a drawing. MSPACE switches from paper space to a model 
space viewport. PSPACE switches from model space to paper space. VPORTS creates viewports when TILEMODE is set to
1 (on). VPLAYER sets the visibility for layers in specific viewports. ZOOM XP scales each view relative to paper space units.

System Variables: TILEMODE controls paper space access and viewport behavior. CVPORT sets the current viewport. 
PSLTSCALE controls paper space linetype scaling. VISRETAIN specifies precedence of settings for xref layers. MAXACTVP
specifies the maximum number of viewports to regenerate. DIMLFAC controls scaling for linear dimensions.



First Point

Specifies the first corners of a new rectangular viewport.



On

Makes a selected viewport active. An active viewport displays objects in model space. If you have more than 15 active 
viewports, you may have to turn one off to make another one active.



Off

Makes a selected viewport inactive. Objects in model space are not displayed in an inactive viewport. 



Hideplot

Removes hidden lines from a viewport during plotting from paper space. Circles, 2D solids, wide polyline segments, and 
extruded objects with nonzero thickness all act as opaque surfaces and can hide other objects behind them.

ON / OFF: Enter on or off

Select objects: Select one or more viewports



Fit

Creates one viewport that fills the available display area. The actual size of the viewport depends on the dimensions of the 
paper space view.



2

Divides the specified area horizontally or vertically into two viewports of equal size.

Horizontal / <Vertical>: Enter h or v, or press RETURN

Fit/ <First Point>: Specify a point or enter f

The point specifies the first corner of a rectangular area to be filled by the new viewports. Choose Fit to fill the entire 
graphics area.



3

Divides the specified area into three viewports.

Horizontal / Vertical / Above / Below / Left / <Right>: Enter an option or press RETURN

The Horizontal and Vertical options split the specified area into thirds. The other options split the area into three viewports: 
one large viewport and two smaller ones. The Above, Below, Left, and Right options specify where the larger viewport is 
placed. 

Fit/ <First Point>: Specify a point or enter f

The point specifies the first corner of a rectangular area to be filled by the new viewports. Choose Fit to fill the entire 
graphics area.



4

Divides the specified area horizontally and vertically into four viewports of equal size.

Fit/ <First Point>: Specify a point or enter f

The point specifies the first corner of a rectangular area to be filled by the new viewports. Choose Fit to fill the entire 
graphics area.



Restore

Restores viewport configurations saved using the VPORTS command.

? / Name of window configuration to insert <*ACTIVE>: Enter ?, enter a name, or press RETURN

Fit/ <First Point>: Specify a point or enter f

The point specifies the first corner of a rectangular area to be filled by the new viewports. Choose Fit to fill the entire 
graphics area.



NEW Command
Up a Level          Related Topics

Creates a new drawing file
 

From the Standard toolbar, choose 

From the File menu, choose New
 At the Command prompt, enter new

AutoCAD LT displays the Create New Drawing dialog box.



For additional information, you can choose More Info in the dialog box for each of these three methods. More Info includes 
the command equivalents for each option and chapter references to the AutoCAD LT User’s Guide.

System Variables: The FILEDIA system variable controls whether the Create New Drawing dialog box appears when you 
enter the New command.

Environment Variables: The NoStartUpDialog environment variable in the aclt.ini file controls whether the Start Up dialog 
box appears when you first start AutoCAD LT. The Measure environment variable in aclt.ini controls the default drawing 
settings, English or metric, and can also be set from the Preferences dialog box. 



Create New Drawing Dialog Box (NEW)
Up a Level

Use a Wizard
If you want to set up a drawing using a dialog box, choose Use a Wizard. You can choose from two wizards: Quick Setup 
and Advanced Setup.

Quick Setup. Choose the Quick Setup wizard to set up the drawing area and change settings, such as text height 
and snap spacing, to an appropriate scale.

Advanced Setup. Choose the Advanced Setup wizard to set up the drawing area and change settings, such as text
height and snap spacing, to an appropriate scale. You can also establish basic layout features.

Use a Template
If you want to start a drawing based on a template drawing, choose Use a Template.

Template Drawing. Choose template drawing is a drawing file as a starting point for new drawings. It stores all the
settings for a drawing and may also include predefined layers, dimension styles, and views. Template drawings are 
distinguished from other drawing files by a different file extension, .dwt. They are normally kept in the template directory. 
Several template drawings are included with AutoCAD LT. You can make additional template drawings by changing the 
extensions of drawing file names to have a .dwt.

Start from Scratch
If you want to begin drawing quickly using default English or metric settings, choose Start From Scratch.

Instructions
If you want a brief description of each of the methods for starting a new drawing, choose Instructions.



Quick Setup Step 1: Units
Select the format in which you want to display units of measure.

Select the format in which you want to enter and display coordinates and measurements. Several measurement styles are 
available in AutoCAD LT. Two of them, “Engineering” and “Architectural,” have a specific base unit (inches) assigned to 
them. You can choose from other measurement styles that can represent any convenient unit of measurement:

 Decimal. Select to display measurements in decimal notation.
 Engineering. Select to display measurements in feet and decimal inches.
 Architectural. Select to display measurements in feet, inches, and fractional inches.
 Fractional. Select to display measurements in mixed number (integer and fractional) notation.
 Scientific. Select to display measurements in scientific notation (numbers expressed in the form of the product of 

a decimal number between 0 and 10 and a power of 10).

You control the precision displayed in all measurements from the Advanced Setup wizard or with the DDUNITS command.



Quick Setup Step 2: Area
Enter the approximate width and length in full-scale units of what you plan to draw. This limits the area of the drawing 
covered by grid dots when the grid is turned on. It also adjusts several default settings, such as text height, linetype scaling, 
and snap distance, to convenient values. You can also adjust these settings, individually, from the Format menu later in the 
drawing session.



Quick Setup
Up a Level

Step 1: Units
Select the format in which you want to display units of measure.

Select the format in which you want to enter and display coordinates and measurements. Several measurement styles are 
available in AutoCAD LT. Two of them, “Engineering” and “Architectural,” have a specific base unit (inches) assigned to 
them. You can choose from other measurement styles that can represent any convenient unit of measurement:

 Decimal. Select to display measurements in decimal notation.
 Engineering. Select to display measurements in feet and decimal inches.
 Architectural. Select to display measurements in feet, inches, and fractional inches.
 Fractional. Select to display measurements in mixed number (integer and fractional) notation.
 Scientific. Select to display measurements in scientific notation (numbers expressed in the form of the product of 

a decimal number between 0 and 10 and a power of 10).

You control the precision displayed in all measurements from the Advanced Setup wizard or with the DDUNITS command.

Step 2: Area
Enter the approximate width and length in full-scale units of what you plan to draw. This limits the area of the drawing 
covered by grid dots when the grid is turned on. It also adjusts several default settings, such as text height, linetype scaling, 
and snap distance, to convenient values. You can also adjust these settings, individually, from the Format menu later in the 
drawing session.



Advanced Setup Step 1: Units
Select the format in which you want to enter and display coordinates and measurements. Several measurement styles are 
available in AutoCAD LT. Two of them, “Engineering” and “Architectural”, have a specific base unit assigned to them 
(inches). You can choose from other measurement styles that can represent any convenient unit of measurement:

Decimal. Select to enter and display measurements in decimal notation.
Engineering. Select to enter and display measurements in feet and decimal inches.
Architectural. Select to enter and display measurements in feet, inches, and fractional inches.
Fractional. Select to enter and display measurements in mixed number (integer and fractional) notation.
Scientific. Select to enter and display measurements in scientific notation (numbers expressed in the form of the 

product of a decimal number between 0 and 10 and a power of 10).

The precision that you specify controls the number of decimal places or fractional size to which you want linear 
measurements displayed.



Advanced Setup Step 2: Angles
Select the format in which you want to enter and display angles:

Decimal Degrees. Select to enter and display partial degrees as decimals.
Deg/Min/Sec. Select to enter and display partial degrees as minutes and seconds.
Grads. Select to enter and display angles as grads.
Radians. Select to enter and display angles as radians.
Surveyor. Select to enter and display angles in surveyor units.



Advanced Setup Step 3: Angle Measure
Select the direction of the zero angle for the entry of angles:

East. Select to specify the compass direction east as the zero angle.
North. Select to specify the compass direction north as the zero angle.
West. Select to specify the compass direction west as the zero angle.
South. Select to specify the compass direction south as the zero angle.
Other. Select to specify a direction different from the points of the compass as the zero angle.



Advanced Setup Step 4: Angle Direction
Select the direction to enter and display positive angle values: counterclockwise or clockwise.



Advanced Setup Step 5: Area
Enter the approximate width and length of what you plan to draw in full-scale units. This limits the area of the drawing 
covered by grid dots when the grid is turned on. It also adjusts several default settings, such as text height, linetype scaling, 
and snap distance, to convenient values. You can also adjust these settings, individually, from the Format menu later in the 
drawing session.



Advanced Setup Step 6: Title Block
Select the description of an AutoCAD LT drawing file of a title block to insert as a symbol in your new drawing. You can add 
or remove drawing files of title blocks from the list with the Add and Remove buttons. You can also include text at the outside
edge of your title block to record the license name, date, time, and drawing file name by checking the Date Stamp box.



Advanced Setup Step 7: Layout
Select Yes to use advanced paper space layout capabilities in AutoCAD LT. Paper space is often used to create complex 
multiple-view drawings. Select No to use model space only. For additional information on paper space, select the What Is 
Paper Space? button on the wizard or the concept topic Overview: Laying out a drawing with multiple views.

If you selected Yes to use paper space, you have three choices of where you want to begin working:

Work on my drawing while viewing the layout. (You can see paper space but all commands apply to model space 
only.)

Work on my drawing without the layout visible. (All commands apply to model space only, paper space is not 
displayed.)

Work on the layout of my drawing. (All commands apply to paper space only, you can see objects in model space.)

After completing the wizard, you can change these settings by double-clicking the Tile and Model/Paper buttons on the 
status bar.



Advanced Setup 
Up a Level

Step 1: Units
Select the format in which you want to enter and display coordinates and measurements. Several measurement styles are 
available in AutoCAD LT. Two of them, “Engineering” and “Architectural”, have a specific base unit assigned to them 
(inches). You can choose from other measurement styles that can represent any convenient unit of measurement:

Decimal. Select to enter and display measurements in decimal notation.
Engineering. Select to enter and display measurements in feet and decimal inches.
Architectural. Select to enter and display measurements in feet, inches, and fractional inches.
Fractional. Select to enter and display measurements in mixed number (integer and fractional) notation.
Scientific. Select to enter and display measurements in scientific notation (numbers expressed in the form of the 

product of a decimal number between 0 and 10 and a power of 10).

The precision that you specify controls the number of decimal places or fractional size to which you want linear 
measurements displayed.

Step 2: Angles
Select the format in which you want to enter and display angles:

Decimal Degrees. Select to enter and display partial degrees as decimals.
Deg/Min/Sec. Select to enter and display partial degrees as minutes and seconds.
Grads. Select to enter and display angles as grads.
Radians. Select to enter and display angles as radians.
Surveyor. Select to enter and display angles in surveyor units.

Step 3: Angle Measure
Select the direction of the zero angle for the entry of angles:

East. Select to specify the compass direction east as the zero angle.
North. Select to specify the compass direction north as the zero angle.
West. Select to specify the compass direction west as the zero angle.
South. Select to specify the compass direction south as the zero angle.
Other. Select to specify a direction different from the points of the compass as the zero angle.

Step 4: Angle Direction
Select the direction to enter and display positive angle values: counterclockwise or clockwise.

Step 5: Area
Enter the approximate width and length of what you plan to draw in full-scale units. This limits the area of the drawing 
covered by grid dots when the grid is turned on. It also adjusts several default settings, such as text height, linetype scaling, 
and snap distance, to convenient values. You can also adjust these settings, individually, from the Format menu later in the 
drawing session.

Step 6: Title Block
Select the description of an AutoCAD LT drawing file of a title block to insert as a symbol in your new drawing. You can add 
or remove drawing files of title blocks from the list with the Add and Remove buttons. You can also include text at the outside
edge of your title block to record the license name, date, time, and drawing file name by checking the Date Stamp box.

Step 7: Layout
Select Yes to use advanced paper space layout capabilities in AutoCAD LT. Paper space is often used to create complex 
multiple-view drawings. Select No to use model space only. For additional information on paper space, select the What Is 
Paper Space? button on the wizard or the concept topic Overview: Laying out a drawing with multiple views.

If you selected Yes to use paper space, you have three choices of where you want to begin working:

Work on my drawing while viewing the layout. (You can see paper space but all commands apply to model space 



only.)
Work on my drawing without the layout visible. (All commands apply to model space only, paper space is not 

displayed.)
Work on the layout of my drawing. (All commands apply to paper space only, you can see objects in model space.)

After completing the wizard, you can change these settings by double-clicking the Tile and Model/Paper buttons on the 
status bar.



OFFSET Command
Up a Level          Related Topics

Creates concentric circles, parallel lines, and parallel curves
The OFFSET command creates a new object at a specified distance from an existing object or through a specified point. 

   

From the Modify toolbar, choose 
   From the Modify menu, choose Offset
 At the Command prompt, enter offset

Offset distance or Through <current>: Specify a distance, enter t, or press RETURN



For more information, see "Offsetting Objects" in chapter 9 of the AutoCAD LT User's Guide.

Commands: COPY duplicates objects. 

System Variables: OFFSETDIST stores the current offset value.



Offset Distance (OFFSET)
Up a Level

Creates an object at a specified distance from an existing object.

Select object to offset: Select one object 

Side to offset?: Specify a point (1) on the side of the object you want to offset

           

        

AutoCAD LT repeats the two prompts, enabling you to create multiple offset objects. To end the command, press RETURN 
at the Select Object To Offset prompt.



Through (OFFSET)
Up a Level

Creates an object passing through a specified point.

Select object to offset: Select one object 

Through point: Specify a point (1) through which you want the offset object to pass

         

          

AutoCAD LT repeats the two prompts, enabling you to create multiple offset objects. To end the command, press RETURN 
at the Select Object To Offset prompt.



OOPS Command
Up a Level          Related Topics

Restores erased objects
   

From the Modify toolbar, choose 
 

At the Command prompt, enter oops

The OOPS command restores objects erased by the last ERASE command.

You can also use OOPS after BMAKE, BLOCK, or WBLOCK because these commands erase the selected objects after 
creating a block.



Commands: U reverses the effect of the previous command. UNDO reverses the effect of multiple commands and provides 
control over the undo feature.



'ORTHO Command
Up a Level          Related Topics

Constrains cursor movement
In Ortho mode, cursor movement is constrained to the horizontal or vertical directions (relative to the UCS) and with the 
current grid rotation angle.

 From the Status Bar, choose Ortho
At the Command prompt, enter ortho

ON / OFF <current>: Enter on or off, or press RETURN

In the example, a line is drawn using Ortho mode. Point 1 is the first point specified, and point 2 is the position of the cursor 
when the second point is specified.

AutoCAD LT uses Ortho mode when you specify an angle or distance by using a pointing device, but Ortho mode does not 
affect keyboard point entry. AutoCAD LT ignores Ortho mode in perspective views.

AutoCAD LT defines horizontal as being parallel to the X axis of the UCS, and vertical as being parallel to the UCS Y axis. 
Changing SNAP rotation adds an additional rotation with respect to the UCS.

      



For more information, see "Using Ortho Mode" in chapter 7 of the AutoCAD LT User's Guide. 

Commands: DDRMODES sets Ortho mode on or off using the Drawing Aids dialog box. SNAP aligns points entered by a 
pointing device. UCS manages user coordinate systems.

System Variables: ORTHOMODE stores the Ortho mode setting.



Object Snaps
Up a Level        

Sets an object snap for a single point
With Object snaps, you can specify a point at an exact location on an object. Each object snap determines a different type of
location. Object snaps stay in effect only for a single point at a time.

 From the Standard toolbar, choose

 From the cursor menu, choose an object snap name
On the command line at any prompt for a point, enter an object 
snap name

You can specify the following object snaps.

Endpoint Tangent
Midpoint Node

Intersection

Insertion

Center Nearest
Quadrant None

Perpendicular

If you want object snaps to stay in effect until you turn them off, set Running Object Snap modes with the DDOSNAP 
command.



Cursor Menu

To access the cursor menu, hold down Shift and click the return button on your pointing device. 



'OSNAP Command
Up a Level          Related Topics

Sets running Object Snap modes
By using an object snap mode, you can specify a point at an exact location on an object. A running object snap mode stays 
in effect until you turn it off or enter another mode. The OSNAP command changes the running object snap modes on the 
command line. To change modes in a dialog box, see DDOSNAP.

 From the Options menu, choose Running Object Snap

 At the Command prompt, enter osnap

Object snap modes: Enter a name list, enter none or off, or press RETURN 

Specify one or more object snap modes by entering at least the first three characters of the name. If you enter more than 
one name, separate the names with commas. AutoCAD LT provides the following object snap modes:

Endpoint Tangent
Midpoint Node

Intersection

Insertion

Center Nearest

Quadrant

None

Perpendicular

Endpoint

Snaps to the closest endpoint of an arc, elliptical arc, line, spline, polyline segment, and ray, the closest corner of a 2D solid, 
and the location on a dimension object.



Midpoint

Snaps to the midpoint of an arc, ellipse, elliptical arc, line, spline, polyline segment, 2D solid, xline, arc segment of a 
polyline, and location on a dimension object.



Intersection

Snaps to the intersection of two objects, including arcs, circles, ellipses, elliptical arcs, lines, 2D solids, polylines, rays, 
splines, xlines, and locations on a dimension objects. 



Center

Snaps to the center of an arc, circle, ellipse, elliptical arc, arc segment of a polyline, and location on a dimension object.



Node

Snaps to a point object and to dimension points. 



Quadrant

Snaps to a quadrant point of an arc, circle, ellipse, elliptical arc, arc segment of a polyline, and location on a dimension 
object.



Insertion

Snaps to the insertion point of an attribute, a block, or text.



Perpendicular

Snaps to a point perpendicular to an arc, circle, ellipse, elliptical arc, line, polyline, ray, solid, spline, xline, and location on a 
dimension object.



Tangent

Snaps to the tangent of an arc, circle, ellipse, elliptical arc, and location on a dimension object.



Nearest

Snaps to the nearest point on an arc, circle, ellipse, elliptical arc, line, point, polyline, spline, xline, and location on a 
dimension object.



None

Turns off running Object Snap mode. 



Commands: APERTURE controls the size of the object snap target box. DDOSNAP sets running Object Snap modes from 
a dialog box. 

System Variables: OSMODE stores the Object Snap mode setting.



'PAN Command
Up a Level          Related Topics

Moves the drawing display in the current viewport
The PAN command works in two ways. You can specify a single coordinate, indicating the relative displacement of the 
drawing with respect to the screen, or more commonly you can specify two points, in which case AutoCAD LT computes the 
displacement of the view from the first point to the second point.

You can use PAN transparently except while in paper space, during a VPOINT or DVIEW command, or while another 
ZOOM, PAN, or VIEW command is in progress.

 

From the Standard toolbar, choose 
 From the View menu, choose Pan, then Pan Point

At the Command prompt, enter pan

Displacement: Specify a point (1)

Second point: Press RETURN or specify a point (2)

If you press RETURN, AutoCAD LT moves the drawing the same distance and direction from the current location as the 
displacement point was from the UCS origin (0,0). 

If you specify a second point, AutoCAD LT shifts the view by the distance and angle defined by the two points.

      



For more information, see "Panning" in chapter 8 of the AutoCAD LT User's Guide. 

Commands: DVIEW creates and restores views. VIEW saves and restores named views. VPOINT sets the viewing 
direction for a 3D visualization of the current drawing. ZOOM increases or decreases the apparent size of objects in the 
current viewport. RTPAN moves the view of the drawing in real time. RTZOOM increases or decreases the apparent size of 
objects in real time.



PASTECLIP Command
Up a Level          Related Topics

Inserts data from the Windows Clipboard
You can paste AutoCAD LT objects, text, and various file formats such as metafile, bitmap, and multimedia into a drawing.

 
From the Standard toolbar, choose 

 From the Edit menu, choose Paste
At the Command prompt, enter pasteclip

If the Clipboard contains a graphic object, AutoCAD LT inserts the object in the upper-left corner of the graphics area. If the 
Clipboard contains text, AutoCAD LT inserts the text in the upper-left corner of the graphics area using the MTEXT 
command prompt defaults. Pasted text becomes an MText object. 

All other objects, except AutoCAD LT objects, exist as embedded or linked objects in their Clipboard formats. You can edit 
these embedded or linked objects by double-clicking on them in AutoCAD LT; the object's native application becomes 
available so that you can make changes.



For more information, see chapter 17, "Exchanging Data with Other Applications," in the AutoCAD LT User's Guide.

Commands: DDINSERT inserts a block by using a dialog box. INSERT inserts a block by using the command line. MTEXT 
creates multi-line paragraphs. PASTESPEC inserts data from the Windows Clipboard and controls the format of the pasted 
data.



PASTESPEC Command
Up a Level          Related Topics

Inserts data from the Windows Clipboard and controls the format of the data
AutoCAD LT supports the Windows feature object linking and embedding (OLE). When an object is inserted into an 
AutoCAD LT drawing from an application that supports OLE, the object can maintain a connection to its source file.

The PASTESPEC command inserts a linked or embedded object from the Clipboard into an AutoCAD LT drawing.

   From the Edit menu, choose Paste Special
 

At the Command prompt, enter pastespec

The Paste Special dialog box is displayed.



Paste Special Dialog Box
Up a Level

Source
Displays the name of the application that created the data and the type of file from which the data is being pasted.

Paste
Pastes the contents of the Clipboard into the current drawing.

Paste Link
Pastes the contents of the Clipboard into the current drawing and creates an OLE link to the original file.

As
Displays the formats in which you can paste the contents of the Clipboard into the current drawing.

Convert
Converts Windows metafile (file extension .wmf) graphics in the Clipboard into AutoCAD LT objects. If the graphics are not 
converted, the metafile is displayed as an OLE object.

Note: The Convert option is available only if the contents of the Clipboard is a Windows metafile object.

Display as Icon
Inserts a picture of the application icon instead of the data. To view or edit the data, double-click the icon.



For more information, see "Linking Information to AutoCAD LT Drawings" in chapter 17 of the AutoCAD LT User's Guide.

Commands: COPYCLIP copies objects to the Clipboard. COPYLINK copies the current view to the Windows Clipboard for 
linking to other OLE applications. CUTCLIP copies selected objects to the Clipboard and erases the objects from the 
drawing. PASTECLIP inserts data from the Clipboard into a drawing.



PLAN Command
Up a Level          Related Topics

Displays the plan view of a User Coordinate System
The PLAN command provides a convenient means of viewing the drawing from plan view, the XY plane of the UCS (0,0,1). 
You can select a plan view of the current UCS, a previously saved UCS, or the World Coordinate System. PLAN affects the 
view in the current viewport only. You cannot use PLAN in paper space.

 From the View menu, choose 3D Viewpoint, then Plan View
At the Command prompt, enter plan

<Current UCS> / Ucs / World      Enter an option or press RETURN

AutoCAD LT changes the viewing direction and turns off perspective and clipping; the current UCS does not change. Any 
coordinates entered or displayed subsequent to the PLAN command remain relative to the current UCS.

      

      



Current UCS

Regenerates a plan view of the display so that the drawing extents fit in the current viewport of the current UCS. 



UCS

Changes to a plan view of a previously saved UCS and regenerates the display. AutoCAD LT requests the name of the UCS 
you want; you can enter ? to request a list of saved coordinate systems.



World

Regenerates a plan view of the display so that the drawing extents fit on the screen of the World Coordinate System.



For more information, see "Setting a Viewing Direction" in chapter 11 of the AutoCAD LT User's Guide. 



PLOT Command
Up a Level          Related Topics

Prints to a plotter, printer, or file
 

From the Standard toolbar, choose 
 From the File menu, choose Print

At the Command prompt, enter plot

The Plot Configuration dialog box is displayed.

When the CMDDIA system variable is set to 0 (off), AutoCAD LT displays PLOT prompts on the command line. When you 
use a script to plot, the command line prompts are displayed regardless of the CMDDIA settings.

When you are plotting from the command line, the FILEDIA system variable controls whether AutoCAD LT displays a dialog 
box at a prompt for a file name.

Multipen Plotting with a Single-Pen Plotter
If you're using a single-pen plotter and your system is configured to plot different colors with different pens (as described in 
the AutoCAD LT Installation Guide), AutoCAD LT pauses when necessary during the plot and issues prompts similar to 
these:

Install pen number 2, color 3 (green)      Change the pen

Press RETURN to continue: Press RETURN to resume plotting



For more information about configuring plotters with these kinds of options, see chapter 16, “Plotting Your Drawing,” in the 
AutoCAD LT User’s Guide.



Plot Configuration Dialog Box
Up a Level

Sets options for printing and plotting. Choose OK to begin plotting with the current settings.
Setup and Default Information 
Pen Parameters 
Additional Parameters 
Paper Size and Orientation 
Scale, Rotation, and Origin 
Plot Preview 



Setup and Default Information (Plot Configuration Dialog Box)
Up a Level        

Printer Name
Displays the current plotting device. 

Print / Plot Setup and Default Selection
Displays the Print/Plot Setup and Default Selection dialog box, in which you can control the setup for your plotter and save 
and retrieve default settings from an ASCII plot configuration parameters file (extension .pcp).



Pen Parameters (Plot Configuration Dialog Box)
Up a Level          

Controls pen parameters for plotters with multiple pens, hardware linetypes, software-controlled pen speeds, and pen 
widths. 

Each object in a drawing has a color associated with it. Depending on the plotter, you can plot each color with a different 
pen, linetype, speed, and pen width.

Some plot devices, such as laser or electrostatic printers, can plot lines of various widths. These widths are sometimes 
called line widths or line weights. Although some plot devices, such as printers, do not have physical pens, AutoCAD LT 
uses pen width assignments for line widths or line weights.

Pen Assignments
Displays the Pen Assignments dialog box, in which you can set the pen number, hardware linetype, speed, and pen width 
associated with each AutoCAD LT color. 

Optimization
Displays the Optimizing Pen Motion dialog box, in which you can choose settings to minimize wasted pen motion and 
reduce plot time. 



 Additional Parameters (Plot Configuration Dialog Box)
Up a Level

Specifies which rectangular area of the drawing will be plotted and how hidden lines and area fills will be handled. Also 
specifies plotting to a file.

The View and Window options are not available unless you have selected a view or defined a window, respectively.

When you specify any rectangular area option except View, AutoCAD LT applies the rectangular area to the current viewport
and the current space, whether it's model or paper space. AutoCAD LT creates the plot from the 3D viewpoint most recently 
established in the current space.

A paper space plot includes all visible viewports and their contents. Viewports that have been turned off are not plotted. The 
MAXACTVP system variable is ignored. If a viewport is on and within the plottable paper space view, it's plotted.

Display
Extents
Limits
View
Window
Hide Lines
Adjust Area Fill
Dithering
Use Previous Printer
Plot To File



Display

Plots the view in the current viewport.



Extents

Plots the portion of the current space of the drawing that contains objects. 

The drawing extents expand automatically as you draw new objects, but when you use such editing commands as ERASE, 
MOVE, or SCALE    AutoCAD LT does not recognize the reduced extents until you next use ZOOM All or ZOOM Extents. 
Thus, it's wise to use ZOOM Extents before using the PLOT Extents option. 

If you plot the drawing’s extents with a perspective view active and the camera position is within the drawing extents, 
AutoCAD LT proceeds as though you had used the Display option. 



Limits

Plots the entire drawing area defined by the drawing limits. If the current viewpoint is not the plan view (viewpoint 0,0,1), 
AutoCAD LT proceeds as though you had used the Extents option. 



View

Plots a view saved previously with the VIEW command. This option is not available until you select a view. To select a view, 
click the View button at the bottom of the Additional Parameters area to display the View Name dialog box. 

The View Name dialog box displays a list of previously saved views. Select the view you want to plot.



Window

Plots any portion of the drawing. This option is not available until you define a window. 

To define a window, click the Window button at the bottom of the Additional Parameters area to display the Window 
Selection dialog box.



Hide Lines

Plots model space views with hidden lines removed. 

When plotting from paper space, AutoCAD LT processes each viewport for hidden lines according to that viewport's Hideplot
setting. The Hideplot option of the MVIEW command does not affect plots made from model space. Hidden lines will be 
removed in a model space plot only if you select the Hide Lines options. 



Adjust Area Fill

Adjusts the pen width for plotting wide polylines and solids. AutoCAD LT pulls the boundaries of the filled region inward one-
half the pen width. Use this option to ensure the greatest possible precision. 

This option is needed only where the plot must be accurate to half the pen width, such as in printed circuit artwork. 



Plot to File

Plots output to a file rather than directly to the plotter. The default plot file name is the drawing name with a .plt extension. 

To specify a name other than the default name, choose File Name to display the Create Plot File dialog box. If the current 
drawing is unnamed, AutoCAD LT creates a plot file using the file name unnamed.plt. To specify an extension other than .plt,
include the extension with the file name. For example, you can enter mpart.hp. 

The plot commands for the current configured plotter are sent to the named file. 

For some plotters, the output format you choose determines whether the plot is written to a file and determines the file 
extension. Also, some plotters may not be able to plot to file. 



Dithering

Simulates more colors than your printer actually supports by mixing colors and white space to create the effect of a new 
color. By default, AutoCAD LT uses dithered output for raster printers. The Windows printer driver has its own control over 
dithering.



Use Previous Printer

Plots your drawings on a plotter without changing the default printer you use for word processing. If you select a system 
printer, you can also use any printer or plotter configured for Windows without changing the default printer in the Windows 
Control Panel. To use the same plotter the next time you plot, you can select the Use Previous Printer option. 



 Paper Size and Orientation (Plot Configuration Dialog Box)
Up a Level

Specifies units for plot size, the paper size, and the orientation.

The Orientation icon displays either landscape or portrait mode depending on the configured device. If your current plotter's 
orientation is portrait, it might be necessary to rotate the plot 270 degrees to achieve the result you want. See Scale, 
Rotation, and Origin for more information on rotating a plot.

Inches
Specifies inches as the plotting units.

MM
Specifies millimeters as the plotting units. 

Size
Displays the Paper Size dialog box. 



Scale, Rotation, and Origin (Plot Configuration Dialog Box)
Up a Level

Sets the scale, rotation, and origin of the plot. If you are plotting a perspective view, you cannot specify a scale. Select 
Scaled to Fit and use the paper size to control the overall size of the plot.

Rotation and Origin
Displays the Plot Rotation and Origin dialog box.

Plotted <> = Drawing Units
Sets the plot scale. The label Plotted Inches = Drawing Units reflects the units previously chosen for paper size (millimeters 
or inches). When millimeters are the chosen units, the label reads Plotted MM = Drawing Units.

To specify an exact scale for the plot, determine the number of drawing units to be plotted per millimeter or inch on the 
paper. Then enter the number of plotter units in the left text box of the Scale, Rotation, and Origin dialog box and the number
of drawing units in the right text box.

Scaled to Fit
Scale the plot so that the portion of the drawing to be plotted is as large as possible for the specified paper size. The text 
boxes display the actual scale used to fit. AutoCAD LT updates this scale whenever you make any entry that affects the 
scale. 

Clear this option to have AutoCAD LT default to 1=1. When the scale has been previously set to other values, AutoCAD LT 
uses that scale and displays it in the text boxes. Here are some examples of what you might enter: 

2.5=1. Could represent 2.5 millimeters = 1 kilometer.
1/4"=1'. Represents 1/4 inch = 1 foot, when units are in feet and inches.
0.25=12. Represents the same scale as in the previous example when units are decimal.



 Plot Preview (Plot Configuration Dialog Box)
Up a Level

Preview
Displays the Preview Effective Plotting Area, which displays the plot on the screen so you can check the correct location on 
the paper. You must select Partial or Full.

Partial
Quickly shows an accurate representation of the effective plot area relative to the paper size. Partial preview also gives 
advance notice of any warnings that you might encounter when AutoCAD LT plots. The final location of the effective area on 
the paper depends on the plotter.

After selecting Partial, choose Preview to display the Preview Effective Plotting Area dialog box.

When you define a positive or negative origin in the Plot Rotation and Origin dialog box, AutoCAD LT offsets the device 
origin from the lower-left corner. If you offset the origin so much that the effective area extends outside the graphic area of 
the preview area, AutoCAD LT displays a green line along any clipped side.

The Rotation icon represents the origin of the drawing. When rotation is set to 0 (the default), it appears in the lower-left 
corner; 90 degrees, in the upper-left; 180 degrees, in the upper-right; and 270 degrees, in the lower-right. This icon indicates
the orientation of the drawing as defined by the rotation setting. 

Full
Displays the drawing on the screen as it will appear when plotted on paper. Because this requires a regeneration of the 
drawing, it's slower than a partial preview. It's faster than the normal plot regeneration because AutoCAD LT performs no 
vector sorting or optimization.

Full preview includes a dynamic pan and zoom feature.



Print / Plot Setup and Default Selection Dialog Box
Up a Level

Select Device
Displays the manufacturer of the current plotting device and the port to which the device is connected.

The list box displays descriptions of all the configured plotters. Selecting another option can change the settings of other 
parameters in the plotting dialog boxes. This box also lists several formats that can be used by other applications. If you plot 
to a file in one of these formats, you can then open that file using another graphics or imaging program.

File Defaults
Saves or gets defaults from an ASCII plot configuration parameters file (extension .pcp). 

Save Defaults to File
Displays the Save to File dialog box, in which you can save the default settings to a new or existing file. 

Get Defaults from File
Displays the Obtain from File dialog box, in which you can retrieve the default settings from a PCP file. 

Show Device Requirements
Displays the Show Device Requirements dialog box, which displays configuration information about the current plotter or the
file type you have created.

Print/Plot Setup
Displays the Print/Plot Setup dialog box.



Pen Assignments Dialog Box
Up a Level

Select the entry or entries to modify from the list box, which shows the current page settings. To deselect an entry, select it 
again.

Modify Values
Modifies parameters for pen, linetype, speed, and width.

Color
Pen
Ltype
Speed
Width

Feature Legend
Displays the Feature Legend dialog box, which lists any available hardware linetypes, speeds, or pen widths. 

Use hardware linetypes only for objects drawn with the CONTINUOUS linetype. Don't try to mix these hardware linetypes 
with the linetypes associated with objects in the drawing.

Pen Width
Specifies line width to instruct AutoCAD LT how many lines are required to fill a solid area. Some devices that don't have 
physical pens rely on AutoCAD LT to fill solid areas with lines. The Pen Width option is not available for some plot devices.



Color

Displays the assigned AutoCAD LT color. When you select multiple entries, AutoCAD LT displays a message that the color 
varies. The values in the text boxes are always those of the lowest color number you selected.



Pen

Displays the pen number assigned to the current color. You can assign different pen numbers to different colors even for 
single-pen plotters. 



Ltype

Displays the linetype assigned to the current color. The linetypes available for your current plotter are displayed when you 
choose Feature Legend. 



Speed

Displays the speed assigned to the current color. You can choose speed on a pen-by-pen basis. This option can be useful if, 
for example, you have a pen that skips when it moves too fast. Some devices have specific speeds that you can assign; this 
information is listed in the Feature Legend dialog box.



Width

Displays the line width assigned to the current color. 

Raster printers: Determines the line width for devices that do not have physical pens. Devices capable of filling solid areas 
use pen widths to determine line width. 

Pen plotters: Provides the width of the pen tip for devices with physical pens. The width governs how much work AutoCAD 
LT must do to fill a solid or wide polyline and eliminates unnecessary raising and lowering of the pen. If you've selected 
Inches in the Paper Size and Orientation area, be sure to convert millimeter pen widths to inches. If the pen width you enter 
is wider than the pen tip, AutoCAD LT might not raise the pen between closely spaced lines.



Print/Plot Setup Dialog Box
Up a Level

Controls other print format options.

Color Output
Select the preferred color display for the image you are saving to a file.

Enter Background Color
Enter the color value, from 0 to 255, of the background color for the image.

Printer
Name. Specifies the name of the configured printer.
Status. Displays status of selected printer.
Type. Displays type of device.
Where. Displays the printer location.
Comment. Displays location of device.

Paper
Size. Specifies paper size.
Source. Specifies paper source, such as upper paper tray.

Orientation
Portrait. Specifies portrait (vertical) orientation.
Landscape. Specifies landscape (horizontal) orientation.



Preview Effective Plotting Area Dialog Box
Up a Level

Displays a view box that represents the viewport. You can shrink or enlarge the view box and move it around the effective 
area of the preview to check information on drawings before plotting.

Paper Size
Displays paper size.

Effective Area
Displays size of the area occupied by the objects in the drawing.

Warnings
Gives advance notice of any warnings you might encounter when AutoCAD LT plots.



Plot Preview Dialog Box
Up a Level

Displays the drawing on the screen as it will appear when plotted on paper.

Pan and Zoom
Displays a view box representing the viewport. When the arrow is displayed, you can shrink or enlarge the view box. You 
can move it around the effective area of the preview to check information on drawings before plotting. Press the pick button 
on your pointing device to switch from panning to zooming. Press the Return button on your pointing device to display the 
new view.

End Preview
Ends the preview and returns to the Plot Configuration dialog box.



Plot Rotation and Origin Dialog Box
Up a Level

Controls plot location and rotation.

Plot Rotation
Select a rotation button to rotate the plot clockwise. The plot normally begins in the lower-left corner of the paper (the home 
position).

0
Select to keep the object in its original position.

90
Select to rotate the object clockwise 90 degrees. 

180
Select to rotate the object 180 degrees.

270
Select to rotate the object 270 degrees

Plot Origin
Enter the plot origin in the X Origin and Y Origin boxes to place the plot origin at another location on the paper. On some 
plotters you can use negative coordinates.



Optimizing Pen Motion Dialog Box
Up a Level

With the exception of the No Optimization check box, selecting each successive check box cumulatively adds that 
optimization level. For example, selecting Adds Elimination Of Overlapping Horizontal Or Vertical Vectors selects all 
preceding check boxes except No Optimization.

The default setting depends on the device configured.



Window Selection Dialog Box
Up a Level

Specifies a rectangular portion of the drawing.

Pick
Choose Pick and use the pointing device to designate the window if the area you want to specify is completely visible on the 
screen. 

You can also specify the window by entering X and Y coordinates in the First Corner and Other Corner boxes. 

First Corner
X Enter X value of coordinate.

Y Enter Y value of coordinate.

Other Corner
X Enter X value of coordinate.

Y Enter Y value of coordinate.



Obtain from File Dialog Box
Up a Level

Retrieves plot settings stored in files.

File Name
Select or enter the name of the file from which you want to retrieve the settings. 

Save File as Type
Select the type of file you want to see in the File Name list.

Directories
Select the directory from which you want to obtain the file. 

Drives
Select the drive from which you want to obtain the file. 

Find File
Locate any file from the specified drive and directory.

Network
Displays the Connect Network Drive dialog box, in which you can connect to a shared directory.



Save to File Dialog Box
Up a Level

File Name
Select or enter the name of the file you want to save.

Save File as Type
Select the type of file you want to see in the File Name list.

Directories
Select the directory where you want to save the file.

Drives
Select the drive where you want to save the file. 

Network
Displays the Connect Network Drive dialog box, in which you can connect to a shared directory.



Create Plot File Dialog Box
Up a Level

Saves plot settings to a file.

File Name
Select or enter the name of the file you want to create.

Save File as Type
Select or enter the type of file you want to see in the File Name list. The default is PCP.

Directories
Select the directory where you want to save the file.

Drives
Select the drive where you want to save the file. 

Network
Displays the Connect Network Drive dialog box, in which you can connect to a shared directory.



Paper Size Dialog Box
Up a Level

Specifies paper size.

Size, Width, Height
Lists the plot sizes the current plotter supports.

User
Specifies paper size. Select a predefined size or enter the width and height in a User text box.

Orientation Is
Displays orientation as landscape or portrait mode depending on the configured device.



PLOT (Command Line)
Up a Level          Related Topics

At the Command prompt, enter plot

When the CMMDIA system variable is set to 0 (off), AutoCAD LT displays prompts for the PLOT command on the command 
line.

What to plot -- Display, Extents, Limits, View, or Window <D>: Enter an option or press RETURN

Display. Plots the view in the current viewport.
Extents. Plots the portion of the current space of the drawing that contains objects. For more information, see 

Additional Parameters, Extents.
Limits. Plots the entire drawing area defined by the drawing limits. For more information, see Additional 

Parameters, Limits.
View. Plots a view saved previously with the VIEW command.

View name: Enter a name

Window. Plots any portion of the drawing. Specify two corners of the area you want to plot.

First corner: Specify a point

Other corner: Specify a point opposite the first point

AutoCAD LT displays the basic plot specifications for the current plot device or the previous plotting session and prompts for 
any changes.

Do you want to change anything? (No / Yes / File / Save) <N>: Enter an option or press RETURN



Changing Pen and Linetype Parameters (PLOT Command Line)
Up a Level

If after AutoCAD LT list the pen parameters you enter y at the prompt Do you want to change any of the above parameters?,
you can change pen and linetype parameters for the current plotter. Depending on the plotter being used, AutoCAD LT might
include displays and prompts for parameters such as pen number, linetype, pen speed, or line width (pen width).

In the following example, AutoCAD LT displays the pen number, linetype, pen speed, and line width currently assigned to 
color 1 and prompts for a new pen number.

Enter values, blank=Next , Cn=Color n, Sn=Show n, X=Exit

Layer Pen Line Pen Line

Color No. Type Speed Width

1 (red) 1 0 36 0.010          Pen number <1>:    Enter a value or a pen number

Besides entering a pen number, you can also use editing values. The first line of this display shows you the values you can 
enter. You can use these editing values at any of the prompts for pen number, linetype, pen speed, or pen width.

blank RETURN or SPACEBAR
c  n   
s  n   
x 

In this example, after you enter a pen number, AutoCAD LT prompts for a linetype, pen speed, and pen width (line width) for 
color 1.

1            (red)            1             0               36 0.010      Line type <0>: 

1            (red)            1             0               36 0.010      Pen speed <36>: 

1            (red)            1             0               36 0.010      Pen width <0.010>:

Enter a value or a number for linetype, pen speed, or pen width

AutoCAD LT then goes to color 2 and prompts for the same sequence of pen number, linetype, pen speed, and pen width.

You can skip from one color to another without answering all the parameter questions. To apply the change to the current 
color and all following colors, precede the new value with an asterisk (*). For example, if AutoCAD LT prompts for the pen 
number for color 4, you can select pen number 2 for colors 4 through 255 by entering *2, as in this example:

Layer Pen Line  Pen  Line

Color No. Type  Speed  Width

1      (red) 1     0       36  0.010      Pen number<1>: Press RETURN.

1      (red) 1     0       36  0.010      Linetype<0>: Enter 3

1      (red) 1     3       36  0.010      Pen speed<32>: Enter  *16

1      (red) 1     3       16  0.010      Pen width<0.010>: Enter    *.007

2      (yellow) 2     0       16  0.007      Pen number<2>: Enter  c6

6      (magenta) 6     0       16  0.007      Pen number<6>: Enter  5

6      (magenta) 5     0       16  0.007      Linetype<0>: Enter    x



 Remaining Plot Specifications (PLOT Command Line)
Up a Level

When you've completed or skipped the prompts for pen and linetype, AutoCAD LT prompts for the remaining plot 
specifications.

Write the plot to a file? <current>: Enter y or n or press RETURN

Some plotters always plot to a file and do not allow you to specify otherwise.

If you enter y, AutoCAD LT displays the following prompt after you've responded to all the plotting prompts:

Size units (Inches or Millimeters) <current>: Enter i or m or press RETURN

Plot origin in units <default X,Y>: Enter the plotter coordinates or press RETURN

If you selected inches as your size units, for example, entering 2,3 sets the plot origin to the point 2 inches to the right of and
3 inches above the home position. Some plotters can use negative coordinates.

AutoCAD LT lists the plotting sizes the current plotter can accommodate.

Enter the Size or Width,Height (in units) <MAX>: Enter a size mnemonic from the list or a specific width and height 
value, or press RETURN

If you enter a unique size by specifying the width and height of the paper, it appears with the label USER or USERn on the 
list for plotter sizes the next time you plot. Five user-defined sizes can be set.

If you enter a USERn mnemonic from the list, AutoCAD LT prompts again for the width and height.

Enter Width, Height (in Inches) <ww,hh>: Enter the width and height or press RETURN

Rotate plot clockwise 0/90/180/270 degrees <0>: Enter a value or press RETURN

If the current device is a single-pen plotter, AutoCAD LT prompts for the width of the pen tip or the line width of plotted lines.

Pen width in <units> <0.010>: Enter a value or press RETURN

If the current device is a multiple-pen plotter or raster printer, this prompt is not displayed.

Adjust area fill boundaries for pen width? <N> Enter y or press RETURN

If you enter y, AutoCAD LT adjusts for the pen width when plotting the boundaries of wide polylines and solids. For most 
applications, no adjustment is necessary.

Remove hidden lines? <N>: Enter y or press RETURN

Plotted units=Drawing units or Fit or ? <current>: Enter a specific scale, f, or ?, or press RETURN

Enter a specific scale by specifying how many drawing units are to be plotted per unit (millimeters or inches) on the paper. 
For example, to produce a plot at a scale of 1 drawing unit per millimeter on the plotter, enter 1=1. Here are some other 
examples of possible responses:

2.5=1. Could represent 2.5 millimeters = 1 kilometer.
1/4"=1. Represents 1/4 inch = 1 foot, when units are in feet and inches.
0.25=12. Represents the same scale as in the previous example when units are decimal.

If you enter f, AutoCAD LT scales the plot so the portion of the drawing to be plotted is made as large as possible for the 
specified paper size.

If you enter ?, AutoCAD LT displays a short description of the options.

Enter file name for plot <current>: Enter a file name or press RETURN

AutoCAD LT uses the file extension .plt, but you can enter a different extension. The plot commands for the current plotter 
are sent to the named file.

For more information, see Scale, Rotation, and Origin.



 No (PLOT Command Line)
Up a Level

Uses the stored basic plot specifications as configured.



 Yes (PLOT Command Line)
Up a Level

Changes any or all of the basic plot specifications. If multiple plotters are configured, AutoCAD LT prompts for a change of 
plotters.

Do you want to change plotters? <N>: Enter y or press RETURN

Pressing RETURN displays the current specifications for plotting parameters such as multiple pens, hardware linetypes, line
widths, software-controlled pen speeds, print density, and so on.

Entering y lists the configured plotters and prompts for a change of plotter.

Enter selection (number or description) <number>: Enter the plotter number or description, or press RETURN

After you enter the selection or press RETURN, AutoCAD LT returns to the main PLOT prompt.

What to plot -- Display, Extents, Limits, View, or Window <D>.

After displaying the current specifications for plotting parameters, AutoCAD LT prompts for changes in any of them. The 
information displayed depends on the currently configured plotter. For more information on these specifications, see Pen 
Parameters.

Do you want to change anything? (No/Yes/File/Save) <N>: Enter y or press RETURN

If you enter y, AutoCAD LT prompts you to change plotters and then lists the pen parameters.

Do you want to change any of the above parameters? <N> Enter y or press RETURN

If you enter y to change these parameters, see Changing Pen and Linetype Parameters.

If you enter RETURN, AutoCAD LT displays the remaining plot prompts. See Remaining Plot Specifications.



 File (PLOT Command Line)
Up a Level

Uses the plot settings in a plot configuration parameters file (extension .pcp). AutoCAD LT prompts for the file name.

Plotter configuration file name <default>: Enter a file name or press RETURN

The default is the name of the current drawing. An extension of .pcp is assumed. If the .pcp file you enter is found, AutoCAD 
LT reads it, displays any error or warning messages on the screen, and displays again the prompt Do you want to change 
anything?



 Save (PLOT Command Line)
Up a Level

Saves the current plot specifications to a plot configuration parameters file (extension .pcp). 

Plotter configuration file name <default>: Enter a file name or press RETURN

The default is the name of the current drawing. An extension of .pcp is assumed. If a .pcp file by that name already exists in 
the current directory, you can replace it or create a new one.

Do you want to replace it with a new one? <N> Enter y or press RETURN

Entering y to replace an existing file causes you to lose any comments in the original file. AutoCAD LT saves the pen and 
linetype parameters for every color as well as all the basic plot specifications. After saving the file, AutoCAD LT returns to the
prompt Do you want to change anything?



blank

Accepts the default and goes to the next parameter. When it reaches the last parameter for a color, AutoCAD LT goes to the 
next color. After color 255, AutoCAD LT goes back to color 1.



Cn

Goes to the Pen Number prompt for color number n. If you enter c without a number, AutoCAD LT goes to the next color. 
This is useful for selective changes. 

For example, to change the pen speed for color 5, enter c5 to move to the Pen number prompt for color 5. Then press 
RETURN twice to skip past the Pen Number and Line Type prompts.



Sn

Displays the updated color assignment table, then returns to the current prompt. To show color numbers beyond 16, include 
the number. 

For example, s200 shows the updated color assignment table beginning with color 200. To redisplay the table starting at 1, 
enter s.



x

Exits the pen parameters prompts and returns to the other plotting prompts.



For more information about plotting, see chapter 16, "Plotting Your Drawing," in the AutoCAD LT User's Guide. 

System Variables: The CMDDIA system variable controls the display of dialog boxes for a number of commands, including 
PLOT. The PLOTTER system variable stores the number for the current plotter. You can change to another configured 
plotter by using this variable. The PLOTID system variable stores a text string of the current plotter's description. You can 
change to another configured plotter by entering its full or partial description.



POLYGON Command
Up a Level          Related Topics

Creates an equilateral closed polyline
A polygon is a polyline object. AutoCAD LT draws polylines with zero width and no tangent information. You can use the 
PEDIT command to change these values.

 

From the Draw toolbar, choose 

From the Draw menu, choose Polygon, then Polygon
At the Command prompt, enter polygon

Number of sides <current>: Enter a value between 3 and 1024 or press RETURN

Edge / <Center of polygon>: Specify a point or enter e



Commands: PEDIT edits polylines. PLINE creates open or closed two-dimensional polylines.

System Variables: POLYSIDES stores the current number of polygon sides.



Center of Polygon (POLYGON)
Up a Level

Defines the center of the polygon.

Specify the distance from the center of the polygon to the midpoints of the polygon segments. 

Radius of circle: Specify a distance

Specifying the radius with your pointing device determines the rotation and size of the polygon. Specifying the radius with 
keyboard entry draws the bottom edge of the polygon at the current snap rotation.



Edge (POLYGON)
Up a Level

Defines a polygon by specifying the endpoints of the first edge. 

First endpoint of edge: Specify a point (1)

Second endpoint of edge: Specify a point (2)



PSPACE Command
Up a Level          Related Topics

Switches from a model space viewport to paper space
AutoCAD LT operates in paper space or in model space. You use paper space to create a finished layout of a drawing for 
printing. In paper space, you create floating viewports, which are windows containing different views of the model. By 
switching from paper space to floating model space, you can edit the model and views within the floating viewports.

Floating viewports differ from tiled viewports, which split the screen into fixed model space views. Floating viewports are 
objects you create in paper space. Switching to paper space from the menu or from the status bar automatically turns off 
TILEMODE (tiled viewports). Before you use PSPACE on the command line, however, the TILEMODE system variable must 
be set to 0 (off).

 

From the Space toolbar, choose 

From the View menu, choose Paper Space
At the Command prompt, enter pspace

AutoCAD LT switches from model space to paper space.



For more information about using paper space and model space, see chapter 15, "Design the Drawing Layout," in the 
AutoCAD LT User's Guide.

Commands: MSPACE switches from paper space to a model space viewport. MVIEW creates a new floating viewport and 
turns on existing floating viewports. VPLAYER sets the visibility for layers in specific viewports. ZOOM XP scales each view 
relative to paper space units. 

System Variables: TILEMODE controls paper space access and viewport type. PSLTSCALE controls paper space linetype 
scaling. VISRETAIN specifies precedence of settings for xref layers. MAXACTVP specifies the maximum number of 
viewports to regenerate. DIMLFAC controls scaling for linear dimensions.



PSUPDATE Command
Up a Level

Adjusts the size of all PostScript text in a drawing
In AutoCAD LT 2 and AutoCAD Release 12, text objects using PostScript fonts are displayed at approximately 0.7 times their
size because of a difference in measurement conventions between AutoCAD text fonts and PostScript text fonts. This effect 
was removed in AutoCAD LT for Windows 95 and in AutoCAD Release 13. To change PostScript text sizes between 
drawings created under different releases, you can use the PSUPDATE command to increase or decrease the size of all 
PostScript text in a drawing.

At the Command prompt, enter psupdate

Enter the scale factor for all PFB text.

User specified / Larger 1.5 / <Smaller 0.67>: Enter u, l, or press RETURN

The height of all PostScript (PFB) text objects in your drawing are changed.



PURGE Command
Up a Level

Removes unused named objects, such as blocks or layers, from the drawing database
 From the Format menu, choose Purge

At the Command prompt, enter purge

Purge unused Blocks / Dimstyles / LAyers / LTypes / STyles / All: Select an object type to purge, or enter a to purge all 
named object types

The PURGE command removes only one level of reference. Repeat PURGE until there are no unreferenced objects in the 
drawing. You can use PURGE at any time during a drawing session.



PURGE Command
Up a Level

Removes unused named objects, such as blocks or layers, from the drawing database
 From the Format menu, choose Purge

At the Command prompt, enter purge

Purge unused Blocks / Dimstyles / LAyers / LTypes / STyles / All: Select an object type to purge, or enter a to purge all 
named object types

The PURGE command removes only one level of reference. Repeat PURGE until there are no unreferenced objects in the 
drawing. You can use PURGE at any time during a drawing session.



PURGE Command
Up a Level

Removes unused named objects, such as blocks or layers, from the drawing database
 From the Format menu, choose Purge

At the Command prompt, enter purge

Purge unused Blocks / Dimstyles / LAyers / LTypes / STyles / All: Select an object type to purge, or enter a to purge all 
named object types

The PURGE command removes only one level of reference. Repeat PURGE until there are no unreferenced objects in the 
drawing. You can use PURGE at any time during a drawing session.



PURGE Command
Up a Level

Removes unused named objects, such as blocks or layers, from the drawing database
 From the Format menu, choose Purge

At the Command prompt, enter purge

Purge unused Blocks / Dimstyles / LAyers / LTypes / STyles / All: Select an object type to purge, or enter a to purge all 
named object types

The PURGE command removes only one level of reference. Repeat PURGE until there are no unreferenced objects in the 
drawing. You can use PURGE at any time during a drawing session.



PURGE Command
Up a Level

Removes unused named objects, such as blocks or layers, from the drawing database
 From the Format menu, choose Purge

At the Command prompt, enter purge

Purge unused Blocks / Dimstyles / LAyers / LTypes / STyles / All: Select an object type to purge, or enter a to purge all 
named object types

The PURGE command removes only one level of reference. Repeat PURGE until there are no unreferenced objects in the 
drawing. You can use PURGE at any time during a drawing session.



PURGE Command
Up a Level

Removes unused named objects, such as blocks or layers, from the drawing database
 From the Format menu, choose Purge

At the Command prompt, enter purge

Purge unused Blocks / Dimstyles / LAyers / LTypes / STyles / All: Select an object type to purge, or enter a to purge all 
named object types

The PURGE command removes only one level of reference. Repeat PURGE until there are no unreferenced objects in the 
drawing. You can use PURGE at any time during a drawing session.



QSAVE Command
Up a Level          Related Topics

Saves the current drawing
 

From the Standard toolbar, choose 

From the File menu, choose Save
At the Command prompt, enter qsave

If the drawing is named, AutoCAD LT saves the drawing without requesting a file name. If the drawing is unnamed, AutoCAD
LT displays the Save Drawing As dialog box and saves the drawing under the file name you specify. 

If the drawing is read-only, use the SAVEAS command to save changes under a different file name.



Commands: QUIT exits AutoCAD LT and allows you to save changes to the current drawing. SAVE saves the drawing 
under the current file name or a specified name. SAVEAS saves an unnamed drawing under a file name or renames the 
current drawing. END saves the current drawing and exits AutoCAD LT.



'QTEXT Command
Up a Level          Related Topics

Controls the display and plotting of text and attribute objects
   From the Options menu, choose Text, then Text Frame Only
 

At the Command prompt, enter qtext

ON / OFF <current>: Enter on or off, or press RETURN

If you entered on, AutoCAD LT displays each text and attribute object as a bounding box around the text object. Turning on 
Quick Text mode reduces the redrawing and regeneration times for drawings that contain many text objects. 

          



'QTEXT Command
Up a Level          Related Topics

Controls the display and plotting of text and attribute objects
   From the Options menu, choose Text, then Text Frame Only
 

At the Command prompt, enter qtext

ON / OFF <current>: Enter on or off, or press RETURN

If you entered on, AutoCAD LT displays each text and attribute object as a bounding box around the text object. Turning on 
Quick Text mode reduces the redrawing and regeneration times for drawings that contain many text objects. 

          



For more information, see "Fill Mode and Text Display" in chapter 8 of the AutoCAD LT User's Guide. 

Commands: DDRMODES controls Quick Text mode using a dialog box.

System Variables: QTEXTMODE stores the Quick Text mode setting.



QUIT Command
Up a Level          Related Topics

Exits AutoCAD LT
From the File menu, choose Exit

 At the Command prompt, enter quit

Quits AutoCAD LT if there have been no changes since the drawing was last saved. If the drawing has been modified, 
AutoCAD LT displays the Drawing Modification dialog box to prompt you to save or discard the changes before quitting.

You can quit a file that has been opened in read-only mode if you have made no modifications or if you are willing to discard 
them. To save modifications to a read-only drawing, use the SAVEAS command    to save the drawing under another name. 



For more information, see "Exiting AutoCAD LT" in chapter 2 of the AutoCAD LT User's Guide. 

Commands: QSAVE saves the current drawing to a file name. SAVE saves the current drawing to a file name. SAVEAS 
renames the current drawing and saves it to a file name. END saves the current drawing and exits AutoCAD LT.



OLELINKS Command
Up a Level          Related Topics

Updates, changes, and cancels existing links
AutoCAD LT supports the Windows feature object linking and embedding (OLE). When an object is inserted into an 
AutoCAD LT drawing from an application that supports OLE, the object can maintain a connection with its source file.

You can set AutoCAD LT to update links automatically or manually when information in the source document changes. 

   From the Edit menu, choose Links
 

At the Command prompt, enter olelinks

The OLELINKS dialog box is displayed.



OLELINKS Dialog Box
Up a Level

Controls updating of linked objects.

Links
Lists information on linked objects. The information included depends on the type of link. To change information for a linked 
object, select it from the list.

Source
Displays the path name of the source file and the type of object.

Type
Displays the application name.

Automatic
Updates the link automatically whenever the source changes.

Manual
Prompts you to update a link when you open the document.

Update Now
Updates selected links.

Change Source
Displays the Change Source dialog box in which you can change the source file.

Break Link
Severs the link between the object and the original file. AutoCAD LT changes the object in your AutoCAD LT drawing into a 
Windows metafile, that is not affected by future changes to the original file.



For more information, see chapter 17, "Exchanging Data with other Applications," in the AutoCAD LT User's Guide. 

Commands: COPYCLIP copies objects to the Clipboard. COPYLINK copies the current view to the clipboard for linking to 
other OLE applications. PASTECLIP inserts data from the Clipboard into a drawing. PASTESPEC inserts data from the 
Clipboard into the drawing and controls the format of the data.



OPEN Command
Up a Level          Related Topics

Opens an existing drawing file
   

From the Standard toolbar, choose 
   From the File menu, choose Open
 At the Command prompt, enter open

If the current drawing has not been saved, AutoCAD LT displays a dialog box so that you can save the current drawing 
before opening a different drawing. 

AutoCAD LT displays the Select File dialog box.



Select File Dialog Box
Up a Level

Specifies a file name.

File Name
Select or enter the name of the drawing file you want to open. 

Note: You can open only a file with the .dwg or .dxf extension.

List Files of Type
Select the type of files you want to see in the File Name list.

Directories
Select the directory that contains the drawing file you want to open.

Drives
Select the drive that contains the drawing file you want to open.

Preview
Choose to display a preview of the selected drawing.

Find File...
To find drawing files on multiple drives and directories, choose Find File. The Browse/Search dialog box is displayed.

Read Only Mode
Select to open the drawing file in read-only mode. You can edit the drawing file, but to save changes you must save the 
drawing with a new file name.

Select Initial View
Select if you want to specify a previously saved view for display when the drawing is opened.

When you choose OK, the Select Initial View dialog box is displayed.

Select a named view or the last view used in the drawing. The letter to the right of the view name represents the space in 
which the view was created, M for model space or P for paper space.



Drawing History 

Lists the most recently saved drawing files. Select from the list to open the drawing file.



Browse/Search Dialog Box
Up a Level

Specifies a file or files.

Browse Tab
Previews and opens files on a selected drive or directory.

File Name
Directories
Drives
List Files of Type
Size
Open
Exit

Search Tab
Uses search criteria to search for and open files on multiple drives and directories.

Files
Search Pattern
File Types
Date Filter
Search Location
Open
Exit
Search



File Name

Select a preview image or enter the name of the file you want to open. 



Directories

Select the directory that contains the file you want to open.



Drives

Select the drive that contains the file you want to open.



List Files of Type

Select the type of files you want to see in the File Name list.



Size

Select the size at which you want the preview images of files to appear in the File Name list.



Open

To open the selected file, choose Open.



Exit

To close the dialog box, choose Exit.



Files

Select a file from a list of all files located in the drives and directories you specify and that match the criteria you define.



Search Pattern

Enter the file name pattern you want to search for and display in the File Name list. For example, you can enter floor* to 
search for all files that begin with floor and are of the file type specified.



File Types

Select the type of file for which you want to search.



Date Filter (Browse/Search Dialog Box)

Controls how AutoCAD LT searches for files based on the date and time of creation of the file.

Before This Date. Select to search for files created before the time and date you specify.
After This Date. Select to search for files created after the time and date you specify.
Time. Enter the time from which AutoCAD LT searches for files.
Date. Enter the date from which AutoCAD LT searches for files created.



Search Location (Browse/Search Dialog Box)

Specifies which drives and directories are searched.

Drives. Select the drive you want to search.
All Drives. Select to search all local drives on your computer, or all drives connected to your computer.
Local Fixed Drives. Select to search all local fixed drives on your computer.
All Drives. Select to search all drives connected to your computer, including local drives and network drives.
Path. Select to search a specific directory or directories. Enter the drive and path of the directory or directories you

want to search. To search more than one directory, separate the path names of the directories with a semicolon (;).
Edit. To use a dialog box to specify the paths you want to search, choose Edit. The Edit Path dialog box is 

displayed.



Open

To open the selected file, choose Open.



Exit

To close the dialog box, choose Exit.



Search

To begin the file search, choose Search.



Edit Path Dialog Box
Up a Level

Path
Enter the name of the path or paths you want to search. To enter more than one path, separate paths with a semi-colon (;).

Directories
Select the directory of the path you want to search.

Drives
Select the drive of the path you want to search.

Search Path
Displays a list of the search paths you want to search.

Add
To add the path or paths displayed in Path, choose Add. The paths are added to Search Path.

Delete
To delete the path you select in Search Path, choose Delete.

Delete All
To delete all paths displayed in Search Path, choose Delete All.

Close
To close the dialog box, choose Close.

Network
To connect network drives to your computer, choose Network. The Map Network Drive dialog box is displayed. 



For more information, see "Opening Existing Drawings" in chapter 2 of the AutoCAD LT User's Guide. 

Commands: NEW creates a new drawing file.

System Variables: DWGWRITE determines the initial state of the read-only mode switch.



PAINTER Command (Property Painter)
Up a Level      Related Topics

Copies properties of one object to other objects
The properties you can copy from one object to other objects include color, layer, linetype, object linetype scale factor, and 
thickness. Text properties and dimension properties can also be copied for text objects and dimension objects, respectively. 
All objects except OLE objects can be modified by this command.

   
From the Standard toolbar, choose 

 At the Command prompt, enter painter.

Select source object:    Select a single object to be used as the source of properties to be copied. 

The Property Painter dialog box is displayed.

Select destination object:    Select the objects to be modified.



For more information, see “Matching Properties of Other Objects” in chapter 10 of the AutoCAD LT User’s Guide.

Commands: DDMODIFY controls properties of existing objects. COPY creates a duplicate object at a specified distance.



Property Painter Dialog Box
Up a Level

Color
Changes the color of the destination object to that of the source object.

Layer
Changes the layer of the destination object to that of the source object.

Linetype
Changes the linetype of the destination object to that of the source object.

Linetype Scale
Changes the linetype scale factor of the destination object to that of the source object.

Thickness
Changes the thickness of the destination object to that of the source object. This option is not available for all object types.

Text Properties
Changes the text style of the destination object to that of the source object. This option is available only for line-text and 
paragraph-text objects.

Dimension Properties
Changes the dimension style of the destination object to that of the source object. This option is available only for dimension,
leader, and tolerance objects.



PEDIT Command
Up a Level          Related Topics

Edits polylines 
The prompts for the PEDIT command vary depending on whether you have selected a 2D or a 3D polyline.

   

From the Modify toolbar, choose 
 From the modify menu, choose Objects, then Edit Polyline
 At the Command prompt, enter pedit

Select polyline: Use an object selection method

If the selected object is a line or an arc, AutoCAD LT prompts:

Object selected is not a polyline.

Do you want it to turn into one? <Y> Enter y or n, or press RETURN

If you enter y, the object is converted into a single-segment 2D polyline that you can edit. You can use this method to join 
lines and arcs into a polyline.

2D Polyline Selection
If you have selected a 2D polyline, AutoCAD LT prompts:

Close / Join / Width / Edit vertex / Fit / Spline/ Ltype gen / Undo / eXit <X>: Enter an option or press RETURN

If the polyline you have selected is closed, Open replaces the Close option in the prompt. 

Note: You can edit a 2D polyline only if the XY plane of the current UCS is the same or parallel to the plane on which the 2D 
polyline was originally created. You can use Object option of the UCS command to realign the UCS to the 2D polyline, if 
necessary.

3D Polyline Selection
If you have selected a 3D polyline, AutoCAD LT prompts:

Close / Edit vertex / Spline curve / Decurve / Undo / eXit <X>: Enter an option or press RETURN

If the polyline you have selected is closed, Open replaces the Close option in the prompt. 



Close (PEDIT, 2D Polyline)
Up a Level

Creates the closing segment of the polyline, connecting the last segment with the first. AutoCAD LT considers the polyline 
open unless you close it using the Close option. 

      



Open (PEDIT, 2D Polyline)
Up a Level

Removes the closing segment of the polyline. AutoCAD LT considers the polyline closed unless you open it using the Open 
option.



Join (PEDIT, 2D Polyline)
Up a Level

Adds lines, arcs, or polylines to the end of an open polyline and removes the curve fitting from a curve-fit polyline. For 
objects to join the polyline, their endpoints must touch.

Select objects: Use an object selection method

      



Width (PEDIT, 2D Polyline)
Up a Level

Specifies a new uniform width for the entire polyline.

Enter new width for all segments: Specify a width

      

Use the Width option of the Edit Vertex option to change the starting and ending widths of segments.



Edit Vertex (PEDIT, 2D Polyline)
Up a Level

Marks the first vertex of the polyline by drawing an X on the screen. If you have specified a tangent direction for this vertex, 
an arrow is also drawn in that direction. 

Next / Previous / Break / Insert / Move / Regen / Straighten / Tangent / Width / eXit <N>: Enter an option or press 
RETURN



Next

Moves the X marker to the next vertex. The marker does not wrap around from the end to the start of the polyline even if the 
polyline is closed. 



Previous

Moves the X marker to the previous vertex. The marker does not wrap around from the end to the start of the polyline even if
the polyline is closed. 



Break

Saves the location of the marked vertex while you move the X marker to any other vertex.

Next / Previous/ Go / eXit <N>: Enter an option or press RETURN

If you leave the X marker where it is and enter go, AutoCAD LT splits the polyline into two pieces at the specified vertex. If 
you move the marker, any segments and vertices between the two vertices you specified are deleted. 
If one of the specified vertices is at an end of the polyline, the polyline is truncated. If both specified vertices are at endpoints
of the polyline, or if just one vertex is specified and it is at an endpoint, you cannot use Break mode.

Next. Moves the X marker to the next vertex. The marker does not wrap around from the end to the start of the 
polyline, even if the polyline is closed.

Previous. Moves the X marker to the previous vertex. The marker does not wrap around from the end to the start 
of the polyline, even if the polyline is closed.

Go. Deletes any segments and vertices between the two vertices you specify and returns to Edit Vertex mode.

Exit. Exits Break mode and returns to Edit Vertex mode.



Insert

Adds a new vertex to the polyline after the marked vertex.

Enter location of new vertex: Specify a point (1)

      



Move

Moves the marked vertex.

Enter new location: Specify a point (1)

      



Regen

Regenerates the polyline. 

      



Straighten

Saves the location of the marked vertex while you move the X marker to any other vertex. 

Next / Previous / Go / eXit<N>: Enter an option or press RETURN

      

If you enter go, any segments and vertices between the two vertices you specified are deleted, and a single straight line 
segment replaces them. If you specify only one vertex by entering go without moving the X marker, the segment following 
that vertex is made straight if it is an arc.
If you want to remove an arc segment that connects two straight segments of a polyline and then extend the straight 
segments until they intersect, use the FILLET command with a fillet radius of 0.

Next. Moves the X marker to the next vertex.
Previous. Moves the X marker to the previous vertex.
Go. Deletes any segments and vertices between the two vertices you specify, replaces them with a single straight 

line segment, . If you do not move the marker, and returns to Edit Vertex mode. Go straightens the arc segment that follows 
the marked vertex.

Exit. Exits Straighten mode and returns to Edit Vertex mode.



Tangent

Attaches a tangent direction to the marked vertex, X for use later in curve fitting. AutoCAD LT prompts:

Direction of tangent: Specify a point or enter an angle



Width

Changes the starting and ending widths for the segment that immediately follows the marked vertex.

Enter starting width <current>: Specify a point, enter a value, or press RETURN

Enter ending width <start>: Specify a point, enter a value, or press RETURN

To display the new width, you must regenerate the polyline. 

      



Exit

Exits Edit Vertex mode.



Fit (PEDIT, 2D Polyline)
Up a Level

Creates a smooth curve consisting of arcs joining each pair of vertices. The curve passes through all vertices of the polyline 
and uses any tangent direction you specify.

      



Spline (PEDIT, 2D Polyline)
Up a Level

Uses the vertices of the selected polyline as the control points, or frame, of a curve approximately a B-spline. This curve, 
called a spline-fit polyline,    passes through the first and last control points unless the original polyline was closed. The curve
is pulled toward the other points but does not necessarily pass through them. The more control points you specify in a 
particular part of the frame, the more pull they exert on the curve. AutoCAD LT can generate quadratic and cubic spline-fit 
polylines.

      

Spline-fit polylines are very different from the curves produced by the Fit option. Fit constructs pairs of arcs that pass through
every control point. Both these curves are different from true B-splines produced with the SPLINE command.
If the original polyline included arc segments, they are straightened when forming the spline's frame. If the frame has width, 
the resulting spline tapers smoothly from the width of the first vertex to the width of the last vertex. All intermediate width 
information is ignored. Once spline-fit, the frame, if displayed, is shown with zero width and CONTINUOUS linetype. Tangent
specifications on control point vertices have no effect on spline-fitting.

When a spline-fit curve is fit to a polyline, the spline-fit curve's frame is stored so that it may be recalled by a subsequent 
decurving. You can turn a spline-fit curve back into its frame polyline by using the PEDIT Decurve option. This option works 
on fit curves in the same manner as it does on splines.

Spline frames are not usually displayed on the screen. If you want to see them, set the SPLFRAME system variable to 1. 
Next time the drawing is regenerated, AutoCAD LT draws both the frame and the spline curve.

      

Most editing commands act the same when applied to spline-fit polylines or fit curves. MOVE, ERASE, COPY, MIRROR, 
ROTATE, and SCALE operate both on the spline curve and its frame, whether the frame is visible or not. EXTEND changes 
the frame by adding a new vertex where the initial or final line of the frame intersects the boundary geometry.
BREAK, TRIM, and EXPLODE delete the frame and generate a polyline with only the fit spline, which is consistent with fit 
curves, where the curve fitting is permanent. OFFSET generates a polyline with only the fit spline, which is consistent with 
its behavior with fit curves. DIVIDE, MEASURE, the Object option of AREA, HATCH, FILLET, and CHAMFER see only the fit
spline, not the frame. STRETCH refits the spline to the stretched frame after a spline is stretched.

The Join option of PEDIT decurves the spline and discards the spline information of the original and any added polylines. 
Once the Join operation is complete, you can fit a new spline to the resulting polyline. 

The Next and Previous options of the Edit Vertex option of PEDIT move the X marker only to points on the frame of the 
spline, whether visible or not. The Break option of the Edit Vertex option discards the spline. The Insert, Move, Straighten, 
and Width options of the Edit Vertex option automatically refit the spline. The Tangent option of the Edit Vertex option has no 
effect on splines.

Object snap uses only the spline-fit curve itself, not the frame. If you want to snap to the frame control points, use PEDIT to 
recall the polyline frame first. 

The SPLINETYPE system variable controls the type of spline curve approximated. Setting SPLINETYPE to 5 approximates 
a quadratic B-spline. Setting SPLINETYPE to 6 approximates a cubic B-spline.



      

You can examine or change the fineness or coarseness of the spline approximation with the SPLINESEGS system variable. 
The default value is 8. If you set the value higher, a greater number of line segments are drawn, and the approximation to 
the ideal spline becomes more precise. The generated spline occupies more space in the drawing file and takes longer to 
generate.

      

If you set SPLINESEGS to a negative value, AutoCAD LT generates segments using the absolute value of the setting and 
then applies a fit-type curve to those segments. Fit-type curves use arcs as the approximating segments. Using arcs yields a
smoother generated curve when few segments are specified, but the curve can take longer to generate.
To change the number of segments used to fit an existing spline, change SPLINESEGS and respline the curve. You do not 
have to decurve it first.



Ltype Gen (PEDIT, 2D Polyline)
Up a Level

Generates the linetype in a continuous pattern through the vertices of the polyline. When turned off, this option generates 
the linetype starting and ending with a dash at each vertex. This option does not apply to polylines with tapered segments. 

Full PLINE line type ON / OFF <current>: Enter on or off, or press RETURN

           

    



Undo (PEDIT, 2D Polyline)
Up a Level

Reverses actions as far back as the beginning of the PEDIT command.



Exit (PEDIT, 2D Polyline)
Up a Level

Exits PEDIT.



Close (PEDIT, 3D Polyline)
Up a Level

Creates the closing segment of the polyline, connecting the last segment with the first. AutoCAD LT considers the polyline 
open unless you close it using the Close option. 



Open (PEDIT, 3D Polyline)
Up a Level

Removes the closing segment of the polyline. AutoCAD LT considers the polyline closed unless you open it using the Open 
option.



Edit Vertex (PEDIT, 3D Polyline)
Up a Level

Marks the first vertex of the polyline by drawing an X on the screen. If you have specified a tangent direction for this vertex, 
an arrow is also drawn in that direction. 

Next / Previous / Break / Insert / Move / Regen / Straighten / eXit <N>: Enter an option or press RETURN



Next

Moves the X marker to the next vertex. The marker does not wrap around from the end to the start of the polyline, even if the
polyline is closed.



Previous

Moves the X marker to the previous vertex. The marker does not wrap around from the end to the start of the polyline, even 
if the polyline is closed.



Break

Saves the location of the marked vertex while you move the X marker to any other vertex.

Next / Previous/ Go  / eXit<N>: Enter an option or press RETURN

If you leave the X marker where it is and enter go, AutoCAD LT splits the polyline into two pieces at the specified vertex. If 
you move the marker, any segments and vertices between the two vertices you specified are deleted. 

If one of the specified vertices is at the end of the polyline, the polyline is truncated. If both specified vertices are at 
endpoints of the polyline, or if just one vertex is specified and it is an endpoint, you cannot use Break mode. 

Next. Moves the X marker to the next vertex. The marker does not wrap around from the end to the start of the 
polyline, even if the polyline is closed.

Previous. Moves the X marker to the previous vertex. The marker does not wrap around from the end to the start 
of the polyline, even if the polyline is closed.

Go. Deletes any segments and vertices between the two vertices you specify and returns to Edit Vertex mode.
Exit. Exits Break mode and returns to Edit Vertex mode.



Insert

Adds a new vertex to the polyline after the marked vertex.

Enter location of new vertex: Specify a point



Move

Moves the marked vertex.

Enter new location: Specify a point



Regen

Regenerates the polyline. 



Straighten

Saves the location of the marked vertex while you move the X marker to any other vertex. If you enter go, any segment and 
vertices between the two vertices you specify are deleted, and a single straight line segment replaces them.

Next/ Previous/ Go / eXit <N>: Enter an option or press RETURN

Next. Moves the X marker to the next vertex.
Previous. Moves the X marker to the previous vertex.
Go. Deletes any segments and vertices between the two vertices you specify, replaces them with a single straight 

line segment. If you do not move the marker, and returns to Edit Vertex mode. Go straightens the arc segment that follows 
the marked vertex.

Exit. Exits Straighten mode and returns to Edit Vertex mode.



Exit

Exits Edit Vertex mode.



Spline Curve (PEDIT, 3D Polyline)
Up a Level

Fits a 3D B-spline curve to its control points. The SPLFRAME system variable controls the accuracy of and displays the 
control points for the 3D B-spline, whose curves can be approximated only by line segments. AutoCAD LT ignores negative 
values for spline segments.

      



Decurve (PEDIT, 3D Polyline)
Up a Level

Removes extra vertices inserted by a fit or spline-fit curve and straightens all segments of the polyline. Retains tangent 
information assigned to the polyline vertices for use in subsequent fit-curve requests. If you edit a spline-fit polyline with 
commands such as BREAK or TRIM, you cannot use the Decurve option.



Undo (PEDIT, 3D Polyline)
Up a Level

Reverses actions as far back as the beginning of the PEDIT command.



Exit (PEDIT, 3D Polyline)
Up a Level

Exits PEDIT.



For more information see "Editing Polylines" in chapter 10, of the AutoCAD LT User's Guide.

Commands:  3DPOLY creates 3D polylines. PLINE creates 2D polylines.

System Variables: SPLFRAME, if set to 1, displays the control polygon for spline-fit polylines, the fit surface of a polygon 
mesh, and the invisible edges of a 3D face or polyface mesh. SPLINESEGS stores the number of line segments to be 
generated for each spline patch. SPLINETYPE controls the type of spline curve that AutoCAD LT generates. 



PLINE Command
Up a Level          Related Topics

Creates a polyline of line segments and arcs in 2D space
   

From the Draw toolbar choose 
 From the Draw menu, choose Polyline 
 At the Command prompt, enter pline

From point: Specify a point 

Current line-width is <current>

Arc / Close / Halfwidth / Length / Undo / Width / <Endpoint of line>: Specify a point or enter an option



For more information, see "Drawing Polylines" in chapter 6 of the AutoCAD LT User's Guide.

Commands: LINE creates single or multiple line segments that are separate objects. PEDIT controls linetype display for 
existing polylines. SPLINE creates quadratic and cubic spline objects. 

System Variables: PLINEGEN controls the linetype pattern display of a 2D polyline. 



Endpoint of Line (PLINE)
Up a Level

Draws a line segment.



Arc (PLINE)
Up a Level

Changes PLINE to Arc mode, in which you can add arc segments to the polyline.

Angle / CEnter / CLose / Direction / Halfwidth / Line / Radius / Second pt / Undo / Width / <Endpoint of arc>: Specify a 
point (3) or enter an option

Note: To specify the Center option of the PLINE command, enter CE; to specify the Center object snap, enter CEN or 
CENTER.



Endpoint of Arc

Draws an arc segment. The arc segment starts at the last point tangent to the previous segment of the polyline.



Angle

Specifies the included angle of the arc segment from the start point.

Included angle: Specify an angle

Entering a positive number creates a counterclockwise arc segment. Entering a negative number creates a clockwise arc 
segment.

Center / Radius / <Endpoint>: Specify a point or enter an option

Center. Specifies the center of the arc segment.
Center point: Specify a point

Radius. Specifies the radius of the arc segment.
Radius: Specify a point

If you specify a point, AutoCAD LT prompts as follows:

Second point: Specify a point

Direction of chord <current>: Specify a point or press RETURN

Endpoint. Draws the arc segment.



Center

Specifies the center of the arc segment.

Center point: Specify a point (3)

Angle / Length / <End point>: Specify a point (4) or enter an option

Angle. Specifies the included angle of the arc segment from the start point.
Included angle: Specify an angle

Length. Specifies the chord length of the arc segment. If the previous segment is an arc, AutoCAD LT draws the 
new arc segment tangent to the previous arc segment.

Length of chord: Specify a length

Endpoint. Draws the arc segment.



Close

Closes a polyline with an arc segment.



Direction

Specifies a starting direction for the arc segment.

Direction from start point: Specify a point (3)

End point: Specify a point (4)



Halfwidth

Specifies the width from the center of a wide polyline segment to one of its edges.

Starting half-width <current>: Enter a value or press RETURN

Ending half-width <current>: Enter a value or press RETURN

The starting half-width becomes the default ending half-width. The ending half-width becomes the uniform half-width for all 
subsequent segments until you change the half-width again. The start points and endpoints of wide line segments are at the 
center of the line.

Typically, the intersections of adjacent wide polyline segments are beveled. AutoCAD LT does not bevel nontangent arc 
segments, or very acute angles or when a dot-dash linetype is used. 



Line

Changes PLINE to Line mode.



Radius

Specifies the radius of the arc segment.

Radius: Specify a point

Second point: Specify a point

Angle / <End point>: Specify an angle, specify a point, or enter a
Angle. Specifies the included angle for the arc segment.

Included angle: Specify an angle

Direction of chord <current>: Specify an angle or press RETURN

Endpoint. Draws the arc segment.



Second Pt

Specifies the second and end points of a three-point arc.

Second point: Specify a point (3)

End point: Specify a point (4)



Undo

Removes the most recent arc segment added to the polyline.



Width

Specifies the width of the next arc segment.

Starting width <current>: Enter a value or press RETURN

Ending width <current>: Enter a value or press RETURN

The starting width becomes the default ending width. The ending width becomes the uniform width for all subsequent 
segments until you change the width again. The start points and endpoints of wide line segments are at the center of the 
line.

Typically, the intersections of adjacent wide polyline segments are beveled. AutoCAD LT does not bevel nontangent arc 
segments, or very acute angles or when a dot-dash linetype is used.



Close (PLINE)
Up a Level

Draws a line segment from the current position to the starting point of the polyline, creating a closed polyline.

      



Halfwidth (PLINE)
Up a Level

Specifies the width of a wide polyline line segment from the center to one of its edges.

Starting half-width <current>: Enter a value or press RETURN

Ending half-width <current>: Enter a value or press RETURN

The starting half-width becomes the default ending half-width. The ending half-width becomes the uniform half-width for all 
subsequent segments until you change the half-width again. The start points and endpoints of wide line segments are at the 
center of the line.
Typically, the intersections of adjacent wide polyline segments are beveled. AutoCAD LT does not bevel nontangent arc 
segments, or very acute angles or when a dot-dash linetype is used.



Length (PLINE)
Up a Level

Draws a line segment of a specified length at the same angle as the previous segment. If the previous segment is an arc, 
AutoCAD LT draws the new line segment tangent to that arc segment.

Length of line: Specify a point

      



Undo (PLINE)
Up a Level

Removes the most recent line segment added to the polyline.



Width (PLINE)
Up a Level

Specifies the width of the next line segment.

Starting width <current>: Enter a value or press RETURN

Ending width <current>: Enter a value or press RETURN

The starting width becomes the default ending width. The ending width becomes the uniform width for all subsequent 
segments until you change the width again. The start points and endpoints of wide line segments are at the center of the 
line.

Typically, the intersections of adjacent wide polyline segments are beveled. AutoCAD LT does not bevel nontangent arc 
segments, or very acute angles or when a dot-dash linetype is used.

The PLINEGEN system variable controls linetype pattern display around a 2D polyline. Setting PLINEGEN to 1 generates 
new polylines in a continuous linetype pattern around the polyline. Setting PLINEGEN to 0 starts and ends the polyline with 
a dash and places a dash at each vertex. PLINEGEN does not apply to polylines with tapered segments. 

      



POINT Command
Up a Level          Related Topics

Creates a point object
 

From the Draw toolbar, choose 
 From the Draw menu, choose Point, then Single Point 

At the Command prompt, enter point

Point: Specify a point

You can specify a full 3D location for a point. The current elevation is assumed if you omit the Z coordinate. To snap to a 
point object, use the Node object snap.

You can change the appearance and size of points using by using the DDPTYPE command.



Commands: DDPTYPE specifies a new Point Display mode and size. REGEN regenerates the drawing and refreshes the 
current viewport.

System Variables: PDMODE specifies the object displayed by POINT. PDSIZE specifies the size of the object displayed by 
POINT.



Point Filters
Up a Level        Related Topics

Combine X, Y, and Z values from different points to specify a single point.
From the Standard toolbar, choose

 
At a prompt to locate a point, enter .x, .y, .xy, .xz, or .yz

At any AutoCAD LT prompt for locating a point, you can enter point filters to specify a single coordinate by extracting the X, 
Y, and Z values of several points.

In this example, the starting point for the line will have a coordinate constructed from the X value of the midpoint of the first 
object you select, together with the Y and Z values of the midpoint of the second object you select.

LINE From point: .X of MID of <Select an object>

(need YZ) MID of <Select another object>

To point: <Specify another point>



For more information, see “Using Point Filters” in chapter 7 of the AutoCAD LT User’s Guide.

Commands: TRACKING locates a point from a series of temporary points.



PREFERENCES Command
Up a Level        

Customizes AutoCAD LT settings
From the Tools menu, choose Preferences

 At the Command prompt, enter preferences

The Preferences dialog box is displayed.



Preferences Dialog Box
Up a Level

Work Space Tab. Controls operating settings, choice of display drivers, and the automatic save feature, and 
specifies the type of digitizer input. You can specify how AutoCAD LT interprets keyboard input.

User Tab. Specifies a user name, a spelling dialect, and a system of measurement.
Color Tab. Specifies color preferences for AutoCAD LT components.
Font Tab. Specifies text font preferences for the AutoCAD LT graphics window and text window.
File System Tab. Specifies the location of temporary files, and support directories, and controls preview options 

and several file settings.



Work Space Tab (Preferences Dialog Box)
Up a Level

Settings
Controls AutoCAD LT operating preferences.

Beep on Error
Scroll Bars
File Locking
Log File

Automatic Save
Saves your drawing at the interval specified in the Minutes text box.

Every
Minutes
File Name

Digitizer Input
Controls the type of digitizer from which AutoCAD LT accepts input.

Tablet or Mouse
Calibrated Tablet

Keystroke Accelerators
Controls how AutoCAD LT interprets keystrokes.

Customizable
AutoCAD LT Compatibility



Minutes

Specifies the number of minutes between automatic timed saves.



Beep on Error

Toggles whether a sound is emitted when AutoCAD LT encounters an input error.



Scroll Bars

Toggles the scroll bars on or off.



File Locking

Toggles whether lock files are generated. Lock files prevent other users on a network from updating drawing files currently in
use.



Every

When selected, turns on Automatic Save.



Log File

Toggles whether AutoCAD LT records the text window contents in an ASCII log file.



Calibrated Tablet 

Accepts input only when the tablet is calibrated and tablet mode is on. If you have no tablet calibrated, this option is 
unavailable and AutoCAD LT defaults to Tablet and Mouse input. 



Tablet and Mouse 

Accepts input from the tablet or the mouse. 



File Name

Specifies the file name for automatic timed saves. The default file name is aclt.sv$.



Customizable

Uses standard Microsoft Windows keyboard accelerators, including ESC to cancel a command and CTRL+C to copy objects
to the clipboard. 

These keyboard accelerators are defined in the AutoCAD LT menu file, aclt.mnu.



AutoCAD LT Compatibility

Uses keyboard accelerators from AutoCAD LT releases 1 and 2, including CTRL+C to cancel a command.



User Tab (Preferences Dialog Box)
Up a Level

User Name
Inserts the user name that you specify into your drawing along with the drawing name, revision date, and time. 

Spelling Dialects
Specifies spelling dialect and language.

Measurement
Specifies English (Imperial) or metric unit conventions.



Color Tab (Preferences Dialog Box)
Up a Level

Basic Colors
Sets the colors for the AutoCAD LT application window. Select a color or use the scroll bars to adjust the color.

System Colors
Resets the AutoCAD LT application window colors to the default colors.

Monochrome Vectors
Displays all objects in a drawing in a single color regardless of layer and color assignments. 

Window Element
Specifies which element you are changing.



Font Tab (Preferences Dialog Box)
Up a Level

Font
Specifies a text font from a list.

Font Style
Specifies a display style, such as italic, bold, or regular, for the selected font.

Size
Specifies the size of the text font.

Font to Change
Specifies the component you are changing.

Sample Font
Displays a sample showing your changes.



File System Tab (Preferences Dialog Box)
Up a Level

Temporary Files
Use Drawing Directory
Other Directory

Support
Support Directories
Menu File

Preview
Specifies whether and in what format a drawing preview is displayed when you choose a drawing to open.

Save BMP Preview
Save WMF Preview

File Settings
Use Long Filenames
Compress Bitmaps
Create Backups



Use Drawing Directory

Specifies the current drawing directory as the location for temporary files.



Other Directory

Specifies a directory to use as the location for temporary files.



Support Directories

Specifies the directories in which AutoCAD LT searches for support files that include text fonts, drawings to insert, linetypes, 
and hatch patterns.



Menu File

Specifies a different menu file to be used by AutoCAD LT.



Save BMP Preview

Saves the drawing preview that is stored in your drawing file in bitmap (BMP) format.



Save WMF Preview

Saves the drawing preview that is stored in your drawing file in a Windows metafile (WMF) format.



Use Long Filenames

Specifies whether AutoCAD LT accepts long file names.



Compress Bitmaps

Specifies that bitmaps generated by AutoCAD LT are compressed.



Create Backups

Specifies that AutoCAD LT automatically creates drawing backup (BAK) files.



PSOUT Command
Up a Level          Related Topics

Creates an encapsulated PostScript file
AutoCAD LTgenerated EPS files contain a PostScript rendering of the model. AutoCAD LT outputs arcs, circles, and 
polylines as PostScript primitives instead of vectors. The exception is objects that are unrepresentable in PostScript. For 
instance, objects with nonzero thickness are output as vectors. AutoCAD LT outputs text objects that use font files named in 
the PostScript support file (aclt.psf) as PostScript text objects in the corresponding PostScript font. 

AutoCAD LT objects that cannot be directly represented in PostScript are output as wire-frame imagesprecisely as AutoCAD
LT displays them on screen. The HIDE and SHADE commands have no effect on output generated by PSOUT.

From the File menu, choose Export
At the Command prompt, enter psout

The Create PostScript File dialog box is displayed. In the Create PostScript File dialog box, enter a file name. AutoCAD LT 
adds the .eps extension.

What to plot -- Display, Extents, Limits, View, or Window <D>: Enter an option or press RETURN



Create PostScript File Dialog Box
Up a Level

Creates an EPS file from an AutoCAD LT file.

File Name
Select or enter the name you want to assign to the postscript file (extension .eps). 

List Files of Type
Select the type of files you want to see in the File Name list.

Directories
Select the directory that you want to contain the postscript file.

Drives
Select the drive that you want to contain the postscript file.

Network
To connect network drives to your computer, choose Network to display the Map Network Drive dialog box. 



Display (PSOUT)
Up a Level

Exports the view in the current viewport in model space or the current view in paper space.
Include a screen preview image in the file? (None / EPSI / TIFF) <None>: Enter an option or press RETURN



Extents (PSOUT)
Up a Level

Exports the portion of the current space of the drawing that contains objects.

Include a screen preview image in the file? (None / EPSI / TIFF) <None>: Enter an option or press RETURN



Limits (PSOUT)
Up a Level

Exports the entire drawing area defined by the drawing limits. If the current viewpoint is not the plan view (0,0,1), this option 
is the same as the Extents option.

Include a screen preview image in the file? (None / EPSI / TIFF) <None>: Enter an option or press RETURN



View (PSOUT)
Up a Level

Exports a view saved previously using the VIEW command.

View name: Enter a name

Include a screen preview image in the file? (None / EPSI / TIFF) <None>: Enter an option or press RETURN



Window (PSOUT)
Up a Level

Exports any portion of your drawing. AutoCAD LT prompts you to specify a lower-left corner and an upper-right corner of the 
area you want to output.

First corner: Specify a point

Other corner: Specify a point

Include a screen preview image in the file? (None / EPSI / TIFF) <None>: Enter an option or press RETURN

After you respond to the Output units=Drawing Units or Fit or ? prompt, AutoCAD LT lists the paper sizes it can 
accommodate.

Enter the Size or Width, Height (in Inches) <current>: Enter a standard size description from the list, or an explicit width 
and height value, or press RETURN

If you enter a unique size by specifying the width and height of the paper, the size you specify appears with the label USER 
or USERn on the list for paper sizes the next time you create an EPS file with PSOUT.

AutoCAD LT exports an EPS file with the file name you specified.



None

Specifies no screen preview image in the file.

Size units (Inches or Millimeters) <current>: Enter an option or press RETURN



EPSI

Includes an EPSI screen preview image.

Screen preview image size (128x128 is standard)? (128 / 256 / 512) <128>: Enter a value or press RETURN

The value you enter specifies the pixel resolution of the screen preview image.



TIFF

Includes a TIFF screen preview image.

Screen preview image size (128x128 is standard)? (128 / 256 / 512) <128>: Enter a value or press RETURN

The value you enter specifies the pixel resolution of the screen preview image.

If you include a TIFF screen preview, you cannot print the EPS file directly to a PostScript printer and produce the image 
output.



Inches or Millimeters

Sets size units in inches or millimeters.

Output units=Drawing Units or Fit or ?<current>: Enter an explicit scale, enter f, or press RETURN

You enter an explicit scale by specifying how many drawing units are to be output per unit (millimeters or inches). For 
example, to produce output at a scale of 1 drawing unit per millimeter, enter 1=1.

If you enter f, AutoCAD LT scales the output so the portion of the drawing that is output is made as large as possible for the 
specified paper size.

If you enter ?, AutoCAD LT displays a short description of the options.



For more information about PostScript, see “Exporting Drawings to Other File Formats” in chapter 17 of the AutoCAD LT 
User’s Guide.



RASTERPREVIEW System Variable
Up a Level

Type: Integer

Saved in: Drawing

Initial value: 0

Controls whether drawing preview images are saved with the drawing and sets the format type.

0 BMP only

1 BMP and WMF

2 WMF only

3 No preview image created



RAY Command
Up a Level          Related Topics

Creates a semi-infinite line
Rays are commonly used as construction lines. A ray has a starting point and extends to infinity. 

 

From the Draw toolbar, choose 
 From the Draw menu, choose Ray
 At the Command prompt, enter ray

From point: Specify a point (1)

Through point: Specify the point (2) through which you want the ray to pass.

AutoCAD LT draws a ray and continues to prompt for through points, enabling you to create multiple rays. Press RETURN to
end the command.



For more information, see "Drawing Construction Lines and Rays" in chapter 7 of the AutoCAD LT User's Guide. 

Commands: DDMODIFY modifies a ray's properties. LINE creates straight line segments. PLINE creates 2D polylines. 
XLINE creates infinite lines. 



RECOVER Command
Up a Level          Related Topics

Repairs a damaged drawing
If AutoCAD LT determines that a drawing you're opening is damaged based on the drawing's header information, the OPEN 
command performs an automatic recovery. 

   From the File menu, choose Management, then Recover
 At the Command prompt, enter recover

The Recover Drawing File dialog box is displayed. Enter or select the name of the damaged drawing file. AutoCAD LT 
begins the drawing recovery and displays the results on the text screen.



Recover Drawing File Dialog Box
Up a Level

Repairs damaged drawing files.

File Name
Select or enter the name of the damaged drawing file you want to recover.

List Files of Type
Select the type of files you want to see in the File Name box.

Directories
Select the directory that contains the damaged file you want to recover.

Drives
Select the drive that contains the damaged file you want to recover.

Find File...
To find the damaged files you want to recover on multiple drives and directories, choose Find File. The Browse/Search 
dialog box is displayed.

Network
To connect network drives to your computer, choose Network. The Map Network Drive dialog box is displayed. 



For more information about recovering a damaged drawing and an explanation of the report AutoCAD LT displays, see 
"Recovering Damaged Drawings" in chapter 17 of the AutoCAD LT User's Guide.

Commands: AUDIT performs a manual drawing audit. OPEN opens an existing drawing file. 



RECTANG Command
Up a Level

Draws a closed rectangular polyline
 

From the Draw toolbar, choose 

From the Draw menu, choose Polygon, then Rectangle
At the Command prompt, enter rectang

First corner: Specify a point (1)

Other corner: Specify a point (2)

The two specified points determine the diagonal corners of a rectangle with sides parallel to the X and Y axes of the current 
UCS.



REDO Command
Up a Level          Related Topics

Reverses the effects of the previous UNDO or U command
You must use REDO immediately after the U or UNDO command.

 
From the Standard toolbar, choose 

 From the Edit menu, choose Redo
At the Command prompt, enter redo

For more information, see "Correcting Mistakes" in chapter 2 of the AutoCAD LT User's Guide. 

Commands: U reverses the effect of the previous command. UNDO reverses the effect of multiple commands and provides 
control over the undo feature.



'REDRAW Command
Up a Level          Related Topics

Refreshes the display of the current viewport
 

From the Standard toolbar, choose 
 From the View menu, choose Redraw

At the Command prompt, enter redraw

AutoCAD LT removes blips and display artifacts (stray pixels) from the current viewport.

          



For more information about redrawing, see "Refreshing the Screen Display" in chapter 2 and "Using the Zoom Options" in 
chapter 8 of the AutoCAD LT User's Guide. 

Commands: REGEN regenerates the drawing and refreshes all viewports.



REGEN Command
Up a Level          Related Topics

Regenerates the drawing and refreshes all viewports
From the View menu, choose Regen
At the Command prompt, enter regen

AutoCAD LT recomputes the screen coordinates for all objects and reindexes the drawing database for optimum display and
object selection performance.

          



For more information about redrawing, see "Refreshing the Screen Display" in chapter 2 and "Using the Zoom Options" in 
chapter 8 of the AutoCAD LT User's Guide. 

Commands: REDRAW refreshes the display of all viewports.



REINIT Command
Up a Level        

Reinitializes the input/output ports, digitizer, display, and program parameters file
   From the Options menu, choose Reinitialize
 At the Command prompt, enter reinit

The Re-initialization dialog box is displayed.

For AutoCAD LT to run properly, the input/output ports, digitizer, display, and AutoCAD LT parameters file aclt.pgp must be 
initialized. If you change the settings, you must be use REINIT to reinitialize before resuming the AutoCAD LT session.

The aclt.pgp file is an ASCII text file that stores command definitions. AutoCAD LT reloads aclt.pgp each time a new or 
existing drawing is opened. REINIT reloads aclt.pgp during an editing session.



Re-initialization Dialog Box
Up a Level

I/O Port Initialization
Controls the device for which you want to reinitialize the I/O port.

Digitizer
Initializes the I/O port for a digitizer.

Plotter
Initializes the I/O port for a digitizer.

Digitizer
Reinitializes the digitizer.

Display
Reinitializes the display.

PGP File
Reinitializes the aclt.pgp file.



RENAME Command
Up a Level          Related Topics

Changes the names of named objects
Several types of objects, such as blocks and layers, can be referred to by name. You can use RENAME for these objects. 

 At the Command prompt, enter rename

Block / Dimstyle / LAyer / LType / Style / Ucs / VIew / VPort: Enter an option

Old (object) name: Enter the old name

New (object) name: Enter the new name



For more information about renaming objects, see "Working with Named Objects," in chapter 10 of the AutoCAD LT User's 
Guide. 

Commands: DDRENAME is the dialog box equivalent of RENAME.



'RESUME Command
Up a Level          Related Topics

Continues an interrupted script
At the Command prompt, enter resume

You can interrupt a macro script that is running by pressing ESC or BACKSPACE. 

Any error encountered while processing input from a script file also causes the script to be suspended. If a script is 
suspended while AutoCAD LT is active, you can use the RESUME command to continue the script. 



Commands: SCRIPT executes a sequence of AutoCAD LT commands from a script file (extension.scr).



REVDATE Command
Up a Level

Inserts or updates a block containing user name, current time and date, and drawing name
   From the Tools menu, choose Date and Time
 At the Command prompt, enter revdate

The first time you use REVDATE in a drawing, AutoCAD LT inserts the block. When you next use REVDATE, AutoCAD LT 
updates the block.

You can explode the revdate block and place its contents in another location, such as a title block.

REVDATE block insertion point <0,0>: Specify a point or press RETURN

REVDATE block rotation (0 or 90 degrees) <0>: Specify an angle or press RETURN

AutoCAD LT inserts a revdate block or updates the existing block.



ROTATE Command
Up a Level          Related Topics

Rotates objects about a base point
 

From the Modify toolbar, choose 

From the Modify menu, choose Rotate 
At the Command prompt, enter rotate

Select objects: Use an object selection method

Base point: Specify a point (1)

<Rotation angle> / Reference: Specify an angle or enter r, or specify a point

The axis of rotation passes through the specified base point and is parallel to the z axis of the current UCS.

      

      



Rotation Angle (ROTATE)
Up a Level

Specifies how far an object rotates around the base point.



Reference (ROTATE)
Up a Level

Specifies the absolute current rotation angle and the desired new rotation angle. The Reference option is used to align an 
object with the X and Y axes of the UCS or with geometric features in a drawing.

Reference angle <0>: Specify an angle by entering a value or by specifying two points

New angle: Specify the new absolute angle

Note: When you rotate a viewport object, the borders of the viewport remain parallel to the edges of the graphics display 
area.



For more information, see "Rotating Objects" in chapter 9 of the AutoCAD LT User's Guide. 

Commands: UCS manages user coordinate systems. 



RSCRIPT Command
Up a Level          Related Topics

Repeats a script file
At the Command prompt, enter rscript

The last script file is repeated.

If RSCRIPT is the last line in a script file, the file runs continuously until interrupted by ESC.

Note: Consider turning off UNDO and any log files if you anticipate running the script over a long period. Otherwise, these 
log files continue to grow and take up increasing amounts of disk space.



Commands: UNDO reverses the effect of commands and keeps a log of commands used. LOGFILEON writes the text 
window to a file. LOGFILEOFF closes the file opened by LOGFILEON. SCRIPT executes a sequence of commands from a 
script file.



RTPAN (Real-Time Pan) Command 
Up a Level      Related Topics

Moves the view of the drawing in the current viewport in real time
You can pan with continuous visual feedback using your pointing device.

   

From the Standard toolbar, choose 
   From the View menu, choose Pan, then Real-Time Pan
 At the Command prompt, enter rtpan.

Hold down the pick button on your pointing device and drag in any direction to move the view of your drawing. Press Esc or 
Return to exit.

Note: Real-time panning is available in model space only.



For more information, see “Scrolling and Panning” in chapter 8 of the AutoCAD LT User’s Guide.

Commands: PAN moves the view of the drawing by a specified distance. DSVIEWER opens the Aerial View window. 
DVIEW defines parallel projection or perspective views. 



RTZOOM (Real-Time Zoom) Command 
Up a Level      Related Topics

Changes the apparent size of objects in the current viewport in real time
You can zoom with continuous visual feedback by using your pointing device.

   From the Standard toolbar, choose

   From the View menu, choose Zoom, then Real-Time Zoom
 

At the Command prompt, enter rtzoom

Hold down the pick button of your pointing device and drag up or down to change the magnification of your drawing. Press 
Esc or Return to exit.

Note: Real-time zooming is available in model space only.



For more information, see “Using the Zoom Options” in chapter 8 of the AutoCAD LT User’s Guide.

Commands: ZOOM changes the magnification in the current viewport. DSVIEWER opens the Aerial View window. DVIEW 
defines parallel projection or perspective views. 



SAVE Command
Up a Level          Related Topics

Saves the drawing under the current file name or a specified name 
At the Command prompt, enter save

If the drawing is named, AutoCAD LT saves the drawing without requesting a file name. If the drawing is unnamed, AutoCAD
LT displays the Save Drawing As dialog box and saves the drawing under the file name you specify. 

If the drawing is read-only, use the SAVEAS command to save changes under a different file name.

Note: The SAVE command is now functionally identical to the QSAVE command.



Commands: QSAVE saves the current drawing. QUIT exits AutoCAD LT and allows you to save changes to the current 
drawing. SAVEAS renames the current drawing to the name specified. END saves the current drawing and exits AutoCAD 
LT.



SAVEAS Command
Up a Level          Related Topics

Saves a copy of the current drawing under a new file name
 From the File menu, choose Save As

At the Command prompt, enter saveas

The Save Drawing As dialog box is displayed. 

You can also specify a new file location and format. 



Save Drawing As Dialog Box
Up a Level

File Name
Select or enter the name you want to assign to the drawing file you want to save. 

Save File as Type
Select the type of files you want displayed in the File Name box. Select the file format in which you want to save the 
drawing.

Directories
Select the directory where you want to store the saved drawing file.

Drives
Select the drive where you want to store the saved drawing file.

Network
To connect network drives to your computer, choose Network. The Map Network Drive dialog box is displayed. 



Template Description Dialog Box
Up a Level

Description
Enter a description of the template.

Measurement
Specify the unit of measurement.



Commands: QSAVE saves the current drawing. QUIT exits AutoCAD LT and allows you to save changes to the current 
drawing. SAVE saves the drawing under the current file name or a specified name. END saves the current drawing and exits
AutoCAD LT.



SCALE Command
Up a Level          Related Topics

Enlarges or reduces selected objects equally in the X, Y, and Z directions
 

From the Modify toolbar, choose 
 From the Modify menu, choose Scale

At the Command prompt, enter scale

Select objects: Use an object selection method

Base point: Specify a point (1)

<Scale factor> / Reference: Specify a scale or enter r

 



Scale Factor (SCALE)
Up a Level

Multiplies the dimensions of the selected objects by the specified scale. A scale factor greater than 1 enlarges the objects. A 
scale factor between 0 and 1 shrinks the objects.

        

      



Reference (SCALE)
Up a Level

Scales the selected objects based on a reference length and a specified new length.

Reference length <1>: Specify a distance or press RETURN

New length: Specify a distance 

If the new length is longer than the reference length, the objects are enlarged. if the new length is shorter than the reference 
length, the objects are reduced.

      



For more information, see "Scaling Objects" in chapter 10 of the AutoCAD LT User's Guide. 

Commands: LENGTHEN lengthens an object, STRETCH moves or stretches an object. 



'SCRIPT Command
Up a Level          Related Topics

Executes a sequence of commands from a script file
   From the Tools menu, choose Run Script
 

At the Command prompt, enter script

The Select Script File dialog box is displayed. Entering the file name of a script in the Select Script File dialog box invokes 
that script.



Select Script File Dialog Box
Up a Level

Runs a series of commands saved in a script file.

File Name
Select or enter the name of the script file you want to run. 

List Files of Type
Select the type of files you want to see in the File Name box.

Directories
Select the directory that contains the script file you want to run.

Drives
Select the drive that contains the script file you want to run.

Find File...
To use search criteria to find script files on multiple drives and directories, choose Find File. The Browse/Search dialog box 
is displayed.

Network
To connect network drives to your computer, choose Network. The Map Network Drive dialog box is displayed. 



Commands: DELAY provides a timed pause in scripts. RSCRIPT replays a script nonstop.



SELECT Command
Up a Level          Related Topics

Places selected objects in the Previous selection set
The SELECT command is most commonly used with the noun-verb method of editing. Using this method, you select objects 
before choosing an editing command instead of after. There are several options for adding objects to the selection set or 
removing them.

   From the Standard Toolbar, choose

 From the Edit menu, choose Select ALL
 At the Command prompt, enter select

Select objects: Use an object selection method

AutoCAD LT places the selected objects in a selected set named previous. You can select objects by picking them 
individually, drawing a selection window around them, entering coordinates, or using another selection method.

In several selection options, a small box, called the pickbox, replaces the crosshairs on the graphics cursor.

The following methods can be used to select objects regardless of the command that initiated the Select Objects prompt. 
With the exception of Auto, these methods are not affected by PICKADD the system variable.

Add
ALL
AUto
BOX
CPolygon
Crossing
Fence
Last

Multiple
Previous
Remove
SIngle
Undo
Window
WPolygon

For more information, see "Selecting Objects" in chapter 9 of the AutoCAD LT User's Guide. 

Commands: DDSELECT controls object selection settings, including noun/verb selection and creates a named selection set
of objects.

System Variables: PICKFIRST controls whether AutoCAD LT accepts object selection before an editing command. 
PICKADD controls whether subsequent selections replace the current selection set or add to it.



Add 

Switches to Add mode. Auto and Add are the default modes in the SELECT command. In Add mode, selected objects can be
added to the selection set by using any of the object selection methods.



All 

Selects all objects on thawed and unlocked layers.



Auto 

Switches to automatic mode. Auto and Add are the default modes in the SELECT command. In automatic selection, pointing 
to an object selects the object. Pointing to a blank area inside or outside an object forms the first corner of a box defined by 
the Box method.



Box 

Selects all objects inside or crossing a rectangle specified by two points. If the rectangle's points are specified from right to 
left, Box is equivalent to Crossing. Otherwise, Box is equivalent to Window. 

First corner: Specify a point

Other corner: Specify a point for the opposite corner



Crossing 

Selects objects within and crossing a box defined by two points. Crossing displays a dashed or otherwise highlighted box to 
differentiate it from a window selection box.

First corner: Specify a point (1) for a right corner

Other corner: Specify a point (2) for a left corner



Cpolygon

Selects objects within and crossing a polygon defined by specifying points around the objects to be selected. The polygon 
can be any shape but cannot cross or touch itself. AutoCAD LT sketches the last segment of the polygon so that it is closed 
at all times. 

First polygon point: Specify a point

Undo / <Endpoint of line>: Specify a point, enter u, or press RETURN



Fence

Selects all objects crossing a selection fence. The Fence method is similar to the CPolygon method except that AutoCAD LT
does not close the last of the fence, and a fence can cross itself. Fence is not affected by the PICKADD system variable.

First fence point: Specify a point

Undo / <Endpoint of line>: Specify a point, enter u, or press RETURN



Last 

Selects the most recently created object. 



Multiple

Specifies multiple points without highlighting the objects, thus speeding up the selection process for complex objects. The 
Multiple method also selects two intersecting objects if the intersection point is specified twice.



Previous

Selects the most recent selection set. The Previous selection set is ignored if you switch between model space and paper 
space.



Remove 

Switches to Remove mode, in which objects can be removed from the current selection set using any object selection 
method. An alternative to Remove mode is to press SHIFT while selecting single objects or using the Automatic option.



Single

Switches to Single mode and selects the first object or set of objects designated rather than continuing to prompt for further 
selections.



Undo 

Cancels selection of the object most recently added to the selection set.



Window

Selects all objects completely inside a rectangle defined by two points.

First corner: Specify a point (1) for a left corner

Other corner: Specify a point (2) for a right corner



Wpolygon

Selects objects within a polygon defined by points. The polygon can be any shape but cannot cross or touch itself. AutoCAD 
LT sketches the last segment of the polygon so that it is closed at all times. WPolygon is not affected by the PICKADD 
system variable.

First polygon point: Specify a point

Undo / <Endpoint of line>: Specify a point, enter u, or press RETURN



'SETVAR Command
Up a Level

Lists or changes the values of system variables
At the Command prompt, enter setvar

Variable name or ? <current>: Enter a variable name or ?, or press RETURN to list all variables and    their current 
options

The current system variable is displayed after SETVAR is used in a drawing session.

You can change the value of system variables at the Command prompt by entering the name of the variable and its new 
value. 



?List Variables

Variable(s) to list <*>: Enter a wild-card pattern or press RETURN



Variable Name

New value for variable<current>: Enter a new value or press RETURN



SHADE Command
Up a Level          Related Topics

Displays a flat-shaded image of the drawing in the current viewport
The SHADE command uses the colors of the object being shaded. AutoCAD LT calculates shading based on one light 
source from directly behind the eye. Subsequent changes to the drawing are not reflected in the shaded object until you use 
the SHADE command again. The shaded image remains in the viewport until the viewport is regenerated. 

The shaded image cannot be printed or plotted; however, you can output a shaded image to a slide using the MSLIDE 
command. 

On systems that display fewer than 256 colors, SHADE produces an image that removes hidden lines and displays the 
faces in their original color with no lighting effect. 

From the View menu, choose Shade
At the Command prompt, enter shade

AutoCAD LT removes hidden lines and displays a shaded picture of the drawing. 

      



For more information, see "Creating a Shaded View of Your Drawing" in chapter 11 of the AutoCAD LT User's Guide.

Commands: HIDE regenerates a 3D model with hidden lines removed. MSLIDE creates a slide file of the current viewport. 
VSLIDE displays a slide file in the current viewport.

System Variables: SHADEDGE determines the shading method used. SHADEDIF controls diffuse reflection.



'SNAP Command
Up a Level          Related Topics

Restricts cursor movement to regular intervals
The points you enter with a pointing device can be locked into regular intervals on an invisible rectangular snap grid. You 
can rotate the snap grid, set differing X and Y spacing, or choose an isometric format.

A change in the snap grid affects only the coordinates of new points. Objects already in the drawing retain their existing 
coordinates.

The snap grid is invisible. Use the GRID command to display a separate visible grid of dots. Set the spacing of the two grids 
to equal or related values.

 At the Command prompt, enter snap

Snap spacing or ON / OFF / Aspect / Rotate / Style <current>: Specify a distance, enter an option, or press RETURN



Spacing (SNAP)
Up a Level

Activates Snap mode with the value you specify.



On (SNAP)
Up a Level

Activates Snap mode using the current snap grid resolution, rotation, and style.



Off (SNAP)
Up a Level

Turns off snap mode but retains the values and modes.



Aspect (SNAP)
Up a Level

Specifies different spacing in the X and Y directions. This option is not available if the current snap style is Isometric.

Horizontal spacing <current>: Specify a distance, or press RETURN

Vertical spacing <current>: Specify a distance, or press RETURN



Rotate (SNAP)
Up a Level

Sets the rotation and base point of the snap grid with respect to the drawing and the display screen. 

The base point sets the origin point of the snap grid, shifting it to a specified location. You can specify a rotation angle 
between -90 and 90 degrees. A positive angle rotates the grid counterclockwise about its base point. A negative angle 
rotates the grid clockwise.

Base point <current>: Specify a point or press RETURN

Rotation angle <current>: Specify an angle or press RETURN

Angle adjusted to value.



Style (SNAP)
Up a Level

Selects the format of the snap grid, which is standard or isometric.

Standard / Isometric <current>: Enter s or i, or press RETURN

Standard
Displays a rectangular grid that is parallel to the XY plane of the current UCS. X and Y spacing may differ.

Spacing / Aspect <current>: Specify a distance, enter a, or press RETURN

Isometric
Displays an isometric grid, where the grid points are initially at 30- and 150-degree angles.

Vertical spacing <current>: Specify a distance or press RETURN

The ISOPLANE system variable determines whether the crosshairs lie in the top isometric plane (30- and 150-degree 
angles), the left isoplane (90- and 150-degree angles), or the right isoplane (30- and 90-degree angles).

 

 

Isometric snap can be rotated but cannot have different horizontal and vertical spacing.



Spacing

Changes the overall spacing.



Aspect

Changes the horizontal and vertical spacing separately.



For more information about Snap mode, see "Snapping to Geometric Points on Objects," in chapter 7 of the AutoCAD LT 
User's Guide.

Commands: GRID displays a dot grid at the specified spacing and angle.

Variables: SNAPBASE stores the origin point of the Snap grid. The grid display is also changed after a redraw or other 
viewing command.



SOLID Command
Up a Level          Related Topics

Creates solid-filled triangles and quadrilaterals
 

From the Draw toolbar, choose 
 From the Draw menu, choose 2D Solid

At the Command prompt, enter solid

First point: Specify a point (1)

Second point: Specify a point (2)

The first two points define one edge of the polygon.

Third point: Specify a point (3) diagonally opposite the second 

Fourth point: Specify a point (4) or press RETURN 

Pressing RETURN creates a filled triangle. Specifying a fourth point creates a quadrilateral area. 

The last two points form the first edge of the next filled area. 

AutoCAD LT repeats the Third Point and Fourth Point prompts. Specifying successive third and fourth points creates 
additional triangles and quadrilaterals. Pressing RETURN ends the command. 

Solids are filled only when the FILLMODE system variable is on and the viewing direction is orthogonal to 2D solid.



For more information about solids, see "Creating Solid Filled Areas" in chapter 6 of the AutoCAD LT User's Guide. 

Commands: FILL controls Fill mode.

System Variables: FILLMODE stores the current setting for Fill mode.



'SPELL Command
Up a Level          Related Topics

Checks spelling in a drawing
   

From the Standard toolbar, choose 
   From the Tools menu, choose Spelling
 At the Command prompt, enter spell

Select objects: Use an object selection method

The SPELL command corrects the spelling of text objects created with the TEXT, DTEXT (line text), and MTEXT (paragraph
text) commands.

The Check Spelling dialog box is displayed only if AutoCAD LT finds an unknown word in the selected text.



Check Spelling Dialog Box
Up a Level

Current Dictionary
Displays the name of the dictionary currently loaded. To use a different dictionary, select Change Dictionaries.

Current Word
Displays the name of the word being checked.

Suggestions
Displays a list of suggested replacement words from the current dictionary. Select a replacement or enter a replacement 
word in the box.

Ignore
Does not replace the word currently being checked with the word displayed in Suggestions. 

Change
Replace the word currently being checked with the word displayed in Suggestions. 

Add
Adds the current word to the custom dictionary.

Note: This option is not available if you have not loaded a custom dictionary. To load a custom dictionary, choose Change 
Dictionaries.

Ignore All
Ignores all instances of the current word in the entire text object.

Change All
Replaces all instances of the word currently being checked in the text object with the word displayed in Suggestions. 

Lookup
Lists words similar to the word selected in Suggestions.

Change Dictionaries
Displays the Change Dictionaries dialog box. You can change the main dictionary, open a custom dictionary, or create a 
custom dictionary. 

Context
Displays the phrase in which the current word is located.



Change Dictionaries Dialog Box
Up a Level

Changes the dictionary used by the SPELL command.

Main Dictionary
Select the main dictionary you want to use for all spelling checks. This dictionary is used in conjunction with any custom 
dictionary you may have loaded.

Custom Dictionary
Enter the drive, directory, and file name of the custom dictionary (file extension .cus) you want to use for the spell check. To 
create a new custom dictionary, enter a name and choose OK.

Browse
Select Browse to use a dialog box to find a custom dictionary or to define the location of a new custom dictionary. The Select
Custom Dictionary dialog box is displayed.

Custom Dictionary Words
Displays a list of words that have been added to the custom dictionary. Enter a word in the box to add to the dictionary or 
select a word you want to delete from the list.

Add. Adds to add the word you entered in the box.
Delete. Deletes to delete the word you selected in the list.



Select Custom Dictionary Dialog Box
Up a Level

File Name
Select or enter the name of the custom dictionary file you want to use or create. Be sure to add the file extension .cus.

List Files of Type
Select the type of files you want to see in the File Name list.

Directories
Select the directory that contains the custom dictionary file you want to use.

Drives
Select the drive that contains the custom dictionary file you want to use.

Find File...
Choose Find File to find custom dictionary files on multiple drives and directories. The Browse/Search dialog box is 
displayed.

Network
Choose Network to connect network drives to your computer so that you can access files on those drives. The Map Network 
Drive dialog box is displayed. 



For more information, see "Checking Spelling", in chapter 12 of the AutoCAD LT User's Guide.

Commands: DDEDIT edits text and attribute definitions. DTEXT creates a single line of text on the screen as you enter it. 
MTEXT creates a paragraph that fits within a specified area. STYLE creates text styles. TEXT creates a single line of text.

System Variables: DCTCUST displays the current custom spelling dictionary path and file name. DCTMAIN displays the 
current main spelling dictionary file name.



SPLINE Command
Up a Level          Related Topics

Creates a quadratic or cubic spline (NURBS) curve
The SPLINE command fits a smooth curve to a sequence of points within a specified tolerance.

   

From the Draw toolbar, choose 
 From the Draw menu, choose Spline
 At the Command prompt, enter spline

Object / <Enter first point>: Specify a point or enter o

Enter First Point
Creates a spline using points you specify.

Enter point: Specify a point

Enter points until you have defined the spline curve. After you have entered two points, AutoCAD LT displays the following 
prompt:

Close / Fit Tolerance / <Enter point>: Specify a point, enter an option, or press RETURN

Object
Converts 2D or 3D quadratic or cubic spline-fit polylines to equivalent splines and deletes the polylines. 

Select objects to convert to splines:

Select objects: Select 2D or 3D spline-fit polylines

If you specify tangency at both endpoints of the spline, you can enter a point or use the Tangent and Perpendicular object 
snaps to make the spline tangent or perpendicular to existing objects. If you press RETURN, AutoCAD LT calculates default 
tangents.



For more information, see "Drawing Spline Curves" in chapter 6 of the AutoCAD LT User's Guide.

Commands: SPLINEDIT edits a spline object. PEDIT can edit a polyline object into a spline-fit polyline. The order of the 
resulting spline-fit polyline depends on the variable SPLINETYPE.



Enter Point (SPLINE)
Up a Level

Continuing to enter points adds additional spline curve segments until you press RETURN. Enter undo to remove the last 
point specified. 

Enter Start Tangent: Specify a point or press RETURN

The Enter start tangent prompt specifies the tangency of the spline curve at the first point.

Enter End Tangent: Specify a point or press RETURN

The Enter End Tangent prompt specifies the tangency of the spline curve at the last point.

      



Close (SPLINE)
Up a Level

Closes the spline curve by defining the last point to be coincident with the first and making it tangent to the joint. 

Enter tangent: Specify a point or press RETURN

Specify a point to define the tangent vector or use the Tangent and Perpendicular object snaps to make the spline tangent or
perpendicular to existing objects.



Fit Tolerance (SPLINE)
Up a Level

Changes the tolerance for fitting of the current spline curve. The current spline curve is redefined such that it can fit through 
existing points differently, according to the new tolerance.

Enter Fit Tolerance <current>: Enter a value or press RETURN

If you set the tolerance to 0, the spline curve passes through the fit points. Entering a tolerance greater than 0 allows the 
spline curve to pass through the fit points within the specified tolerance. 

      



SPLINEDIT Command
Up a Level          Related Topics

Edits a spline object
   

From the Modify toolbar, choose 

From the Modify menu, choose Objects, then Edit Spline
 At the Command prompt, enter splinedit

Select spline: Use an object selection method

If you select a spline that was created with the SPLINE command, fit points appear in the same color as grips. If you select a
spline that was created with the PLINE command, control points also appear in the same color as grips. 

Fit Data / Close / Move Vertex / Refine / rEverse / Undo / eXit <X>: Enter an option or press RETURN

If the selected spline is closed, the Close option changes to Open. If the selected spline has no fit data, the Fit Data option is
not available. Fit data consists of all fit points, the fit tolerance, and tangents associated with splines created with the 
SPLINE command.

A spline can lose its fit data if you

Use the Purge option while editing fit data
Refine the spline
Fit the spline to a tolerance and move its control vertices
Fit the spline to a tolerance and open or close it



For more information, see "Editing Splines" in chapter 10 of the AutoCAD LT User's Guide.

Commands: PEDIT edits spline-fit polylines. SPLINE creates a quadratic or cubic spline (NURBS) curve.



Fit Data (SPLINEDIT)
Up a Level

Edits fit data using the following options:

Add / Close / Delete / Move / Purge / Tangents / toLerance / eXit <X>: Enter an option or press RETURN



Add

Adds fit points to a spline.

Select point: Select a fit point

Enter new point: Specify a point

Enter new point: Specify a point or press RETURN

When you select a point, AutoCAD LT highlights it and the next point and interprets the new point to go between the 
highlighted points. Use the Undo option to remove the last point added. Selecting the last point on an open spline highlights 
only that point, and AutoCAD LT adds the new point after the last. If you select the first point on an open spline, you have the
option of placing the new point before or after the first point.

After / <Before> <Enter new point>: Specify a point, enter an option, or press RETURN

Enter new point: Specify a point or press RETURN

AutoCAD LT adds the point and refits the spline through the new set of points.

      

      



Close

Closes an open spline and makes it tangent continuous (smooth) at its endpoints. If the start point and endpoint of the spline
are the same, the close option makes it tangent continuous at both points.

      



Open

Opens a closed spline. If the start point and endpoint of the spline were the same before the Close option was used to make
it tangent continuous at both points, the Open option returns the spline to its original state. The start point and endpoint 
remain the same but lose their tangent continuity (smoothness).

If the spline was open before the Close option was used to make it tangent continuous where the start point and endpoint 
meet, the open option returns the spline to its original open state and removes tangent continuity.

      



Delete

Removes fit points from a spline and refits the spline through the remaining points.

Select point: Select a fit point or press RETURN



Move

Moves a fit point to a new location.

Next / Previous / Select Point / eXit / Enter new location: <N>: Specify a point, enter an option, or press RETURN

      

      

Use Select Point to select from the set of fit points. Next changes the selected point to be the next point; Previous changes it
to be the previous point. Enter New Location moves the selected point when you specify a point. Exit returns you to the main
prompt of the SPLINEDIT command.



Purge

Removes a spline's fit data from the drawing database. After purging the spline's fit data, AutoCAD LT displays the main 
prompt without the Fit Data option.



Tangents

Edits the start and end tangents of a spline.

System Default/<Enter start tangent>: Specify a point, enter an option, or press RETURN

System Default/<Enter end tangent>: Specify a point, enter an option, or press RETURN

If the spline is closed, the Enter Start Tangent option changes to Enter Tangent. 

The System Default option calculates the default tangents at the ends.

You can specify a point or use Tan or Perp object snap mode to make the spline tangential or perpendicular to existing 
objects. 



Tolerance

Refits the spline to the existing points with new tolerance values.

Enter fit tolerance <current>: Enter a value or press RETURN



Exit

Returns to the main prompt of the SPLINEDIT command.



Close (SPLINEDIT)
Up a Level

Closes an open spline and makes it tangent continuous (smooth) at its endpoints. If the start point and endpoint of the spline
are the same, the Close option makes it tangent continuous at both points.



Open (SPLINEDIT)
Up a Level

Opens a closed spline. If the start point and endpoint of the spline were the same before the Close option was used to make
it tangent continuous at both points, the Open option returns the spline to its original state. The start point and endpoint 
remain the same but lose their tangent continuity (smoothness).

If the spline was open before the Close option was used to make it tangent continuous where the start point and endpoint 
meet, the Open option returns the spline to its original open state and removes tangent continuity.



Move Vertex (SPLINEDIT)
Up a Level

Relocates the control vertices of a spline and purges the fit points.

Next / Previous / Select Point / eXit / Enter new location <N>: Specify a point, enter an option, or press RETURN



Next
Changes the selected point to be the next point. The point marker does not wrap around from the end to the start of the 
spline, even if the spline is closed. 



Previous
Changes the selected point to be the previous point. The point marker does not wrap around from the end to the start of the 
spline, even if the spline is closed. 



Select Point
Selects a point from the set of control points.



Exit
Returns to the main prompt of the SPLINEDIT command.



Enter New Location
Moves the selected point to a new location when you locate a point or enter a coordinate.

After you enter a new location for the selected point, AutoCAD LT recalculates and displays the spline with a new set of 
control points.



Refine (SPLINEDIT)
Up a Level

Fine-tunes a spline definition.

Add control point / Elevate Order / Weight / eXit <X>: Enter an option or press RETURN

Add Control Point
Increases the number of points that control a portion of a spline.

Select a point on the spline: Select a point or press RETURN

AutoCAD LT adds a new control point close to the location you select between the two control points. 

      

Elevate Order
Increases the order of the spline.

Enter new order <current>: Enter an integer or press RETURN

Entering a value greater than the current value increases the number of control points uniformly across the spline for more 
localized control. The maximum value for order is 26.

Weight
Changes the weight at various spline control points. A larger value will pull the spline closer to the control point.

Next / Previous / Select Point / eXit / <Enter new weight> <current> <N>: Enter an integer, enter an option, or press 
RETURN

Exit

Returns to the main prompt.



Next

Changes the selected point to be the next point. The point marker does not wrap around from the end to the start of the 
spline, even if the spline is closed.



Previous

Changes the selected point to be the previous point. The point marker does not wrap around from the end to the start of the 
spline, even if the spline is closed.



Select Point

Selects a point from the set of control points.



Exit

Returns to the main Refine prompt.



Enter New Weight

Recalculates the spline based on the new weight value at the selected control point. The larger the value, the more the 
spline is pulled toward the control point.



Reverse (SPLINEDIT)
Up a Level

Reverses the direction of a spline.



Undo (SPLINEDIT)
Up a Level

Cancels the last editing action.



Exit (SPLINEDIT)
Up a Level

Ends the command and returns to the Command prompt.



STRETCH Command
Up a Level          Related Topics

Moves or stretches objects
 

From the Modify toolbar, choose 

From the Modify menu, choose Stretch
At the Command prompt, enter stretch

Select objects: Use the CPolygon or Crossing object selection method

AutoCAD LT stretches arcs, elliptical arcs, lines, polyline segments, 2D solids, rays, and splines that cross the selection 
window. The STRETCH command also moves vertices of traces and 2D solids that lie inside the window and leaves those 
outside unchanged. Polylines are handled segment-by-segment, as if they were primitive lines or arcs. STRETCH does not 
modify polyline width, tangent, or curve-fitting information.

      

Any objects that are entirely within the window or polygon are moved, as if you were using the MOVE command. 

Base point or displacement: Specify a point (3) or press RETURN

Second point of displacement: Specify a point (4) or press RETURN

      

If you enter a second point, the objects are stretched the distance from the base point to the second point. If you press 
RETURN instead of specifying a second point of displacement prompt, STRETCH treats the first point as the X,Y 
displacement value.





For more information, see "Stretching Objects" in chapter 10 of the AutoCAD LT User's Guide. 

Commands: EXTEND extends a line, arc, or polyline to meet another object. LENGTHEN lengthens an object. MOVE 
displaces objects a specified distance in a specified direction. TRIM trims selected objects precisely at a defined cutting 
edge. 



'STYLE Command
Up a Level          Related Topics

Creates named text styles
The STYLE command also modifies existing styles and sets the current style for subsequent TEXT, DTEXT, and MTEXT 
commands. 

   From the Data menu, choose Text Style
 At the Command prompt, enter style

Text style name (or ?) <current>: Enter a style name, enter ?, or press RETURN

Entering ? displays the following prompt:

Text style(s) to list <*>: Enter a wild-card pattern, or press RETURN

Entering the name of a style displays the name, font file, height, width factor, obliquing angle, and generation of the style and
exits the command. Entering an asterisk (*) or pressing RETURN displays the height, width factor, obliquing angle, and 
generation of each style and exits the command.

The text style name can contain up to 31 characters, including digits, letters, and the special character dollar sign ($), 
hyphen (-), and underscore (_) . Press RETURN to display the Select Font File dialog box.

In the Select Font File dialog box, valid types include files with .pfa, .pfb, .shx, and .ttf extensions. AutoCAD LT reads the 
specified font file and automatically loads the file's character definitions unless the file is already in use by another text style. 
You can have several styles in the same font file.

Height <current>: Specify a distance or press RETURN

If you enter a height of 0.0, AutoCAD LT prompts you for the text height each time you enter text using this style. Entering a 
height greater than 0.0 sets the text height for this style.

Width factor <current>: Specify a distance or press RETURN

Entering a value less than 1.0 condenses the text. Entering a value greater than 1.0 expands it.

Obliquing angle <current>: Specify an angle or press RETURN

Entering values between -85 and 85 italicizes the text.

Backwards <N>: Enter y or n, or press RETURN

Upside-down <N>: Enter y or n, or press RETURN

Vertical <N>: Enter y or n, or press RETURN

Vertical is available only if the selected font supports dual orientation.

If you change the orientation or font file of an existing text style, all text objects with that style use the new values when the 
drawing is regenerated.

You can use the DDRENAME or RENAME command to change the name of an existing text style. Any existing text object 
that uses the old style name, takes the new name automatically.



For more information about working with text, see "Working with Styles" in chapter 12 of the AutoCAD LT User's Guide. 

Commands: DDSTYLE is the dialog box version of the STYLE command. You can use it to create or change text styles. 
DDEDIT edits text and attribute definitions. DDRENAME and RENAME change the names of objects. DTEXT creates text 
on the screen as you enter the text. MTEXT creates a paragraph that fits within a specified area. TEXT enters a single line 
of text. 



SYSWINDOWS Command
Up a Level        

Arranges windows
The SYSWINDOWS command is equivalent to the standard Window menu options in Windows applications. 

 At the Command prompt, enter syswindows

Cascade / tileHorz / tileVert / Arrangeicons: Enter an option



Cascade

Overlaps windows with visible title bars.



Tilehorz

Arranges windows in horizontal, nonoverlapping tiles.



Tilevert

Arranges windows in vertical, nonoverlapping tiles.



Arrangeicons

Arranges the window icons.



TABLET Command
Up a Level          Related Topics

Calibrates and configures the tablet; turns Tablet mode on and off
   From the Options menu, choose Tablet

 At the Command prompt, enter tablet

Option (ON / OFF / CAL/ CFG): Enter an option



On (TABLET)
Up a Level

Turns on Tablet mode. Setting the TABMODE system variable to 1 also turns on Tablet mode. Pressing CTRL+T on some 
systems turns Tablet mode on and off. 



Off (TABLET)
Up a Level

Turns off Tablet mode.. Setting the TABMODE system variable to 0 also turns off Tablet mode. Pressing CTRL+T on some 
systems turns Tablet mode on and off.



Cal (TABLET)
Up a Level

Calibrates the digitizer with a paper drawing or photograph, creating the tablet transformation, which is the mapping of points
from the tablet to the coordinate drawing system. Calibration is digitizing points on the drawing and mapping them to their 
real coordinates.

Calibration can be performed in model space or paper space. The CAL option turns on Tablet mode in the space in which 
the tablet is calibrated. When the space is changed, the CAL option turns off Tablet mode.

The paper should be flat (with no bumps or wrinkles), and securely fastened to the digitizing tablet. The paper can be 
oriented at any angle.

Digitize point #1: Digitize a point on the paper drawing

Enter coordinates point #1: Specify an X,Y coordinate at the digitized point

Digitize point #2: Digitize a point on the paper drawing

Enter coordinates point #2: Specify an X,Y coordinate at the digitized point

Digitize point #3 (or RETURN to end): Digitize a point on the tablet or press RETURN

Enter coordinates for point #3: Specify an X,Y coordinate in the drawing

The points entered can not be duplicates. The points need not be the origin on either axis, and you can enter as many points
as you like. The more points entered, the more accurate the drawing will be.

After calibrating the tablet, set the transformation to Orthogonal, Affine, or Projective.

If only two points are entered, AutoCAD LT automatically computes an orthogonal transformation. If it is successful, 
AutoCAD LT ends the command.

If three or more points are entered, AutoCAD LT computes the transformation in each of the three types to determine which 
best fits the calibration points. If more than four points are entered, computing the best-fitting projective transformation can 
take a long time. You can cancel the process by pressing ESC. 

When the computations are complete, AutoCAD LT displays a table with the number of calibration points and a column for 
each transformation type. The following information is provided under each column: Outcome of fit, RMS error, Standard 
deviation, Largest residual/At point and Second largest residual/At point. The remaining entries in each column are blank 
unless the outcome of fit is Success. 



Cfg (TABLET)
Up a Level

Designates or realigns the tablet menu areas or designates a portion of a large tablet as a screen pointing area.

To configure the digitizer for use with the tablet menu

To configure or reconfigure the template for digitizing drawings

For more information, see appendix H, “Using Digitizers,” in the AutoCAD LT User’s Guide.



To configure the digitizer for use with the tablet menu
Up a Level

This procedure maps the digitizer template to AutoCAD LT commands. It is not recommended for digitizing drawings.

The printed menu form must be affixed to the tablet surface, and the requested points must be digitized. Each set of three 
points must form a 90-degree angle. Tablet menu areas can be skewed to an angle.

1 At the Command prompt, enter tablet

Option (ON/OFF/CAL/CFG): Enter cfg

2 At the following prompt, enter 4. 

Enter number of tablet menus desired (0-4) <0>: 

3 When prompted, digitize the upper-left, lower-left, and lower-right corners of menu area 1.

In response to the following prompts, press RETURN.

Enter the number of columns for menu area 1, 1 to 4991 <25>: 

Enter the number of rows for menu area 1, 1 to 1839 <9>: 

4 When prompted, digitize the upper-left, lower-left, and lower-right corners of menu area 2.

In response to the following prompts, press RETURN.

Enter the number of columns for menu area 2, 1 to 2202 <11>: 

Enter the number of rows for menu area 2, 1 to 1809 <9>:

5 When prompted, digitize the upper-left, lower-left, and lower-right corners of menu area 3.

In response to the following prompts, press RETURN.

Enter the number of columns for menu area 3, 1 to 539 <9>: 

Enter the number of rows for menu area 3, 1 to 1806 <13>: 

6 When prompted, digitize the upper-left, lower-left, and lower-right corners of menu area 4.

In response to the following prompts, press RETURN.

Enter the number of columns for menu area 4, 1 to 5004 <25>: 

Enter the number of rows for menu area 4, 1 to 1407 <7>: 

In response to the following prompt, enter y.

Do you want to respecify the Fixed Screen Pointing Area? <N>: 

7 When prompted, digitize the lower-left and upper-right corners of the fixed screen-pointing area.

8 Continue to respond to the following prompts to designate your floating screen-pointing area.

In response to the following prompts, enter y.

Do you want to specify the Floating Screen Pointing Area? <N>: 

In response to the following prompts, enter y or n.

Do you want the Floating Screen Pointing Area to be the same size as the Fixed Screen Pointing Area? <Y>: 

9 When prompted, digitize the lower-left and upper-right corners of the floating screen-pointing area.

In response to the following prompts, enter y or n.

The F12 key will toggle the Floating Screen Pointing Area ON and OFF. Would you like to specify a button to toggle the 
Floating Screen Area? <N>:

Press any nonpick button that you wish to designate as the toggle for the floating screen area. 



To configure or reconfigure the template for digitizing drawings
Up a Level

This procedure configures the template to calibrate the tablet for digitizing drawings or photographs.

1 At the Command prompt, enter tablet.

Option (ON/OFF/CAL/CFG): Enter cfg.

2 At the following prompt, enter 0. 

Enter number of tablet menus desired (0-4) <0>: 

3 At the following prompt, enter y.

Do you want to respecify the Fixed Screen Pointing Area? <N>

4 At the following prompt, digitize an area that is greater than or equal to the area you will use to digitize drawings.

Digitize lower left corner of Fixed Screen Pointing Area:

Digitize upper right corner of Fixed Screen Pointing Area:

5 At the following prompt, enter y if you want a floating screen-pointing area.

Do you want to specify the Floating Screen Pointing Area? <N>

6 At the following prompt, enter y or n.

Do you want the Floating Screen Pointing Area to be the same size as the Fixed Screen Pointing Area? <Y>: 

7 In response to the following prompt, enter y or n.

The F12 key will toggle the Floating Screen Pointing Area ON and OFF. Would you like to specify a button to toggle the 
Floating Screen Area? <N>:

8 In response to the following prompt, enter y or n.

Press any nonpick button that will become the toggle for the Floating Screen Area.



Commands: REINIT reinitializes the digitizer.

System Variables: TABMODE turns Tablet mode on and off.



Orthogonal 

Specifies translation, uniform scaling, and rotation with two calibration points.

Use Orthogonal for dimensionally accurate paper drawings and paper drawings in which the portion to be digitized is long 
and narrow, with most points confined to single lines.



Affine 

Specifies arbitrary linear transformation in two dimensions consisting of translation, independent X- and Y-scaling, rotation, 
and skewing with three calibration points.

Use Affine when horizontal dimensions in a paper drawing are stretched with respect to vertical dimensions, and lines that 
are supposed to be parallel actually are parallel.

The RMS (root mean square) error reported after calibration measures how close AutoCAD LT has come to making a perfect
fit. Affine should be used if the RMS is small.



Projective 

Specifies a transformation equivalent to a perspective projection of one plane in space onto another plane with four 
calibration points. 

A projective transformation provides a limited form of what cartographers call rubber sheeting, in which different portions of 
the tablet surface are stretched by varying amounts. Straight lines map into straight lines. Parallel lines do not necessarily 
stay parallel.

Projective transformation corrects parallel lines that appear to converge. 



Outcome of Fit

Reports the outcome of fit for each of the transformation types. If the outcome of fit is not Success or Exact for any of the 
transformation types, AutoCAD LT reports failure of the entire calibration process and ends the command. 

Exact
Correct number of points for a valid transformation.

Success
More than enough points. AutoCAD LT succeeded in fitting a transformation to the data.

Impossible
Not enough points.

Failure
Enough points, but AutoCAD LT was unable to fit a transformation to the points, usually because some points were colinear 
or coincident.

Canceled
Fit process canceled. This outcome occurs only with the projective transformation.



RMS Error

Reports the RMS (root-mean-square) error, which measures how close AutoCAD LT has come to finding a perfect fit. The 
goal is the smallest RMS error.



Standard Deviation

Reports the standard deviation of the residuals. If it is near zero, the residual at each calibration point is about the same. 



Largest Residual/At Point

Reports the point at which the mapping is least accurate. The residual is the distance between where the point was mapped 
during transformation and where it would be mapped if the fit were perfect. The distance is given in the current linear units.



Second-Largest Residual/At Point 

Reports the point at which the mapping is second least accurate. The residual is the distance between where the point was 
mapped during transformation and where it would be mapped if the fit were perfect. The distance is given in the current 
linear units.

If there have been no failures of projection transformation, AutoCAD LT prompts:

Select transformation type...

Orthogonal / Affine / Projective?<Repeat table>: Enter an option or press RETURN

Only transformation types for which the outcome was Success, Exact, or Canceled are included in this prompt. A projective 
transformation can be specified even if it was canceled. AutoCAD LT uses the result computed at the time you canceled.



TBCONFIG Command
Up a Level          Related Topics

Creates and customizes toolbars
   From the Tools menu, choose Customize Toolbars

 At the Command prompt, enter tbconfig

The Customize Toolbars dialog box is displayed. You can also display the Toolbars dialog box by clicking a tool on the 
toolbar with the Return button on your pointing device.



Customize Toolbars Dialog Box
Up a Level

Creates and customizes toolbars.

Toolbars

Lists available toolbars. The toolbar name has a prefix that indicates the menu group with which the toolbar is associated. 
For example, ACLT. represents the AutoCAD LT menu group. Menu groups help you distinguish any independently 
developed menus you have loaded.

Close

Closes the Toolbars dialog box and saves toolbar customization.

New

Creates a new toolbar in the New Toolbar dialog box.

Delete

Deletes the selected toolbar.

Modify

Changes a toolbar in the Modify Toolbars dialog box.

Properties

Opens the Toolbar Properties dialog box, which displays the toolbar name, the alias used internally by AutoCAD LT, the help 
text that appears in the status bar, and a control for hiding the toolbar.

Button Properties Dialog Box
The Button Properties dialog box controls the command, icon, and name associated with a tool. To display the Button 
Properties dialog box, click a tool on a toolbar with the Return button on your pointing device.

Flyout Properties Dialog Box
The Flyout Properties dialog box controls the flyout toolbar, icon, and name. To display the Flyout Properties dialog box, click
a flyout with the Return button on your pointing device.



For more information, see “Customizing Toolbars” in chapter 19 of the AutoCAD LT User's Guide.

Commands: TOOLBAR displays, hides, and positions toolbars.

System Variables: TOOLTIPS controls the display of ToolTips.



New Toolbar Dialog Box
Up a Level

Creates new toolbars.

Toolbar Name
Specifies a name for the new toolbar.

Menu Group
Specifies the menu group for the new toolbar. For more information, see the AutoCAD LT user’s Guide.



Modify Toolbars Dialog Box
Up a Level

Provides tools with associated AutoCAD LT commands. Drag a tool from the dialog box and drop it onto a toolbar. To copy a 
tool from another toolbar, press CTRL and drag the tool to the new toolbar.

Categories
Organizes AutoCAD LT commands into categories based on the toolbars listed in the Tools menu, plus a miscellaneous 
category for all other buttons and a custom category. The custom category contains blank icons for creating custom tools.



Toolbar Properties Dialog Box
Up a Level

Provides information about the toolbar, changes the toolbar name and help text, and controls whether AutoCAD LT displays 
or hides the toolbar.

Name
Specifies the toolbar name.

Help
Displays the help text that appears in the status bar when the pointing device moves over the toolbar. You can change the 
text by typing over it.

Alias
Displays the toolbar name that AutoCAD LT uses internally. The name includes a prefix that represents the toolbar's menu 
group followed by the toolbar name as it appears in the aclt.mnu file. The toolbar alias is used in the TOOLBAR command.

Hide
Controls whether AutoCAD LT displays or hides the toolbar.



Button Properties Dialog Box
Up a Level

Changes the name and other properties of a button.

Name
Specifies the tool name. If Show Tooltips is selected in the Toolbars dialog box, the name appears beside the tool when the 
pointing device passes over the tool.

Help
Displays the help text that appears in the status line when the pointing device passes over the tool. You can change this text 
by typing over it.

Macro
Controls the command or set of commands associated with a tool. 

Enter a command in the Macro box. Separate a series of commands using a semicolon (;). For more information about 
entering commands in macros, see the AutoCAD LT User’s Guide.

Button Icon
Specifies the icon associated with a tool. Select an icon from the scrolling list or choose Edit to modify an icon in the Button 
Editor dialog box. You can customize an existing button or create a new one. 



Flyout Properties Dialog Box
Up a Level

Changes the names and other properties of a flyout.

Name

Specifies the tool name. If Tooltips is selected in the Toolbars dialog box, the name appears beside the tool when the 
pointing device passes over the tool.

Help

Displays the help text that appears in the status line when the pointing device passes over the tool. You can change the text 
by typing over it.

Associated Toolbar

Specifies the toolbar associated with the flyout icon.

Show This Button's Icon

Displays the flyout icon specified in the Button Icon area. If Show This Button's Icon is selected, AutoCAD LT uses this icon 
for the flyout. Otherwise, the flyout icon reflects the icon of the last flyout selected.

Button Icon

Specifies the icon associated with a tool. Select an icon from the scrolling list or choose Edit to modify an icon in the    Button
Editor dialog box. You can customize an existing button or create a new one. 



Button Editor Dialog Box
Up a Level

Modifies or creates buttons.

Button Image
Displays the button at its actual size.

Editing Tools
Pencil
Line
Circle
Erase

Editing Area
Provides a close-up view of the button icon for pixel editing.

Color Palette
Sets the current color.

Clear
Clears the editing area.

Open
Opens an existing button icon for editing. Button icons are stored as bitmap (BMP) files.

Undo
Undoes the last action.

Save
Saves the customized button icon as a .BMP file.

Close
Closes the current button icon.

Grid
Divides the view into a grid. Each grid box represents one pixel.



Pencil

Edits one pixel at a time in the selected color. Drag the pointing device to edit several pixels at once.



Line

Creates lines in the selected color. Press the Return button on your pointing device to set the first endpoint of the line. Drag 
to draw the line, and release the Return button to complete the line.



Circle

Creates circles in the selected color. Press the Return button on your pointing device to set the center of the circle, and drag 
to set the radius. Release the Return button to complete the circle.



Erase

Sets pixels to white. Double-click the Erase tool with your pointing device to set all pixels to white.



TEXT Command
Up a Level          Related Topics

Creates a single line of text
AutoCAD LT can create text with a variety of character patterns, or fonts. These fonts can be stretched, compressed, 
obliqued, mirrored, or aligned in a vertical column by applying a style to the font. Text can be rotated, justified, and made any
size.
     At the Command prompt, enter text

Justify / Style / <Start point>: Specify a point, enter an option, or press RETURN 

If TEXT was the last command entered, pressing RETURN skips the prompts for height and rotation angle and immediately 
displays the Text prompt. The text you enter is placed directly beneath the previous line of text. 

The prompts that appear are the same as those for the DTEXT command, but the TEXT command displays the Text prompt 
only once. For a description of each option, see DTEXT. 

When you use the Insertion object snap mode, AutoCAD LT snaps to the point you specified at the Start Point prompt.

You can overscore and underscore text and insert special characters. See Special Unicode Characters and Control Codes 
and Special Characters.



Commands: DDEDIT edits text content. STYLE creates text styles. DTEXT displays text on the screen as you enter it. 
MTEXT creates a paragraph object that fits within a specified area. SPELL checks the spelling of text. 



'TEXTSCR Command
Up a Level          Related Topics

Switches from the graphics to the text screen
From the View menu, select Text Window
At the Command prompt, enter textscr

This command is ignored on dual-screen systems.



Commands: GRAPHSCR switches from the text to the graphics screen.



'TIME Command
Up a Level          Related Topics

Displays the date and time statistics of a drawing 
 From the Tools menu, choose Time

At the Command prompt, enter time

AutoCAD LT displays information as in the following example: 

Current time: 16 Mar 1994 at 09:10:44.005

Times for this drawing:

Created: 23 Jul 1993 at 07:21:30.648

Last updated: 12 Mar 1994 at 15:33:59.771

Total editing time: 0 days 01:44:10.520

Elapsed timer (on): 0 days 00:07:05.312

Next automatic save in: 0 days 01:59:15.570



Current Time

Current date and time. AutoCAD LT displays all times to the nearest millisecond using a 24-hour clock.



Created

Date and time of creation of the current drawing.



Last Updated

Date and time of latest update of the current drawing. This date and time is initially the drawing creation time. AutoCAD LT 
revises it with each use of the END or SAVE command, and applies the default file name.



Total Editing Time

Time spent editing the current drawing. This timer is updated by AutoCAD LT and cannot be reset or stopped. Plotting time is
not included in the total editing time. If you quit an editing session without saving the drawing, the time you spent in the 
editing session is not added to the accumulated editing time.



Elapsed timer

Another timer that runs while AutoCAD LT is running. You can turn it on and off or reset it whenever you like.



Next Automatic Save In

Time remaining until the next automatic save. You can set the time interval using the PREFERENCES command or the 
SAVETIME system variable.

Display / On  / OFF / Reset: Enter an option or press RETURN



Display

Repeats the display with updated times.



On

Starts the user elapsed timer if it was off.



Off

Stops the user elapsed timer.



Reset

Resets the user elapsed timer to 0 days 00:00:00.000.



For more information about time, see "Tracking Drawing Time" in chapter 7 of the AutoCAD LT User's Guide. 

Commands: PREFERENCES sets the time interval for automatic saves. 

System Variables: SAVETIME stores the time interval for automatic saves. CDATE stores the current date. TDCREATE 
stores the time and date of the drawing creation. TDINDWG calculates the total editing time. TDUPDATE stores the time and
date of the last update/save. TDUSRTIMER calculates time for the user elapsed timer. 



TOLERANCE Command
Up a Level          Related Topics

Creates geometric tolerances
Geometric tolerances define the maximum allowable variations of form or profile, orientation, location, and runout from the 
exact geometry in a drawing. They specify the required accuracy for proper function and fit of the objects you draw in 
AutoCAD LT.

AutoCAD LT adds geometric tolerances to a drawing in feature control frames. These are frames divided into compartments 
that contain the geometric characteristic symbols followed by one or more tolerance values. Where applicable, the tolerance 
is preceded by the diameter symbol and followed by datums and symbols for their material conditions.

   From the Dimensioning toolbar, choose

   From the Dimension menu, choose Tolerance
 At the Command prompt, enter tolerance

AutoCAD LT opens the Symbol dialog box, which displays the geometric characteristic symbols for location, orientation, 
form, profile, and runout. Select the symbol you want to use. AutoCAD LT closes the dialog box and inserts the symbol into 
the Sym box in the Geometric Tolerance dialog box. The following table describes the symbols.

Symbol Characteristic Type

Position Location

Concentricity 
or coaxiality

Location

Symmetry Location

Parallelism Orientation

Perpendicularity Orientation

Angularity Orientation

Cylindricity Form

Flatness Form

Circularity 
or roundness

Form

Straightness Form



Surface profile Profile

Line profile Profile

Circular runout Runout

Total runout Runout

TOLERANCE Command
Up a Level          Related Topics

Creates geometric tolerances
Geometric tolerances define the maximum allowable variations of form or profile, orientation, location, and runout from the 
exact geometry in a drawing. They specify the required accuracy for proper function and fit of the objects you draw in 
AutoCAD LT.

AutoCAD LT adds geometric tolerances to a drawing in feature control frames. These are frames divided into compartments 
that contain the geometric characteristic symbols followed by one or more tolerance values. Where applicable, the tolerance 
is preceded by the diameter symbol and followed by datums and symbols for their material conditions.

   From the Dimensioning toolbar, choose

 
At the Command prompt, enter tolerance

AutoCAD LT opens the Symbol dialog box, which displays the geometric characteristic symbols for location, orientation, 
form, profile, and runout. Select the symbol you want to use. AutoCAD LT closes the dialog box and inserts the symbol into 
the Sym box in the Geometric Tolerance dialog box. The following table describes the symbols.

Symbol Characteristic Type

Position Location

Concentricity 
or coaxiality

Location

Symmetry Location

Parallelism Orientation

Perpendicularity Orientation

Angularity Orientation



Cylindricity Form

Flatness Form

Circularity 
or roundness

Form

Straightness Form

Surface profile Profile

Line profile Profile

Circular runout Runout

Total runout Runout

Geometric Tolerance Dialog Box
Up a Level

Specifies the symbols and values for a feature control frame.

Sym
Contains the geometric characteristic symbol you selected from the Symbol dialog box. Select this option to open the 
Symbol dialog box again.

Tolerance 1
Creates the first tolerance value in the feature control frame. Two modifying symbols can be included with this value: 
diameter and material condition. The tolerance value indicates the amount by which the geometric characteristic can deviate
from a perfect form.

Dia, Inserts a diameter symbol (Æ) in front of the tolerance value.
Value, Creates the tolerance value. Enter a value in the box.
MC, Displays the Material Condition dialog box, in which you select a symbol. These symbols act as modifiers to 

the geometric characteristic and the tolerance value of features that can vary in size.

Tolerance 2
Creates the second tolerance value in the feature control frame. Specify the second tolerance value in the same way as the 
first. 

Dia. Inserts a diameter symbol (Æ) in front of the tolerance value.
Value. Creates the tolerance value. Enter a value in the box.
MC. Displays the Material Condition dialog box, in which you select a symbol. These symbols act as modifiers to 

the geometric characteristic and the tolerance value of features than can vary in size.

Datum 1
Creates the primary datum reference in the feature control frame. The datum reference can consist of a value and a 



modifying symbol. A datum is a theoretically exact geometric reference used to establish the tolerance zone for a feature.

Datum. Creates the datum reference value. Enter the value in the text box.
MC. Displays the Material Condition dialog box, in which you select a modifying symbol. These symbols act as 

modifiers to the datum reference.

Datum 2
Creates the secondary datum reference in the feature control frame. Specify the secondary datum reference in the same 
way as the primary. 

Datum. Creates the datum reference value. Enter the value in the box.
MC. Displays the Material Condition dialog box, in which you select a modifying symbol. These symbols act as 

modifiers to the datum reference.

Datum 3
Creates the tertiary datum reference in the feature control frame. Create the tertiary datum reference in the same way as the
primary datum reference.

Datum. Creates the datum reference value. Enter the value in the box.
MC. Displays the Material Condition dialog box, in which you select a modifying symbol. These symbols act as 

modifiers to the datum reference.

Height
Creates a projected tolerance zone value in the feature control frame. A projected tolerance zone controls the height of the 
extended portion of a fixed perpendicular part and refines the tolerance to that specified by positional tolerances. Enter the 
value in the box.

Projected Tolerance Zone
Inserts a projected tolerance zone symbol, , after the projected tolerance zone value.

Datum Identifier
Creates a datum-identifying symbol consisting of a reference letter preceded and followed by a dash. A datum is a 
theoretically exact geometric reference from which you can establish the location and tolerance zones of other features. A 
point, line, plane, cylinder, or other geometry can serve as a datum. Enter the letter in the box. 

After you select geometric characteristic symbols, the Geometric Tolerance dialog closes and, AutoCAD LT displays this 
prompt:

Enter tolerance location: Specify a location

AutoCAD LT places the feature control frame at the specified location.



Material Condition Dialog Box
Up a Level

Select the symbol you want to use. AutoCAD LT closes the Material Condition dialog box and inserts the symbol into the MC
box for the tolerance value in the Geometric Tolerance dialog box. The following table describes the symbols.

Symbol Term

At maximum 
material condition

At least material 
condition

Regardless of 
feature size

Material Condition Dialog Box

Select the symbol you want to use. AutoCAD LT clears the Material Condition dialog box and inserts the symbol into the MC 
text box for the datum reference in the Geometric Tolerance dialog box. 

Symbol Term

At maximum 
material condition

At least material 
condition

Regardless of 
feature size

For more information about geometric tolerances and feature control frames, see "Adding Geometric Tolerances" in chapter 
13 of the AutoCAD LT User's Guide.

Commands: DDIM controls dimension styles and settings such as lateral and limits tolerancing for dimensions. LEADER 
creates leader lines to which you can attach geometric tolerances

System Variables: DIMCLRE controls the color of the feature control frame. DIMCLRT controls the color of the tolerance 
text. DIMGAP controls the gap between the feature control frame and the text. DIMTXT controls the size of the tolerance 
text. DIMTXSTY controls the style of the tolerance text.



TOOLBAR Command
Up a Level          Related Topics

Displays, hides, and positions toolbars
 At the Command prompt, enter toolbar

Toolbar name (or ALL): Enter a name or all

For a listing of the available AutoCAD LT toolbars, see the Toolbars dialog box displayed by the TBCONFIG command or the
VIEWTOOLBAR command.



For more information, see chapter 19, "Customizing Toolbars," in the AutoCAD LT User's Guide.

Commands: TBCONFIG customizes toolbars.

System Variables: TOOLTIPS turns ToolTips on or off.



Toolbar Name (TOOLBAR)
Up a Level

Displays, closes, or positions, the specified toolbar.

Show / Hide / Left / Right / Top / Bottom / Float <Show>: Enter an option or press RETURN



Show

Displays the toolbar.



Hide

Closes the toolbar.



Left

Docks the toolbar at the left side of the screen.

Position <0,0>: Enter two values separated by a comma, or press RETURN

The values you enter set the position of the toolbar in columns and rows relative to a toolbar dock. The first value is 
horizontal. The second value is vertical.



Right

Docks the toolbar at the right side of the screen.

Position <0,0>: Enter two values separated by a comma, or press RETURN

The values you enter set the position of the toolbar in columns and rows relative to a toolbar dock. The first value is 
horizontal. The second value is vertical.



Top

Docks the toolbar at the top of the screen.

Position <0,0>: Enter two values separated by a comma, or press RETURN

The values you enter set the position of the toolbar in columns and rows relative to a toolbar dock. The first value is 
horizontal. The second value is vertical.



Bottom

Docks the toolbar at the bottom of the screen.

The values you enter set the position of the toolbar in columns and rows relative to a toolbar dock. The first value is 
horizontal. The second value is vertical.

Position <0,0>: Enter two values separated by a comma, or press RETURN



Float

Changes the toolbar from docked to floating.

Position <0,0>: Enter XY coordinates or press RETURN

Rows <1>: Enter a value

The Position prompt specifies the location of the floating toolbar in screen coordinates. The Rows prompt specifies the 
number of rows in the floating toolbar.



All (TOOLBAR)
Up a Level

Displays or closes all toolbars.

Show / Hide: Enter s or h



Show

Displays all toolbars.



Hide

Closes all toolbars.



Tracking
Up a Level        

Locates a point from a series of temporary points

From the Object Snap toolbar, choose

Choose Tracking, from the cursor menu

Tracking turns on Ortho mode and can be used with Snap mode.

At any AutoCAD LT prompt to locate a point, enter tracking, track, or tk

First tracking point: Specify a location or distance

Next point    (Press RETURN to end tracking): Specify a second location or distance

Tracking accepts a series of temporary points, each offset from the previous one. Thus, you specify a new point location 
from a series of directions and distances. 

To determine the location of each temporary point, you can use direct distance entry. First move the cursor to specify the 
direction, and then enter a numeric distance.

Alternatively, tracking can establish a new point by combining the X and Y values of two specified points. You can specify 
these two points in any order depending on the cursor direction after the first point.

For more information, see “Using Tracking” in chapter 7 of the AutoCAD LT User’s Guide. From locates a point offset from a
reference point within a command. Direct distance entry accepts a distance in the direction of the current location of your 
cursor. Point filters combine X, Y, and Z values from different points into a single point. Relative coordinate entry locates a 
point relative to the last point entered.



TRIM Command
Up a Level          Related Topics

Trims objects at a cutting edge defined by other objects
Objects that can be trimmed include arcs, circles, elliptical arcs, lines, open 2D and 3D polylines, rays, and splines. 

   

From the Modify toolbar, choose Trim 
   From the Modify menu, choose Trim 
 At the Command prompt, enter trim

Select cutting edges: (Projmode = UCS, Edgemode = No extend)

Select objects: Use an object selection method

Select the objects that define the cutting edges at which you want to trim an object, or press RETURN to select all objects as
potential cutting edges. Valid cutting edge objects include 2D and 3D polylines, arcs, circles, ellipses, lines, floating 
viewports, rays, regions, splines, text, and xlines. 

<Select object to trim> / Project / Edge / Undo: Select an object, enter an option, or press RETURN



For more information, see "Trimming Objects" in chapter 10 of the AutoCAD LT User's Guide.

Commands: BREAK erases parts of an object or splits an object in two. EXTEND extends an object to meet another object.

System Variables: EDGEMODE determines whether an object is trimmed at another object's implied edge, or only to an 
object that intersects it in 3D space. PROJMODE sets the Projection mode AutoCAD LT uses when trimming objects. 



Select Object to Trim (TRIM)
Up a Level

Specifies the object to trim. AutoCAD LT repeats the main TRIM prompt with its options so that you can trim multiple objects.
Pressing RETURN ends the command.

          

If the point you used to select the object is between the end of the object and a cutting edge, TRIM removes the portion of 
the object extending beyond the cutting edge. If the selection point is between two cutting edges, the portion between is 
deleted and the portions outside are preserved, turning one object into two.

AutoCAD LT trims wide 2D polylines at their center lines. If the polyline is tapered, the width at the cutting edge is the same 
after trimming. The ends of a wide polyline are always square. Cutting a wide polyline at an angle causes portions of the end
to extend beyond the cutting edge. Trimming a spline-fit polyline turns the curve-fit information into ordinary polyline 
segments.



Project (TRIM)
Up a Level

Specifies the Projection mode AutoCAD LT uses when trimming objects.

None / Ucs / View <current>: Enter an option or press RETURN



None

Specifies no projection. AutoCAD LT trims only objects that intersect the boundary edge in 3D space.

          

          



UCS

Specifies projection onto the XY plane of the current UCS. AutoCAD LT trims objects that do not intersect with the boundary 
objects in 3D space.

          

          



View

Specifies projection along the current view direction. AutoCAD LT trims objects that intersect the boundary in the current 
view.

          

          



Edge (TRIM)
Up a Level

Determines whether the cutting edge is extended along its natural path to trim an object or must intersect an object in order 
to trim it.

Extend / No extend <current>: Enter an option or press RETURN



Extend

Extends the cutting edge along its natural path to trim 
an object in 3D space.

No extend

Specifies that the object is to be trimmed only at a cutting edge that intersects it in 3D space.



Undo (TRIM)
Up a Level

Reverses the most recent change made by TRIM. 



U Command
Up a Level          Related Topics

Reverses the most recent action
   

From the Standard toolbar, choose 
 

At the Command prompt, enter u

You can enter u as many times as you wish, backing up one step at a time until the drawing is as it was when you began the
current editing session.

When an operation cannot be undone, AutoCAD LT displays the command name but performs no action. Actions external to 
the current drawing, such as plotting or writing to a file, cannot be undone.

If you used mode toggles or transparent commands during a command, their effects are undone along with the main 
command.

The U command is equivalent to entering undo 1.



For more information, see "Correcting Mistakes" in chapter 2 of the AutoCAD LT User's Guide. 



UCS Command
Up a Level          Related Topics

Manages user coordinate systems
The user coordinate system is a movable system for coordinate entry, planes of operation, and viewing. Most AutoCAD LT 
geometric editing commands are dependent on the location and orientation of the UCS.

The UCS command sets the orientation of the user coordinate system in 3D space. It defines the orientation for 2D objects 
and the extrusion direction for the THICKNESS command. It also provides the axis of rotation for the ROTATE command 
and the default projection plane for pointing.

 From the Standard toolbar, choose

 From the View menu, choose Set UCS 
At the Command prompt, enter ucs

Origin / ZAxis / 3point / OBject / View / X / Y / Z / Prev / Restore / Save / Del / ? / <World>: Enter an option or press 
RETURN



World (UCS)
Up a Level

Sets the current UCS to the World Coordinate System (WCS). The WCS is the basis for all user coordinate systems and 
cannot be redefined.



Origin (UCS)
Up a Level

Defines a new UCS by shifting the origin of the current UCS, but leaving the direction of its X, Y, and Z axes unchanged.

Origin point <0,0,0>: Specify a point

Specify a new origin point relative to the origin of the current UCS. If you do not specify a Z coordinate value for the origin, 
this option uses the current elevation. 



Zaxis (UCS)
Up a Level

Defines a UCS with a particular positive Z axis.

Origin point <0,0,0>: Specify a point

Point on positive portion of Z-axis <current>: Specify a point

Specify a new origin and a point that lies on the new positive Z axis. The Z Axis option tilts the XY plane.



3point (UCS)
Up a Level

Specifies the new UCS origin and the direction of its positive X and Y axes. The Z axis follows by applying the right-hand 
rule. (For information about the right-hand rule, see chapter 11, "Working in Three-Dimensional Space," in the AutoCAD LT 
User's Guide.) You can use this option to specify any possible coordinate system.

Origin point <0,0,0>: Specify a point (1)

Point on positive portion of the X-axis <current>: Specify a point (2)

Point on positive-Y portion of the UCS XY plane <current>: Specify a point (3)

The first point specifies the origin of the new UCS. The second point defines the positive X axis. The third point defines the 
positive Y axis. The third point can be anywhere on the positive Y portion of the new UCS XY plane.



Object (UCS)
Up a Level

Defines a new coordinate system based on a selected object. The new UCS has the same extrusion direction (positive Z 
axis) as that of the selected object.

Select object to align UCS: Select an object

The following objects cannot be used: 3D solid, 3D polyline, 3D mesh, viewport, region, spline, ellipse, ray, xline, leader, 
mtext.

For objects other than 3D faces, the XY plane of the new UCS is parallel to the XY plane in effect when the object was 
drawn. However, the X and Y axes can be rotated differently.

The new UCS is defined as described in the following table.

Object Method of UCS determining

Arc The center of the arc becomes the new UCS origin. 
The X axis passes through the arc endpoint that is 
closest to the selection point.

Circle The center of the circle becomes the new UCS 
origin. The X axis passes through the selection 
point.

Dimension The midpoint of the dimension text becomes new 
UCS origin. The direction of the new X axis is 
parallel to the X axis of the UCS in effect when the 
dimension was drawn.

Line The endpoint nearest the selection point becomes 
the new UCS origin. AutoCAD LT chooses the new 
X axis so that the line lies in the XZ plane of the new
UCS. The line's second endpoint has a Y coordinate
of zero in the new system. 

Point The point becomes the new UCS origin. 

2D polyline The start point of the polyline is the new UCS origin. 
The X axis extends along the line segment from the 
start point to the next vertex.

Solid The first point of the solid determines the new UCS 
origin. The new X axis lies along the line between 
the first two points.

Trace The "from" point of the trace becomes the UCS 
origin, with the X axis lying along its center line.

3D face The new UCS origin is taken from the first point, the 
X axis from the first two points, and the Y positive 
side from the first and fourth points. The Z axis 
follows by application of the right-hand rule.

Shape, Text, 
Block Reference, 
Attribute Definition

The insertion point of the object becomes the new 
UCS origin, and the new X axis is defined by the 
rotation of the object around its extrusion direction. 



The object you select to establish a new UCS has a 
rotation angle of zero in the new UCS.

View (UCS)
Up a Level

Establishes a new coordinate system with the XY plane perpendicular to your viewing direction (parallel to your screen). The
UCS origin remains unchanged. 



X / Y / Z (UCS)
Up a Level

Rotates the current UCS about a specified axis.

Rotation angle about n axis <0>: Specify an angle

In the prompt, n is X, Y, or Z. Enter a positive or negative angle to rotate the UCS. AutoCAD LT uses the right-hand rule to 
determine the positive direction of rotation around the axis. (For information about the right-hand rule, see chapter 11, 
"Working in Three-Dimensional Space," in the AutoCAD LT User's Guide.)

You can define any UCS by specifying an origin and one or more rotations around the X, Y, or Z axes.



X / Y / Z (UCS)
Up a Level

Rotates the current UCS about a specified axis.

Rotation angle about n axis <0>: Specify an angle

In the prompt, n is X, Y, or Z. Enter a positive or negative angle to rotate the UCS. AutoCAD LT uses the right-hand rule to 
determine the positive direction of rotation around the axis. (For information about the right-hand rule, see chapter 11, 
"Working in Three-Dimensional Space," in the AutoCAD LT User's Guide.)

You can define any UCS by specifying an origin and one or more rotations around the X, Y, or Z axes.



X / Y / Z (UCS)
Up a Level

Rotates the current UCS about a specified axis.

Rotation angle about n axis <0>: Specify an angle

In the prompt, n is X, Y, or Z. Enter a positive or negative angle to rotate the UCS. AutoCAD LT uses the right-hand rule to 
determine the positive direction of rotation around the axis. (For information about the right-hand rule, see chapter 11, 
"Working in Three-Dimensional Space," in the AutoCAD LT User's Guide.)

You can define any UCS by specifying an origin and one or more rotations around the X, Y, or Z axes.



Prev (UCS)
Up a Level

Restores the previous UCS. AutoCAD LT saves the last 10 coordinate systems created in paper space and the last 10 
coordinate systems created in model space. Repeating the Previous option steps back through one set or the other 
depending on which space is current.



Restore (UCS)
Up a Level

Makes a saved UCS the current UCS. Restoring a saved UCS does not reestablish the viewing direction in effect when the 
UCS was saved.

? / Name of UCS to restore: Enter ? or a name

Enter ? to view a list of names. 

UCS name(s) to list <*>: Enter a wild-card pattern or press RETURN



Save (UCS)
Up a Level

Saves the current UCS to a specified name. The name can contain up to 31 characters, including letters, digits, and the 
special characters dollar sign ($), hyphen (-), and underscore (_). AutoCAD LT converts all UCS names to uppercase.

? / Desired UCS name: Enter ? or a name

Enter ? to list the currently defined UCS names.

UCS name(s) to list <*>: Enter a wild-card pattern or press RETURN



Del (UCS)
Up a Level

Removes the specified UCS from the list of saved coordinate systems. 

UCS name(s) to delete <none>: Enter a name or a list of names separated by commas



?—List (UCS)
Up a Level

Lists defined UCS names and provides the origin and X, Y, and Z axes for each saved coordinate system relative to the 
current UCS. If the current UCS is unnamed, it is listed as *WORLD* or *NO NAME*, depending on whether it's the same as
the WCS.

UCS name(s) to list <*>: Enter a wild-card pattern or press RETURN

Changing from one UCS to another does not change the drawing view unless the UCSFOLLOW system variable is on.



For information about 3D orientation, see "Relocating a UCS in 3D Space" in chapter 11 of the AutoCAD LT User's Guide. 

Commands: DDUCS renames, restores, deletes, or lists defined coordinate systems. DDUCSP UCS. PLAN displays the 
plan view of a specified UCS. 

System Variables: UCSICON controls visibility and placement of the UCS icon in viewports. UCSNAME displays the name 
of the current coordinate system. UCSORG displays the origin point of the current coordinate system for the current space. 
UCSXDIR  displays the X direction of the current UCS for the current space. UCSYDIR displays the Y direction of the 
current UCS for the current space. 



UCSICON Command
Up a Level          Related Topics

Controls the visibility and placement of the UCS icon
The UCS icon represents the orientation of the UCS axes and the location of the current UCS origin. It also represents the 
current viewing direction relative to the XY plane.

   From the Options menu, choose UCS Icon
 

At the Command prompt, enter ucsicon

AutoCAD LT displays different coordinate system icons in paper space and model space. In both cases, a plus sign (+) 
appears at the base of the icon when it is positioned at the origin of the current UCS. The letter W appears in the Y portion of
the icon if the current UCS is the same as the World Coordinate System.

A box is formed at the base of the icon if you are viewing the UCS from above (the positive Z direction). The box is missing if
you are viewing the UCS from below.

If your view direction is edge-on to the current UCS, the coordinate system icon is replaced by a broken pencil icon.

ON / OFF / All / Noorigin / ORigin <current>: Enter an option or press RETURN

      

        



For more information about controlling the placement of the UCS icon, see "Using the UCS to Work in Three Dimensions" in 
chapter 11 of the AutoCAD LT User's Guide. 

Commands: DDUCS and UCS save, restore, rename, delete, and list defined coordinate systems. DDUCSP selects a 
preset UCS. PLAN displays the plan view of a specified UCS. 

System Variables: UCSICON controls the icon setting for the current viewport. UCSNAME displays the name of the current
coordinate system. UCSORG displays the origin point of the current coordinate system for the current space. UCSXDIR 
displays the X direction of the current UCS for the current space. UCSYDIR displays the Y direction of the current UCS for 
the current space. 



On

Displays the coordinate system icon.



Off

Turns off display of the coordinate system icon.



All

Applies changes to the icon in all active viewports. Otherwise, the UCSICON command affects only the current viewport.



Noorigin

Displays the icon at the lower-left corner of the viewport regardless of the true location of the UCS origin.



Origin

Displays the icon at the origin (0,0,0) of the current coordinate system. If the origin is off the screen, or if the icon cannot be 
positioned at the origin without being clipped at the viewport edges, the icon appears at the lower-left corner of the viewport.



UNDO Command
Up a Level          Related Topics

Reverses the effect of commands
You can use the options of the UNDO command to undo more than one action at a time. Begin and End define a number of 
actions as a group, and Mark and Back work together to undo all actions back to a predetermined point.

 From the Edit menu, choose Undo
At the Command prompt, enter undo

Auto / Control / BEgin / End / Mark / Back / <Number>: Enter an option, enter a positive number, or press RETURN

UNDO displays the command or system variable name on the command line to indicate that you have stepped back before 
the point where the command was used.

When you use Back or Number to undo multiple actions, AutoCAD LT regenerates or redraws the drawing, if necessary. This
occurs at the end of the UNDO command; therefore, entering UNDO 5 will cause at most one regeneration, while U U U U 
U, could cause as many as five.

UNDO has no effect on the following commands and system variables:

ABOUT HELP REDRAWALL

AREA HIDE REGEN

ATTEXT ID REGENALL

COMPILE LIST REINIT

CONFIG MSLIDE RESUME

CVPORT NEW SAVE

DBLIST OPEN SAVEAS

DELAY PLOT SHADE

DIST PSOUT SHELL

DXFOUT QSAVE STATUS

END QUIT TEXTSCR

FILES RECOVER

GRAPHSCR REDRAW

For more information about, see "Correcting Mistakes" in chapter 2 of the AutoCAD LT User's Guide. 

Commands: U undoes the most recent action. 



Number (UNDO)
Up a Level

Reverses the specified number of preceding actions. The effect is the same as entering U multiple times, but the drawing is 
not regenerated at each step.



Auto (UNDO)
Up a Level

Groups a menu selection as a single command, reversible by a single U command. When the Auto option is on, whenever 
you choose a menu item AutoCAD LT groups all actions until you exit that item. You can undo the group as if it were one 
action.

The Auto option is not available if the Control option has turned off or limited UNDO.

ON / OFF <current>: Enter on or off, or press RETURN



Control (UNDO)
Up a Level

Limits the UNDO command or turns it on or off.

All / None / One <All>: Enter an option or press RETURN

All
Turns on the full UNDO command.

None
Turns off the U and UNDO commands and discards any UNDO command information saved earlier in the editing session.

If you attempt to use UNDO while it is turned off, AutoCAD LT offers the Control option, and the following prompt is 
displayed: All / None / One <All>:

One
Limits UNDO to a single action.

The Auto, Begin, and Mark options are not available when None or One is in effect. The main prompt for the UNDO 
command changes to show that only a Control option or a single step of the UNDO command is possible: Control / <1>:



Begin and End (UNDO)
Up a Level

The Begin option groups a sequence of actions. All subsequent actions become part of the group until you use the End 
option to terminate the group. Entering undo begin while a group is already active ends the current group and begins a new
group.

UNDO and U treat grouped actions as a single action.

If you enter undo begin without undo end, using the Number option undoes the specified number of commands at a time 
but does not back up past the Begin point. If you want to go back to before the begin point, you must use the End option 
even if the group is empty. The same applies to U.

A mark disappears inside an UNDO group.



Mark and Back (UNDO)
Up a Level

The Mark option places a mark in the undo information. The Back option undoes all the work done back to this mark. If you 
undo one action at a time, AutoCAD LT informs you when you reach the mark.

You can place as many marks as necessary. The Back option undoes by moving back one mark at a time, removing the 
mark. If no mark is found, AutoCAD LT displays the following prompt:

This will undo everything. OK? <Y>    Enter y or n

Entering y undoes everything done since you last started AutoCAD LT. Entering n causes AutoCAD LT to ignore the Back 
option.

When you use the Number option to undo multiple actions, UNDO stops if it encounters a mark.



'UNITS Command
Up a Level          Related Topics

Selects coordinate and angle display formats and precision
At the Command prompt, enter units

The Text screen displays the following prompt:

Report formats: (Examples)

1. Scientific 1.55E+01

2. Decimal 15.50

3. Engineering 1'-3.50"

4. Architectural 1'-3 1/2"

5. Fractional 15 1/2

Enter choice, 1 to 5 <current>: Enter a value (1-5) or press RETURN

If you specified scientific, decimal, or engineering format, AutoCAD LT prompts for decimal precision:

Number of digits to right of decimal point (0 to 8) <current>: Enter a value (0-8) or press RETURN

If you specified architectural or fractional format, AutoCAD LT prompts for the denominator of the smallest fraction:

Denominator of smallest fraction to display

(1, 2, 4, 8, 16, 32, 64, 128, or 256) <current>: Enter a value (1, 2, 4, 8, 16, 32, 64, 128, or 256) or press RETURN

AutoCAD LT prompts for angle formats and precision:

Systems of angle measure: (Examples)

1. Decimal degrees 45.0000

2. Degrees/minutes/seconds 45d0'0"

3. Grads 50.0000g

4. Radians 0.7854r

5. Surveyor's units N 45d0'0" E

Enter choice, 1 to 5 <current>: Enter a value (1-5) or press RETURN

Number of fractional places for display of angles (0 to 8) <current>: Enter a value (0-8) or press RETURN

AutoCAD LT prompts for the direction of angle 0:

Direction for angle 0:

East 3 o'clock = 0

North 12 o'clock = 90

West 9 o'clock = 180

South 6 o'clock = 270

Enter direction for angle 0 <current>: Enter a value or press RETURN

The default direction for 0 degrees is to the righteast quadrant, or 3 o'clock. The default direction for positive angular 
measurement is counterclockwise.

Do you want angles measured clockwise? <current> Enter y or n or press RETURN

For a more comprehensive explanation of formats and precision, see the DDUNITS command.



For more information about units, see chapter 7, “Drawing with Precision,” in the AutoCAD LT User's Guide.

Commands: DDUNITS sets coordinate and angle display formats and precision in the Units Control dialog box.

System Variables: ANGBASE stores the angle 0 direction with respect to the current UCS. ANGDIR stores the setting for 
clockwise or counterclockwise direction with respect to the current UCS. AUNITS stores the angular units mode. AUPREC 
stores the number of decimal places for angular units. LUNITS stores the setting for linear units mode. LUPREC stores the 
number of decimal places or the denominator for linear units. UNITMODE stores the setting for fractional, feet and inches, 
and surveyor's angles as previously set or in input format.



AutoCAD LT Utilities
Up a Level

These applications help you set up AutoCAD LT and convert files and data. 

DXFIX Converts an AutoCAD LT DXF file from Release 13 to Release 12 format

SLIDELIB Compiles AutoCAD LT slide files listed in an ASCII file into a slide library file    



DXFIX Utility
Up a Level

DXFIX™ is a file conversion program that reads AutoCAD LT for Windows 95 and AutoCAD Release 13 DXF files and 
creates DXF files compatible with previous releases of AutoCAD LT and AutoCAD. You can also program the converter to 
perform an arbitrary translation of a DXF file.

DXFIX has the following benefits: 

An open architecture
User-programming capability
Ability to perform any transformation on a DXF file 

DXFIX incorporates the FORTH-based Autodesk Threaded Language Application System Toolkit (ATLAST™). 

The program instructions in the dxfix13.dxt file control the translation of DXF files. See dxfix.doc in the AutoCAD LT for 
information on customizing translations.

Syntax
You run DXFIX from a DOS prompt using the following syntax:

dxfix [-an    -tfilename]    infile    outfile



-an

Specifies ASCII format as the output file format. The n option specifies the precision (number of decimal places) DXFIX uses
when converting a drawing. Use the -a option if the DXF file is intended for an AutoCAD LT release that supports only ASCII 
DXF (prior to AutoCAD Release  10) or is being sent to a non-Autodesk DXF processing program that requires ASCII.

For example, to perform a translation that generates an ASCII output file with six decimal places of precision, you enter the 
following command: 

dxfix -a6 house12 house10 



-tfilename

Specifies a different name (or path) for the translation specifications file. For example, to tell DXFIX to find its translation 
specifications in the file \dxfix\12_to_10.dxt, you enter the following command:

dxfix -t\dxfix\12_to_10 house12    house10 

The translation file you use to translate files created using previous releases of AutoCAD LT and AutoCAD is dxfix13.dxt, 
which is located in the AutoCAD LT installation directory.



infile

Specifies the file name of the input DXF file, which can be in either binary or ASCII format. Binary format is much faster to 
process and maintains full accuracy of drawing objects. DXFIX reads binary DXF files written in AutoCAD LT portable 
format, regardless of the system on which it is running. DXFIX reads ASCII DXF files with any of the end-of-line conventions 
that AutoCAD LT recognizes.

For example, to convert an AutoCAD LT for Windows 95 DXF file named house13.dxf to a Release 12 DXF file named 
house12.dxf (writing house12.dxf in binary format), you enter the following command:

dxfix -tdxfix13.dxt house13 house12 



outfile

Specifies the file name of the output binary DXF file. When you translate data to AutoCAD LT Release 12, the binary format 
is preferable because it is much faster to write, is generally smaller, and preserves full accuracy. 

For example, to convert an AutoCAD LT for Windows 95 DXF file named house13.dxf to a Release 12 DXF file named 
house12.dxf (writing house12.dxf in binary format), you enter the following command:

dxfix -tdxfix13.dxt house13 house12 



SLIDELIB Utility
Up a Level          Related Topics

You can construct slide library files (extension .slb) from slide files (extension .sld) by using the SLIDELIB utility program 
supplied in the AutoCAD LT support directory. Use the following syntax on the operating system command line:

slidelib library [ < slide-list ] 

SLIDELIB reads a list of slide file names. This list is normally supplied by redirecting a list of files (one per line in another file 
created using a text editor or a user-supplied utility program) to standard input. 

All the slide files you want to compile into a slide library should be placed in a single directory. To create a file mylist that you 
can pass to the SLIDELIB utility, enter the following at a DOS prompt (version 5.0 or later):

dir *.sld /b > mylist

You can also create this file with a text editor by listing the slide file names (and paths, if necessary), such as lobby, d:\
slides\office, and \aec\slides\stairs. The slide file name, but not the drive and directory information, is saved in the library file.
Because only the file name is included, a library can contain slides with the same name from different directories, but only 
one of the slides can be accessed by AutoCAD LT.

To generate the slide library mlib from mylist, enter the following:

slidelib mlib < mylist

This entry creates the file mlib.slb, which contains the names and definitions of the slides listed in mylist. 

Warning: Do not delete your original slides. The SLIDELIB program has no provision for updating a slide library once it is 
created. If you want to add or delete a slide, update the slide list file and re-create the library with SLIDELIB. All the original 
slides must be present for the update to be successful.



library

Specifies the slide library file (extension.slb) into which the slide files (extension.sld) are added.



slide List

Specifies a list of slide files (extension.sld). You need not specify extension.



Commands: MSLIDE creates a slide file of the current viewport. VSLIDE displays a raster image slide file in the current 
viewport.



AutoCAD LT Database Objects
Up a Level

Everything you create in AutoCAD LT is a distinct object. Most AutoCAD LT objects can take several forms. For example, 
polygons and rectangles are both polyline objects, and boxes, cones, and cylinders are three-dimensional solid (3DSolid) 
objects. Use the LIST command to identify an object is type. 

The table lists the AutoCAD LT object types and their descriptions.

Object type Description Command

Arc A circular arc ARC

Attribute 
definition

An object that appears as a text 
string and describes the 
characteristics of an attribute

ATTDEF

DDATTDEF

Attribute An object containing text that links 
to a block

ATTEXT

BLOCK

DDATTEXT

INSERT

Body Any structure that uniformly 
represents solids and free-form, 
trimmed nonuniform rational B-
spline (NURBS) surfaces 

EXPLODE

Circle A full circle CIRCLE

Dimension An object that can be composed of
a dimension line, extension lines, 
arrowheads, a leader, and 
annotative text including 
alphanumeric characters and 
tolerances

DIMALIGNED

DIMANGULAR

DIMBASELINE

DIMCENTER

DIMCONTINUE

DIMDIAMETER

DIMLINEAR

DIMORDINATE

DIMRADIUS

Ellipse, 
elliptical arc

A full ellipse ELLIPSE

End 
sequence

An object that marks the last 
polyline vertice or the end of an 
insert's attributes

3DPOLY

BHATCH

BOUNDARY

ELLIPSE

HATCH

INSERT



PLINE

POLYGON

Insert A block insertion (also known 
as a block reference)

BHATCH

HATCH

INSERT

Leader A polyline with or without an arrow 
at one end and text at the other

LEADER

Line A single line segment LINE

Mtext A paragraph of alphanumeric 
characters

MTEXT

Point A point marker that can appear as 
a dot, square, circle, X, tick, or plus
sign (+), or as a combination of 
these figures

POINT

DIVIDE

MEASURE

Polyline A 2D line or mesh of adjustable 
width or a 3D line or mesh of non-
adjustable width composed of line 
and arc segments

3DPOLY

BOUNDARY

ELLIPSE 
 (if PELLIPSE = 1)

PLINE

POLYGON

RECTANG

Ray A construction line that is infinite in 
one direction

RAY

Solid A filled 2D area SOLID

Spline A nonuniform rational B-spline 
(NURBS) curve

SPLINE

Text A single line of alphanumeric 
characters

DTEXT

STYLE

TEXT

Vertex For polylines, the point at which 
line or arc segments intersect

3DPOLY

PLINE

Viewport A rectangular area in paper space 
that contains a view of model 
space 

VPORTS

MVIEW



Xline A construction line that is infinite in 
both directions

XLINE



UNLOCK Command
Up a Level          Related Topics

Opens locked files
When you attempt to open a locked file, a message state who locked the file and when. You can open a file with a read lock 
without unlocking it. If the file has a write lock, you can choose to unlock the file or to cancel the command. Before you 
unlock a file, however, make sure it is safe to do so; to avoid destroying data, unlock a file only when you are sure no one 
else is using it.

From the File menu, choose Management, then Unlock File

At the Command prompt, enter unlock

For more information about unlocking files, see chapter 17, “Managing Files and Other Formats,” in the AutoCAD LT User's 
Guide. 



'VIEW Command
Up a Level          Related Topics

Saves and restores named views 
A view is a portion of a drawing that is displayed in a viewport. Views can be saved and restored by name for convenient 
access. Views are saved separately in model space and paper space.

At the Command prompt, enter view

? / Delete / Restore / Save / Window: Enter an option

You cannot use VIEW transparently while in paper space; during a VPOINT or DVIEW command; or while another ZOOM, 
PAN, or VIEW is in progress. Fast Zoom mode must be on.



For more information about viewing drawings, see chapter 8, “Controlling the Drawing Display,” in the AutoCAD LT User's 
Guide. 

Commands: DDVIEW creates and restores views. DVIEW defines parallel projection or perspective views on the screen as 
you change views. PLOT prints a drawing to a plotter, printer, or file.



?    List Named Views (VIEW)
Up a Level

Lists the named views in the drawing.

View(s) to list <*>: Enter a wild-card pattern or press RETURN

AutoCAD LT lists the name of each specified view and the space in which it was defined. M designates model space, and P 
designates paper space.



Delete (VIEW)
Up a Level

Deletes one or more named views. 

View name(s) to delete: Enter a name or a list of names separated by commas



Restore (VIEW)
Up a Level

Restores the view you specify to the current viewport. 

View name to restore: Enter a name

AutoCAD LT also restores the center point and magnification of each saved view. If you restore a model space view while 
working in paper space, AutoCAD LT asks you to select a viewport in which to restore that view.

Restoring model space view.

Select viewport: Select a viewport

Select the viewport by choosing its border. The viewport you select must be on and active. AutoCAD LT switches to model 
space and restores the view in the selected viewport. 

If you restore a paper space view while working in model space with TILEMODE off, AutoCAD LT switches to paper space 
and restores the view. TILEMODE must be off when you restore a paper space view.



Save (VIEW)
Up a Level

Saves the display in the current viewport using the name you supply.

View name to save: Enter a name



Window (VIEW)
Up a Level

Saves a portion of the current display as a view. 

View name to save: Enter a name

First corner: Specify a point

Other corner: Specify a point in the opposite corner

Restoring such a view may display objects outside the window you specified because the shape of the window may differ 
from that of the viewport in which you are restoring the view. However, plotting the view will plot only the objects inside the 
window, not the entire viewport display.



VIEWTOOLBAR Command
Up a Level          Related Topics

Opens, closes, and controls display options for toolbars

From the View menu, choose Toolbars

At the Command prompt, enter viewtoolbar

The Toolbars dialog box is displayed. In the Toolbars dialog box, you can select the toolbars you want to view or hide. You 
can select options to display color buttons, large buttons, and ToolTips.



For more information about toolbars, see chapter 19 of the AutoCAD LT User's Guide. 

Commands: TOOLBAR displays, hides, and positions toolbars. TBCONFIG customizes toolbars.

System Variables: TOOLTIPS controls the display of ToolTips.



Toolbars dialog box
Up a Level

Toolbars
Lists all of the toolbars available in AutoCAD LT. Click in the box next to a toolbar to display it.

Reset
Restores the toolbars that are displayed by default.

Menu Group
Lists the menus that have been created. You can display toolbars from any of them.

Color Buttons
Controls whether the button icons are displayed in color or not.

Large Buttons
Controls whether small buttons (16 pixels wide) or large buttons (24 pixels wide) are displayed.

Show ToolTips
Controls whether tooltips are displayed. Tooltips are small pop-up windows that display the name of a button when the 
pointing device remains over the button for a short period of time.



VPLAYER Command
Up a Level          Related Topics

Sets layer visibility within viewports
A layer can be visible in one or more viewports and invisible in all other viewports. 

Before you use VPLAYER, the TILEMODE system variable must be set to 0 (off). A layer must be thawed and on globally 
before you can use VPLAYER to affect its visibility in a specific viewport.

   From the Format menu, choose Viewport Layer Controls
 

At the Command prompt, enter vplayer

? / Freeze / Thaw / Reset / Newfrz / Vpvisdflt: Enter an option



Commands: DDLMODES uses a dialog box to control the creation and visibility of layers and layer settings. LAYER uses 
the command line to control the creation and visibility of layers and layer settings.



List Frozen Layers (VPLAYER)
Up a Level

Displays the names of frozen layers in a selected viewport.



Freeze (VPLAYER)
Up a Level

Freezes a layer or set of layers in one or more viewports. AutoCAD LT does not display, regenerate, or plot objects on frozen
layers.

Layer(s) to freeze: Enter a name or a list of names separated by commas

All / Select / <curren  t  >: Enter an option or press RETURN



Current

Applies the changes in the current viewport only.



All

Applies the changes in all viewports.



Select

Applies the changes in selected viewports.

Select objects: Select one or more viewports and press RETURN



Thaw (VPLAYER)
Up a Level

Thaws layers in specific viewports.

Layer(s) to thaw: Enter a name or a list of names separated by commas

All / Select / <current>: Enter an option or press RETURN



Reset (VPLAYER)
Up a Level

Sets the visibility of layers in specified viewports to their current default setting.

Layer(s) to reset: Enter a name or a list of names separated by commas

All / Select / <current>: Enter an option or press RETURN



Newfrz (New Freeze; VPLAYER)
Up a Level

Creates new layers that are frozen in all viewports.

New Viewport frozen layer names: Enter a name or a list of names separated by commas



Vpvisdflt (Viewport Visibility Default; VPLAYER)
Up a Level

Determines whether the specified layers are thawed or frozen in subsequently created viewports. 

Layer name(s) to change default viewport visibility: Enter a name or a list of names separated by commas

Change default viewport visibility to Frozen / <Thawed>: Enter f or t or press RETURN



VPOINT Command
Up a Level          Related Topics

Sets the viewing direction for a 3D visualization of the drawing
You can use VPOINT to look at the drawing as if looking back at the origin (0,0,0) from a specified point in space. VPOINT 
cannot be used in paper space.

 From the View menu, choose 3D Viewpoint, then any 
option except Plan View 

At the Command prompt, enter vpoint

Rotate / <View point> <current>: Enter r, specify a point, or press RETURN to display a compass and axis tripod



VPOINT Command
Up a Level          Related Topics

Sets the viewing direction for a 3D visualization of the drawing
You can use VPOINT to look at the drawing as if looking back at the origin (0,0,0) from a specified point in space. VPOINT 
cannot be used in paper space.

 From the View menu, choose 3D Viewpoint, then any 
option except Plan View 

At the Command prompt, enter vpoint

Rotate / <View point> <current>: Enter r, specify a point, or press RETURN to display a compass and axis tripod



VPOINT Command
Up a Level          Related Topics

Sets the viewing direction for a 3D visualization of the drawing
You can use VPOINT to look at the drawing as if looking back at the origin (0,0,0) from a specified point in space. VPOINT 
cannot be used in paper space.

 From the View menu, choose 3D Viewpoint, then any 
option except Plan View 

At the Command prompt, enter vpoint

Rotate / <View point> <current>: Enter r, specify a point, or press RETURN to display a compass and axis tripod



VPOINT Command
Up a Level          Related Topics

Sets the viewing direction for a 3D visualization of the drawing
You can use VPOINT to look at the drawing as if looking back at the origin (0,0,0) from a specified point in space. VPOINT 
cannot be used in paper space.

 From the View menu, choose 3D Viewpoint, then any 
option except Plan View 

At the Command prompt, enter vpoint

Rotate / <View point> <current>: Enter r, specify a point, or press RETURN to display a compass and axis tripod



VPOINT Command
Up a Level          Related Topics

Sets the viewing direction for a 3D visualization of the drawing
You can use VPOINT to look at the drawing as if looking back at the origin (0,0,0) from a specified point in space. VPOINT 
cannot be used in paper space.

 From the View menu, choose 3D Viewpoint, then any 
option except Plan View 

At the Command prompt, enter vpoint

Rotate / <View point> <current>: Enter r, specify a point, or press RETURN to display a compass and axis tripod



VPOINT Command
Up a Level          Related Topics

Sets the viewing direction for a 3D visualization of the drawing
You can use VPOINT to look at the drawing as if looking back at the origin (0,0,0) from a specified point in space. VPOINT 
cannot be used in paper space.

 From the View menu, choose 3D Viewpoint, then any 
option except Plan View 

At the Command prompt, enter vpoint

Rotate / <View point> <current>: Enter r, specify a point, or press RETURN to display a compass and axis tripod



VPOINT Command
Up a Level          Related Topics

Sets the viewing direction for a 3D visualization of the drawing
You can use VPOINT to look at the drawing as if looking back at the origin (0,0,0) from a specified point in space. VPOINT 
cannot be used in paper space.

 From the View menu, choose 3D Viewpoint, then any 
option except Plan View 

At the Command prompt, enter vpoint

Rotate / <View point> <current>: Enter r, specify a point, or press RETURN to display a compass and axis tripod



VPOINT Command
Up a Level          Related Topics

Sets the viewing direction for a 3D visualization of the drawing
You can use VPOINT to look at the drawing as if looking back at the origin (0,0,0) from a specified point in space. VPOINT 
cannot be used in paper space.

 From the View menu, choose 3D Viewpoint, then any 
option except Plan View 

At the Command prompt, enter vpoint

Rotate / <View point> <current>: Enter r, specify a point, or press RETURN to display a compass and axis tripod



VPOINT Command
Up a Level          Related Topics

Sets the viewing direction for a 3D visualization of the drawing
You can use VPOINT to look at the drawing as if looking back at the origin (0,0,0) from a specified point in space. VPOINT 
cannot be used in paper space.

 From the View menu, choose 3D Viewpoint, then any 
option except Plan View 

At the Command prompt, enter vpoint

Rotate / <View point> <current>: Enter r, specify a point, or press RETURN to display a compass and axis tripod



VPOINT Command
Up a Level          Related Topics

Sets the viewing direction for a 3D visualization of the drawing
You can use VPOINT to look at the drawing as if looking back at the origin (0,0,0) from a specified point in space. VPOINT 
cannot be used in paper space.

 From the View menu, choose 3D Viewpoint, then any 
option except Plan View 

At the Command prompt, enter vpoint

Rotate / <View point> <current>: Enter r, specify a point, or press RETURN to display a compass and axis tripod



VPOINT Command
Up a Level          Related Topics

Sets the viewing direction for a 3D visualization of the drawing
You can use VPOINT to look at the drawing as if looking back at the origin (0,0,0) from a specified point in space. VPOINT 
cannot be used in paper space.

 From the View menu, choose 3D Viewpoint, then any 
option except Plan View 

At the Command prompt, enter vpoint

Rotate / <View point> <current>: Enter r, specify a point, or press RETURN to display a compass and axis tripod



For more information, see "Setting a Viewing Direction" in chapter 11 of the AutoCAD LT User's Guide. 

System Variables: TARGET is the location in UCS coordinates of the target point for the current viewport. VIEWDIR is the 
current viewport viewing direction. WORLDVIEW determines whether input to the VPOINT and DVIEW commands is relative
to the WCS (default) or to the UCS. 



RETURN—Axis Tripod (VPOINT)
Up a Level

Pressing RETURN displays a compass and axis tripod, which you use to define a viewing direction in the viewport.

The compass is a 2D representation of a globe. The center point is the north pole (0,0,n), the inner ring is the equator 
(n,n,0), and the entire outer ring is the south pole (0,0,-n). 
You can move the small crosshairs on the compass to any portion of the globe with your pointing device. As you move the 
crosshairs, the axis tripod rotates to conform to the viewing direction indicated on the compass. To select a viewing direction,
move your pointing device to a location on the globe and press the pick button.



View Point (VPOINT)
Up a Level

Uses a point to define a direction from which the drawing is viewed. The view defined is as if the viewer were looking from 
the point back at the origin (0,0,0).

        



Rotate (VPOINT)
Up a Level

Specifies a new viewing direction using two angles.

Enter angle in XY plane from X axis <current>: Specify an angle

The first angle is specified with respect to the X axis, in the XY plane.

Enter angle from XY plane <current>: Specify an angle

The second angle is specified up or down from the XY plane.



VPORTS Command
Up a Level          Related Topics

Divides the graphics area into multiple tiled viewports
Before you use VPORTS, the TILEMODE system variable must be set to 1. The number and layout of active viewports and 
their associated settings are called viewport configurations.

   From the View menu, choose Tiled Viewports
 

At the Command prompt, enter vports

Save / Restore / Delete / Join / SIngle / ? / 2 / <3 > / 4: Enter an option or press RETURN



For more information about dividing a drawing into multiple tiled viewports, see "Changing the Tiling Configuration" in 
chapter 8 of the AutoCAD LT User's Guide. 

Commands: MVIEW creates viewport objects in paper space and controls the display of objects in those viewports.

System Variables: CVPORT sets the current viewport. MAXACTVP specifies the maximum number of viewports to be 
regenerated at one time. TILEMODE controls paper space access and viewport behavior.



Save (VPORTS)
Up a Level

Saves the current viewport configuration using a specified name.

? / Name for new viewport configuration: Enter a name or ?

Entering ? lists previously saved viewport configurations.



Restore (VPORTS)
Up a Level

Restores a previously saved viewport configuration.

? / Name of viewport configuration to restore: Enter a name or ?

Entering ? lists the saved viewport configurations.



Delete (VPORTS)
Up a Level

Deletes a named viewport configuration.

? / Name of viewport configuration to delete: Enter a name or ?

Entering ? lists the saved viewport configurations.



Join (VPORTS)
Up a Level

Combines two adjacent viewports into one larger viewport. The resulting viewport inherits the view of the dominant viewport.

Select dominant viewport <current>: Select a viewport or press RETURN 

Select viewport to join: Select a viewport

          



Single (VPORTS)
Up a Level

Returns the drawing to a single viewport, using the view from the active viewport.

          



?List Viewport Configurations (VPORTS)
Up a Level

Displays the identification numbers and screen positions of the active viewports. This option also displays the names and 
screen positions of the currently saved viewport configurations.

Viewport configuration(s) to list <*>: Enter a name or press RETURN 

The lower-left and upper-right corners of a viewport define its location. For these corners, AutoCAD LT uses values between 
0.0,0.0 for the lower-left corner of the graphics area and 1.0,1.0 for the upper-right corner. The current viewport is listed first. 



2 (VPORTS)
Up a Level

Divides the current viewport in half.

Horizontal <Vertical>: Enter h or press RETURN 



3 (VPORTS)
Up a Level

Divides the current viewport into three viewports.

Horizontal / Vertical / Above / Below / Left / <Right>: Enter an option or press RETURN 

The Horizontal and Vertical options split the area into thirds. The other options create one large viewport of half the available
area and two smaller ones. The Above, Below, Left, and Right options specify where the larger viewport is placed. 



4 (VPORTS)
Up a Level

Divides the current viewport into four viewports of equal size.



VSLIDE Command
Up a Level          Related Topics

Displays a raster image slide file in the current viewport
   From the File menu, choose Slide, then View
 

At the Command prompt, enter vslide

The Select Slide File dialog box is displayed.

To display a slide in a slide library file extension (.slb), choose Type it to see the following prompt:

Slide file: Enter the library file name and the slide file name as library-file-name(slide-file-name)

When you view slides of images shaded with the SHADE command in a larger window or at a higher resolution than was 
used for creating the slide, black lines may appear interspersed among the lines of the shaded image. To avoid this problem,
use a full screen that is set at the highest resolution when creating slides.



Select Slide File Dialog Box
Up a Level

File Name
Select or enter the name of the slide file extension .sld you want to display. The only type of file accepted currently is SLD.

List Files of Type
Select the type of files you want to see in the File Name box.

Directories
Select the directory that contains the slide file you want to display.

Drives
Select the drive that contains the slide file you want to display.

Find File
To find slide files on multiple drives and directories, choose Find File. The Browse/Search dialog box is displayed.

Network
To map a network path to a drive letter, choose Network. The Map Network Drive dialog box is displayed..



For more information about displaying slide files, see "Viewing Slides" in chapter 21 of the AutoCAD LT User's Guide. 

Commands: REDRAW restores the current drawing. MSLIDE creates slide files for viewing. 

Utilities: SLIDELIB creates slide libraries (file extensions.slb). This utility is found in the AutoCAD LT support directory. For 
more information, see appendix B, "Command Quick Reference," in the AutoCAD LT User's Guide.



Map Network Drive Dialog Box
Up a Level

Drive
Displays the first available drive letter for connection. You can select a different drive in the Drive box.

Path
Specifies the network path for connection. Select a previous network path from the Path box, or enter the name of a 
computer and shared directory. 

Reconnect at Logon
Connects you to the shared directory each time you log on.

Note: The Windows NT dialog box is titled “Connect Network Drive.”



WBLOCK Command
Up a Level          Related Topics

Writes objects to a new drawing file
 At the Command prompt, enter wblock

The Create Drawing File dialog box is displayed. Enter the name of the output file in the File Name box.

Block name: Enter the name of an existing block, enter =, enter *, or press RETURN

Entering the name of an existing block saves that block as a file. You cannot enter the name of an external 
reference (xref) or one of its dependent blocks.

Entering an equal sign (=) specifies that the existing block and the output file have the same name. If no block of 
that name exists in the drawing, AutoCAD LT redisplays the Block Name prompt.

Entering an asterisk (*) saves the entire drawing to the new output file, except for unreferenced symbols. AutoCAD 
LT writes model space objects to model space and paper space objects to paper space.

If you press RETURN at the Block Name prompt, AutoCAD LT prompts you to select the objects to save as a file. 

Select objects: Use an object selection method

Insertion base point: Specify a point (1)

          

      

After AutoCAD LT creates the file, the selected objects are deleted from the drawing. You can use the OOPS command to 
restore the objects.

In the new drawing, the World Coordinate System (WCS) is set parallel to the UCS in effect at the time the objects were 
saved to the file.



Create Drawing File Dialog Box
Up a Level

File Name
Select or enter the name you want to assign to the drawing file you are creating. 

Save Files as Type
Select the type of files you want to see in the File Name box. The only type of file accepted currently is DWG.

Directories
Select the directory that you want to contain the drawing file.

Drives
Select the drive that you want to contain the drawing file.

Preview
Display a preview of the drawing for which you want to create a drawing file.

Network
To connect network drives to your computer, choose Network. The Map Network Drive dialog box is displayed. 



For more information about blocks, see "Defining Blocks" in chapter 14 of the AutoCAD LT User's Guide. 

Commands: DDINSERT and INSERT place a previously defined block or drawing in the current drawing. END saves the 
current drawing and exits AutoCAD LT. EXPORT saves objects to other file formats. OOPS restores erased objects. QSAVE 
saves the current drawing. SAVE saves the current drawing with the current file name or a specified name. SAVEAS saves 
an unnamed drawing with a file name or renames the current drawing. XREF controls external references to drawing files. 



Using Wild-Card Characters
Up a Level

When the prompt directions ask for a name list, such as a block name, variable name, or named view, you can use the 
following wild-card characters to specify names.

Character Definition

# (pound) Matches any numeric digit.

@ (at) Matches an alpha character.

. (period) Matches any nonalphanumeric character.

* (asterisk) Matches any string, including the null string. It
can be used anywhere in the search pattern: 
at the beginning, middle, or end of the string.

? (question mark) Matches any single character.

~ (tilde) Matches anything but the pattern.

[...] Matches any one of the characters enclosed.

[~...] Matches any character not enclosed.

- (hyphen) Used inside brackets, specifies a range for a 
single character.

` (reverse quote) Reads the next character literally instead of 
as a wild-card character.



WMFIN Command
Up a Level          Related Topics

Imports a file in Windows metafile format
Unlike bitmap or raster files, metafiles contain vector information, which can be scaled and printed without loss of resolution.

 At the Command prompt, enter wmfin

The Import WMF dialog box is displayed.

Insertion point: Specify a point

X scale factor <1 > / Corner / XYZ: Enter a scale factor or enter c



Import WMF Dialog Box
Up a Level

File Name
Select or enter the name of the Windows metafile (file extension .wmf) you want to import. 

List Files of Type
Select the type of files you want to see in the File Name box.

Directories
Select the directory that contains the Windows metafile you want to import.

Drives
Select the drive that contains the Windows metafile you want to import.

Preview
Displays a preview of the Windows metafile you want to import.

Find File
To find Windows metafiles on multiple drives and directories, choose Find File. The Browse/Search dialog box is displayed.

Network
To connect network drives to your computer, choose Network. The Map Network Drive dialog box is displayed. 



X Scale Factor (WMFIN)
Up a Level

Places a copy of the metafile with its base point at the specified insertion point. 

Y scale factor (default = X): Enter a scale factor or press RETURN 

Rotation angle <0>: Specify an angle or press RETURN

AutoCAD LT multiplies all X and Y dimensions of the metafile by the X and Y scale factors supplied. The metafile is rotated 
by the angle specified, using the insertion point as the center of rotation.



Corner (WMFIN)
Up a Level

Defines the X and Y scales at the same time, using the insertion point and another point as the corners of a box. The X and 
Y dimensions of the box become the X and Y scale factors. The insertion point is the first corner.

Other corner: Specify a point

Rotation angle <0>: Specify an angle or press RETURN 



XYZ (WMFIN)
Up a Level

Scales the metafile in all three dimensions.

X scale factor <1> / Corner: Enter a scale factor, enter c, or press RETURN 



X Scale Factor

Defines X, Y, and Z scale factors for the metafile. 

Y scale factor <default=X>: Enter a scale factor or press RETURN

Z scale factor <default=X>: Enter a scale factor or press RETURN 

Rotation angle <0>: Specify an angle or press RETURN 



Corner

Defines the X and Y scales at the same time, using the insertion point and another point as the corners of a box, and then 
defines the Z scale.

Other corner: Specify a point

Z scale factor (default = X): Enter a scale factor or press RETURN 

Rotation angle <0>: Specify an angle or press RETURN 



Commands: WMFOPTS sets options for the WMFIN command. WMFOUT saves selected objects to a file in Windows 
metafile format. 



WMFOPTS Command
Up a Level          Related Topics

Sets options for WMFIN
   From the File menu, choose Import, then Options
 

At the Command prompt, enter wmfopts

The WMF Import Options dialog box is displayed.



WMF Import Options Dialog Box
Up a Level

Sets options for importing files in WMF format.

Wire Frame (No Fills)
Select to import objects in a Windows metafile as wire frames.

Clear to import objects in a Windows metafile as solid objects.

Wide Lines
Select to maintain the relative line width of lines and borders when the Windows metafile is imported.

Clear to set all line widths of lines and borders to zero when the Windows metafile is imported.



Commands: COPYCLIP copies vector objects to the Clipboard. WMFIN imports a file in WMF format. WMFOUT saves 
selected objects to a WMF file.



WMFOUT Command
Up a Level          Related Topics

Saves objects to a file in Windows metafile format
 At the Command prompt, enter wmfout

The Create WMF File dialog box is displayed. 

Select Objects: Use an object selection method

The selected objects are saved to a file in    Windows metafile format.



Create WMF File Dialog Box
Up a Level

File Name
Select or enter the name you want to assign to the Windows metafile. AutoCAD LT adds a .wmf    file extension. 

Save Files as Type
Select the type of files you want to see in the File Name box.

Directories
Select the directory that you want to contain the exported Windows metafile.

Drives
Select the drive that you want to contain the exported Windows metafile.

Network
To connect network drives to your computer, choose Network. The Map Network Drive dialog box is displayed. 



Commands: WMFIN imports a file in Windows metafile format. WMFOPTS sets options for the WMFIN command. 



XBIND Command
Up a Level          Related Topics

Binds dependent symbols of an xref to a drawing
An xref is a drawing that you attach to or overlay on your current drawing. To use XBIND, you must have an xref attached to 
the current drawing. For more information, see the XREF command.

Dependent symbols are named objects in an xref such as blocks, dimension styles, layers, linetypes, and text styles. 
AutoCAD LT binds the dependent symbols to the current drawing and saves them with the drawing at the end of the session.

 

From the External References toolbar, choose 

From the Edit menu, choose External Reference, then Bind Symbols
At the Command prompt, enter xbind

Block / Dimstyle / LAyer / LType / Style: Enter an option

Depending on the option, AutoCAD LT prompts for a dependent symbol such as a block, dimstyle, layer, linetype, or style.

Dependent symbol name(s): Enter a name or a list of names separated by commas

Any name you specify must include all the xref file name characters, including the vertical bar symbol (|), also known as the 
pipe character.

The dependent symbols you specify are added to your drawing. You can manipulate them as you would any other named 
object. AutoCAD LT replaces the vertical bar symbol (|) from each dependent symbol name with three new characters: a 
number (usually 0) between two dollar signs ($).

If you specify a layer whose associated linetype is not CONTINUOUS, AutoCAD LT also binds the referenced linetype. If you
apply XBIND to a block, any block, dimension style, layer, linetype, or text style that's referenced by objects in the block is 
also bound. If the block contains a reference to an xref (external reference), AutoCAD LT binds that xref and all its 
dependent symbols.



XBIND Command
Up a Level          Related Topics

Binds dependent symbols of an xref to a drawing
An xref is a drawing that you attach to or overlay on your current drawing. To use XBIND, you must have an xref attached to 
the current drawing. For more information, see the XREF command.

Dependent symbols are named objects in an xref such as blocks, dimension styles, layers, linetypes, and text styles. 
AutoCAD LT binds the dependent symbols to the current drawing and saves them with the drawing at the end of the session.

 

From the External References toolbar, choose 

From the Edit menu, choose External Reference, then Bind Symbols
At the Command prompt, enter xbind

Block / Dimstyle / LAyer / LType / Style: Enter an option

Depending on the option, AutoCAD LT prompts for a dependent symbol such as a block, dimstyle, layer, linetype, or style.

Dependent symbol name(s): Enter a name or a list of names separated by commas

Any name you specify must include all the xref file name characters, including the vertical bar symbol (|), also known as the 
pipe character.

The dependent symbols you specify are added to your drawing. You can manipulate them as you would any other named 
object. AutoCAD LT replaces the vertical bar symbol (|) from each dependent symbol name with three new characters: a 
number (usually 0) between two dollar signs ($).

If you specify a layer whose associated linetype is not CONTINUOUS, AutoCAD LT also binds the referenced linetype. If you
apply XBIND to a block, any block, dimension style, layer, linetype, or text style that's referenced by objects in the block is 
also bound. If the block contains a reference to an xref (external reference), AutoCAD LT binds that xref and all its 
dependent symbols.



XBIND Command
Up a Level          Related Topics

Binds dependent symbols of an xref to a drawing
An xref is a drawing that you attach to or overlay on your current drawing. To use XBIND, you must have an xref attached to 
the current drawing. For more information, see the XREF command.

Dependent symbols are named objects in an xref such as blocks, dimension styles, layers, linetypes, and text styles. 
AutoCAD LT binds the dependent symbols to the current drawing and saves them with the drawing at the end of the session.

 

From the External References toolbar, choose 

From the Edit menu, choose External Reference, then Bind Symbols
At the Command prompt, enter xbind

Block / Dimstyle / LAyer / LType / Style: Enter an option

Depending on the option, AutoCAD LT prompts for a dependent symbol such as a block, dimstyle, layer, linetype, or style.

Dependent symbol name(s): Enter a name or a list of names separated by commas

Any name you specify must include all the xref file name characters, including the vertical bar symbol (|), also known as the 
pipe character.

The dependent symbols you specify are added to your drawing. You can manipulate them as you would any other named 
object. AutoCAD LT replaces the vertical bar symbol (|) from each dependent symbol name with three new characters: a 
number (usually 0) between two dollar signs ($).

If you specify a layer whose associated linetype is not CONTINUOUS, AutoCAD LT also binds the referenced linetype. If you
apply XBIND to a block, any block, dimension style, layer, linetype, or text style that's referenced by objects in the block is 
also bound. If the block contains a reference to an xref (external reference), AutoCAD LT binds that xref and all its 
dependent symbols.



XBIND Command
Up a Level          Related Topics

Binds dependent symbols of an xref to a drawing
An xref is a drawing that you attach to or overlay on your current drawing. To use XBIND, you must have an xref attached to 
the current drawing. For more information, see the XREF command.

Dependent symbols are named objects in an xref such as blocks, dimension styles, layers, linetypes, and text styles. 
AutoCAD LT binds the dependent symbols to the current drawing and saves them with the drawing at the end of the session.

 

From the External References toolbar, choose 

From the Edit menu, choose External Reference, then Bind Symbols
At the Command prompt, enter xbind

Block / Dimstyle / LAyer / LType / Style: Enter an option

Depending on the option, AutoCAD LT prompts for a dependent symbol such as a block, dimstyle, layer, linetype, or style.

Dependent symbol name(s): Enter a name or a list of names separated by commas

Any name you specify must include all the xref file name characters, including the vertical bar symbol (|), also known as the 
pipe character.

The dependent symbols you specify are added to your drawing. You can manipulate them as you would any other named 
object. AutoCAD LT replaces the vertical bar symbol (|) from each dependent symbol name with three new characters: a 
number (usually 0) between two dollar signs ($).

If you specify a layer whose associated linetype is not CONTINUOUS, AutoCAD LT also binds the referenced linetype. If you
apply XBIND to a block, any block, dimension style, layer, linetype, or text style that's referenced by objects in the block is 
also bound. If the block contains a reference to an xref (external reference), AutoCAD LT binds that xref and all its 
dependent symbols.



XBIND Command
Up a Level          Related Topics

Binds dependent symbols of an xref to a drawing
An xref is a drawing that you attach to or overlay on your current drawing. To use XBIND, you must have an xref attached to 
the current drawing. For more information, see the XREF command.

Dependent symbols are named objects in an xref such as blocks, dimension styles, layers, linetypes, and text styles. 
AutoCAD LT binds the dependent symbols to the current drawing and saves them with the drawing at the end of the session.

 

From the External References toolbar, choose 

From the Edit menu, choose External Reference, then Bind Symbols
At the Command prompt, enter xbind

Block / Dimstyle / LAyer / LType / Style: Enter an option

Depending on the option, AutoCAD LT prompts for a dependent symbol such as a block, dimstyle, layer, linetype, or style.

Dependent symbol name(s): Enter a name or a list of names separated by commas

Any name you specify must include all the xref file name characters, including the vertical bar symbol (|), also known as the 
pipe character.

The dependent symbols you specify are added to your drawing. You can manipulate them as you would any other named 
object. AutoCAD LT replaces the vertical bar symbol (|) from each dependent symbol name with three new characters: a 
number (usually 0) between two dollar signs ($).

If you specify a layer whose associated linetype is not CONTINUOUS, AutoCAD LT also binds the referenced linetype. If you
apply XBIND to a block, any block, dimension style, layer, linetype, or text style that's referenced by objects in the block is 
also bound. If the block contains a reference to an xref (external reference), AutoCAD LT binds that xref and all its 
dependent symbols.



XBIND Command
Up a Level          Related Topics

Binds dependent symbols of an xref to a drawing
An xref is a drawing that you attach to or overlay on your current drawing. To use XBIND, you must have an xref attached to 
the current drawing. For more information, see the XREF command.

Dependent symbols are named objects in an xref such as blocks, dimension styles, layers, linetypes, and text styles. 
AutoCAD LT binds the dependent symbols to the current drawing and saves them with the drawing at the end of the session.

 

From the External References toolbar, choose 

From the Edit menu, choose External Reference, then Bind Symbols
At the Command prompt, enter xbind

Block / Dimstyle / LAyer / LType / Style: Enter an option

Depending on the option, AutoCAD LT prompts for a dependent symbol such as a block, dimstyle, layer, linetype, or style.

Dependent symbol name(s): Enter a name or a list of names separated by commas

Any name you specify must include all the xref file name characters, including the vertical bar symbol (|), also known as the 
pipe character.

The dependent symbols you specify are added to your drawing. You can manipulate them as you would any other named 
object. AutoCAD LT replaces the vertical bar symbol (|) from each dependent symbol name with three new characters: a 
number (usually 0) between two dollar signs ($).

If you specify a layer whose associated linetype is not CONTINUOUS, AutoCAD LT also binds the referenced linetype. If you
apply XBIND to a block, any block, dimension style, layer, linetype, or text style that's referenced by objects in the block is 
also bound. If the block contains a reference to an xref (external reference), AutoCAD LT binds that xref and all its 
dependent symbols.



For information about dependent symbols and how they're named, see "Working with External References" in chapter 14 of 
the AutoCAD LT User's Guide. 

Commands: XREF controls xrefs (external references).



XLINE Command
Up a Level          Related Topics

Creates an infinite line
Infinite lines are commonly used as construction lines.

   

From the Draw toolbar, choose 

From the Draw menu, choose Construction Line
 At the Command prompt, enter xline

Hor / Ver / Ang / Bisect / Offset / <From point>: Specify a point or enter an option



For more information about using infinite lines, see "Creating Construction Lines" in chapter 7 of the AutoCAD LT User's 
Guide. 

Commands: DDMODIFY modifies the properties of an xline. LINE creates straight line segments. PLINE creates 2D 
polylines. RAY creates a semi-infinite line.

System Variables: OFFSETDIST stores the current offset value.



From Point (XLINE)
Up a Level

Specifies the location of the infinite line using a second point through which it passes.

Through point: Specify the point (2) through which you want the xline to pass, or press RETURN to end the command

AutoCAD LT places the xline through the specified points.



Hor (XLINE)
Up a Level

Creates a horizontal xline passing through a selected point.

Through point: Specify the point (1) through which you want the xline to pass, or press RETURN to end the command

AutoCAD LT places the xline parallel to the X axis. 



Ver (XLINE)
Up a Level

Creates a vertical xline passing through a selected point. 

Through point: Specify the point (1) through which you want the xline to pass, or press RETURN to end the command

AutoCAD LT places the xline parallel to the Y axis. 



Ang (XLINE)
Up a Level

Creates an xline at a specified angle.

Reference / <enter angle (current)>: Specify an angle or enter r

Reference

Creates an xline at a specific angle from a selected reference line. The angle is measured counter-clockwise from the 
reference line.

Select a line object: Select a line, polyline, ray, or xline

Enter angle <0.000>: Specify an angle

Through point: Specify the point through which you want to xline to pass, or press RETURN to end the command

AutoCAD LT places the xline through the specified point, using the specified angle.

Enter angle

Creates an xline at a specific angle through a specified point.

Through point: Specify a point

AutoCAD LT places an xline through the point, using    the specified angle.



Bisect (XLINE)
Up a Level

Creates an xline that passes through the selected angle vertex and bisects the angle between the first and second line.

Angle vertex point: Specify a point (1)

Angle start point: Specify a point (2)

Angle end point: Specify a point (3) or press RETURN to end the command

The xline lies in the plane determined by the three points.



Offset (XLINE)
Up a Level

Creates an xline parallel to another object.

Offset distance or Through <current>: Specify an offset distance, enter t, or press RETURN

Offset Distance

Creates the xline as an offset from the selected object.

Select a line object: Select a line, polyline, ray, or xline,
or press RETURN to end the command

Side to offset? Specify a point (1)

Through

Creates an xline parallel to a line object and passing through 
a specified point.

Select a line object: Select a line, polyline, ray, or xline, 
or press RETURN to end the command

Through point: Specify the point (1) through which you 
want the xline to pass

XREF Command
Up a Level          Related Topics

Controls external references to drawing files
XREF attaches, overlays, lists, binds, detaches, modifies the path of, and reloads other drawings as external references 
(xrefs) to the current drawing.

You can attach xrefs to create subassemblies that make up a drawing. You can overlay xrefs to check how your drawing 
relates to other drawings.

Attaching or overlaying an xref is similar to inserting an entire drawing as a block. The contents of the specified drawing, 
except for overlaid xrefs, are copied into a new block definition. Instances of the xref in the drawing are block references.

When you open or plot a drawing containing xrefs, AutoCAD LT automatically reloads the latest version of each xref.

 From the External Reference toolbar, choose

From the Edit menu, choose External Reference
At the Command prompt, enter xref

? / Bind / Detach / Path / Reload / Overlay / <Attach>: Enter an option or press RETURN



Attach (XREF)
Up a Level

Attaches a drawing as an external reference (xref). If you reference a drawing that itself contains an attached xref, the 
attached xref appears in the current drawing. Like blocks, attached xrefs can be nested. If another person is currently editing
the xref, the drawing attached is based on the most recently saved version.

Xref to attach <current>: Enter a file name or press RETURN

For more information about attaching xrefs, see Attaching and Overlaying Xrefs.



?List (XREF)
Up a Level

Lists the xref names, with path, and xref type, and the number of xrefs currently attached to your drawing. AutoCAD LT 
displays the following prompt:

Xref(s) to list <*>: Enter a wild-card pattern or press RETURN



Bind (XREF)
Up a Level

Converts a block making it a permanent part of the drawing.

Xref(s) to bind: Enter a name or a list of names separated by commas

The dependent symbols, such as layer names, of the former xref are added to your drawing. In each dependent symbol 
name, AutoCAD LT replaces the vertical bar symbol (|) with three new characters: a number (usually 0) between two dollar 
signs ($).



Detach (XREF)
Up a Level

Erases all copies of a specified xref from your drawing, and marks the xref definition for deletion.

Xref(s) to detach: Enter a name or a list of names separated by commas

AutoCAD LT does not detach an xref referenced by another xref or block.



Path (XREF)
Up a Level

Displays and edits the path name associated with a particular xref. This option is useful if you change the location of or 
rename the drawing file associated with the xref.

Edit path for which xref(s): Enter an xref name

AutoCAD LT lists the xref and its existing path and prompts for the new path:

Xref name: Enter the xref name

Old path:  Enter the existing path name

New path: Enter the new path name



Reload (XREF)
Up a Level

Reloads one or more xrefs. If another person is currently editing the xref, AutoCAD LT loads the most recently saved 
version.

Xref(s) to reload: Enter a name or a list of names separated by commas

AutoCAD LT creates a temporary lock file if the drawing you are editing is externally referenced by someone else while you 
are using the XREF Reload command. If AutoCAD LT encounters an error while reloading, the XREF command ends and 
the entire reloading sequence is undone.



Overlay (XREF)
Up a Level

Attaches a drawing as an external reference (xref) overlay. If you reference a drawing that itself contains an overlaid xref, the
overlaid xref does not appear in the current drawing. Unlike blocks and attached xrefs, overlaid xrefs cannot be nested. If 
another person is currently editing the xref, AutoCAD LT overlays the most recently saved version.

Xref to overlay <current>: Enter a file name or press RETURN

For more information on overlaying xrefs, see Attaching and Overlaying Xrefs.



Attaching and Overlaying Xrefs
Up a Level

At the Xref to attach or Xref to overlay prompt, you can also enter a tilde  (~) to display a dialog box regardless of the setting 
of the FILEDIA system variable.

If the xref (including the path) exceeds 31 characters, you need to assign a name different from the drawing name at the 
prompt using the following syntax.

Xref to attach: xrefname=referenced_file

To request a File dialog box, use the tilde  (~) character.

xrefname=~ 

If the xref you specify is not already attached or overlaid, AutoCAD LT creates a new xref, using the name of the referenced 
file. AutoCAD LT then prompts for an insertion point, scale, and rotation angle, as described for the INSERT command.

When reading objects from the xref into the new block, AutoCAD LT copies only those objects created in model space and 
ignores objects created in paper space. Thus, viewports and other objects in paper space do not become a part of the block 
definition.

In a master drawing, the 0 and DEFPOINTS layers and the CONTINUOUS linetype override entries with the same name 
that exist in the attaching or overlaying xref. Any objects on these layers remain unaffected. If the DEFPOINTS layer exists 
in the attaching or overlaying xref but not in the master drawing, the DEFPOINTS layer becomes a permanent part of the 
master drawing.



For more information, see "Working with External References" in chapter 14 of the AutoCAD LT User's Guide. 

Commands: BLOCK creates a compound object (a block definition) from a group of objects. INSERT places a previously 
defined block or drawing into the current drawing. DDLMODES or LAYER control the creation and visibility of layers along 
with layer settings. XBIND binds dependent symbols of an xref to a drawing.

System Variables: FILEDIA controls the display of dialog boxes used to read and write files. XREFCTL controls the 
creation of the xref log file.



'ZOOM Command
Up a Level          Related Topics

Increases or decreases the apparent size of objects in the current viewport
 From the Standard toolbar, choose

 From the view menu, choose Zoom 
At the Command prompt, enter zoom

All / Center / Extents / Previous / Window / <Scale(X/XP)>: Enter an option or a value, specify a point, or press 
RETURN



'ZOOM Command
Up a Level          Related Topics

Increases or decreases the apparent size of objects in the current viewport
 From the Standard toolbar, choose

 From the view menu, choose Zoom 
At the Command prompt, enter zoom

All / Center / Extents / Previous / Window / <Scale(X/XP)>: Enter an option or a value, specify a point, or press 
RETURN



For more information, see "Using the Zoom Options" in chapter 8 of the AutoCAD LT User's Guide. 

Commands: LIMITS sets and controls the drawing boundaries. PAN moves the drawing display in the current viewport. 
VIEW saves and restores named views. VPOINT sets the viewing direction for a 3D visualization of the current drawing. 



Scale X / XP (ZOOM)
Up a Level

Changes the display by a specified scale factor. The value you enter is relative to the limits of the drawing. For example, 
entering 2 displays objects at twice the size they would appear if you were zoomed to the limits of the drawing. 

      

If you enter a value followed by x, AutoCAD LT specifies the scale relative to the current view. For example, entering .5x 
causes each object to be displayed at half its current size on the screen.

      

If you enter a value followed by xp, AutoCAD LT specifies the scale relative to paper space units. For example, entering .5xp
displays model space at half the scale of paper space units. 

The following illustration shows a number of viewports arranged in paper space. The view in each viewport is scaled relative 
to paper space. For example, Detail 1 is scaled 1=1 relative to paper space (1xp), Detail 2 is scaled .5=1 relative to paper 
space (.5xp), and so on.



All (ZOOM)
Up a Level

Displays the entire drawing in the current viewport. 

In a plan view, AutoCAD LT zooms to the drawing limits or current extents, whichever is greater. In a 3D view, ZOOM All is 
equivalent to ZOOM Extents. The display shows all objects even if the drawing extends outside the drawing limits.

      

In the illustration, LIMITS is greater than the extents of the drawing.

Because it always regenerates the drawing, you cannot use ZOOM All transparently.



Center (ZOOM)
Up a Level

Changes the display by using a center point, and a magnification value or height. The smaller the value, the greater the 
magnification. Entering a larger value decreases the magnification.

Center point: Specify a point (1)

Magnification or Height <current>: Enter a value or press RETURN

      



Extents (ZOOM)
Up a Level

Displays the drawing extents. Because it always regenerates the drawing, you cannot use ZOOM Extents transparently.

              



Previous (ZOOM)
Up a Level

Displays the previous view. You can restore up to 10 previous views.

      

      



Window (ZOOM)
Up a Level

Displays an area specified by two opposite points defining a rectangular window.

First corner: Specify a point (1)

Other corner: Specify a point (2)



Overview: Starting a new drawing
Related Topics

You can start a new drawing several ways:

· Choose a wizard to help you specify basic settings such as unit of measurement style and drawing area

· Choose default English or metric settings

· Choose a template drawing that contains predefined settings

To learn more about starting a new drawing quickly, see

Using a template drawing file

Including a border and title block

Opening a template drawing



Using a template drawing file

You can start a new drawing quickly with a template drawing. A template drawing is an AutoCAD LT drawing file that has the 
extension .dwt and is saved automatically in the template directory. Template drawings can store hundreds of AutoCAD LT 
settings that you would otherwise have to set individually. Template drawings are also useful for maintaining drawing 
standards and conventions.

In a template drawing file, you can predefine the settings:

Drawing units
Sheet size and layout
Lettering and dimensioning styles
Colors
Types of lines
Layer names
View names
UCS names
Title blocks

A template drawing file may also include construction geometry and other objects.
Several template drawings have been included with AutoCAD LT for you to choose from. You can also make your own 
template drawings.

Note: You need to scale the title blocks in the template drawings that are included with AutoCAD LT. For example, if you 
plan to print your drawing at 1/4 size, use the inverse of 1/4 (4) as the value in the SCALE command.

To learn more about using template drawing files, see

How to open a template drawing

Setting the scale of your drawing



Including a title block and drawing border

You can include a title block and drawing border in your drawing two ways:
Start a new drawing and use the wizard to specify a template drawing file that includes a title block and drawing 

border
Insert a separate drawing file that contains the geometry of a title block and drawing border.

Note: In AutoCAD LT, symbols are called blocks or block inserts. The drafting term for the area containing title 
information in a drawing is title box, title form, title and record strip, or title block.

To learn more about including a border and title block, see

How to insert a block

Setting the scale of your drawing

Using a template drawing file



Starting a new drawing

How to

Load a template drawing

Insert a block

Concepts

Using a template drawing file

Including a border and title block

Commands

DDINSERT

NEW

Dialog Boxes

Create New Drawing

Insert

AutoCAD LT User's Guide

See chapter 4, "Organizing Your Project". 



Overview: Organizing your drawing
Related Topics

orientation of coordinate system

layer control

dimensions

Before you begin a new drawing, determine the following:

How you will name and use layers
Which types of lines (linetypes) you will use
How and where you will apply color when you plot your drawing
Which lettering styles you will use
Which dimension styles you will use
Which views you will need
Which coordinate system orientations you will use

You can set these features individually in each drawing file, or you can store the settings in a template drawing file.

To learn more about organizing your drawing, see

Setting the scale of your drawing

Using layers

Using linetypes

Setting the width of a line

Drawing with color

Using lettering styles

Using dimension styles

Using views

Using coordinate systems



Layers

A feature that is similar to transparent overlays in paper-based drafting. Layers are important for organizing your AutoCAD 
LT drawings.



Setting the scale of your drawing

In AutoCAD LT, you draw at full scale and then scale your drawing just before plotting it. 

To define your sheet size in the drawing area, draw a rectangle that represents your sheet or use the LIMITS command to 
draw an invisible boundary. In the Units Control dialog box, set your drawing units style (scientific notation, decimal feet, 
miles, inches, or metric units) and the precision to which AutoCAD LT displays values. Then draw your geometry, text, 
dimensions, and so on.

If you are drawing in model space only, scale your border, title block, text, and dimensions to fit your geometry. When you 
need several views of what you are modeling, you can split your screen into tiled viewports.

If you are using paper space for your drawing layout, scale the views that are displayed in each floating viewport. 

To learn more about setting the scale of your drawing, see

How to set units

How to specify the sheet size for printing

How to set the scale for a plotted drawing

How to set the overall scale for dimensions



Paper space

With AutoCAD LT there are two general drawing modes: model space and paper space. In paper space, you lay out and 
scale one or more views of what you have drawn in model space. This process is similar to arranging photographs 
(viewports) on a page in an album (paper space). Paper space typically contains only drawing borders, title blocks, notes, 
and floating viewports.



Model space

With AutoCAD LT there are two general drawing modes: model space and paper space. In model space, you draw objects at
full scale.

To display additional views of model space, you can divide your screen into areas called tiled viewports, or you can create 
floating viewports in paper space.

To plot your drawing, you can either scale a single view to fit on the paper, or you can use paper space to lay out your 
drawing with multiple views.



Tiled Viewports

You can use tiled viewports to divide your screen into adjacent rectangular areas, each displaying a different view of what 
you are drawing. Tiled viewports are available in model space when the variable TILEMODE is turned on.



Floating Viewports

Floating viewports are special rectangular objects in paper space that function like the viewfinder and lens on a camera. Just
as you use a viewfinder and lens to frame a picture, and to zoom into or out of a picture, you frame the objects in model 
space that you want to display in a floating viewport. Floating viewports can have space between them or they may overlap. 
Floating viewports can be created in paper space when the variable TILEMODE is turned off.



Using layers

Layers are similar to transparent overlays in paper-based drafting. You use layers to control the visibility of similar objects, 
such as electrical parts or dimensions. Also, you can lock a layer to prevent objects on that layer from being selected.
A drawing can contain multiple layers. You use the Layer Control dialog box to

Create layers
Select layers
Rename layers
Turn layers on or off
Freeze or thaw layers
Set a layer color
Set a layer linetype
Lock or unlock layers

To learn more about how to use layers, see

How to create a layer

How to make a layer current

How to turn a layer on or off

How to change the layer of an object



Using linetypes

AutoCAD LT provides many standard linetypes, such as HIDDEN, CENTER, and CONTINUOUS. Change the appearance 
of a line by loading and assigning a different linetype to an individual object, an entire layer, or a entire block.
To learn more about using linetypes, see

How to load a linetype



Setting the width of a line

There are two ways to change the width of a line: assign a width to a segment of a polyline or assign a color to a pen of a 
particular width on your plotter and assign that color to a line in your drawing.
If you change the width of a polyline, you see the new width on the screen. If you assign a color to a line and to a pen on 
your plotter, you will not see the new line width on the screen, but the line is plotted at the width of the pen.
For more information on setting the width of a line, see

How to assign width to polylines

How to map line colors to different pens on my plotter



Drawing with color

You can use color to help you group objects visually. Each object and each layer in a drawing is assigned a color by number 
from 1 to 255. 

You can assign the color of an object either individually or by the layer the object is on.

You also can use color to control line width on pen plotters.

In AutoCAD LT, the colors of the first eight pens are assigned as follows:

Number Color
1 Red
2 Yellow
3 Green
4 Cyan
5 Blue
6 Magenta
7 White

For more information on drawing with color, see

How to assign a color to a layer

How to change the color of an object

How to map line colors to different pens on the plotter



Using lettering styles

A lettering style includes the font size, stroke, angle, and orientation of the text. You can save and recall these settings, 
called text styles, by name.
AutoCAD LT comes with one text style, STANDARD, but you can create other text styles easily. If you save a text style to a 
template drawing, it is always available with that template.
When you begin a text command, you can specify the text style you want to use for that text.
For more information about using lettering styles, see

How to define a lettering style



Using dimension styles

A dimension style determines the appearance of a dimension. You can use the Dimension Styles dialog box to create, 
modify, or assign dimension styles. Dimension styles include a “parent” style and members of that style “family.” A parent 
style is the base on which you specify style variations, depending on the type of dimension you are drawing.
You can assign a dimension style and then modify it without affecting existing dimensions of the same style.

AutoCAD LT has 58 system variables that control a dimension style. You set the values of these system variables either 
through the Dimension Styles dialog box or by entering the name of the system variable at the command line. Examples of 
what you can control include

Arrow size
Angular unit format
Arrow block name
Center mark size
Dimension line and leader color
Extension line color
Dimension text color
Number of decimal places
Dimension line extension
Dimension line spacing
Gap from dimension line to text
Justification of text on dimension line
Prefix and suffix for dimension text

For more information about using dimension styles, see

How to choose a dimension style



Using views

You can save and restore different views of your drawing with the VIEW command. By using this feature, you can easily 
switch between several views.



Organizing your drawing

How to

Set units

Choose the sheet size for printing

Set the scale for a plotted drawing

Set the overall scale for dimensions

Create a layer

Make a layer current

Turn a layer on or off

Change the layer of an object

Load a linetype

Assign width to polylines

Map line colors to a wider pen on the plotter

Change the color of an object

Assign a color to a layer

Define a new lettering style

Choose a dimension style

Concepts

Setting the scale of your drawing

Using layers

Using linetypes

Setting the width of a line

Drawing with color

Using lettering styles

Using dimension styles

Commands

DDIM

DDLMODES

DDMODIFY

DDSTYLE

DDUNITS

PLINE

PLOT

STYLE

Dialog Boxes

Dimension Styles

Layer Control

Modify Arc

Modify Associative Hatch

Modify Attribute Definition



Modify Block Insertion

Modify Circle

Modify Dimension

Modify Ellipse

Modify External Reference

Modify Leader

Modify Line

Modify Mtext

Edit Mtext

Modify Point

Modify Polyline

Modify Ray

Modify Solid

Modify Spline

Modify Text

Modify Tolerance

Modify Viewport

Modify Xline

Units Control

Plot

Text Style
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See chapter 5, "Using Two-Dimensional Coordinate System and Layers" and chapter 6, “Drawing Geometry”. 



Overview: Laying out a drawing with multiple views
Related Topics

three different views of a model in paper space.

One of the most powerful features in CAD is the ability to display an object in several views. With AutoCAD LT, you typically 
draw at full scale in model space and lay out your views in paper space. For access to paper space, you turn off the system 
variable TILEMODE by double-clicking TILE on the status bar.

In model space, you can divide your screen into several tiled viewports for easy access to several views of your drawing.

In paper space, you lay out multiple views for plotting by creating floating viewports. A floating viewport is a rectangular 
object that frames a view of model space. Before plotting, you scale the views in each floating viewport by using the ZOOM 
XP command. Floating viewports can be easily moved around in paper space.

If you have been using AutoCAD or AutoCAD LT for a long time, you may be accustomed to working primarily in model 
space with TILEMODE set to 1 (on). You may prefer direct access to both model space and paper space by setting 
TILEMODE to 0: use the MSPACE command to switch to model space, the PSPACE command to switch back to paper 
space.

In addition to viewport objects, paper space typically contains drawing borders, title blocks, and notes.

For more information about laying out single and multiple views, see

Working with floating viewports 

Working with tiled viewports 



Working with floating viewports

In paper space, you lay out views of objects that you have drawn in model space so that you can plot them. You frame your 
views with floating viewports. A floating viewport object is like the viewfinder and lens on a camera. You use a viewfinder and
lens to frame a picture, and to zoom into or out of a picture.

With AutoCAD LT, you are “standing” in paper space and “aiming” the camera into model space. You move the camera until
you have framed the objects that you want to display in the viewport. You also set the viewing angle when working in three 
dimensions.

You resize and move viewport objects until you are satisfied with the layout of your drawing. It is important to create viewport
objects on their own layer: you can make the borders of a viewport object invisible by turning off the viewport’s layer. When 
you turn off the viewport’s layer, the view within the viewport is still visible.

You can edit the objects that are visible in a floating viewport. Use the MSPACE command to access model space through a 
floating viewport. To return to paper space, use the PSPACE command.

For more information on working with floating viewports, see

How to create floating viewports



Working with tiled viewports

In model space, you draw at full scale. You can divide your screen into several adjacent rectangular areas, called tiled 
viewports, to display different views. Tiled viewports display different views of your drawing at the same time.

If you need to plot multiple views, use paper space. Set TILEMODE to 1 to use tiled viewports.

For more information on working with tiled viewports, see

How to create tiled viewports



Laying out your drawing with multiple views

How to

Create floating viewports

Create tiled viewports

Concepts

Working with floating viewports 

Working with tiled viewports 

Commands

MSPACE

MVIEW

PSPACE

VPORTS
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See chapter 8, "Controlling the Drawing Display". 



Overview: Drawing objects

The following are types of objects that you can draw in AutoCAD LT:
Lines
Polylines
Splines
Leaders
Construction lines
Fillets
Rays
Circles
Ellipses
Arcs
Rectangles
Polygons
Paragraph text
Line text
Dimensions

You can assign a specific color to an object or allow the object take on the color of the layer on which you are drawing.
To learn more about how to draw objects, see
Drawing straight lines

Drawing curves



Drawing straight lines

There are three commands you can use to draw contiguous, straight line segments: LINE, DLINE, and PLINE (polyline). The
segments of a line are the same width, and each segment is a separate object. The segments of a polyline may vary in 
width, however, they are not separate objects. 
Draw rectangles by choosing Rectangle from the Draw menu. Draw polygons by choosing Polygon from the Draw menu.

Other types of straight lines include construction lines and rays.



Drawing curves

You can create curves by drawing the following objects: circles, arcs, ellipses, polylines with arc segments, splines, and 
fillets. You can use DLINE to create arcs with double lines.



Drawing objects

Concepts

Drawing lines, rectangles, and polygons

Drawing curves

Commands

ARC

CIRCLE

ELLIPSE

FILLET

LEADER

LINE

OFFSET

PLINE

POLYGON

RAY

RECTANG

SPLINE

XLINE
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See chapter 6, "Drawing Geometry". 



Overview: Using tools to draw with precision

You can use several AutoCAD LT tools to draw with precision:

Snap mode to restrict cursor movement to regular intervals
Coordinate entry methods 
Object Snaps to “snap” to a location (such as an endpoint) on an object
Ortho (orthogonal) mode to restrict cursor input to either horizontal or vertical locations relative to the previous 

point
DIST (distance) command to determine distances between points
UCS command to reposition a user coordinate system

To learn more about using these tools, see

Snap mode

Several ways to specify locations

Using object snaps

Restricting cursor point locations to horizontal and vertical

Obtaining distances

Applying a user coordinate system



Using Snap mode

Snap mode limits your cursor’s movements to anan invisible rectangular grid of locations on your drawing. You can turn 
Snap mode on or off.

Complementing the Snap mode is a visible rectangular pattern of dots that you can turn on or off called the grid. You can 
match the grid spacing to the spacing of the Snap mode by using the Drawing Aids dialog box.

The grid does not appear in your plotted drawing.

For more information, see

How to turn on Snap mode or the Grid



Specifying locations

You can specify locations on a drawing several ways:

Pick a location: move the cursor to a location and click the pick button

Absolute rectangular coordinate entry: enter an X,Y coordinate such as 3,4, relative to the origin
Relative rectangular coordinate entry: enter an X,Y coordinate such as @3,4 relative to the most recently specified 

location; a relative coordinate always begins with the @ symbol
Relative polar coordinate entry: enter a distance and an angle such as @1<45 relative to the most recently 

specified location
Absolute polar coordinate entry: enter a distance and an angle such as 1<45 from the origin
Snap: snap to locations on an invisible grid
Object snap: snap to features on an object such as the center of a circle
Tracking: specify locations relative to the most recently tracked location on your drawing

To learn how to specify locations, see

How to specify a point using the cursor

How to enter coordinate locations

How to snap to locations on your drawing

How to snap to a feature on an object



Using object snaps

With object snaps you can specify point locations on existing objects. When AutoCAD LT prompts you for a point, you can 
choose 1 of 10 different object snaps. For example, you can use object snaps to draw a line from the center of a circle to the
midpoint of a line. 

You use the cursor menu or the Object Snap toolbar to choose the type of location that you want to snap to: for example, 
snapping to an endpoint or the midpoint of a line.

To learn how to specify locations with object snaps, see

How to snap to a feature on an object



Restricting cursor point locations to horizontal and vertical

You can restrict cursor input to either horizontal or vertical locations relative to the previous point by using Ortho mode. 
Ortho mode works with commands that require you to specify a second point, such as LINE.

You can turn Ortho mode on and off while you are drawing. AutoCAD LT overrides Ortho mode when you enter coordinates 
on the command line or specify an object snap. 

To learn how to turn Ortho on, see

How to restrict cursor input to horizontal and vertical locations



Obtaining distances

You can obtain the distance between two locations in a drawing with the DIST (Distance) command. AutoCAD LT displays 
the distance on the command line.

To learn how to obtain distances, see

How to obtain distances



Applying a user coordinate system

grid coordinates (5,4)

AutoCAD LT provides you with a moveable Cartesian (X,Y,Z) coordinate system called a user coordinate system (UCS) to 
locate points in your drawing. 

You can move or rotate a UCS to any position. For example, you might relocate a UCS when you are drawing a floor plan or 
a part of the floor plan that has a significant portion at an angle from the horizontal. Also, you can save and restore 
convenient UCS locations.

An icon controlled by the UCSICON command is a useful visual reminder of the UCS location.

To learn how to set up a temporary coordinate system, see

How to apply a user coordinate system



Using tools to draw with precision

How to

Turn on a grid

Specify a point using the cursor

Enter a coordinate

Snap to locations on or off the grid

Snap to a feature on an object

Restrict cursor point locations to horizontal and vertical locations

Measure distances

Apply a user coordinate system

Concepts

Using Snap mode

Several ways to specify locations

Restricting cursor point locations to horizontal and vertical locations

Obtaining distances

Using a user coordinate system

Commands

DIST

DDOSNAP

DDRMODES

DDUCS

GRID

OSNAP

UCS

Dialog Boxes

Drawing Aids

UCS Control
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See chapter 7, "Drawing with Precision". 



Overview: Editing your drawing
Related Topics

copied objects

An object’s properties determine its appearance size, location, and orientation. You edit an object by changing its properties.

If you want to edit an object’s appearance, choose Properties from the Edit menu. You can edit properties such as color, 
layer, and linetype.

If you want to edit an object’s geometric properties, such as its size, location, and orientation, choose a command from the 
Modify menu:

DUPLICATE (copy)
OFFSET
MIRROR
ARRAY
CHAMFER
FILLET
MOVE
ROTATE
STRETCH
SCALE
LENGTHEN
TRIM
EXTEND
BREAK
EXPLODE

You can use also use Grip commands to stretch, move, rotate, scale, mirror, and copy objects quickly.

To learn more about editing your drawing, see

Modifying an object  ’  s properties  

Creating a new object based on existing geometry

Using Grip commands



Modifying an object  ’  s properties  

An object  ’  s properties include its color, location, rotation angle, elevation, thickness, layer, linetype, linetype scale factor, and  
size.

You can modify the properties of an object by choosing Properties from the Edit menu and then choosing the object whose 
properties you want to change. AutoCAD LT displays a dialog box that lists properties that are specific to the type of object 
you have selected. You can modify the values of the properties that are listed in the dialog box.

You can also use the Property Painter to copy properties from one object to another. With the Property Painter dialog box, 
you can select which properties to copy.

You can modify the size and location properties of an object with editing commands such as Move, Rotate, Scale, Trim, and 
Extend. 

To learn more about modifying an object’s properties, see

How to change a property

How to use the Property Painter

How to move an object

How to rotate an object

How to trim an object

How to extend an object



Creating a new object based on existing geometry

copied object

You can create a new object by using one of the following commands on existing objects: Duplicate (copy), Mirror, Offset, 
Array, Fillet or Chamfer.

Duplicating an object creates an exact replica of the original. Mirroring an object creates a mirror image of the existing 
object. Offsetting a line, arc, circle, polyline, ellipse, elliptical arc, xline, or ray creates a similar object at a specified distance 
from the original object. Filleting a line, circle, or arc creates an arc that is tangent to two existing objects.

To learn more about these methods for creating an object, see

How to duplicate an object

How to mirror an object

How to offset an object

How to fillet



Using Grip commands

Grips are small squares that appear at locations such as the quadrants and centers of circles or the endpoints and midpoints
of lines. You select a grip and use it as a handle to stretch, move, rotate, scale, mirror, or copy an object without using a 
menu or a tool. To use grips, the GRIPS system variable must be set to 1.
When you are using grips, AutoCAD LT displays at the command line the Grip commands:

**Stretch**
**Move**
**Rotate**
**Scale**
**Mirror**

Cycle through the commands by pressing RETURN or the equivalent button on your pointing device.
When you move your cursor close to a grip, the cursor snaps to the grip. Because grips appear on object features, such as 
endpoints and midpoints, snapping to grips is an alternative to using object snaps for editing commands.
To learn more about using grips, see

How to display grips

How to cycle through Grip commands

How to edit an object using grips



Editing your drawing

How to
Use the Property Painter

Move an object

Rotate an object

Trim an object

Extend an object

Duplicate an object

Mirror an object

Offset an object

Fillet

Display grips

Cycle through Grip commands 

Use Grip commands

Concepts
Modifying an object  ’  s properties  

Creating a new object based on existing geometry

Using Grip commands

Commands
COPY

DDMODIFY

EXTEND

FILLET

GRIPS

MIRROR

MOVE

OFFSET

ROTATE

TRIM

Dialog Boxes
Modify Arc

Modify Associative Hatch

Modify Attribute Definition

Modify Block Insertion

Modify Circle

Modify Dimension

Modify Ellipse

Modify External Reference

Modify Leader

Modify Line



Modify Mtext

Modify Point

Modify Polyline

Modify Ray

Modify Solid

Modify Spline

Modify Text

Modify Viewport

Modify Xline

AutoCAD LT User's Guide
See chapter 9, "Copying, Moving, and Erasing Objects" and chapter 10, “Modifying Objects”. 



Overview: Filling an area with a hatch pattern 
Related Topics

A hatch pattern is a pattern that you apply to an area of your drawing to represent various components of an object or a 
specific type of material. A hatch pattern contains one or more hatch lines set at a specific angle and spacing. The hatch 
lines can be continuous or a series of dots and dashes.
AutoCAD LT hatches an area automatically when you choose an enclosed area defined by geometric objects and does not 
hatch over text or islands. If you redefine the hatch boundary and the boundary remains closed, the hatch pattern adjusts 
itself to fit the new boundary. This feature is called associative hatching.

To learn more about filling an area with a hatch pattern, see

Hatching an area

Modifying a filled area



Hatching an area

You hatch an area by using the Boundary Hatch dialog box. Then you can choose the objects that define the area’s 
boundary or pick a point inside the boundary. Valid objects for defining a boundary are any combination of lines, arcs, 
circles, 2D polylines, ellipses, splines, blocks, and paper space viewports.
Under Advanced Options, you can choose to retain a closed polyline that traces the boundary that you have defined. More 
than 50 standard hatch patterns are available with AutoCAD LT. Fourteen of these patterns conform to ISO standards. You 
can set the scale and the angle of the hatch pattern.

To learn more about filling an area, see

How to hatch an area



Modifying a filled area

hatched object nonassociative hatch associative hatch

You can stretch, move, rotate, scale, and mirror the boundaries of a hatched area. If you redefine the hatch boundary and 
the boundary remains closed, the hatch pattern adjusts itself to fit the new boundary. This feature is called associative 
hatching. 

In the Hatchedit dialog box, you can modify a hatch pattern by changing its scale, angle, or spacing.

To learn more about modifying a hatch pattern, see

How to change the angle of a hatch pattern



Filling an area with a section lining or hatch pattern

How to
Hatch an area

Change the angle of a hatch pattern

Concepts
Filling an area

Modifying a filled area

Commands
BHATCH

DDMODIFY

HATCH

HATCHEDIT

Dialog Boxes
Boundary Hatch

Hatchedit

Modify Associative Hatch
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See "Adding Hatch Patterns" in chapter 6.



Overview: Dimensioning
Related Topics

Five basic types of dimensions are included with AutoCAD LT: linear, angular, diameter, radius, and ordinate. When you 
dimension an object, AutoCAD LT extracts the true size of the object from the drawing database to create the dimension 
text.
There are 58 system variables that control the appearance of dimensions. You can change the values of these variables in 
the Dimension Styles dialog box. For general properties, choose Properties from the Edit menu.

You can save your dimension settings under a new style name in the Dimension Styles dialog box and apply the new style to
other dimensions. You can also create a “parent” style that you alter slightly for each dimension type, creating a “family” of 
styles. Thus, for a particular dimension style, you may incorporate variations for angular dimensions and for radial 
dimensions. You can also override a dimension style for specific dimensions.

To help organize your drawing, put all dimensions on the same layer or on a set of layers.

For information on scaling dimensions, see

Overview: Printing and plotting.

To learn more about dimensioning your drawing, see

Adding a dimension

Modifying a dimension

Using dimension styles



Adding a dimension

With AutoCAD LT, you add a dimension by choosing one of the dimensioning commands and then, depending on the 
command, either selecting an object or locating two or more points with object snaps. When specifying the location of the 
dimension line, you move your cursor to see how the dimension will appear before completing the command.

Some experienced users add dimensions quickly and then use Grip commands to make adjustments.

With AutoCAD LT, you can create the following types of dimensions:

horizontal vertical radius diameter

aligned rotated angular center

baseline continuous leader ordinate
(chained)

oblique isometric (applying a user coordinate system)

To learn more about adding a dimension, see

How to draw a horizontal or vertical dimension

How to draw a radius or diameter dimension

How to draw an aligned dimension

How to draw a chained dimension

How to draw an angular dimension

How to add a leader line with text



Modifying a dimension

To modify the appearance of a dimension, use the Dimension Styles dialog box. This dialog box contains several other 
dialog boxes. For example, to modify dimension lines, extension lines, arrowheads, and center marks, use the Geometry 
dialog box. To change the appearance of dimension text, use the Annotation dialog box. To change the location of dimension
text, arrowheads, leader lines, and the dimension line, use the Format dialog box.

Stretch, move, rotate, scale, or mirror dimensioned objects by using Grip    commands. AutoCAD LT automatically adjusts 
dimension values when you modify a dimension.

You can make extension lines oblique by choosing Oblique from the Dimension menu. To control the justification and 
rotation of dimension text, choose Align Text from the Dimension menu.

You can draw dimensions at the correct scale for plotting. For more information on dimensions and plotting, see

Overview: Printing and Plotting 

To learn more about modifying a dimension, see

How to make dimensions oblique

How to rotate dimension text

How to change arrowheads for leaders and dimensions

How to create dimension styles



Dimensioning

How to
Draw a horizontal or vertical dimension

Draw a radial or diameter dimension

Draw an aligned dimension

Draw a chained dimension

Draw an angular dimension

Add a leader line with text

Make dimensions oblique

Rotate dimension text

Change arrowheads and dimensions

Create dimension styles

Concepts
Adding a dimension

Modifying a dimension

Commands
DDIM

DIM

DIMALIGNED

DIMANGULAR

DIMBASELINE

DIMCENTER

DIMDIAMETER

DIMEDIT

DIMLINEAR

DIMORDINATE

DIMOVERRIDE

DIMRADIUS

DIMSTYLE

DIMTEDIT

Dialog Boxes
Dimension Styles

Annotation

Format

Geometry
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See chapter 13, "Dimensioning and Tolerancing". 



Overview: Lettering and Annotating
Related Topics

paragraph text line text

There are two ways to enter text: as line text or as paragraph text. With line text, each line of text is an object. With 
paragraph text, each paragraph is an object. You can also import an ASCII text file with the Edit MText dialog box.

Several text settings, such as the text font, width factor, and obliquing angle, can be saved as a text style. To save and 
restore text styles, use the Text Style dialog box.

Every text object is associated with a text style. Any change to a text style is automatically reflected in all text objects 
associated with that text style.

You can modify the position, rotation angle, and size of any text by using Grip commands.

In model space, you need to determine the scale factor for your text so that it will be the correct size when you plot your 
drawing. In paper space, you create text at full size.

For more information on text and plotting, see

Overview: Printing and Plotting 

To learn more about annotating your drawing, see

Choosing a text style

Annotating a drawing



Choosing a text style

Text styles are convenient when you need to switch between text settings quickly. Text styles are also useful when you want 
to make a global change to your text.
For example, by using a simple font such as txt.shx to enter text, AutoCAD LT can regenerate your drawing faster than when
you use a PostScript, a TrueType, or a complex font such as romanc.shx. You can draw all the text in the simple font for 
speed. When you finish your drawing and you are ready to plot, by using a text style you can switch the text style from a 
simple font to a more complex font with a single command. All text objects associated with that text style are changed to the 
new font automatically.

To learn more about choosing a text style, see

How to choose a text style



Annotating a drawing

When creating text in a drawing, use line text when you need only a single line of text; use paragraph text when you want 
additional options and need to enter multiple lines of text as a single object.
To enter paragraph text, specify the location and size of the text boundary in which to place your text. The text window 
defines the margins of the paragraph. In the Edit Mtext dialog box, you can enter your text.

To learn more about annotating your drawing, see

How to add line text

How to add paragraph text



Lettering and Annotating

How to
Choose a text style

Add line text

Add paragraph text

Concepts
Choosing a text style

Annotating a drawing

Commands
DDMODIFY

DDSTYLE

DTEXT

MTEXT

Dialog Boxes
Edit Mtext

Text Style
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See chapter 12, "Adding Text to Drawings". 



Overview: Combining drawings

To combine drawings, you can use blocks or external references.
You can insert a saved drawing file into your current drawing as a block: a block is a composite object of lines, arcs, text, 
and other types of objects. Typically, a block is a symbol, such as an electrical part, or a standard detail.
You can link another drawing file to your current drawing by attaching it as an external reference (xref). An xref is a pointer or
link to another drawing file. Typically, an xref is a drawing of a subassembly, a drawing from a subcontractor, or a drawing file
in progress that you need to reference before it is complete.

To learn more about combining drawings, see

Inserting a block

Exploding a block

Using an external reference (xref) drawing



Inserting a block

block block inserted into a drawing

When you need a symbol, you can insert the geometry from a saved drawing file into your current drawing as a block. When
you insert a drawing file as a block, it becomes a single, composite object in your drawing. This saves time and disk space 
over redrawing the geometry each time. You can specify the insertion point, scale and rotation for the block.

Blocks are not automatically updated if the source drawing is modified. The block is not linked to its original file, but it can be 
updated using the INSERT or BLOCK commands.

You can disassemble a block into its constituent objects by “exploding” it. Then you can modify the objects    to create 
variations of symbols.

For convenient access, it is a good idea to create one or more subdirectories of drawing for symbols such as doors, gears, 
or electrical parts.

To learn more about inserting blocks, see

How to insert a block

How to explode a block



Exploding a block

assembly block component blocks 

You can disassemble a block into its constituent objects by “exploding” it. Most commonly, you explode a block for one of 
three reasons:

To create special instance of a block by exploding the block and modifying the resulting objects
To redefine a block in your current drawing by exploding the block, modifying the resulting objects, and then 

reassembling the block
To modify a detail by inserting the drawing file of a detail as a block, exploding the block, and then modifying the 

resulting objects

You can explode a block as you insert it by using the Explode option in the Insert dialog box.

To learn more about exploding a block, see

How to explode a block



Using an externally referenced drawing

When you need to reference another drawing file in your current drawing, you can attach the drawing file as an external 
reference (xref). Once it is attached, the referenced drawing is automatically displayed each time you open your drawing. If 
any changes are made to the referenced drawing, the changes are reflected in all drawings that reference it. You can specify
the insertion point, scale and rotation for an xref.

Externally referencing a drawing file saves disk space because you are only referencing the file, not copying it into your 
current drawing. Only model space objects from an externally referenced drawing are displayed in your current drawing.

Externally referenced drawing files that reference other drawing files are called nested xrefs. You can use xref overlays if 
you don’t want to include nested xrefs when you reference a drawing.

If you want to merge an xref to make it a permanent part of your current drawing, you can “bind” the xref. Binding an xref 
breaks the link to the referenced drawing file and converts the xref into a block.

To learn more about using external references, see

How to attach an xref

How to bind an xref



Combining drawings

How to
Insert a block

Explode a block

Attach an xref

Concepts
Inserting a block

Exploding a block

Using an external reference (xref) drawing

Commands
EXPLODE

INSERT

XREF

Dialog Boxes
Insert
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See chapter 14, "Using Attributes, Blocks, and External References". 



Overview: Displaying a portion of your drawing

before panning after panning

To take a picture you use a camera lens to pan and frame a subject. Think of your monitor as a lens through which you view 
your drawing. With AutoCAD LT, you pan your drawing to frame a particular view. You can also zoom in and out of your 
drawing.

Several view commands are available only in model space. They are Real-Time Pan, Real-Time Zoom, and Aerial View. The
ZOOM command and the PAN command are available in both model space and paper space.

To learn more about displaying a portion of your drawing, see

Magnifying a portion of your drawing

Panning in your drawing



Magnifying a portion of your drawing

Zooming in increases and zooming out decreases the magnification at which you view your drawing. There are three 
methods for zooming: Real-Time Zoom (in model space only), Aerial View zoom (in model space only), and the ZOOM 
command.

In model space, Real-Time Zoom is the quickest zoom method. 
You an also use the Aerial View window to zoom in and out of your drawing area in model space. The Aerial View window is 
particularly convenient when you have to jump from one part of a drawing to another.

From the View menu, you can use several zoom command options :

Extents displays your entire drawing
Center specifies a new center point for your drawing
Previous displays the previous zoomed view
Window prompts you to specify a rectangular area in which to zoom
Scale prompts you for a scale factor that can be relative to the current view, the drawing limits, or to paper space

To learn more about magnifying a portion of your drawing, see

How to zoom in and out of a drawing

How to zoom with the Aerial View window



Panning in your drawing

Panning moves the view on the screen to frame a particular area. There are three methods for panning: Real-Time Pan (in 
model space only), Aerial View pan (in model space only), and the PAN command.

In model space, Real-Time Pan is the quickest panning method. The cursor turns into a hand. Hold down the pick button on 
your pointing device and drag the hand cursor to pan the view of your drawing.

To pan through your drawing by specifying the distance and direction to pan, choose Pan Point from the Pan option on the 
View menu.

You can also use Aerial View to pan in your drawing area. Aerial View is especially useful when you have to jump from one 
part of your drawing to another.
To learn more about magnifying a portion of your drawing, see

How to pan in my drawing

How to pan with the Aerial View window



Displaying a portion of your drawing

How to I
Zoom in and out of a drawing

Pan the drawing

Zoom with Aerial View window

Pan with the Aerial View window

Concepts
Magnifying a portion of your drawing

Panning in your drawing

Commands
DSVIEWER

PAN

zoom
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Overview: Printing and plotting

In AutoCAD LT, you draw at full scale. Before you plot, you will need to set the scale of the objects in your drawing:
plot scale = the plotted size of object divided by the true size of the same object in your drawing

If you plan to plot from model space, set the scale for your dimensions, text, linetypes, and symbols to the inverse of the plot
scale. For example, if your plot scale is 1/4, multiply your text height by 4 for correctly sized text in your plot. After scaling 
dimensions, text, linetypes, and symbols, add them to your drawing and plot it at the desired plot scale.

To plot from paper space (used for plotting complex multiple view 2D drawings and 3D drawings), you scale each viewport 
separately. Select each viewport and use ZOOM nXP, where n is the desired plot scale.

For example, to plot at 1/4 scale, enter Zoom 0.25XP. Set the value for the overall dimension scale factor (the DIMSCALE 
system variable) to 0. The dimensions that you create in floating model space are automatically scaled to their full size 
relative to paper space. Insert drawing borders, title blocks, and notes at their full size in paper space, and then plot your 
drawing at the desired plot scale from paper space.

To learn more about printing and plotting, see

Understanding printing and plotting options

Creating a plot file and using a plotting service



Understanding printing and plotting options

Once you have set up plot parameters, you can save them in a plot configuration parameters (PCP) file to save time when 
you plot again, using the same plotter.

Set the following options in the Plot Configuration dialog box:

Select your printer or plotter
Assign colors in your drawing to a plotter pen that has a specific linetype and width
Select a unit of measurement (inches or millimeters) for paper size and scaling factors
Specify the scale factor for the plot
Select or enter a paper size, subtracting the margins required by your printer or plotter
Select the area to plot by choosing one of the following options:

- Display plots the current view

- Extents plots all objects (except those on frozen layers)

- Limits plots objects within the current drawing limits

- View plots a named view

- Window plots an area that you specify using a method similar to Zoom window

Specify where on the paper to plot your drawing and the rotation angle at which to plot
Choose whether to preview your plot

To learn more about printing and plotting options, see

How to specify my sheet size

How to print using landscape orientation

How to define the plotted size of a drawing

How to define the area that I want to plot

How to preview my plotted drawing



Creating a plot file and using a plotting service

A plot file contains your drawing, the fonts used, and the plot settings specific to your plotter. You can print a plot file without 
opening AutoCAD LT. The most common way to do this is to copy the plot file to the printer port (you use the /b option to 
designate the file as binary). Use plot files when you need to batch-print drawings or send drawings to a plotting service.

You can create a plot file by selecting Plot to File in the Plot Configuration dialog box. AutoCAD LT uses the current file name
and adds the extension .plt.

To learn more about creating a plot file, see

How to save a drawing as a plot file



Printing and plotting

How to
Specify a sheet size

Print using landscape orientation

Define the plotted size of a drawing

Define the area that I want to plot

Preview a drawing before plotting

Save a drawing as a plot file

Concepts
Understanding printing and plotting options

Creating a plot file and using a plotting service

Commands
PLOT

Dialog Boxes
Plot Configuration
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See chapter 16, "Plotting Your Drawing". 



To open a template drawing

1. From the File menu, choose New. 

2. In the Create New Drawing dialog box, choose Use a Template.

3. In the Select a Template list box, select the template drawing you want to use.

In the Preview tile, a “thumbnail” of the template is displayed.

4. To open the template and close the Create New Drawing dialog box, choose OK.

AutoCAD LT opens the drawing as unnamed.dwg.



To set units
1. From the Format menu, choose Units.

2. In the Units Control dialog box, under Units, select a unit type and precision.

3. Choose OK.



Setting the scale of model space

To set the scale of model space relative to true size for plotting in paper space

1. From the View menu, choose Model Space (Floating).

2. Create at least one floating viewport (if none exist).

3. If more than one floating viewport is available, click in the one you want to scale to make it current.

4. From the View menu, choose Zoom and then Scale.

5. Enter the desired scale factor followed by xp.

6. From the File menu, choose Print.

7. From the Scale, Rotation, and Origin area of the Plot Configuration dialog box, make sure Scaled to Fit is not selected. 
Then enter 1 in the box under Plotted Inches and enter 1 in the box under Drawing Units.

Example:If you enter Zoom 0.25xp in model space, the view in the current viewport is displayed. You can plot at 1/4 
scale in paper space.

To set the scale of model space for plotting from model space (rather than from paper space)

1. From the View menu, choose Model Space (either Tiled or Floating).

2. From the File menu, choose Print.

3. From the Scale, Rotation, and Origin area of the Plot Configuration dialog box, make sure Scaled to Fit is not selected. 
Then enter a value for plotted units and a value for drawing units.

Example:If you enter 1 for plotted units and 4 for drawing units in the Plot Configuration dialog box, the plotted drawing 
will be at 1/4 scale.



To set the overall scale for dimensions

To set the overall scale for dimensions in model space for plotting from paper space:

1. From the Format menu, choose Dimension Style. 

2. In the Dimension Styles dialog box, choose Geometry.

3. In the Geometry dialog box under Scale, select Scale to Paper Space.

4. Choose OK to close the Geometry dialog box,.

5. Choose OK to close the Dimension Styles dialog box.

To set the overall scale for dimensions in model space:

1. From the Format menu, choose Dimension Style.

2. In the Dimension Styles dialog box, choose Geometry.

3. In the Geometry dialog box under Scale, enter a value in the Overall Scale box. The value you enter should be the 
inverse of your intended plot scale. For example, if your intended plot scale is 1/4, enter 4 as the value in the Overall 
Scale box.

4. Choose OK to close the Geometry dialog box.

5. Choose OK to close the Dimension Styles dialog box.



To make a layer current

1. From the Format menu, choose Layers. 

2. In the Layer Control dialog box, select the layer you want to make current from the Layer Name list.

3. Select Current.

4. Choose OK.



To turn a layer on or off

1. From the Format menu, choose Layers. 

2. In the Layer Control dialog box, select from the Layer Name list the layer that you want to turn on or off.

To select all layers, choose Select All. To cancel selection of all layers, select Clear All.

3. Select On or Off.

4. Choose OK.



To change the layer of an object

1. From the Edit menu, choose Properties.

2. Select the object whose layer you want to change.

AutoCAD LT opens the dialog box for the object type that you selected.

3. Under Properties, choose Layer.

4.  In the Select Layer dialog box, select another layer from the Layer Name list.

5. Choose OK to close the Select Layer dialog box.

6. Choose OK to close the Modify Properties dialog box.



To create a layer

1. From the Format menu, choose Layers.

2.  In the Layer Control dialog box, enter a new layer name in the text box.

3. Select New.

4. Choose OK.



To load a linetype

1. From the Format menu, choose Linetype.

2. In the Select Linetype dialog box, choose Load.

3. In the Load or Reload Linetypes dialog box, select a linetype from the Available Linetypes list.

4. Choose OK to close the Load or Reload dialog box.

5. Choose OK to close the Select Linetype dialog box.



To scale linetypes

In tiled model space

1. From the Options menu, choose Linetypes then Global Linetype Scale.

2. Enter a value for the global scale factor (usually the inverse of the intended plot scale, for example, if you intend to plot 
at 1/4 scale, enter 4).

In floating model space relative to paper space

1. From the Options menu, choose Linetypes.

Make sure Paper Space Linetype Scale is turned on.

2. Choose Global Linetype Scale.

Make sure the global scale factor is set to 1.000.

3. From the Object Properties toolbar, choose 
4. Enter a value for the true scale of the linetype (often 1.000).

In paper space

1. From the Options menu, choose Linetypes, then choose Global Linetype Scale.

Make sure the global scale factor is set to 1.000.

2. From the Object Properties toolbar, choose 
3. Enter a value for the true scale of the linetype (often 1.000).



To assign width to polylines

1. From the Draw menu, choose Polyline.

2. Specify the start point for the first segment in the polyline.

3. Enter w to specify the width.

4. Enter a value for the width at the start of the line segment.

5. Enter a value for the width at the end of the line segment.

6. Specify the endpoint of the first segment of the polyline.

7. Enter w to specify different widths for the next segment, or press RETURN to end the command.



To map line colors to different pens on a plotter

1. From the File menu, choose Print.

2. In the Plot Configuration dialog box, under Pen Parameters, choose Pen Assignments.

3. In the Pen Assignments dialog box, select a color number from the list of colors and pens.

4. Under Modify Values, enter a pen number for that color.

5. Choose OK to close the Pen Assignments dialog box.

6. Choose OK to close the Plot Configuration dialog box.



To change the color of an object

1. From the Edit menu, choose Properties.

2. Select the object whose color you want to change, and then press RETURN.

3. In the dialog box, choose Color. 

4. In the Select Color dialog box, choose a new color.

5. Choose OK to close the Select Color dialog box.

6. Choose OK to close the Modify dialog box.



To assign a color to a layer

1. From the Format menu, choose Layers. 

2. In the Layer Control dialog box, select a layer from the Layer Name list.

3. Choose Set Color.

4. In the Select Color dialog box, select a new color.

5. Choose OK to close the Select Color dialog box.

6. Choose OK to close the Modify dialog box. 



To define a new lettering style

1. From the Format menu, choose Text Style. 

2. In the Text Style dialog box, under Styles, enter a new text style name, and then choose New.

3. Under Font, choose Browse on the same line as Font File.

5. In the AutoCAD LT directory, select a font file from the list.

6. Choose Open to open that font file (also closes the Select Font File dialog box).

7. Under Effects, enter or select any special effects for the new text style.

8. Choose Apply.

9.. Choose Close.



To choose a dimension style

1. From the Format menu, choose Dimension Style.

2. In the Dimension Styles dialog box, select a dimension style from the Current list box.

3. Choose OK.



To create a floating viewport

1. From the View menu, choose Paper Space.

2. From the View menu, choose Floating Viewports, and then choose 1 Viewport.

3. To define the rectangular area for the viewport, specify the first point and the other corner diagonal from the first point.



To create tiled viewports

1. From the View menu, choose Model Space (Tiled).

2. From the View menu, choose Tiled Viewports.

3. From the submenu, choose 1, 2, 3, or 4 viewports.

If you chose more than one viewport, enter an option to specify a viewport arrangement.



To turn on a grid

1. From the Format menu, choose Drawing Limits.

2. Specify the lower-left corner of the area in which you want the grid to appear.

3. Specify the upper-right corner of the area in which you want the grid to appear.

4. From the Options menu, choose Drawing Aids.

5. In the Drawing Aids dialog box, under Grid, select On.

6. For X Spacing, enter the horizontal grid spacing in units.

7. Enter a value for Y Spacing if the value differs from the X value.

8. Choose OK.

Note: F7 turns the grid on and off as does double-clicking the Grid button on the status bar.



To specify a point using the cursor

1. Move your pointing device until the cursor is at the location that you want to specify.

2. Click the pick button on your pointing device.



To enter coordinate locations

You can use several different methods to enter coordinate locations with the keyboard.

For more information on the four most common methods, see

How do I enter absolute   X,Y   coordinates?  

How do I enter relative   X,Y   coordinates?  

How do I enter absolute polar coordinates?

How do I enter relative polar coordinates?

Note: Cylindrical and spherical coordinates can also be entered but are not commonly used.



To enter absolute X,Y coordinates

1. Start to draw an object.

2. When you are prompted for a point location, enter X and Y values for each coordinate, separated by a comma. For 
example, enter -2,1, for a point 2 units in the negative X direction and 1 unit in the positive Y direction from the origin.



To enter relative X,Y coordinates

1. Start to draw an object.

2. When you are prompted for a location, enter the @ symbol and X and Y values for the coordinate, separated by a 
comma. For example, enter @4, -2, for a point 4 units in the positive X direction and 2 units in the negative Y direction 
from the current point.



To enter absolute polar coordinates

1. Start to draw an object.

2. When you are prompted for a point location, enter a distance and an angle separated by a less than sign.

For example, enter 4<120 for a distance of 4 units at an angle of 120 degrees from the origin (0,0).



To enter relative polar coordinates

1. Start to draw an object.

2. When you are prompted for a point location, enter the @ symbol, a distance, and an angle separated by a less than 
sign.

For example, enter @3<45 for a distance of 3 units at an angle of 45 degrees from the current point.



To snap to a location

1. From the Options menu, choose Drawing Aids. 

2. In the Drawing Aids dialog box, under Snap, select On.

3. Under X Spacing, enter the horizontal snap spacing in units.

4. Enter a value for Y spacing if the value differs from the X value.

5. Choose OK.

Note: F9 turns snap on and off as does double-clicking the Snap button on the status bar.



To snap to a feature on an object

1. Begin a draw command (or any other command that requires specifying a point location).

2. To open the cursor menu, hold down SHIFT and press the return button on your pointing device.

3. From the cursor menu, choose one of the object snaps.

4. Select an existing object.

The resulting point is located on the feature you specified on the cursor menu.



To restrict cursor movement

1. Double-click the Ortho button on the status bar.

2. Choose a command that requires you to specify two points, such as Line or Move.

The second point you specify is always in a horizontal or vertical direction from the first point.



To find a distance

1. At the Command prompt, enter dist.

2. Specify the first point of the distance you want to measure.

3. Specify the second point of the distance you want to measure.

AutoCAD LT displays on the command line the distance and angle you measured.



To apply a User Coordinate System

1. From the View menu, choose Set UCS, then 3 Point.

2. Specify a new origin point.

3. Specify a point on the positive X axis to indicate the horizontal orientation of the new UCS.

4. Specify a point on the positive Y axis    to indicate the vertical orientation.



To use the Property Painter

1. From the toolbar, choose .
2. Select the object whose properties you want to copy.

The Property Painter dialog box is displayed.
3. Select the objects to which you are copying properties.
4. In the Property Painter dialog box, clear check boxes of properties that should not be copied.
5. Choose Apply.



To change a property

1. From the Edit menu, choose Properties.

2. Select the object whose property you want to change.

AutoCAD LT examines the object that you selected and displays the appropriate dialog box. (For example, if you select 
a circle, the Modify Circle dialog box is displayed.) 

If you select more than one object, AutoCAD LT displays the Change Properties dialog box.

3. Change any of the settings in the dialog box.

4. Choose OK.



To move an object

1. From the Modify menu, choose Move.

2. Select the objects to move and press RETURN.

3. Choose one of the following:

Specify the base point (location at which to begin the move) and then specify the second point of displacement 
(location at which to complete the move).

Enter the displacement in the form of X,Y. Press RETURN. Press RETURN, again, to complete the move 
command.

To move an object without using the menu, see Using Grip commands.



To rotate an object

1.        From the Modify menu, choose Rotate.  

2.        Select the objects to rotate and press RETURN.  

3.        Specify the base point (location about which to rotate).  

4.        Specify the angle of rotation.  

         To rotate an object without using the menu, see Using Grip commands.  



To trim an object

1.        From the Modify menu, choose Trim.  

2.        Select the objects to use as the trimming boundaries or cutting edges.  

3.        Press RETURN.  

4.        Select the objects to trim near the portion to be trimmed off.  

5.        Press RETURN to complete the trim command.  



To extend an object

1.        From the Modify menu, choose Extend.  

2.        Select the objects to use as the boundary edges.  

3.        Press RETURN.  

4.        Select the objects to extend near the portion to be extended.  

5.        Press RETURN to compete the extend command.  



To duplicate an object

1.        From the Modify menu, choose Duplicate.  

2.        Select the objects to copy and press RETURN.  

3.        Choose one of the following:  

           Specify the base point (location at which to begin the copy), and then specify the second point of displacement   
(location at which to complete the copy).

           Enter the displacement in the form   X,Y  . Press RETURN. Press RETURN again to complete the duplicate   
command.



To mirror an object

1.        From the Modify menu, choose Mirror.  

2.        Select the objects to mirror and press RETURN.  

3.        Specify the first point of the mirror line.  

4.        Specify the second point of the mirror line.  

5.        To retain the original object, press RETURN.  

         To mirror an object without using the menu, see Using Grip commands.  



To offset an object

1.        From the Modify menu, choose Offset.  

2.        Specify an offset distance.  

3.        Select the object to offset.  

4.        Specify the side on which to place the offset object.  

5.        Press RETURN.  



To fillet an object

1.        From the Modify menu, choose Fillet.  

2.        Enter   r   (Radius).  

3.        Enter the fillet radius.  

4.        To re-enter the FILLET command, press RETURN.  

5.        Select the objects to fillet near the portions you want to keep.  



To display grips

1.        From the Options menu, choose Grips.  

2.        In the Grips dialog box  , under Select Settings, select Enable Grips.

3. Choose OK.

4. Select an object.



To cycle through Grip commands

Make sure Grip mode is on. See how to display Grips.

1. Select an object, and then select a grip.

At the Command prompt, AutoCAD LT displays the **Stretch** command.

2. To cycle to the **Move** command, press RETURN or enter mo.

3. To cycle to the **Rotate** command, press RETURN or enter ro.

4. To cycle to the **Scale** command, press RETURN or enter sc.

5. To cycle to the **Mirror** command, press RETURN or enter mi.

6. To cycle back to the **Stretch** command, press RETURN or enter st.

7. To exit Grip, press ESC or enter x.



To edit an object using grips

1. Select an object.

2. Select a grip on that object.

The command line displays the **Stretch** command and several options.

<Stretch to point>/Base point/Copy/Undo/eXit: 

3. Select one of the grip commands: **Stretch**, **Move**, **Rotate**, **Scale**, or **Mirror**. 

You can cycle through the grip commands by pressing SPACEBAR or you can enter the keyboard shortcut. For 
example, enter ro for Rotate and the following prompt is displayed on the command line.

<Rotation angle>/Base point/Copy/Undo/eXit: 

4. After selecting a grip command, choose an option.

5. Exit the grip command by entering x or pressing ESC.



To hatch an area

1. From the Draw menu, choose Hatch.

2. In the Boundary Hatch dialog box, under Boundary, select Pick Points.

3. Specify a point inside the area that you want to hatch.

4. Press RETURN.

5. In the Pattern Properties area, select a hatch pattern from the Pattern box.

A sample of the pattern is displayed in the Pattern Type area.

6. To hatch the specified area, choose Apply.



To change the angle, scale, or pattern of a hatch pattern

1. From the Edit menu, choose Properties.

2. Select the hatch pattern you want to modify and press RETURN.

3. In the Modify Associative Hatch dialog box, choose Hatch Edit.

4. In the Hatch Edit dialog box, select or enter the new angle, scale, or pattern.

5. To change the hatch angle, choose Apply.



To draw a horizontal or vertical dimension

1. From the Dimension menu, choose Linear.

2. To select an object to dimension, press RETURN, and then select the object.

Alternatively, you can specify two points, using object snaps to ensure precise locations on geometric features.

3. Specify the dimension line location.

Note: When there is a choice, your cursor location determines whether you can draw a horizontal or a vertical dimension.



To draw a radius or diameter dimension

1. From the Dimension menu, choose Radial, then Radius or Diameter.

2. Select the arc or circle to dimension.

3. Specify the dimension line location.



To draw an aligned dimension

1. From the Dimension menu, choose Aligned.

2. To select an object to dimension, press RETURN, and then select the object to dimension.

Alternatively, you can specify two points.

3. Specify the dimension line location.



To draw a chained dimension

1. From the Dimension menu, choose Continue.

2. Select the dimension object that you want to chain. Make your selection nearest the first extension line origin point that 
you want to use.

3. Specify the location of a second extension line origin point.

4. To end the command, press RETURN twice.



To draw an angular dimension

1. From the Dimension menu, choose Angular.

2. Do one of the following:

Select two lines
Select an arc
Select a circle and a second point
Press RETURN and select three points

3. Specify the location of the dimension arc.



To append text to dimensions 

1. Begin a dimension command.

2. At the prompt for a dimension line location, enter t.

3. Enter text in the Edit Mtext dialog box, and choose OK.

Text entered before the angle brackets (<>) becomes a prefix to the dimension value; text entered after the angle 
brackets becomes a suffix to the dimension value.



To make dimensions oblique

1. From the Dimension menu, choose Oblique.

2. Select the dimension to modify and press RETURN.

3. Specify the angle of obliqueness.



To rotate dimension text

1. From the Dimension menu, choose Align Text, then Rotate.

2. Select the dimension to rotate.

3. Enter the angle by which to rotate the text.

Note: To return the text to its original position, choose the Home option instead of the Rotate option. 



To change arrowheads for leaders and dimensions

1. From the Format menu, choose Dimension Style. 

2. In the Dimension Styles dialog box, choose Geometry.

3. In the Geometry dialog box, under Arrowheads, choose an arrowhead type in the 1st list box.

AutoCAD LT automatically applies the same arrowhead type to 2nd, which is the arrowhead that appears at the other 
end of the dimension line. You can select a different arrowhead type for 2nd.

4. In the Size text box, under Arrowheads, enter a size for the arrowhead.

5. Choose OK to close the Geometry dialog box.

6. If you want to save the change to the current dimension style, choose Save.

7. Choose OK to close the Dimension Styles dialog box.



To create dimension styles

1. From the Format menu, choose Dimension Style to open the Dimension Styles dialog box.

2. Choose Geometry to change the dimension line, extension line, arrowheads, center mark, and scale of the dimension. 
The Geometry dialog box is displayed.

3. Change settings as needed and choose OK to close the Geometry dialog box.

4. Choose Format to change the location of dimension text, arrowheads, leader lines, and the dimension line. The Format 
dialog box is displayed.

5. Change settings as needed and choose OK to close the Format dialog box.

6. Choose Annotation to change annotation styles. The Annotation dialog box is displayed.

7. Change settings as needed and choose OK to close the Annotation dialog box.

8. In the Name text box, enter a new style name.

9. Choose Save to save the new dimension style.

10. Choose OK to close the Dimension Styles dialog box.



To create a new text style

1. From the Format menu, choose Text Style. The Text Style dialog box is displayed.

2. In the Styles text box, enter a new text style name and select New.

3. Under Font, select Browse on the Font File line. The Select Font File dialog box is displayed.

4. From the Select Font File dialog box, select a font file and choose Open.

5. Choose Apply and then Close.



To add a leader line with text

1. From the Dimension menu, choose Leader.

2. Specify the start point of the leader line.

3. Specify successive points in the leader line until you have reached its endpoint and press RETURN.

4. Enter a line of text and press RETURN.

5. Repeat step 4 or end the command by pressing RETURN.

Note: If you need to enter large amounts of text, you can use the Edit Mtext dialog box by pressing RETURN twice after 
completing step 3. If you use the Edit Mtext dialog box, skip steps 4 and 5.



To choose a text style

1. From the Format menu, choose Text Style. 

2. In the Text Style dialog box, under Styles, select a text style from the list.

If only one text style is available, you may want to create a new text style.

A sample of the text style is displayed in the Character Preview box.

3. Choose Apply to close the Text Style dialog box.



To add paragraph text

1. From the Draw menu, choose Text and then Paragraph Text.

2. Specify the location and size of the text boundary.

The Edit MText dialog box is displayed.

3. Enter your text.

The Edit MText dialog box shows how the text wraps at the text boundary.

4. Choose OK to close the Edit MText dialog box.



To add line text

1. From the Draw menu, choose Text and then Line Text.

2. Specify the starting point of the text, and if prompted, specify a height and rotation angle for the text.

3. Enter your text.

4. To finish entering your text, press RETURN twice.



To insert a block

1. From the Draw menu, choose Insert Block.

2. In the Insert dialog box, under Block, choose File and select the name of the DWG file to insert in your drawing.

3. Choose OK to close the Select Drawing File dialog box.

4. Choose OK to close the Insert dialog box.

5. Specify the insertion point.

6. Specify the X scale factor.

7. To set the Y scale factor equal to the X scale factor, press RETURN.

8. Specify the rotation angle.



To explode a block

1. From the Modify Menu, choose Explode.

2. Select the block to explode.

Note: You can also explode a block while inserting it by selecting an option in the Insert dialog box.



To attach an external reference

1. From the Edit menu, choose External Reference, and then choose Attach.

2. In the Select file to attach dialog box, select the name of a DWG file to attach and press OK.

3. Specify an insertion point for the DWG file.

4. Specify an X Scale factor.

5. To set the Y scale factor equal to the X scale factor, press RETURN.

6. Specify a rotation angle.



To detach an external reference

1. From the Edit menu, choose External Reference, then Detach.

2. Enter the names of the DWG files that you want to detach.



To bind an external reference

1. From the Edit menu, choose External Reference, and then Bind.

2. Enter the names of the xrefs to bind.



To zoom in and out of a drawing

Option 1

1. From the View menu, choose Zoom, and then Out.

AutoCAD LT changes the view of    your drawing to half the magnification.

Option 2

1. From the Zoom menu, choose Window.

2. Specify a corner of the area into which you want to zoom.

3. Specify the opposite corner of the area into which you want to zoom.

AutoCAD LT zooms into the area that you have specified.

Option 3

1. From the Zoom menu, choose Extents.

AutoCAD LT displays the entire drawing.

Option 4

1. From the View menu, choose Zoom and then Real-Time Zoom.

The cursor becomes a magnifying glass.

2. Hold down the pick button and drag the cursor vertically to increase or decrease the magnification.

3. Press RETURN or ESC to exit.



To pan in a drawing

1. From the View menu, choose Pan, and then Real-Time Pan.

The cursor becomes a hand.

2. Hold down the pick button and drag the hand in the direction in which you want to pan.

3. Press RETURN or ESC to exit.



To zoom with the Aerial View window

1. From the View menu, choose Aerial View.

AutoCAD LT displays the Aerial View window and its toolbar.

2. To zoom into your drawing from the toolbar, choose .

3. To zoom out of your drawing from the toolbar, choose .



To pan with the Aerial View window

1. From the View menu, choose Aerial View.

AutoCAD LT displays the Aerial View window and its toolbar.

2. Choose .

3. In the Aerial View window, move the dashed-line box to a new location and click.

The buttons  control the display magnification within the aerial view.



To specify sheet size for printing

1. From the File menu, choose Print.

2. In the Plot Configuration dialog box, under Paper Size and Orientation, select either inches or millimeters as the basis 
of measurement.

3. To display the Paper Size dialog box, choose Size.

The Paper Size dialog box displays a list of the paper sizes that your printer or plotter supports.

4. Select an existing size or enter a custom size in a User box.

5. Choose OK to return to the Plot Configuration dialog box.

6. To preview your drawing, under Plot Preview, choose Full, then Preview.

AutoCAD LT displays a preview of your plot.

7. Choose End Preview to return to the Plot Configuration dialog box.

You can change additional plotting parameters or you can print your drawing.

Note: You cannot change the sheet size for every printer. If you are using the system printer, paper size is determined in the 
Windows Control Panel, and this option is not available.



To print using landscape orientation

1. From the File menu, choose Print. 

2. In the Plot Configuration dialog box, choose Rotation and Origin.

3. In the Plot Rotation and Origin dialog box, under Plot Rotation, choose 90.

4. To specify where on the paper the plot should begin, enter X and Y values under Plot Origin.

5. Choose OK to return to the Plot Configuration dialog box.

6. To preview your drawing, under Plot Preview, choose Full, and then Preview.

AutoCAD LT displays a preview of your plot.

7. To return to the Plot Configuration dialog box to make changes, choose End Preview.

You are ready to print your drawing. You can change additional plotting parameters, or you can print your drawing.

Note: For the Windows 95 system printer, the rotation is also affected by the portrait and landscape settings in the Control 
Panel.



To define the plotted size of a drawing

See Overview: Printing and plotting before completing this procedure.

1. From the File menu, choose Print. 

2. In the Plot Configuration dialog box, under Scale, Rotation, and Origin, clear Scaled to Fit.

3. In the Plotted Inches and Drawing Units boxes, enter the ratio of plotted inches to drawing units.

You are ready to plot at the scale you entered.



To define the area to plot

1. From the File menu, choose Print.

2. In the Plot Configuration dialog box, under Additional Parameters, choose one of the following:

Display to plot the view in the graphics area.
Extents to plot all objects in the drawing.
Limits to plot objects within current drawing limits.
View to plot a previously saved view. To save a view, use the VIEW command. 
Window to plot an area that you define. Define the window by choosing the Window button and then defining the 

area to print.

You can change additional plotting parameters or you can plot your drawing.



To preview a plotted drawing

1. From the File menu, choose Print.

2. In the Plot Configuration dialog box, select a plotter, your page size, the area to plot, and the scale at which to plot

3. Under Plot Preview, select Full, then Preview.

4. Choose Pan and Zoom to examine different areas of the plot.

Click the pick button inside the box to switch between pan (an X) and zoom (an arrow).

With Zoom, drag the box to change magnification.
Click the return button to display the new view.

5. After viewing your plot on the screen, choose Pan and Zoom or End Preview.

You can change additional plotting parameters or you can plot your drawing.



To Save a drawing as a plot file

1. From the File menu, choose Print.

2. In the Plot Configuration dialog box, under Additional Parameters, select Plot to File.

3. To name the plot file, choose File name.

4. In the Create Plot File dialog box, enter a new file name.

5. Specify the directory in which to save the plot file.

6. Choose OK to return to the Plot Configuration dialog box.

You can change additional plotting parameters or you can plot your drawing.



System Variable Overview

AutoCAD LT stores the settings (or values) for its operating environment and some of its commands in system variables. 
Each system variable has an associated type: integer, real, point, or text string. Unless they are read-only, you can change 
these variables directly on the command line.



> ACIS15 System Variable
Up a Level

Type: Integer

Saved in:Not saved

Initial value: 0

Converts ACIS-specified objects such as 3D solids, bodies, or regions, between AutoCAD Release 13c3 and Release 13c4. 
The setting of this variable has no effect on ellipses and splines because data for these objects are not ACIS-specific.

0 All ACIS data is saved in c4 (ACIS 1.6) format and can be read only by c4 or later versions.

1 All ACIS data is saved in both c3 (ACIS 1.5) and c4 (ACIS 1.6) format in two different places. ACIS 1.5 format data 
is saved in the usual place where ACIS-specific data is retained. ACIS 1.6 format data is retained in the extension 
dictionary of the object along with a checksum of the ACIS 1.5 data. This checksum is used to determine whether 
the ACIS 1.5 data has changed. If it is changed, AutoCAD LT reads the changed data; otherwise, it reads the ACIS 
1.6 data in the extension dictionary. This process ensures that you are able to use a drawing saved in the c4 
release and open it in releases c0-c3 and that you are able to make modifications to ACIS-specific objects in the 
earlier releases and then use that drawing in c4.

Note: For DXF files, if ACIS15 is set to 1, AutoCAD saves the ACIS-specific data in ACIS 1.5 format in the usual place. 
There's no storage of ACIS 1.6 data in the extension dictionary.

Commands affected by the ACIS15 system variable are

SAVE

OPEN

DXFOUT

DXFIN

ACISOUT

ACISIN



> ACLTPREFIX System Variable
Up a Level

(Read-only)

Type: String

Saved in:Not saved

Stores the directory path, if any, specified by the Preferences dialog box, with path separators appended if necessary.



> ACLTVER System Variable
Up a Level

(Read-only)

Type: String

Saved in:Not saved

Stores the AutoCAD LT version number. Note that this variable differs from the DXF file $ACADVER header variable, which 
contains the drawing database level number.



> AFLAGS System Variable
Up a Level

Type: Integer

Saved in:Not saved

Initial value: 0

Sets attribute flags for the ATTDEF command bit-code. It is the sum of the following:

0 No attribute mode selected

1 Invisible

2 Constant

4 Verify

8 Preset



> ANGBASE System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 0

Sets the base angle 0 with respect to the current UCS.



> ANGDIR System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Sets the angle from angle 0 with respect to the current UCS.

0 Counterclockwise

1 Clockwise



> APERTURE System Variable
Up a Level

Type: Integer

Saved in:Config

Initial value: 10

Sets object-snap target width and height, in pixels.



> AREA System Variable
Up a Level

(Read-only)

Type: Real

Saved in:Not saved

Initial value: 0.0000

Stores the last area computed by AREA or LIST. Use the SETVAR command to access this system variable rather than the 
AREA command.



> ATTDIA System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Controls whether INSERT uses a dialog box for attribute value entry.

0 Issues prompts on the command line.

1 Uses a dialog box.



> ATTMODE System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 1

Controls Attribute Display mode.

0 Off

1 Normal

2 On



> ATTREQ System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 1

Determines whether INSERT uses default attribute settings during insertion of blocks.

0 Assumes the defaults for the values of all attributes.

1 Turns on prompts or a dialog box for attribute values, as selected by ATTDIA.



> AUDITCTL System Variable
Up a Level

Type: Integer

Saved in:Config

Initial value: 0

Controls whether AutoCAD LT creates an .adt file (audit report).

0 Turns off or prevents the writing of .adt files.

1 Turns on the writing of .adt files by AUDIT.



> AUNITS System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Sets Angular Units mode.

0 Decimal degrees

1 Degrees/minutes/seconds

2 Gradians

3 Radians

4 Surveyor's units



> AUPREC System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Sets the number of digits displayed to the right of the decimal point for angular units.

Note: Precision in dimensions is set by the DIMDEC variable.



> BACKZ System Variable
Up a Level

(Read-only)

Type: Real

Saved in:Drawing

Initial value: 0.0000

Stores the back clipping-plane offset from the target plane for the current viewport, in drawing units. Meaningful only if the 
back clipping bit in VIEWMODE is on. The distance of the back clipping plane from the camera point can be found by 
subtracting BACKZ from the camera-to-target distance.



> BLIPMODE System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 1

Controls whether marker blips are visible.

0 Turns off marker blips.

1 Turns on marker blips.



> CDATE System Variable
Up a Level

(Read-only)

Type: Real

Saved in:Not saved

Stores the calendar date and time.



> CECOLOR System Variable
Up a Level

Type: String

Saved in:Drawing

Initial value: "BYLAYER"

Sets the color of new objects.



> CELTSCALE System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 1.0000

Multiplies the linetype scale for new objects. Use CELTSCALE to change the linetype scale on new objects without changing
the linetype or the global linetype scale factor (LTSCALE). The linetype scale for each object is determined by the product of 
LTSCALE and CELTSCALE.



> CELTYPE System Variable
Up a Level

Type: String

Saved in:Drawing

Initial value: "BYLAYER"

Sets the linetype of new objects.



> CHAMFERA System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 0.5000

Sets the first chamfer distance.



> CHAMFERB System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 0.5000

Sets the second chamfer distance.



> CHAMFERC System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 1.0000

Sets the chamfer length.



> CHAMFERD System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 0.0000

Sets the chamfer angle.



> CHAMMODE System Variable
Up a Level

Type: Integer

Saved in:Not saved

Initial value: 0

Sets the input method by which AutoCAD LT creates chamfers.

0 Requires two chamfer distances.

1 Requires one chamfer length and an angle.



> CIRCLERAD System Variable
Up a Level

Type: Real

Saved in:Not saved

Initial value: 0.0000

Sets the default circle radius. A zero sets no default.



> CLAYER System Variable
Up a Level

Type: String

Saved in:Drawing

Initial value: "0"

Sets the current layer.



> CMDACTIVE System Variable
Up a Level

(Read-only)

Type: Integer

Saved in:Not saved

Stores the bit-code that indicates whether an ordinary command, transparent command, script, or dialog box is active. It is 
the sum of the following:

1 Ordinary command is active.

2 Ordinary command and a transparent command are active.

4 Script is active.

8 Dialog box is active.



> CMDDIA System Variable
Up a Level

Type: Integer

Saved in:Config

Initial value: 1

Controls whether a dialog box is turned on for the PLOT command.

0 Turns off dialog box.

1 Turns on dialog box.



> CMDNAMES System Variable
Up a Level

(Read-only)

Type: String

Saved in:Not saved

Displays the name (in English) of the currently active command and transparent command. For example, LINE'ZOOM 
indicates that the ZOOM command is being used transparently during the LINE command.



> COORDS System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 1

Controls when coordinates are updated.

0 Coordinate display is updated on pick points only.

1 Display of absolute coordinates is continuously updated.

2 Distance and angle from last point are displayed when a distance or angle is requested.



> CVPORT System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 2

Sets the identification number of the current viewport. You can change this value, thereby changing the current viewport, if 
the following conditions are met:

The identification number you specify is that of an active viewport.
A command in progress has not locked cursor movement to that viewport.
Tablet mode is off.



> DATE System Variable
Up a Level

(Read-only)

Type: Real

Saved in:Not saved

Stores the current date and time represented as a Julian date and fraction in a real number:

<Julian date>.<Fraction>

For example, on January 29, 1993, at 2:29:35 in the afternoon, the DATE variable would contain 2446460.603877364.

The DATE system variable returns a true Julian date only if the system clock is set to UTC/Zulu (Greenwich Mean Time). 
TDCREATE and TDUPDATE have the same format as DATE, but their values represent the creation time and last update 
time of the current drawing.



> DCTCUST System Variable
Up a Level

Type: String

Saved in:Config

Initial value: ""

Displays the current custom spelling dictionary path and file name.



> DCTMAIN System Variable
Up a Level

Type: String

Saved in:Config

Initial value: ""

Displays the current main spelling dictionary file name. The full path is not shown because this file is expected to reside in 
the \support directory.

You can specify a default main spelling dictionary using the SETVAR command. When prompted for a new value for 
DCTMAIN, you can enter one of the following keywords:

Keyword Language name

enu American English

ena Australian English

ens British English (ise)

enz British English (ize)

ca Catalan

cs Czech

da Danish

nl Dutch (primary)

nls Dutch (secondary)

fi Finnish

fr French (unaccented capitals)

fra French (accented capitals)

de German (Scharfes s)

ded German (Dopple s)

it Italian

no Norwegian (Bokmal)

non Norwegian (Nynorsk)

pt Portuguese (Iberian)

ptb Portuguese (Brazilian)

ru Russian (infrequent io)

rui Russian (frequent io)

es Spanish (unaccented capitals)

esa Spanish (accented capitals)

sv Swedish

> DIASTAT System Variable
Up a Level

(Read-only)



Type: Integer

Saved in:Not saved

Stores the exit method of the most recently used dialog box.

0 Cancel

1 OK



> DIMALT System Variable
Up a Level

Type: Switch

Saved in:Drawing

Initial value: Off

Turns on alternate units dimensioning. See also DIMALTD, DIMALTF, DIMALTZ (DIMALTTZ, DIMALTTD), and DIMAPOST.



> DIMALTD System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 2

Controls alternate units decimal places. If DIMALT is turned on, DIMALTD sets the number of digits displayed to the right of 
the decimal point in the alternate measurement.



> DIMALTF System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 25.4000

Controls alternate units scale factor. If DIMALT is turned on, DIMALTF multiplies linear dimensions by a factor to produce a 
value in an alternate system of measurement.



> DIMALTTD System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 2

Sets the number of digits displayed to the right of the decimal point for the tolerance values of alternate units dimensions. 
DIMALTTD sets this value when entered on the command line or set in the Alternate Units area of the Annotation dialog box.



> DIMALTTZ System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Controls suppression of zeros for tolerance values.

0 Suppresses zero feet and precisely zero inches.

1 Includes zero feet and precisely zero inches.

2 Includes zero feet and suppresses zero inches.

3 Includes zero inches and suppresses zero feet.

To the preceding values, add:

4 Suppresses leading zeros.

8 Suppresses trailing zeros.

DIMALTTZ sets this value when entered on the command line or set in the Alternate Units area of the Annotation dialog box.



> DIMALTU System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 2

Sets the units format for alternate units of all dimension style family members except angular.

1 Scientific

2 Decimal

3 Engineering

4 Architectural (stacked)

5 Fractional (stacked)

6 Architectural

7 Fractional

DIMALTU sets this value when entered on the command line or set in the Alternate Units area of the Annotation dialog box.



> DIMALTZ System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Comtrols suppression of zeros for alternate unit dimension values.

0 Suppresses zero feet and precisely zero inches.

1 Includes zero feet and precisely zero inches.

2 Includes zero feet and suppresses zero inches.

3 Includes zero inches and suppresses zero feet.

To the preceding values, add:

4 Suppresses leading zeros.

8 Suppresses trailing zeros.

DIMALTZ sets this value when entered on the command line or set in the Alternate Units area of the Annotation dialog box.



> DIMAPOST System Variable
Up a Level

Type: String

Saved in:Drawing

Initial value: ""

Specifies a text prefix or suffix (or both) to the alternate dimension measurement for    all types of dimensions except angular.
For instance, if the current Units mode is Architectural, DIMALT is turned on, DIMALTF is 25.4, DIMALTD is 2, and 
DIMAPOST is set to "mm," a distance of 10 units would be edited as 10"[254.00mm]. To turn off an established prefix or 
suffix (or both), set it to a single period (.).



> DIMASO System Variable
Up a Level

Type: Switch

Saved in:Drawing

Initial value: On

Controls the creation of dimension objects.

Off The lines, arcs, arrowheads, and text of a dimension are drawn as separate objects.

On The lines, arcs, arrowheads, and text of a dimension are created as a single object. Each dimension includes 
definition points located on the features of the object being dimensioned. If the definition point is moved along with 
the feature, the dimension is automatically adjusted and updated.

The DIMASO value is not stored in a dimension style.



> DIMASZ System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 0.1800

Controls the size of dimension line and leader line arrowheads. Also controls the size of hook lines. Multiples of the 
arrowhead size determine whether dimension lines and text are to fit between the extension lines. Also used to scale 
arrowhead blocks if set by DIMBLK. DIMASZ has no effect when DIMTSZ is other than zero.



> DIMAUNIT System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Sets the angle format for angular dimensions.

0 Decimal degrees

1 Degrees/minutes/seconds

2 Gradians

3 Radians

4 Surveyor's units

DIMAUNIT sets this value when entered on the command line or set from the Primary Units area of the Annotation dialog 
box.



> DIMBLK System Variable
Up a Level

Type: String

Saved in:Drawing

Initial value: "" (a closed, filled arrowhead)

Sets the name of a block to be drawn instead of the normal arrowhead at the ends of the dimension line or leader line. To 
turn off a specified block name, set it to a single period (.).



> DIMBLK1 System Variable
Up a Level

Type: String

Saved in:Drawing

Initial value: "" (a closed, filled arrowhead)

If DIMSAH is on, DIMBLK1 specifies user-defined arrowhead blocks for the first end of the dimension line. This variable 
contains the name of a previously defined block. To turn off a specified block name, set it to a single period (.).



> DIMBLK2 System Variable
Up a Level

Type: String

Saved in:Drawing

Initial value: "" (a closed, filled arrowhead)

If DIMSAH is on, DIMBLK2 specifies user-defined arrowhead blocks for the second end of the dimension line. This variable 
contains the name of a previously defined block. To turn off a specified block name, set it to a single period (.).



> DIMCEN System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 0.0900

Controls drawing of circle or arc center marks and center lines by the DIMCENTER, DIMDIAMETER, and DIMRADIUS 
dimensioning commands.

    0 No center marks or lines are drawn.

<0 Center lines are drawn.

>0 Center marks are drawn.

The absolute value specifies the size of the mark portion of the center line. DIMRADIUS and DIMDIAMETER draw the 
center mark or line only if the dimension line is placed outside the circle or arc.



> DIMCLRD System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Assigns colors to dimension lines, arrowheads, and dimension leader lines. Also controls the color of leader lines created 
with the LEADER command. Using the SETVAR command, supply the color number. The color can be any valid color 
number, 0 for BYBLOCK, or 256 for BYLAYER.



> DIMCLRE System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Assigns colors to dimension extension lines. The color can be any valid color number, 0 for BYBLOCK, or 256 for BYLAYER.



> DIMCLRT System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Assigns colors to dimension text. The color can be any valid color number, 0 for BYBLOCK, or 256 for BYLAYER.



> DIMDEC System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 4

Sets the number of digits displayed to the right of the decimal point for the primary units dimension. DIMDEC stores this 
value when entered on the command line or set in the Primary Units area of the Annotation dialog box



> DIMDLE System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 0.0000

Extends the dimension line beyond the extension line when oblique strokes are drawn instead of arrowheads.



> DIMDLI System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 0.3800

Controls the dimension line spacing for baseline dimensions. Each baseline dimension is offset by this amount, if necessary,
to avoid drawing over the previous dimension.



> DIMEXE System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 0.1800

Determines how far to extend the extension line beyond the dimension line.



> DIMEXO System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 0.0625

Determines how far extension lines are offset from origin points. If you point directly at the corners of an object to be 
dimensioned, the extension lines stop just short of the object.



> DIMFIT System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 3

Controls the placement of text and arrowheads inside or outside extension lines based on the available space between the 
extension lines. Also, if DIMFIT is set to a value of 0 - 3, when you move dimension text, the dimension line moves with it. If 
DIMFIT is set to a value of 4 or 5, when you move dimension text, the dimension line does not move.

When space is available, AutoCAD LT always places text and arrowheads between the extension lines. When space 
between the extension lines is inadequate, the DIMFIT setting determines the placement of text and arrowheads as follows:

0 Places both text and arrowheads outside extension lines.

1 Places text between the extension lines and places arrowheads outside them. When not enough space is available
for text, places both text and arrowheads outside extension lines.

2 Places arrowheads between the extension lines and places the text outside. When not enough space is available 
for arrowheads, places both text and arrowheads outside extension lines.

3 Places the text between the extension lines and places the arrowheads outside the extension lines. When enough 
space is available for arrowheads only, places them between the extension lines and the text outside the extension
lines. When not enough space is available for either the text and arrowheads, places them outside the extension 
lines.

4 Creates leader lines when there is not enough space for text between extension lines. Horizontal justification 
controls whether the text is drawn to the right or the left of the leader. For more information, see DIMJUST.

5 When enough space is available for arrowheads only, places them between the extension lines and places the text
above the dimension line. When not enough space is available for both text and arrowheads, you can place the 
text anywhere, independent of the dimension line. No leader line is created in either case.



> DIMGAP System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 0.0900

Sets the distance around the dimension text when you break the dimension line to accommodate dimension text. Also sets 
the gap between annotation and a hook line created with the LEADER command. A negative DIMGAP value creates basic 
dimensioning -- dimension text with a box around its full extents.

AutoCAD LT also uses DIMGAP as the minimum length for pieces of the dimension line. When calculating the default 
position for the dimension text, it positions the text inside the extension lines only if doing so breaks the dimension lines into 
two segments at least as long as DIMGAP. Text placed above or below the dimension line is moved inside if there is room 
for the arrowheads, dimension text, and a margin between them at least as large as DIMGAP: 2 * (DIMASZ + DIMGAP).



> DIMJUST System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Controls horizontal dimension text position.

0 Positions the text above the dimension line and center-justifies it in between the extension lines.

1 Positions the text next to the first extension line.

2 Positions the text next to the second extension line.

3 Positions the text above and aligned with the first extension line.

4 Positions the text above and aligned with the second extension line.



> DIMLFAC System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 1.0000

Sets a global scale factor for linear dimensioning measurements. All linear distances measured by dimensioning (including 
radii, diameters, and coordinates) are multiplied by the DIMLFAC setting before being converted to dimension text.

DIMLFAC has no effect on angular dimensions, and it is not applied to the values held in DIMTM, DIMTP, or DIMRND.

If you are creating a dimension in paper space and DIMLFAC is nonzero, AutoCAD LT multiplies the distance measured by 
the absolute value of DIMLFAC. In model space, negative values for DIMLFAC are ignored, and the value 1.0 is used 
instead. AutoCAD LT computes a value for DIMLFAC if you change DIMLFAC from the Dim prompt while in paper space and
you select the Viewport option.

Dim: dimlfac
Current value <1.0000> New value (Viewport): v
Select viewport to set scale:

AutoCAD LT calculates the scaling of model space to paper space and assigns the negative of this value to DIMLFAC.



> DIMLIM System Variable
Up a Level

Type: Switch

Saved in:Drawing

Initial value: Off

When turned on, generates dimension limits as the default text. Setting DIMLIM on forces DIMTOL to be off



> DIMPOST System Variable
Up a Level

Type: String

Saved in:Drawing

Initial value: ""

Specifies a text prefix or suffix (or both) to the dimension measurement. For example, to establish a suffix for millimeters, set
DIMPOST to mm; a distance of 19.2 units would be displayed as 19.2mm.

If tolerances are turned on, the suffix is applied to the tolerances as well as to the main dimension.

To separate DIMPOST values into prefix and suffix parts of the dimension text, use the < > mechanism; this allows AutoCAD
LT to use the DIMPOST values as text. Use this mechanism for angular dimensions.



> DIMRND System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 0.0000

Rounds all dimensioning distances to the specified value. For instance, if DIMRND is set to 0.25, all distances round to the 
nearest 0.25 unit. If you set DIMRND to 1.0, all distances round to the nearest integer. Note that the number of digits edited 
to the right of the decimal point depends on the precision set by DIMDEC. DIMRND does not apply to angular dimensions. A
value of 0 turns off rounding.



> DIMSAH System Variable
Up a Level

Type: Switch

Saved in:Drawing

Initial value: Off

Controls use of user-defined arrowhead blocks at the ends of the dimension line.

Off Normal arrowheads or user-defined arrowhead blocks set by DIMBLK are used.

On User-defined arrowhead blocks are used.

DIMBLK1 and DIMBLK2 specify different user-defined arrowhead blocks for each end of the dimension line.



> DIMSCALE System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 1.0000

Sets the overall scale factor applied to dimensioning variables that specify sizes, distances, or offsets. It is not applied to 
tolerances or to measured lengths, coordinates, or angles. Also affects the scale of leader objects created with the LEADER 
command.

0.0 AutoCAD LT computes a reasonable default value based on the scaling between the current model space viewport
and paper space. If you are in paper space, or in model space and not using the paper space feature, the scale 
factor is 1.0.

>0 AutoCAD LT computes a scale factor that leads text sizes, arrowhead sizes, and other scaled distances to plot at 
their face values.



> DIMSD1 System Variable
Up a Level

Type: Switch

Saved in:Drawing

Initial value: Off

When turned on, suppresses the display of the dimension line and arrowhead between the first extension line and the text.



> DIMSD2 System Variable
Up a Level

Type: Switch

Saved in:Drawing

Initial value: Off

When turned on, suppresses the display of the dimension line and arrowhead between the second extension line and the 
text.



> DIMSE1 System Variable
Up a Level

Type: Switch

Saved in:Drawing

Initial value: Off

When turned on, suppresses the display of the first extension line.



> DIMSE2 System Variable
Up a Level

Type: Switch

Saved in:Drawing

Initial value: Off

When turned on, suppresses the display of the second extension line.



> DIMSHO System Variable
Up a Level

Type: Switch

Saved in:Drawing

Initial value: On

When turned on, controls redefinition of dimension objects while dragging. Associative dimensions recompute dynamically 
as they are dragged. Radius or diameter leader length input uses dynamic dragging and ignores DIMSHO. On some 
computers, dynamic dragging can be very slow, so you can set DIMSHO to off to drag the original image instead. The 
DIMSHO value is not stored in a dimension style.



> DIMSOXD System Variable
Up a Level

Type: Switch

Saved in:Drawing

Initial value: Off

When turned on, suppresses drawing of dimension lines outside the extension lines. If the dimension lines would be outside 
the extension lines and DIMTIX is on, setting DIMSOXD to on suppresses the dimension line. If DIMTIX is off, DIMSOXD 
has no effect.



> DIMSTYLE System Variable
Up a Level

(Read-only)

Type: String

Saved in:Drawing

Stores the current dimension style by name. To change the dimension style, use DDIM or DIMSTYLE.



> DIMTAD System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Controls vertical position of text in relation to the dimension line.

0 Centers the dimension text between the extension lines.

1 Places the dimension text above the dimension line except when the dimension line is not horizontal and text 
inside the extension lines is forced horizontal (DIMTIH = 1). The distance from the dimension line to the baseline of
the lowest line of text is the current DIMGAP value.

2 Places the dimension text on the side of the dimension line farthest away from the defining points.

3 Places the dimension text to conform to a Japanese Industrial Standards (JIS) representation.



> DIMTDEC System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 4

Sets the number of digits displayed to the right of the decimal point for the tolerance values of the primary units in a 
dimension. DIMTDEC stores this value when entered on the command line or set in the Primary Units area of the Annotation
dialog box.



> DIMTFAC System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 1.0000

Specifies a scale factor for text height of tolerance values relative to the dimension text height as set by DIMTXT. 

DIMTFAC    = Tolerance Height
        Text Height

For example, if DIMTFAC is set to 1.0, the text height of tolerances is the same as the dimension text. If DIMTFAC is set to 
0.75, the text height of tolerances is three-quarters the size of dimension text.

Use DIMTFAC for plus and minus tolerance strings when DIMTOL is on and DIMTM is not equal to DIMTP, or when DIMLIM
is on.



> DIMTIH System Variable
Up a Level

Type: Switch

Saved in:Drawing

Initial value: On

Controls the position of dimension text inside the extension lines for all dimension types except ordinate dimensions.

0 or Off Aligns text with the dimension line.

1 or On Draws text horizontally.



> DIMTIX System Variable
Up a Level

Type: Switch

Saved in:Drawing

Initial value: Off

Draws text between extension lines.

0 or Off The result varies with the type of dimension. For linear and angular dimensions, AutoCAD LT places text 
inside the extension lines if there is sufficient room. For radius and diameter dimensions, setting DIMTIX off forces 
the text outside the circle or arc.

1 or On Draws dimension text between the extension lines even if AutoCAD LT would ordinarily place it outside those 
lines.



> DIMTM System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 0.0000

Sets the minimum (or lower) tolerance limit for dimension text when DIMTOL or DIMLIM is on. DIMTM accepts signed 
values. If DIMTOL is on and DIMTP and DIMTM are set to the same value, AutoCAD LT draws a ± symbol followed by the 
tolerance value.

If DIMTM and DIMTP values differ, the upper tolerance is drawn above the lower, and a plus sign is added to the DIMTP 
value if it is positive.

For DIMTM, AutoCAD LT uses the negative of the value you enter (adding a minus sign if you specify a positive number and 
a plus sign if you specify a negative number). No sign is added to a value of zero.



> DIMTOFL System Variable
Up a Level

Type: Switch

Saved in:Drawing

Initial value: Off

When turned on, draws a dimension line between the extension lines even when the text is placed outside the extension 
lines. For radius and diameter dimensions (while DIMTIX is off), draws a dimension line and arrowheads inside the circle or 
arc and places the text and leader outside.



> DIMTOH System Variable
Up a Level

Type: Switch

Saved in:Drawing

Initial value: On

When turned on, controls the position of dimension text outside the extension lines.

0 or Off Aligns text with the dimension line.

1 or On Draws text horizontally.



> DIMTOL System Variable
Up a Level

Type: Switch

Saved in:Drawing

Initial value: Off

When turned on, appends dimension tolerances to dimension text. Setting DIMTOL on forces DIMLIM off.



> DIMTOLJ System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Sets the vertical justification for tolerance values relative to the nominal dimension text.

0 Bottom

1 Middle

2 Top



> DIMTP System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 0.0000

Sets the maximum (or upper) tolerance limit for dimension text when DIMTOL or DIMLIM is on. DIMTP accepts signed 
values. If DIMTOL is on and DIMTP and DIMTM are set to the same value, AutoCAD LT draws a ± symbol followed by the 
tolerance value.

If DIMTM and DIMTP values differ, the upper tolerance is drawn above the lower and a plus sign is added to the DIMTP 
value if it is positive.



> DIMTSZ System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 0.0000

Specifies the size of oblique strokes drawn instead of arrowheads for linear, radius, and diameter dimensioning.

0 Draws arrowheads.

>0 Draws oblique strokes instead of arrowheads. Size of oblique strokes is determined by this value multiplied by the 
DIMSCALE value. Also determines if dimension lines and text fit between extension lines.



> DIMTVP System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 0.0000

Adjusts the vertical position of dimension text above or below the dimension line. AutoCAD LT uses the DIMTVP value when
DIMTAD is off. The magnitude of the vertical offset of text is the product of the text height and DIMTVP. Setting DIMTVP to 
1.0 is equivalent to setting DIMTAD to on. AutoCAD LT splits the dimension line to accommodate the text only if the absolute
value of DIMTVP is less than 0.7.



> DIMTXSTY System Variable
Up a Level

Type: String

Saved in:Drawing

Initial value: "STANDARD"

Specifies the text style of the dimension.



> DIMTXT System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 0.1800

Specifies the height of dimension text, unless the current text style has a fixed height.



> DIMTZIN System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Controls suppression of zeros for tolerance values.

0 Suppresses zero feet and precisely zero inches.

1 Includes zero feet and precisely zero inches.

2 Includes zero feet and suppresses zero inches.

3 Includes zero inches and suppresses zero feet.

To the preceding values, add:

4 Suppresses leading zeros.

8 Suppresses trailing zeros.

DIMZIN stores this value when entered on the command line or set in the Primary Units area of the Annotation dialog box.



> DIMUNIT System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 2

Sets the units format for all dimension style family members except angular.

1 Scientific

2 Decimal

3 Engineering

4 Architectural (stacked)

5 Fractional (stacked)

6 Architectural

7 Fractional



> DIMUPT System Variable
Up a Level

Type: Switch

Saved in:Drawing

Initial value: Off

Controls cursor functionality for dimension text.

0 or Off Cursor controls only the dimension line location.

1 or On Cursor controls the text position as well as the dimension line location.



> DIMZIN System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Controls the suppression of zeros in dimension text. DIMZIN stores this value when entered on the command line or set in 
the Primary Units area of the Annotation dialog box.

0 Suppresses zero feet and precisely zero inches.

1 Includes zero feet and precisely zero inches.

2 Includes zero feet and suppresses zero inches.

3 Includes zero inches and suppresses zero feet.

4 Suppresses leading zeros in decimal dimensions.

8 Suppresses trailing zeros in decimal dimensions.



> DISTANCE System Variable
Up a Level

(Read-only)

Type: Real

Saved in:Not saved

Stores the distance computed by the DIST command.



> DITHER System Variable
Up a Level

Type: Integer

Saved in:aclt.ini

Initial value: 0

Controls whether drawings printed using a Windows system printer are dithered. Dithering attempts to simulate more colors 
than the printer actually supports by mixing colors and white space.

0 Dithering is off

1 Dithering is on



> DONUTID System Variable
Up a Level

Type: Real

Saved in:Not saved

Initial value: 0.5000

Sets the default for the inside diameter of a donut.



> DONUTOD System Variable
Up a Level

Type: Real

Saved in:Not saved

Initial value: 1.0000

Sets the default for the outside diameter of a donut. Must be nonzero. If DONUTID is larger than DONUTOD, the two values 
are swapped by the next DONUT command.



> DWGCODEPAGE System Variable
Up a Level

(Read-only)

Type: String

Saved in:Drawing

Stores the drawing code page. This variable is set to the system code page when you create a new drawing; otherwise, 
AutoCAD LT does not maintain it. It should reflect the code page of the drawing. You can set it to any of the values used by 
the SYSCODEPAGE system variable or set it as undefined. It is saved in the header.



> DWGNAME System Variable
Up a Level

(Read-only)

Type: String

Saved in:Not saved

Stores the drawing name as entered by the user. If the drawing hasn't been named yet, DWGNAME reports that it is 
unnamed. If the user specified a drive/directory prefix, it is included as well.



> DWGPREFIX System Variable
Up a Level

(Read-only)

Type: String

Saved in:Not saved

Stores the drive/directory prefix for the drawing.



> DWGTITLED System Variable
Up a Level

(Read-only)

Type: Integer

Saved in:Not saved

Indicates whether the current drawing has been named.

0 The drawing has not been named.

1 The drawing has been named.



> DWGWRITE System Variable
Up a Level

Type: Integer

Saved in:Not saved

Initial value: 1

Controls the initial state of the read-only box in the Open Drawing dialog box of the OPEN command.

0 Opens the drawing for reading only.

1 Opens the drawing for reading and writing.



> EDGEMODE System Variable
Up a Level

Type: Integer

Saved in:Config

Initial value: 0

Controls how the TRIM and EXTEND commands determine cutting and boundary edges.

0 Uses the selected edge without an extension.

1 Extends the selected edge to its natural boundary.

Line, arc, elliptical arc, ray, and polyline are eligible objects for natural extension. The natural extension of a line or ray is an 
unbounded line (xline); an arc is a circle, and an elliptical arc is an ellipse. A polyline is broken down into its line and arc 
components, which are extended to their natural boundary.



> ELEVATION System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 0.0000

Stores the current 3D elevation relative to the current UCS for the current space.



> EXEDIR System Variable
Up a Level

(Read-only)

Type: String

Saved in:Not saved

Displays the directory path of the AutoCAD LT executable file.



> EXPERT System Variable
Up a Level

Type: Integer

Saved in:Not saved

Initial value: 0

Controls whether certain prompts are issued.

0 Issues all prompts normally.

1 Suppresses "About to regen, proceed?" and "Really want to turn the current layer off?"

2 Suppresses the preceding prompts and "Block already defined. Redefine it?" (BLOCK) and "A drawing with this 
name already exists. Overwrite it?" (SAVE or WBLOCK).

3 Suppresses the preceding prompts and those issued by LINETYPE if you try to load a linetype that's already 
loaded or create a new linetype in a file that already defines it.

4 Suppresses the preceding prompts and those issued by UCS Save and VPORTS Save if the name you enter 
already exists.

5 Suppresses the preceding prompts and those issued by the DIMSTYLE Save option and DIMOVERRIDE if the 
dimension style name you enter already exists (the entries are redefined).

When a prompt is suppressed by EXPERT, the operation in question is performed as though you entered y at the prompt. 
The setting of EXPERT can affect scripts, menu macros, and the command functions.



> EXTMAX System Variable
Up a Level

(Read-only)

Type: 3D Point

Saved in:Drawing

Stores the upper-right point of drawing extents. Expands outward as new objects are drawn, shrinks only with ZOOM All or 
ZOOM Extents. Reported in World coordinates for the current space.



> EXTMIN System Variable
Up a Level

(Read-only)

Type: 3D Point

Saved in:Drawing

Stores the lower-left point of drawing extents. Expands outward as new objects are drawn, shrinks only with ZOOM All or 
ZOOM Extents. Reported in World coordinates for the current space.



> FFLIMIT System Variable
Up a Level

Type: Integer

Saved in:Config

Initial value: 0

Limits the number of PostScript and TrueType fonts in memory. Valid values are from 0 to 100. If set to 0, there is no limit.



> FILEDIA System Variable
Up a Level

Type: Integer

Saved in:Config

Initial value: 1

Suppresses the display of the file dialog boxes.

0 Turns off file dialog boxes. You can still request a file dialog box to appear by entering a tilde (~) in response to the 
command's prompt.

1 Turns on file dialog boxes. However, if a script is active, an ordinary prompt appears.



> FILLETRAD System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 0.0000

Stores the current fillet radius.



> FILLMODE System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 1

Specifies whether 2-D solid objects created with SOLID are filled in.

0 Objects are not filled.

1 Objects are filled.



# fontalt$ FONTALT System VariableK System variables; FONTALT+ SYSVAR:00615



> FRONTZ System Variable
Up a Level

(Read-only)

Type: Real

Saved in:Drawing

Initial value: 0.0000

Stores the front clipping plane offset from the target plane for the current viewport, in drawing units. Meaningful only if the 
front clipping bit in VIEWMODE is on and the front clip not at eye bit is also on. The distance of the front clipping plane from 
the camera point is found by subtracting FRONTZ from the camera-to-target distance.



> GRIDMODE System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: Varies

Specifies whether the grid is turned on or off.

0 Turns the grid off.

1 Turns the grid on.



> GRIDUNIT System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: Varies

Specifies the grid spacing (X and Y) for the current viewport. Changes to GRIDUNIT are not reflected in the displayed grid 
until you use the REDRAW or REGEN command.



> GRIPBLOCK System Variable
Up a Level

Type: Integer

Saved in:Config

Initial value: 0

Controls the assignment of grips in blocks.

0 Assigns grip only to the insertion point of the block.

1 Assigns grips to objects within the block.



> GRIPCOLOR System Variable
Up a Level

Type: Integer

Saved in:Config

Initial value: 5

Controls the color of nonselected grips (drawn as a box outline). The valid range is 1-255.



> GRIPHOT System Variable
Up a Level

Type: Integer

Saved in:Config

Initial value: 1

Controls the color of selected grips (drawn as a filled box). The valid range is 1-255.



> GRIPS System Variable
Up a Level

Type: Integer

Saved in:Config

Initial value: 1

Turns on grips and the **Stretch**, **Move**, **Rotate**, **Scale**, and **Mirror** grip commands.

0 Turns off grips.

1 Turns on grips.

To adjust the size of the grips and the effective selection area used by the cursor when you snap to a grip, use the 
GRIPSIZE system variable.



> GRIPSIZE System Variable
Up a Level

Type: Integer

Saved in:Config

Initial value: 3

Sets the size of the box drawn to display the grip in pixels. The valid range is 1-255.



> HANDLES System Variable
Up a Level

(Read-only)

Type: Integer

Saved in:Drawing

Initial value: 1

Reports that object handles are turned on and can be accessed by applications. Included for compatibility with earlier 
versions. Handles can no longer be turned off.



> HIGHLIGHT System Variable
Up a Level

Type: Integer

Saved in:Not saved

Initial value: 1

Controls object highlighting; does not affect objects selected with grips.

0 Turns off object selection highlighting.

1 Turns on object selection highlighting.



> HPANG System Variable
Up a Level

Type: Real

Saved in:Not saved

Initial value: 0

Specifies the hatch pattern angle.



> HPDOUBLE System Variable
Up a Level

Type: Integer

Saved in:Not saved

Initial value: 0

Specifies hatch pattern doubling for "U" (user-defined) patterns.

0 Turns off hatch pattern doubling.

1 Turns on hatch pattern doubling.



> HPNAME System Variable
Up a Level

Type: String

Saved in:Not saved

Initial value: ANSI31

Sets default hatch pattern name of up to 34 characters, no spaces allowed. Returns "" if there is no default. Enter a period (.)
to set no default.

AutoCAD LT stores the Normal, Outer, and Ignore style codes by appending characters to the pattern name in the HPNAME 
system variable.



> HPSCALE System Variable
Up a Level

Type: Real

Saved in:Not saved

Initial value: Varies

Specifies the hatch pattern scale factor; must be nonzero.



> HPSPACE System Variable
Up a Level

Type: Real

Saved in:Not saved

Initial value: Varies

Specifies the hatch pattern line spacing for "U" (user-defined) simple patterns; must be nonzero.



> INSBASE System Variable
Up a Level

Type: 3D point

Saved in:Drawing

Initial value: 0.0000,0.0000,0.0000

Stores insertion base point set by BASE command, expressed in UCS coordinates for the current space.



> INSNAME System Variable
Up a Level

Type: String

Saved in:Not saved

Initial value: ""

Sets default block name for DDINSERT or INSERT. The name must conform to symbol naming conventions. Returns "" if no
default. Enter a period (.) to set no default.



> LASTANGLE System Variable
Up a Level

(Read-only)

Type: Real

Saved in:Not saved

Initial value: 0

Stores the end angle of the last arc entered relative to the XY plane of the current UCS for the current space.



> LASTPOINT System Variable
Up a Level

Type: 3D point

Saved in:Drawing

Initial value: 0.0000,0.0000,0.0000

Stores the last point entered, expressed in UCS coordinates for the current space; referenced by @ during keyboard entry.



> LENSLENGTH System Variable
Up a Level

(Read-only)

Type: Real

Saved in:Drawing

Initial value: 50

Stores the length of the lens (in millimeters) used in perspective viewing for the current viewport.



> LIMCHECK System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Controls object creation outside the drawing limits.

0 Permits object creation outside the drawing limits.

1 Prevents object creation outside the drawing limits.



> LIMMAX System Variable
Up a Level

Type: 2D point

Saved in:Drawing

Initial value: Varies

Stores upper-right drawing limits for the current space expressed in World coordinates.



> LIMMIN System Variable
Up a Level

Type: 2D point

Saved in:Drawing

Initial value: 0.0000,0.0000

Stores lower-left drawing limits for the current space expressed in World coordinates.



> LOCALE System Variable
Up a Level

(Read-only)

Type: String

Saved in:Not saved

Initial value: Varies

Displays the ISO language code of the current AutoCAD LT version you're running.



> LTSCALE System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 1.0000

Sets the global linetype scale factor. The linetype scale for each object is determined by the product of LTSCALE and 
CELTSCALE.



> LUNITS System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 2

Sets Linear Units mode.

1 Scientific

2 Decimal

3 Engineering

4 Architectural

5 Fractional



> LUPREC System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 4

Linear Units Precision sets the number of digits displayed to the right of the decimal point for nondimensioning commands, 
variables, and output. This includes coordinate display, LIST, DIST, AREA, ID, and DDMODIFY. You can use values between
0 and 8.



> MAXACTVP System Variable
Up a Level

Type: Integer

Saved in:Not saved

Initial value: 16

Sets maximum number of viewports that can be active at the same time.



> MENUECHO System Variable
Up a Level

Type: Integer

Saved in:Not saved

Initial value: 0

Sets menu echo and prompt control bits. It is the sum of the following:

1 Suppresses echo of menu items (^P in a menu item toggles echoing).

2 Suppresses display of system prompts during menu.

4 Turns off ^P toggle of menu echoing.

8 Displays input/output strings; debugging aid for DIESEL macros.



> MIRRTEXT System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 1

Controls how MIRROR reflects text.

0 Retains text direction.

1 Mirrors the text.



> MODEMACRO System Variable
Up a Level

Type: String

Saved in:Not saved

Initial value: ""

Displays a text string on the status line, such as the name of the current drawing, time/date stamp, or special modes. Use 
MODEMACRO to display a string of text, or use special text strings written in the DIESEL macro language to have AutoCAD 
LT evaluate the macro from time to time and base the status line on user-selected conditions.



> MTEXTED System Variable
Up a Level

Type: String

Saved in:Config

Initial value: Internal

Sets the name of the program to use for editing MTEXT objects. You can specify a different text editor for the Paragraph Text
(MTEXT) and Edit Text (DDEDIT) commands. If you set MTEXTED to internal, AutoCAD LT will display the internal Edit 
Mtext dialog box; if you set MTEXTED to null by entering a period (.), AutoCAD LT will display the Notepad; if you specify a 
directory path and the name of the executable for a another text editor or word processor, AutoCAD LT will display it instead.
Text editors other than the internal one will show the formatting codes in paragraph text. To include other formatting such as 
underscoring, see “Formatting Paragraph Text on the Command Line” in chapter 12 of the AutoCAD LT User’s Guide.



> OFFSETDIST System Variable
Up a Level

Type: Real

Saved in:Not saved

Initial value: -1.0000

Sets the default offset distance.

<0 Changes to Through mode.

>0 Sets the default offset distance.



> ORTHOMODE System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Controls orthogonal display of lines or polylines.

0 Turns off Ortho mode.

1 Turns on Ortho mode.



> OSMODE System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Sets running Object Snap modes using the following bit-codes. To specify more than one object snap, enter the sum of their 
values. For example, entering 3 specifies the Endpoint (1) and Midpoint (2) object snap.

    NONe

    ENDpoint

    MIDpoint

    CENter

    NODe

 16 QUAdrant

 32 INTersection

 64 INSertion

12 PERpendicular

25 TANgent

51 NEArest

> PDMODE System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Sets the display mode for point objects. For information on values to enter, see the POINT command.



> PDSIZE System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 0.0000

Sets point object display size.

    0 Creates a point at 5% of the graphics area height.

>0 Specifies an absolute size.

<0 Specifies a percentage of the viewport size.



> PELLIPSE System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Controls the ellipse type created with ELLIPSE.

0 Creates a true ellipse object.

1 Creates a polyline representation of an ellipse.



> PERIMETER System Variable
Up a Level

(Read-only)

Type: Real

Saved in:Not saved

Initial value: 0.0000

Stores the last perimeter value computed by AREA and LIST.



> PICKADD System Variable
Up a Level

Type: Integer

Saved in:Config

Initial value: 1

Controls additive selection of objects.

0 Turns off PICKADD. The objects most recently selected, either by an individual pick or windowing, become the 
selection set. Previously selected objects are removed from the selection set. Add more objects to the selection set
by holding down Shift while selecting them.

1 Turns on PICKADD. Each object selected, either individually or by windowing, is added to the current selection set.
To remove objects from the set, hold down Shift while selecting them.



> PICKAUTO System Variable
Up a Level

Type: Integer

Saved in:Config

Initial value: 1

Controls automatic windowing when the Select objects prompt appears.

0 Turns off PICKAUTO.

1 Turns on selection window specification (both window and crossing window) automatically at the Select objects 
prompt.



> PICKBOX System Variable
Up a Level

Type: Integer

Saved in:Config

Initial value: 3

Sets object selection target height and width, in pixels.



> PICKDRAG System Variable
Up a Level

Type: Integer

Saved in:Config

Initial value: 0

Controls the method of drawing a selection window:

0 Draws the selection window by clicking the mouse or digitizer at one corner and then at the other corner.

1 Draws the selection window by clicking at one corner, holding down the mouse or digitizer button, dragging, and 
releasing the mouse or digitizer button at the other corner.



> PICKFIRST System Variable
Up a Level

Type: Integer

Saved in:Config

Initial value: 1

Controls the method of object selection so that you can also select objects first and then use an edit or inquiry command.

0 Turns off PICKFIRST.

1 Turns on PICKFIRST.



> PLINEGEN System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Sets the linetype pattern generation around the vertices of a 2D polyline. Does not apply to polylines with tapered segments.

0 Polylines are generated to start and end with a dash at each vertex.

1 Generates the linetype in an uninterrupted pattern across the vertices of the polyline.



> PLINEWID System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 0.0000

Stores the default polyline width.



> PLOTID System Variable
Up a Level

Type: String

Saved in:Config

Initial value: ""

Changes the default plotter, based on its assigned description, and retains the text string of the current plotter description. 
Change to another configured plotter by entering its full or partial description.

Applications can use PLOTTER to step through the available plotter descriptions retained by PLOTID and thus control the 
default plotter.



> PLOTROTMODE System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 1

Controls the orientation of plots.

0 Rotates the effective plotting area so that the corner with the Rotation icon aligns with the paper at the lower-left for
0, top-left for 90, top-right for 180, and lower-right for 270.

1 Aligns the lower-left corner of the effective plotting area with the lower-left corner of the paper.



> PLOTTER System Variable
Up a Level

Type: Integer

Saved in:Config

Initial value: 0

Changes the default plotter, based on its assigned integer, and retains an integer number that AutoCAD LT assigns for each 
configured plotter. This number can be in the range of 0 up to the number of configured plotters. You may configure up to 29 
plotters. Change to another configured plotter by entering its valid, assigned number. For example, if you configured four 
plotters, the valid numbers are 0 through 3.

Note: AutoCAD LT does not permanently assign a number to a given plotter. If you delete a plotter configuration, AutoCAD 
LT assigns new numbers to each of the configured plotters. AutoCAD LT also updates the value of PLOTTER.

Applications can use PLOTTER to step through the available plotter descriptions retained by PLOTID and thus control the 
default plotter.



> POLYSIDES System Variable
Up a Level

Type: Integer

Saved in:Not saved

Initial value: 4

Sets the default number of sides for POLYGON. The range is 3-1024.



> PROJMODE System Variable
Up a Level

Type: Integer

Saved in:Config

Initial value: 1

Sets the current Projection mode for trim or extend operations.

0 True 3D mode (no projection)

1 Project to the XY plane of the current UCS

2 Project to the current view plane



> PSLTSCALE System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 1

Controls paper space linetype scaling for non-continuous linetypes.

0 No special linetype scaling. Linetype dash lengths are based on the drawing units of the space (model or paper) in 
which the objects were created, scaled by the global LTSCALE factor.

1 Viewport scaling governs linetype scaling. If TILEMODE is set to 0, dash lengths are based on paper space 
drawing units, even for objects in model space. In this mode, viewports can have varying magnifications, yet 
display linetypes identically. For a specific linetype, the dash lengths of a line in a viewport are the same as the 
dash lengths of a line in paper space. You can still control the dash lengths with LTSCALE and CELTSCALE.

When you change PSLTSCALE or use a command such as ZOOM with PSLTSCALE set to 1, objects in viewports are not 
automatically regenerated with the new linetype scale. Use the REGEN command to update the linetype scales in each 
viewport.



PSPROLOG System Variable
Up a Level

Type: String

Saved in:Config

Initial value: ""

Assigns a name for a prologue section to be read from the aclt.psf file when using PSOUT.



QTEXTMODE System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Controls Quick Text mode.

0 Turns off Quick Text mode; displays characters.

1 Turns on Quick Text mode; displays a box in place of text.



SAVEFILE System Variable
Up a Level

(Read-only)

Type: String

Saved in:Config

Initial Value: aclt.sv$

Stores current auto-save file name and directory path.



SAVENAME System Variable
Up a Level

(Read-only)

Type: String

Saved in:Not saved

Stores the file name and directory path of your current drawing after you save it.



SAVETIME System Variable
Up a Level

Type: Integer

Saved in:Config

Initial value: 0

Sets automatic save interval, in minutes.

    0 Turns off automatic save.

>0 Automatically saves the drawing at intervals specified by the nonzero integer.

The SAVETIME timer starts as soon as you make a change to a drawing. It is reset and restarted by a manual SAVE, 
SAVEAS, or QSAVE. The current drawing is saved to aclt.sv$.



SHADEDGE System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 3

Controls shading of edges in rendering.

0 Faces shaded, edges not highlighted

1 Faces shaded, edges drawn in background color

2 Faces not filled, edges in object color

3 Faces in object color, edges in background color



SHADEDGE System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 3

Controls shading of edges in rendering.

0 Faces shaded, edges not highlighted

1 Faces shaded, edges drawn in background color

2 Faces not filled, edges in object color

3 Faces in object color, edges in background color



SHADEDGE System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 3

Controls shading of edges in rendering.

0 Faces shaded, edges not highlighted

1 Faces shaded, edges drawn in background color

2 Faces not filled, edges in object color

3 Faces in object color, edges in background color



SHADEDGE System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 3

Controls shading of edges in rendering.

0 Faces shaded, edges not highlighted

1 Faces shaded, edges drawn in background color

2 Faces not filled, edges in object color

3 Faces in object color, edges in background color



SHADEDIF System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 70

Sets the ratio of diffuse reflective light to ambient light (in percent of diffuse reflective light).



SNAPANG System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 0

Sets snap/grid rotation angle for the current viewport relative to the current UCS.

Note: Changes to this variable are not reflected in the displayed grid until a redraw is performed. AutoCAD LT does not 
perform automatic redraws when variables are changed.



SNAPBASE System Variable
Up a Level

Type: 2D point

Saved in:Drawing

Initial value: 0.0000,0.0000

Sets the snap and grid origin point for the current viewport relative to the current UCS.

Note: Changes to this variable are not reflected in the displayed grid until a redraw is performed. AutoCAD LT does not 
perform automatic redraws when variables are changed.



SNAPISOPAIR System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Controls current isometric plane for the current viewport.

0 Left

1 Top

2 Right



> SNAPMODE System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Controls the Snap mode.

0 Snap off

1 Snap on for current viewport



> SNAPSTYL System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Sets snap style for current viewport.

0 Standard

1 Isometric



> SNAPUNIT System Variable
Up a Level

Type: 2D point

Saved in:Drawing

Initial value: Varies

Sets the X and Y snap spacing for the current viewport.

Note: Changes to this variable are not reflected in the displayed grid until a redraw or regen operation is performed. 
AutoCAD LT does not perform automatic redraws when variables are changed.



> SPLFRAME System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Controls display of spline-fit polylines.

0 Does not display the control polygon for spline fit polylines.

1 Displays the control polygon for spline-fit polylines.



> SPLINESEGS System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 8

Sets the number of line segments to be generated for each spline-fit polyline created by the PEDIT spline.



> SPLINETYPE System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 6

Sets the type of spline-fit polyline generated by PEDIT Spline.

5 Quadratic B-spline

6 Cubic B-spline



> SYSCODEPAGE System Variable
Up a Level

(Read-only)

Type: String

Saved in:Drawing

Indicates the system code page specified in aclt.xmx. Codes are as follows:

ascii dos860 dos932 iso8859-8

big5 dos861 iso8859-1 iso8859-9

dos437 dos863 iso8859-2 johab

dos850 dos864 iso8859-3 ksc5601

dos852 dos865 iso8859-4 mac-
roma
n

dos855 dos866 iso8859-6

dos857 dos869 iso8859-7

> TABMODE System Variable
Up a Level

Type: Integer

Saved in:Not saved

Initial value: 0

Controls the use of Tablet mode.

0 Turns off Tablet mode.

1 Turns on Tablet mode.



> TARGET System Variable
Up a Level

(Read-only)

Type: 3D point

Saved in:Drawing

Stores the location (in UCS coordinates) of the DVIEW target point for the current viewport.



> TDCREATE System Variable
Up a Level

(Read-only)

Type: Real

Saved in:Drawing

Stores the time and date the drawing was created.



> TDINDWG System Variable
Up a Level

(Read-only)

Type: Real

Saved in:Drawing

Stores the total editing time in a drawing.



> TDUPDATE System Variable
Up a Level

(Read-only)

Type: Real

Saved in:Drawing

Stores the time and date of last update/save.



> TDUSRTIMER System Variable
Up a Level

(Read-only)

Type: Real

Saved in:Drawing

Stores user elapsed timer.



> TEXTFILL System Variable
Up a Level

Type: Integer

Saved in:Config

Initial value: 0

Controls the filling of Bitstream, TrueType, and Adobe Type 1 fonts.

0 Displays text as outlines.

1 Displays text as filled images.



> TEXTFILL System Variable
Up a Level

Type: Integer

Saved in:Config

Initial value: 0

Controls the filling of Bitstream, TrueType, and Adobe Type 1 fonts.

0 Displays text as outlines.

1 Displays text as filled images.



> TEXTQLTY System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 50

Sets the resolution of Bitstream, TrueType, and Adobe Type 1 fonts. Lower values decrease resolution and increase display 
and plotting speed. Higher values increase resolution and decrease display and plotting speed. Valid values are 0 to 100.0.



> TEXTSIZE System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 0.2000

Sets the default height for new text objects drawn with the current text style (not used if the style has a fixed height).



> TEXTSTYLE System Variable
Up a Level

Type: String

Saved in:Drawing

Initial value: STANDARD

Stores the name of the current text style.



> THICKNESS System Variable
Up a Level

Type: Real

Saved in:Drawing

Initial value: 0.0000

Sets the current 3D thickness.



> TILEMODE System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 1

Controls access to paper space, as well as the behavior of AutoCAD LT viewports.

0 Turns on paper space and viewport objects (uses MVIEW). AutoCAD LT clears the graphics area and prompts you 
to create one or more viewports.

1 Turns on Auto CAD Release 10 Compatibility mode (uses VPORTS). AutoCAD LT returns to Tiled Viewport mode, 
restoring the most recently active tiled-viewport configuration. Paper space objects -- including viewport objects -- 
are not displayed, and the MVIEW, MSPACE, PSPACE, and VPLAYER commands are turned off.



> TOOLTIPS System Variable
Up a Level

Type: Integer

Saved in:Config

Initial value: 1

Controls the display of ToolTips.

0 Turns off display of ToolTips.

1 Turns on display of ToolTips.



> TRIMMODE System Variable
Up a Level

Type: Integer

Saved in:Config

Initial value: 1

Controls whether AutoCAD LT trims selected edges for chamfers and fillets.

0 Leaves selected edges intact.

1 Trims selected edges to the endpoints of chamfer lines and fillet arcs.



> UCSICON System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Displays the Coordinate System icon using bit-code for the current viewport. It is the sum of the following:

1 On; icon display is turned on.

2 Origin; if icon display is turned on, the icon floats to the UCS origin if possible.



> UCSNAME System Variable
Up a Level

(Read-only)

Type: String

Saved in:Drawing

Initial value: “”

Stores the name of the current coordinate system for the current space. Returns a null string if the current UCS is unnamed.



> UCSORG System Variable
Up a Level

(Read-only)

Type: 3D point

Saved in:Drawing

Initial value: 0.0000,0.0000,0.0000

Stores the origin point of the current user coordinate system for the current space. This value is always returned in World 
coordinates.



> UCSXDIR System Variable
Up a Level

(Read-only)

Type: 3D point

Saved in:Drawing

Stores the X direction of the current UCS for the current space.



> UCSYDIR System Variable
Up a Level

(Read-only)

Type: 3D point

Saved in:Drawing

Stores the Y direction of the current UCS for the current space.



> UNITMODE System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Controls the units display format.

0 Displays fractional, feet-and-inches, and surveyor's angles as previously set.

1 Displays fractional, feet-and-inches, and surveyor's angles in input format.



> VIEWCTR System Variable
Up a Level

(Read-only)

Type: 3D point

Saved in:Drawing

Stores the center of view in the current viewport, expressed in UCS coordinates.



> VIEWDIR System Variable
Up a Level

(Read-only)

Type: 3D vector

Saved in:Drawing

Initial value: 0.0000,0.0000,1.0000

Stores the viewing direction in the current viewport expressed in UCS coordinates. This describes the camera point as a 3D 
offset from the target point.



> VIEWMODE System Variable
Up a Level

(Read-only)

Type: Integer

Saved in:Drawing

Controls Viewing mode for the current viewport using bit-code. The value is the sum of the following bit values:

0 Turned off.

1 Perspective view active.

2 Front clipping on.

4 Back clipping on.

8 UCS Follow mode on.

16 Front clip not at eye. If on, the front clip distance (FRONTZ) determines the front clipping plane. If off, FRONTZ is 
ignored, and the front clipping plane is set to pass through the camera point (vectors behind the camera are not 
displayed). This flag is ignored if the front clipping bit (2) is off.



> VIEWSIZE System Variable
Up a Level

(Read-only)

Type: Real

Saved in:Drawing

Initial value: Varies

Stores height of view in current viewport, expressed in drawing units.



> VIEWTWIST System Variable
Up a Level

(Read-only)

Type: Real

Saved in:Drawing

Initial value: 0

Stores view twist angle for the current viewport.



> VISRETAIN System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 0

Controls visibility of layers in xref files.

0 The xref layer definition in the current drawing takes precedence over these settings: On/Off, Freeze/Thaw, color, 
and linetype settings for xref-dependent layers.

1 On/Off, Freeze/Thaw, color, and linetype settings for xref-dependent layers take precedence over the xref layer 
definition in the current drawing.



> VSMAX System Variable
Up a Level

(Read-only)

Type: 3D point

Saved in:Drawing

Stores the upper-right corner of the current viewport's virtual screen, expressed in UCS coordinates.



> VSMIN System Variable
Up a Level

(Read-only)

Type: 3D point

Saved in:Drawing

Stores the lower-left corner of the current viewport virtual screen, expressed in UCS coordinates.



> WORLDVIEW System Variable
Up a Level

Type: Integer

Saved in:Drawing

Initial value: 1

Controls whether UCS changes to WCS during DVIEW or VPOINT.

0 Current UCS remains unchanged.

1 Current UCS is changed to the WCS for the duration of DVIEW or VPOINT. DVIEW and VPOINT command input is
relative to the current UCS.



> XREFCTL System Variable
Up a Level

Type: Integer

Saved in:Config

Initial value: 0

Controls whether AutoCAD LT writes .xlg files (external reference log files).

0 Xref log (.xlg) files are not written.

1 Xref log (.xlg) files are written.



What’s New    
Choose any of the selections to learn more about what’s new in AutoCAD LT for Windows 
95.

Compatibility
Windows 95 Features
Ease of Use
Text Features
Dimensioning
Linetypes
Drawing
Editing
Geometry
User Interface
Customization
Learning Aids



COMPATIBILITY

AutoCAD Release 13
AutoCAD LT drawings are compatible with AutoCAD Release 13 drawings. You can open and edit AutoCAD Release 
13 drawing files in AutoCAD LT for Windows 95 and vice versa.

AutoCAD LT for Windows 3.1 Drawing Files
You can open and edit drawing files that are compatible with previous releases of AutoCAD LT, AutoCAD Release 11, 
and AutoCAD Release 12. For more information, see “Sharing Drawings with AutoCAD,” in chapter 17 of the 
AutoCAD LT User’s Guide.



WINDOWS 95 FEATURES

OLE 2.0 Object and Container
With AutoCAD LT you can use object linking and embedding (OLE): that is, you can link or embed OLE objects from 
other applications into AutoCAD LT drawings, and you can also link and embed AutoCAD LT objects into other 
applications that support OLE.

Long File Names
File names are no longer limited to eight characters. AutoCAD LT supports long file names that have up to 256 
characters, including spaces.

Electronic Mail
You can send drawing files by electronic mail that are MAPI-compliant from within AutoCAD LT to your clients or 
colleagues. 

Universal Naming Convention
You can use universal naming conventions path names to network drives and devices: you can specify a drawing 
name on a network by the network server name and path without referencing a drive letter.

Windows NT 3.51 Compatibility
You can use AutoCAD LT on computers running Windows NT 3.51.

Microsoft Office 95 Compatibility
The organization of menus and toolbar buttons is similar to other Microsoft Office productivity applications, such as 
Microsoft Word, Excel, and PowerPoint. Accelerator key combinations, ToolTips, and toolbar icon sizes and colors 
also conform to Microsoft Office 95 standards.



EASE OF USE

Create New Drawing Dialog Box
The easy-to-use Create New Drawing dialog box helps you open new drawings. With the Create New Drawing dialog 
box, you can choose how to start your drawings from three methods: Use a Wizard, Use a Template, or Start from 
Scratch. For more information, see NEW in the online “Command Reference.”

Property Painter
With the new Property Painter feature, you can transfer properties such as color, linetype, layer, text style, and 
dimension from one selected object in a drawing to other objects. For more information, see PAINTER in the online 
“Command Reference.”

WinTab Digitizer Support
Digitizing devices with WinTab drivers are supported. You can accurately trace paper drawings, converting them into
electronic format, or you can use the digitizing tablet menu and menu overlay for fast access to AutoCAD LT 
commands. For more information, see appendix H, “Using Digitizers” in the AutoCAD LT User’s Guide.

Text Style Dialog Box
You can create and modify text styles with the new Text Style dialog box, which provides a graphical area for 
previewing changes. For more information, see DDSTYLE in the online “Command Reference.”



TEXT FEATURES

Paragraph Text Objects
You can create paragraph text objects, that is, multiple lines of text as a single object. You also can import 
paragraphs of text from other applications. For more information, see MTEXT in the online “Command Reference.”

Spelling Verification and Correction
You can use the new spelling checker to correct mistakes in single words or an entire drawing. You can use both 
standard and custom dictionaries. For more information, see SPELL in the online “Command Reference.”

TrueType Fonts
You can use TrueType fonts. AutoCAD LT includes a dozen special hand-lettered and engineering style TrueType font 
families. For more information, see “TrueType Fonts” in appendix D and “Font Mapping and MTEXT” in chapter 18 of 
the AutoCAD LT User’s Guide.



DIMENSIONING

Dimension Style Management
Each dimension is associated with a dimension style so that you can manage them easily. For more information, see
DDIM in the online “Command Reference.”

Access to Dimension Properties
You can use the redesigned Dimension Styles dialog box for convenient visual confirmation of many dimension style
settings, including arrowheads, text alignment, text justification, and center mark styles. For more information, see 
“Creating Dimension Styles” in chapter 13 of the AutoCAD LT User’s Guide.

Dimension Commands
You can create vertical and horizontal dimensions by inference: that is, once you specify a point or object, AutoCAD 
LT automatically infers the type of dimension (horizontal or vertical) from the direction in which you drag the 
pointing device. For more information, see DIMLINEAR in the online “Command Reference.”

Geometric Dimensioning and Tolerancing
AutoCAD LT supports geometric dimensioning and tolerancing symbology, which is compliant with ANSI standards. 
For more information, see TOLERANCE in the online “Command Reference.”

Leader Objects
Leaders are now unified compound objects comprised of multiple lines of text, leader lines of straight lines or 
splines, and an arrowhead. For more information, see LEADER in the online “Command Reference.”



LINETYPES

Linetype Scaling
You can change the scale of an object’s linetype without having to change the linetype style. For example, you can 
set the linetype scale of a dashed linetype to be 0.5 on one object and 2 on another.

Complex Linetypes
Linetypes can use symbols other than dashes, dots, and spaces. You can add text characters or custom shapes to a 
linetype.

For more Information, see chapter 20, “Customizing Linetypes and Hatch Patterns,” in the AutoCAD LT User’s Guide.



DRAWING

Locating Points
The new FROM command establishes a temporary reference, or base point, from which you can specify an offset to 
determine the next point. As a result, you can locate points that are not physical features on existing geometry. For 
more information, see FROM in the online “Command Reference.”
The Intersection object snap has been enhanced to find the location where two objects would intersect if extended.

Tracking
Tracking has been enhanced to work in conjunction with the Ortho mode setting. For more information, see 
TRACKING in the online “Command Reference.”

Overlays
If you need to share data between multidiscipline work groups, a new type of external reference (xref) is available. 
You can use xref overlays to exclude nested references to other drawings. For more information, see XREF in the 
online “Command Reference.”



EDITING

Trim and Extend Commands
The Trim and Extend features can trim or extend objects to an implied boundary. Both features allow geometry to 
be projected to an extrapolated intersection. For more information, see TRIM and EXTEND in the online “Command 
Reference.”

Fillet and Chamfer Commands
Fillet and chamfer operations can be performed with or without trimming the corner. Also, chamfers can be set by 
length and angle. For more information, see FILLET and CHAMFER in the online “Command Reference.”

Lengthen Command
You can change the length of existing lines, arcs, polylines, and splines by dragging the objects, by specifying a 
desired percentage change, or by entering a new relative or absolute length. For more information, see LENGTHEN 
in the online “Command Reference.”

Object Selection Cycling
By holding down CTRL and repeatedly pressing the pick button on your pointing device, you can highlight and cycle 
through all objects that appear within the pick box before selecting an object. For more information, see “Editing 
Objects” in chapter 9 of the AutoCAD LT User’s Guide.

Purge at Any Time
You can purge unused layers, linetypes, blocks, text styles, or dimension styles at any time during the drawing 
session.



GEOMETRY

Construction Lines
Two new construction line objects are available: xlines and rays. Xlines are unbounded in both directions, that is, 
they extend to infinity and can be used as a reference for creating other objects. Rays are similar, except that they 
have a start point and are unbounded only in one direction. For more information, see XLINE and RAY in the online 
“Command Reference.”

NURBS Curves
The new spline object, true ellipses, and elliptical arcs take advantage of the NURBS (Non-Uniform Rational B-
Spline) curves in AutoCAD LT. These curves smoothly pass through and between sets of control points. For more 
information, see SPLINE in the online “Command Reference.”

Exploding Non-uniformly Scaled Blocks
You now can explode blocks that are inserted with different X and Y scale factors.



+ USER INTERFACE

Toolbars and Flyouts
Related tools and commands are grouped into toolbars that can be easily displayed or hidden at any time. All 
toolbars can be easily resized and displayed as either “floating” on the screen or “docked” to any edge of the 
drawing window.

Enhanced Layer and Linetype Control
The new Object Properties toolbar contains new controls for layers and linetypes. The new layer control display 
shows the status of all layers and allows layers to be quickly locked or unlocked, frozen or thawed, and turned on or 
off.    The new linetype control displays an example and name of the current linetype, enabling you to change 
linetypes quickly.

Status Bar
The new status bar is at the bottom of the screen and displays coordinate data, keeps track of snap, grid, ortho, and
object snap settings, paper space and model space settings, and the current time. Double-clicking a button turns 
the function on or off. Also a description is displayed when the cursor passes over a toolbar icon or menu item.

Command Line Window
The command line window supports the Windows Clipboard, and enables you to cut and paste from the command 
history. The command line window also can be dynamically resized, docked at the top or bottom of the screen, or 
left floating over the drawing.

Preview Drawings 
A preview window in the new Open File dialog box displays the preview image of drawings before you open them. In
addition, a browse feature displays “thumbnail” images of all drawings in a selected directory.

Drawing Window Scroll Bars
With horizontal and vertical scroll bars, you can pan easily in the graphics area.
For more information, see “Touring the Interface” in chapter 2 of the AutoCAD LT User’s Guide.

Real-Time Pan and Zoom
You can pan and zoom with continuous visual feedback using your pointing device.
For more information, see RTPAN and RTZOOM in the online “Command Reference.”

Multiple AutoCAD LT Sessions
You can run several sessions of AutoCAD LT simultaneously, limited only by your system resources. With several 
sessions, you can compare drawings, cut and paste between drawings, and print or plot in one session while 
drawing in another.



CUSTOMIZATION

Customizable Toolbars
You can create an unlimited number of toolbars and button flyouts. You can rearrange tool groupings or create new 
ones with the Customize Toolbars dialog box. You can drag and drop tool icons from one location to another. You can
edit button images on screen and customize button macros to perform one or more commands. For more 
information, see “Customizing Toolbars” in chapter 19 of the AutoCAD LT User’s Guide.

Customizable Accelerator Keys
You can now define accelerator key shortcuts that use CTRL and SHIFT in combination with other alphanumeric or 
special function keys.

Partial Menu Loading
Menu lists can be added or removed from the current menu, individually, without having to load an entire menu file.
For more information, see Customizing Menus.



LEARNING AIDS

Online Conceptual and Procedural Information 
Dozens of new concept and how-to topics help you learn AutoCAD LT. These topics provide the background needed 
to understand the concepts and procedures for the most common computer-aided drafting operations. You can 
browse this online conceptual and procedural information in the AutoCAD LT Help system, under the topics 
“Concepts” and “How to.”



Overview: Customizing menus

By customizing your menus, you can improve your productivity: you can automate a complex task that requires multiple 
steps by adding it to your menu as a single option. These topics describe how to create custom menus to complement those
supplied with AutoCAD LT. 

To customize menus, you should be familiar enough with AutoCAD LT to know which commands are required to complete 
the task you want to accomplish.

Although the syntax for menu macros is not complicated and programming experience is not required, you use programming
principles to customize menus. For example, you might first create an outline of what you want your menus to do. Then, 
customizing the menus requires that you test and fix them afterward, as you would when debugging a program.

Before modifying the menu files, make a copy of them under a different name so that you can restore them later, if 
necessary. 

To learn more about customizing menus, see the following topics.

Menu Files
Menu File Structure
Menu Item Syntax
Button (AUX  n  ) Menus  
Pull-Down and Cursor (POP  n  ) Menus  
Image Tile (ICON) Menus
Tablet Menus
Toolbars
Accelerator Keys
DIESEL  —  String Expression Language  



Overview: Menu files
Up a Level

Menus are defined by ASCII files with an .mnu extension. You can modify an existing menu file (such as aclt.mnu) or create 
your own. By editing the text in a menu file, you can control the appearance and location of menu items. You can then 
assign menu macros that execute specific actions when a menu item is chosen.

Menu macros can be simple recordings of keystrokes that accomplish a task, or they can be a complex combination of 
commands and DIESEL (Direct Interpretively Evaluated String Expression Language) programming code. More complex 
menu macros have some decision-making ability and can pause for interactive input.

A menu file is a text file containing the AutoCAD LT command strings and menu syntax that define the menu labels and 
menu macros. AutoCAD LT uses the menu file aclt.mnu as its default menu. 

AutoCAD LT supports the following menu types.

Pointing-device button menus
Pull-down and cursor menus
Toolbars
Keyboard accelerators
Help strings and ToolTips
Menu groups
Image tile menus

To learn more about using menu files, see Loading Menu Files and Loading and Unloading Partial Menus.



Loading Menu Files
Up a Level

AutoCAD LT stores the name of the current menu files without the extension in the Partial Menus section of the aclt.ini file. 
The default menu name is ACLT. 

The following table lists the files used by AutoCAD LT for each menu.

Menu file extension Description

.mnu Menu template file that contains menu definitions and comments; generally used for reference

.mnc Compiled binary menu file that contains the command strings and menu syntax that define the 
functionality and appearance of the menu

.mnr Menu binary resource file that contains the bitmaps used by the menu

.mns Source menu file that can be customized by TBCONFIG or by using a text editor

AutoCAD LT tracks the last menu used and loads the first corresponding MNU, MNC, MNR, or MNS file it finds in the search
path. If no menu file is found, AutoCAD LT displays an error message and loads an internally generated menu with short 
versions of the File, Edit, and Help pull-down menus.

AutoCAD LT searches for menu files in the following order: (1) the current (working) directory; (2) directories specified as 
support directories on the System File tab in the Preferences dialog box; and (3) the directory containing the aclt.exe file.

When AutoCAD LT generates the MNC file, it also creates an MNS file. This is an ASCII file that is initially the same as the 
MNU file (without comments or special formatting). The MNS file is modified by AutoCAD LT each time you make changes to
the contents of the menu file through the interface (such as modifying the contents of a toolbar). 

When AutoCAD LT is executed, it automatically loads the menu file named in the aclt.ini file. AutoCAD LT loads the menu file
according to the extension that's supplied with the file name as follows:

No extension (typical of the menu name set in the Preferences dialog box and stored in the aclt.ini file)—AutoCAD LT finds 
the more recent of the MNC-MNR file pair and the MNS file. If MNC and MNR files are more recent, no compilation is 
required. If the MNS is more recent, new MNC and MNR files are created. If no MNC, MNR, or MNS file is found, AutoCAD 
LT finds the MNU file, creates new MNS, MNC, and MNR files from it, and then loads the resulting MNC and MNR files.

MNS extension—The date and time of the MNS file is compared to the MNC and MNR files. If MNS is newer, new MNC and 
MNR files are created.

MNC extension (MNR is not a valid file extension if no MNC file exists)—The date and time of the MNS file is compared to 
the MNC and MNR files. If MNS is newer, new MNC and MNR files are created.

MNU extension—Usually a confirmation message that the MNS will be overwritten is displayed. The MNS file is loaded, 
compiled into MNC and MNR files, and a new MNS file is created. 

If no MNR file is found, toolbars are not displayed, and executing the VIEWTOOLBAR command causes AutoCAD LT to fail.

Although the initial positioning of the toolbars is defined in the MNU and MNS files, changes to the show/hide and 
docked/floating status or changes to the toolbar positions are recorded in the aclt.ini file. After an MNS file has been created,
it is used as the source for generating future MNC and MNR files. If you modify the MNU or MNS file, you must use the 
PREFERENCES command to load the MNU or MNS file explicitly so that AutoCAD LT will generate new menu files and your 
changes will be displayed.



Loading and Unloading Partial Menus
Up a Level

AutoCAD LT uses the concepts of base and partial menus. The base menu is the menu that is initially loaded with AutoCAD 
LT. In AutoCAD LT, this file is called aclt. The term base menu refers to a complete menu description and usually contains 
button, image, and other sections as well as the pull-down menu definitions found in the section labeled POPn. If there is an 
associated menu resource file (DLL), the resources in that file are loaded.

A partial menu is any menu that is loaded with the MENULOAD command. With the MENULOAD command, you load a 
partial menu and then add and rearrange the pull-down menus on the menu bar. This allows you to make effective use of 
multiple menus.

You can load partial menus and modify the menu bar with the MENULOAD Menu Customization dialog box in which multiple
partial menu files and specific base files work together. AutoCAD LT enforces strict MENUGROUP definitions; no two menus 
can define the same MENUGROUP. If you attempt to load a menu with a conflicting MENUGROUP, the MENULOAD request is 
cancelled. 

To load a partial menu

1 At the Command prompt, enter menuload.

2 In the Menu Customization dialog box on the Menu Groups tab, enter the name of the MNU, MNC, or MNS file you 
want to load under File Name. Then choose Load.

Use the Browse button if the file you want to load is not in the current directory or if you do not know the path name of 
the directory.

3 Choose Menu Bar.

4 Under Menu Groups, select the menu group name of the menu you loaded. Then choose Menu Bar.

5 On the Menu Bar tab under Menus, select the name of the pull-down menu you want to insert into the menu bar. 

6 On the Menu Bar tab under Menu Bar, select the pull-down menu name that you want to follow the new menu name.

7 Choose Insert.

You can also choose to remove one or all pull-down menus listed under Menu Bar by choosing Remove or Remove All.

8 Choose Close.

The MENUUNLOAD command unloads the partial menu from the base menu, which removes the pull-down menus from the
menu bar. You can also remove individual pull-down menus without unloading the entire menu group.

Note: When the system variable FILEDIA is set to 1, MENULOAD and MENUUNLOAD use the same dialog box. When 
FILEDIA is set to 0, the command line prompts are unique for each command

Frequent changes to the contents of a menu bar result in a poor user interface. It is not recommended that you change the 
state of the menu bar visually except on explicit requests made by the user. For example, if a user wants to unload an 
application, menus referenced specifically by that application could be removed as well.

The menu could also be completely reinitialized, removing all partial menus currently loaded, by executing the MENULOAD 
command and loading a new base menu file by checking Replace All in the Menu Customization dialog box. This procedure 
removes all partial menus as well as their associated tag definitions. 

To unload a partial menu

1 At the Command prompt, enter menuunload.

2 Under Menu Groups, select the menu file that contains the partial menus you want to delete from the POPn section. 

3 Choose Unload. Then choose Close.

The Partial Menus section that was added to the aclt.ini file is modified to reflect only the menu group (Group1, for 
example) that is currently loaded with AutoCAD LT.

You can also use a customized menu for some tasks while keeping the standard menu easily available. To load your custom



menu, on the File System tab of the Preferences dialog box, enter the custom menu name next to Menu File.

When you use MENULOAD or MENUUNLOAD to alter the loaded menus or customize the menu bar with Pop and Toolbar 
menus, the changes are saved to aclt.ini file. The next time you start up AutoCAD LT, the menus that were loaded last and 
the menu bar configuration are restored. You can load and unload up to 8 partial menus and up to 16 POPn menus.

The following is a sample portion of the aclt.ini file after a partial menu has been loaded using MENULOAD or after the 
support directory has been modified in the Preferences dialog box. The Data pull-down menu from the acadfull.mnu menu 
file has been inserted between the Tools and Dimensions pull-down menus on the AutoCAD LT menu bar.

[Partial Menus]
Group1=ACLT d:\program files\autocad lt\aclt
Group2=ACAD D:\r13w\support\acad
Group3=
Group4=
Group5=
Group6=
Group7=
Group8=
Pop1=ACLT pop1
Pop2=ACLT pop2
Pop3=ACLT pop3
Pop4=ACLT pop4
Pop5=ACLT pop5
Pop6=ACAD pop4—AutoCAD pull-down menu has been inserted here
Pop7=ACLT pop7
Pop8=ACLT pop8
Pop9=ACLT pop9
Pop10=ACLT pop10
Pop12=
Pop13=
Pop14=
Pop15=
Pop16=

The following is a sample portion of the aclt.ini file after a partial menu has been unloaded using MENUUNLOAD.

Group1=ACLT d:\program files\autocad lt\aclt
Group3=
Group4=
Group5=
Group6=
Group7=
Group8=
Pop1=ACLT pop1
Pop2=ACLT pop2
Pop3=ACLT pop3
Pop4=ACLT pop4
Pop5=ACLT pop5
Pop6=ACLT pop6
Pop7=ACLT pop7
Pop8=ACLT pop8
Pop9=ACLT pop9
Pop10=ACLT pop10
Pop11=ACLT pop11
Pop12=



Pop13=
Pop14=
Pop15=
Pop16=



Overview: Menu file structure
Up a Level

Menu files are divided into sections relating to specific menu areas, for example, the area that contains pull-down menus. 
Each section contains instructions for the appearance and function of menu selections. When a menu file is used, the 
appropriate sections load into the various menu areas.

Menu sections can contain submenus. Referencing submenus is a way to use a virtually unlimited number of menus. Each 
menu selection is made up of a menu label and a menu macro. Although menu macros are similar in structure and function, 
each section of a menu uses a special syntax for its menu labels. The combination of a menu label and a menu macro is 
called the menu item. 

To learn more about menu file structure, see Menu Sections, IMAGE and TOOLBAR Submenus, and Submenu Aliases.



Menu Sections
Up a Level

A menu file is not required to contain entries for every menu section. You can experiment with each section independently 
and add only entries that pertain to your application. 

Menu file sections are identified by section labels. Each section belongs to a different menu area and contains command 
strings targeted for that area. The following table lists the section labels.

Section label Description

***BUTTONSn Pointing-device button menu (where n is a number from 1 to 4)

***AUXn Auxiliary device menu (where n is a number from 1 to 4)

***POPn Pull-down/cursor menu areas (where n is a number from 0 to 16) 
***TABLETn Tablet menu area (where n is a number from 1 to 4)

***MENUGROUP= Alias for this menu file (defaults to full file name if alias is omitted)

***TOOLBARS Toolbar definitions

***HELPSTRINGS User interface descriptions that appear on the status bar

***ACCELERATORS Accelerator key definitions

Each label specifies that subsequent menu items, up to the next section label or the end of the file, belong to a specific 
menu area. 

Following is a short menu file with three sections:

***AUX1
;
***AUX2
erase l;;
***POP1
[draw]
line
circle

In the example, item ; (semicolon) belongs to the AUX1 section, item erase 1;; belongs to the AUX2 section, and items 
[draw], line, and circle belong to the POP1 section.

Each of these menus requires a ***label in which label is an unbroken string made up of the proper keyword indicating 
which type of menu it is (such as ***BUTTONS, ***AUX, ***POP, ***TABLET) followed by any additional text you wish.

Note: The use of text characters following the keyword is not guaranteed to work in future releases of AutoCAD LT. To 
ensure compatibility, you should use only index numbers after the keyword. So, even though labels such as 
***AUXTEST, ***BUTTONS1-2, and ***TABLET3ALT1 are all valid, labels such as ***AUX10 or ***BUTTONS15 
are preferred for their long-term compatibility.



IMAGE and TOOLBAR Submenus
Up a Level

A menu section can be very large, containing more items than there is space in which to place them on the screen. 
Submenus are smaller groups of menu items that can be activated and made available for selection by the user.

A submenu label indicates the beginning of a submenu. Submenu labels have the following form:

**menuname

where menuname is a string of up to 33 characters containing letters, digits, and the dollar sign ($), hyphen (-), and 
underscore (_) characters. The submenu label must reside on a menu file line by itself and must not contain embedded 
blanks. 

Menu items that immediately follow a submenu label, up to the next label or to the end of the file, belong to that submenu 
label. Submenu names defined on consecutive lines refer to the next set of menu items. You can use these submenu names
to create submenus with aliases.

A submenu can contain any number of items, but each menu area has a limited number of accessible items (due to the 
screen size). For example, if a button submenu has three items but you are using a two-button mouse, the last item in the 
submenu is inaccessible.

Use the following format as a menu item to activate or deactivate another submenu. 

$section=submenu 

where

$ Instructs AutoCAD LT to load a menu section. The $M= command is a special case that enables a menu item 
to call (get information supplied by) a DIESEL string macro (for more information, see DIESEL Expressions in 
Menus). 

section Specifies the menu section; valid names are
T1 - T4 for the tablet menu
B1 - B4 for the button menu
P0 - P16 for POP menus 0 through 16
I for the ICON menu
A1 - A4 for AUX menus 1 through 4

submenu Specifies which submenu to activate. The name must be a submenu label (without double asterisks **) in the 
currently loaded menu file or a menu section name as defined earlier. A single asterisk (*) specifies the current
menu.

Before a submenu is activated, the currently activated menu items in the section are copied (or pushed) onto a stack. For 
example, if a menu item issues the following command the active screen items are pushed onto the screen stack, and the 
items of the submenu labeled **PARTS are activated. 

$S=PARTS

To restore the previous screen items, a menu item must issue the following command without a submenu label.

$S=

This command removes (pops) the last pushed items off the stack, reactivating them. You can have up to eight nested 
submenu calls. If you exceed eight, the first menus that you have pushed are “forgotten.”

The submenu mechanism can be activated in the middle of a command without interrupting it. For example, the following 
menu macros have the same result. 

$P1=ARCSTUFF ARC



ARC $P1=ARCSTUFF 

Each one starts the ARC command, switches to the ARCSTUFF POP1 submenu, and awaits entry of arc parameters. A 
space must follow the submenu reference to separate it from subsequent commands in the menu item. 



Submenu Aliases
Up a Level

Due to a change from previous releases of AutoCAD LT, the BUTTON, AUX, POP and TABLET sections use only a 
***label to indicate full menus, and use the **label syntax indicating aliases to a given *** menu. Each of these 
menus requires ***label, in which label is an unbroken string made up of the proper keyword to indicate which type of 
menu it is (such as ***BUTTONS, ***AUX, ***POP, ***TABLET) followed by any additional text you wish.

Note: The use of text characters following the keyword is not guaranteed to work in future releases. To ensure compatibility, 
you should use only index numbers after the keyword. So, even though labels such as ***AUXTEST, ***BUTTONS1-
2, and ***TABLET3ALT1 are all valid, labels such as ***AUX10 or ***BUTTONS15 are preferred for their long-term 
compatibility.

The **label lines must come between the ***label line and the first menu macro line for that menu. The alias label 
string can be any string—it does not need to contain any keyword. You may have as many aliases as you like for each 
submenu. However, it is recommended that you keep them to a minimum to save system resources. The alias label 
strings, as well as the menu type label (those associated with the ***), may be used to identify the menu for swapping 
purposes. For example, in the following menu any of the labels BUTTONS1, alias1, or alias2 can be used as a 
designator for the following menu. 

MENUGROUP=test
***BUTTONS1
**alias1
**alias2
;
^C

Therefore, the following lines all swap in the same menu.

$B1=test.buttons1
$B1=test.alias1
$B1=test.alias2

If you use the ** syntax to name subsequent menus, the ** is changed to *** in the MNS file. For example, when the 
following MNU file is loaded, it is converted to the MNS file as shown in the following examples.

MNU File Example

***AUX1
**alias1
circle

**sub2
line
**sub3
arc

MNS File Example

***AUX1
**alias1
circle

***sub2
line



***sub3
arc

The menu parser assumes that typos have been made and that **sub2 and **sub3 are intended. Of course, sub2 and 
sub3 can still be used as labels for swapping purposes.

You may have as many uniquely named ***BUTTONS, ***AUX, ***POP, and ***TABLET menus as you like in a given 
menu file. However, remember that each menu takes up memory and system resources. Excessive menus in a single menu 
file may require more resources than are available on some systems, leading to strange and unpredictable behavior.

It is strongly recommended that you split your menus up into several smaller menu files that can be loaded and unloaded on 
demand (with the MENULOAD command). Not only does this give you better control of your system resources, it also 
makes development and maintenance easier because you can work with smaller pieces as needed.



Overview: Menu item syntax
Up a Level

Each menu item can consist of a menu label and a menu macro. A menu item normally resides on one line of the file.

If you intend to include AutoCAD LT command sequences in a menu macro, you must know the order of parameters that the
command expects. Every character in a menu macro is significant, including blank spaces. As AutoCAD LT is revised and 
enhanced, the sequence of prompts for various commands (and sometimes the command names) can change. As a result, 
your custom menus might require minor changes when you upgrade to a new version of AutoCAD LT.

A simple command menu that performs one task could contain the following lines.

line
ZOOM W
GRID
ON
GRID ON
SNAP 0.001

When you select any of these items from the menu, the result is the same as entering them directly from the keyboard. For 
instance, selecting GRID and ON is the same as entering GRID ON or selecting the item that says GRID ON. 

You can use the $M= command within a menu item to introduce macro expressions written in DIESEL. Using DIESEL, you 
can perform a certain task depending on the current state or condition of some setting. AutoCAD LT evaluates the portion of 
the item following $M= and the result is used as the menu item. The format is

$M=expression 

where $M= prompts AutoCAD LT to evaluate the string that follows as a DIESEL expression, and expression is the 
DIESEL expression. The following is an example of a macro expression.

[FILLFLIP]FILLMODE $M=$(-,1,$(getvar,fillmode))

The FILLFLIP menu item turns FILLMODE on and off by subtracting the current value of FILLMODE from 1 and returning 
the resulting value to the FILLMODE setting. You can use this method to switch between the states of settings whose values
are 1 or 0.

If you use the DIESEL string language to perform if-then tests, conditions might exist that make the normal terminating 
space or semicolon (resulting in a carriage return ) undesirable. If you follow the menu item with ^Z, AutoCAD LT does not 
add RETURN to the end of the macro expression.

Note: As with other control characters in menu items, the ^Z used here is a string composed of a caret (^) and Z. Do not 
mistake it for CTRL+Z.

[X Coordinate]$M=$(if,(getvar,cmdactive),.x) )^Z

If these menu items did not end with ^Z, AutoCAD LT would append RETURN, unnecessarily reissuing the last command 
entered. 

For more information and examples, see Overview: DIESEL   –   string expression language  .

To learn more about menu item syntax, see

Menu Syntax Reference
Foreign Language Support in Menus
Long Menu Macros
Control Characters in Menu Macros
Command Cancellation
Echoes and Prompts



Menu Macro Repetition
Single Object Selection Mode



Menu Syntax Reference
Up a Level

The following table lists the special characters used in menu files for the IMAGE and TOOLBARS sections. 

Special menu characters

Character Description

*** Indicates section title 

** Indicates submenu section label or alias

[...] Encloses a label 

; Issues a carriage return
SPACEBAR Enters a blank space in a menu item equivalent to SPACEBAR
\ Pauses for user input 
_ Translates AutoCAD LT commands and keywords 

+ Continues menu macro to the next line (if last character) 
=* Displays the current image tile, pull-down, or cursor menu 

*^C^C Indicates a prefix for a repeating item 

$ Indicates a special character code to load a menu section or introduce a conditional DIESEL 
macro expression ($M=) 

^B Turns Snap mode on/off (CTRL+B) 
^D Turns coordinates on/off (CTRL+D) 
^E Sets the next isometric plane (CTRL+E) 
^G Turns Grid mode on/off (CTRL+G) 
^H Issues a backspace 

^O Turns Ortho mode on/off (CTRL+L) 
^P Turns menu echoing on/off 

^V Changes current viewport (CTRL+R) 
^Z Indicates null character; suppresses the automatic addition of SPACEBAR at the end of a menu 

item 

Note: The BUTTONS, AUX, POP, and TABLET sections use a different syntax. For these sections there are no submenus. 

Menu Item Labels
You can give a short title, or label, to an item in a pull-down, cursor, or image tile menu by enclosing the title in square 
brackets ([ ]) at the start of the line. 

Each type of menu handles labeling in a different way. Pull-down and cursor menus use many special labeling methods. Text
in square brackets at the beginning of a button menu is not displayed and is used only to embed comments in the menu file. 
For more information, see Display Control of Menu Item Labels and Using Image Tile Menu Syntax. 

Item Termination—Blanks or Semicolons
When a menu item is selected, AutoCAD LT places a blank after the macro before processing the command sequence. For 
example, AutoCAD LT processes the following menu item as though you had entered line followed by SPACEBAR:

LINE

Sometimes this processing is undesirable: for example, the TEXT or DIM command must be terminated by RETURN not a 



space. Also, it sometimes takes more than one space or RETURN to complete a command, but with some text editors, you 
cannot create a line with trailing blanks. Two special conventions overcome these problems:

When a semicolon (;) appears in a menu item, AutoCAD LT substitutes a RETURN.
If a line ends with a control character, a backslash (\), a plus sign (+), or a semicolon (;), AutoCAD LT does not add 

a blank after it. 

For example, study the ERASE 1 menu item in the following example.

[ERASE 1]erase \; 

If this item ended with a backslash (\), which indicates user input, it would fail to complete the Erase operation because 
AutoCAD LT does not add a blank after the backslash. Therefore, this menu item uses a semicolon to force a RETURN after
the user input, as shown in the following examples:

UCS
[UCSW]ucs ;
[Address]text \.4 0 DRAFT Inc;;;Main St.;;;City, State;

Selecting the first item enters ucs and a space at the Command prompt and displays the following prompt:

Origin/ZAxis/3point/Entity/View/X/Y/Z/Prev/Restore/Save/Del/?/<World>:

Selecting the second menu item enters ucs, a space, and ; (interpreted as RETURN ) at the Command prompt. This enters 
the UCS command and accepts the default value, World. This item has a title in brackets instead of only ucs ;.    This 
prevents the semicolon from being displayed and causes a more descriptive title to be displayed.

Selecting the third item displays a prompt for a starting point and then draws the address on three lines. With three 
semicolons (;;;), the first semicolon ends the text string, the second causes repetition of the TEXT command, and the third 
calls for the default placement below the previous line. 

Pauses for User Input 
Many command options prompt for user input, for example, an option may prompt a user for information that describes how 
an object should be drawn. If you include such a command option in your customized menus, you can accept input from the 
keyboard or pointing device in the middle of a menu item by placing a backslash (\) at the point where you want input.

[CIRCLE-1]circle \1
[LAYEROFF]layer off \;

CIRCLE-1 pauses to prompt the user for the center point and then reads a radius of 1 from the menu file. Note that there is 
no space after the backslash (\). With LAYEROFF, you can enter one layer name, turn that layer off, and exit the LAYER 
command. The LAYER command normally prompts for another operation and exits only if you press SPACEBAR (blank) or 
RETURN (;). 

Normally, the menu item resumes after one item is entered. Therefore, it is not possible to construct a menu item that 
accepts a variable number of entries (as in object selection) and then continues. However, an exception is made for the 
SELECT command, which prompts multiple times for object selection: a backslash suspends the menu item until the 
selection set is complete. For example, consider the following menu item:

[MAKE RED]select \change previous ;properties color red ;

This menu item uses the SELECT command to create a selection set of one or more entities. It then issues the CHANGE 
command, references this selection set using the Previous option, and changes the color of all selected objects to red.

Note: The backslash character causes a menu macro to pause for user input. Therefore, when specifying a path, use a 
forward slash (/) as the path delimiter, for example, /direct/file. A delimiter separates one string or word from the next 
string or word.

The execution of a menu macro may be delayed until certain user input is given, as shown in the following situations:

If input of a point is expected, object snap modes can precede entry of the actual point.



If X,Y,Z coordinate filters are used, the menu macro remains suspended until the entire point has been defined.
If the SELECT command is issued, the menu macro does not resume until the selection set is complete.
If the user responds with a transparent command, the suspended menu macro remains suspended until the 

transparent command is completed and the originally requested input is received.
If the user responds by choosing another menu item (to supply options or execute a transparent command), that 

macro is processed to completion before the suspended menu macro resumes.



International Language Support in Menus
Up a Level

If you develop menus to use with different language versions of AutoCAD LT, the standard AutoCAD LT commands and 
keywords are translated automatically if you precede each command or keyword with the underscore character ( _ ). The 
aclt.mnu file makes extensive use of this feature. 

The following example demonstrates the use of the underscore character with command names and options.

[->Arc]
 [3-point]^C^C_arc
 [Start, Cen, End]^C^C_arc;\_c
 [Start, Cen, Angle]^C^C_arc;\_c;\_a
 [Start, Cen, Length]^C^C_arc;\_c;\_l
 [Start, End, Angle]^C^C_arc;\_e;\_a
 [Start, End, Radius]^C^C_arc;\_e;\_r



Long Menu Macros
Up a Level

If a macro does not fit on one line, you can continue it on the next line by providing a plus sign (+) as the last character of the
line to be continued.

[SETUP ]layer set ground-floor;;grid on; ... ;fill off;+
limits 0,0 12,9;status

This macro, which you might use to set initial conditions for a new drawing, continues onto a second line. Menu macros can 
continue on as many lines as necessary. When menu source files are saved, menu macros are placed on single lines.



Control Characters in Menu Macros
Up a Level

You can place ASCII control characters in menu macros by entering a caret (^) followed by another character. For example, 
^H is converted to the single character issued by the keystrokes CTRL+H. The nonalphabetic control characters are

^@ (ASCII code 0, NULL)
^[ (ASCII code 27, Escape)
^\ (ASCII code 28, File separator)
^] (ASCII code 29, Group separator)
^^ (ASCII code 30, Record separator)
^_ (ASCII code 31, Unit separator)

You can use this technique to construct menu items that do such things as turn the grid on and off (^G) or cancel a 
command (^C):

[GridFlip]^G
[*Cancel*]^C

You might want a menu macro to enter one or more characters but not submit them as final input. For example, you could 
create a series of menu items to act as a numeric keypad:

[1]1x^H
[2]2x^H
[3]3x^H

When you pick one of these items, the appropriate digit is entered. Another character follows (the letter x in this case), and 
that character is removed by ^H. (CTRL+H is the ASCII code for a backspace.) Each of these menu macros ends with a 
control character, and AutoCAD LT does not add a space or a carriage return to such macros. Thus, you can pick [2], [2], [3],
[1], constructing the input 2231. To enter the completed number, press RETURN.

The above method is recommended; however, the following menu items perform the same function as described in the 
previous paragraph but with the backslash.

[1]1\ 
[2]2\ 
[3]3\ 

Although this method is easier to implement and in most cases produces the same result, a command issued while a menu 
pause is active might not function as expected.



Command Cancellation
Up a Level

You can cancel a command from the menu just as you can from the command line. To make sure you have no previous 
incomplete commands, use the string ^C^C in a menu macro. This is the same as pressing ESC twice. Although a single ^C 
cancels most commands, ^C^C is required to return to the Command prompt from a Dim prompt or a transparent command.
Therefore, ^C^C ensures that AutoCAD LT always returns to the Command prompt as shown in the following example.

[New...]^C^C_new



Echoes and Prompts
Up a Level

Normally, characters read from a menu macro are displayed in the command area of the screen exactly like keyboard input, 
and prompts are displayed even if a menu macro provides the responses. You can suppress character display by means of 
the MENUECHO system variable setting. If MENUECHO is turned off, a ^P in the menu macro turns echoing on.



Menu Macro Repetition
Up a Level

Once you select a command, you're likely to use it several times before moving on to another. To avoid having to enter the 
command each time, you can repeat commands by entering a SPACEBAR or a RETURN. However, you cannot specify 
command options.

Using the menu macro repetition feature, you can repeat frequently used commands until you choose another command. If 
a menu macro begins with *^C^C immediately following the menu label, the menu macro is saved in memory. Subsequent 
Command prompts are answered by that menu macro until it is terminated by pressing ESC or by selection of another menu
item.

Do not use ^C (cancel) within a menu macro that begins with the string *^C^C. It cancels the menu macro repetition.

Following is an example of the repetitive, or modal, approach to command handling.

**EDITM
[Move   ]*^C^CMOVE Single 
[Copy   ]*^C^CCOPY Single 
[Erase  ]*^C^CERASE Single 
[Stretch]*^C^CSTRETCH Single Crossing
[Rotate ]*^C^CROTATE Single

When chosen, each of these menu items calls the associated command, allows a single selection to be made, completes 
the command, and then issues the command again. 

Note: Menu macro repetition does not work for macros in image tile menus.



Single Object Selection Mode
Up a Level

Single-object selection mode limits selection within a command to a single object or set, disables the normal repetition 
conducted by object selection, and causes it to return the first object or objects selected by a subsequent option. This can be
useful in a menu because it automates the selection process without having to prompt for user input. For example, consider 
the following menu item:

[Erase]*^C^CERASE Single

This menu item terminates the current command and activates the ERASE command with the Single selection option. You 
either point to the single object to be erased or point to a blank area and drag a window (crossing to the left, enclosing to the
right) around the objects to be erased. The object or objects selected are erased, and the menu macro repeats (due to the 
leading asterisk) so that you can erase something else. Single selection mode leads to a more dynamic interaction with 
AutoCAD LT. 



Overview: Button menus
Up a Level

The AUXn and BUTTONSn sections of the menu file control the buttons on your pointing device. Each line in this section 
represents a button on your pointing device. The key and button sequences that follow provide access to the button menu 
shown in the table below. However, the Windows driver for your pointing device takes precedence over the key or button 
sequences shown.

Key/button sequence Menu section

button AUX1

SHIFT+button AUX2

CTRL+button AUX3 

CTRL+SHIFT+button AUX4 

Tablet pointing devices use the BUTTONSn menu sections except when the cursor is in the screen pointing area of the 
tablet. The operation of the tablet pointing device may vary depending on the tablet driver being used.

Creating or customizing button menus can make using the pointing device more efficient and dynamic. By adding menu 
macros to the button menus, you can personalize your pointing device to fit your needs.

Look at the AUX1 section of the aclt.mnu file:

***AUX1
;
$P0=POP0 $P=*
^C^C
$PO=*

The first line after the menu section label, ***AUX1, represents the next button after the pick button on your pointing device.
If the pick button is button number 1, the semicolon (;) assigns a carriage return to button number 2 on your pointing device. 
The second line after the menu section label represents the third button, and the next line represents the fourth button.

Note: You cannot reassign the pick button. The pick button may be different on each pointing device, depending on the 
manufacturer.

Because labels in button menus are not displayed, you can use them as comments. The following example uses the label 
area to note the button number.

***AUX1
[button no.2];
[button no.3]$P0=*
[button no.4]^C^C

The macro assigned to button number 3 in the previous example causes another menu to be displayed. It has the following 
format:

$Pn=* 

where

$ Loads a menu area

Pn Specifies the POPn menu area

=* Displays what is currently loaded to the specified menu area

Therefore, in the example from aclt.mnu, selecting button number 3 displays the menu assigned to the P0 menu area (the 
cursor menu). Typically, the ***POP0 section of the menu file is assigned to the P0 menu area. 



When you select a menu item with one of the menu buttons on a multibutton pointing device, AutoCAD LT receives not only 
the button number but also the coordinate of the screen crosshairs at the time you press the button. By carefully 
constructing the macros in the AUX2 section of the menu file, you can choose to ignore this coordinate or to use it in the 
command activated by the button.

As described earlier, you can include a backslash (\) in a menu macro to pause for user input. For the button menus, the 
coordinate of the screen crosshairs is supplied as user input when the button is pressed. This occurs only for the first 
backslash in the menu macro; if the macro contains no backslashes, the coordinate is not used.

For example, consider the following menu items:

***AUX2
line
line \ 

The first menu button issues the LINE command and the prompt From Point in the normal fashion. The second menu button 
also issues a LINE command; however, AutoCAD LT reads the current cursor location and uses it as the response to From 
Point. 

You can use bitmap resource DLLs to store the bitmaps used for TOOLBARS and POP menus. The DLL file name must be the
same as the menu file name it's associated with; the resources must be named, not index numbered; and the DLL file must 
be located in the same directory as the menu file that uses it.

To use these resources in the menu, use the appropriate resource names in the ID_SMALL and ID_BIG parameters for 
toolbar buttons and flyouts or in between the ^ symbols in the label brackets [] in a POP menu as shown in the following 
example:

ID_Sample [^bitmap-name^]^C^Cmycommand;



Overview: Pull-Down and Cursor (POPn) menus
Up a Level

The pull-down and cursor menus are displayed as cascading menus (also known as hierarchical menus). They provide a 
logical layout of menus without swapping menu areas. For more information about swapping, see Pull-Down Menu 
Swapping. The cursor menu can provide quick access to often-used menu items, such as object snaps. Pull-down and 
cursor menu items use the same rules and syntax as items in other menu sections.

Pull-down menus can contain up to 999 menu items. The cursor menu can contain up to 499 menu items. Both limits include
all menus in the hierarchy. If menu items in the menu file exceed these limits, AutoCAD LT ignores the extra items. If a pull-
down or cursor menu is longer than the available space on the AutoCAD LT window, it is truncated to fit.

Whereas pull-down menus always display menu options below the menu bar, the cursor menu is always displayed at or near
the crosshairs in the graphics area. The syntax for both these POPn menu sections is similar except that the cursor menu 
title is not included in the menu bar. The cursor title is not displayed at all (but you must still specify a dummy title). Access to
the cursor menu is through the $P0=* menu command, which can be issued by another menu macro (such as an AUXn 
menu item). While the cursor menu is active, the menu bar is not available.

Note: If no pull-down menus are defined (POP1-POP16), default pull-down menus File, Edit, and Help are created. To view 
them, use the PREFERENCES command and enter a null name for the menu file.

To learn more about pull-down and cursor (POPn) menus, see

Pull-Down and Cursor Menu Syntax
Long Menu Labels
Menu Bar Titles
Cascading Submenus
Separation of Menu Item Labels
Display Control of Menu Item Labels
Pull-Down Menu Swapping
Restrictions



Pull-Down and Cursor Menu Syntax
Up a Level

The ***POPn menu sections control the pull-down menus and the cursor menu. POP0 controls the cursor menu; POP1 
through POP16 control the pull-down menus for the menu bar.

AutoCAD LT scans for POPn menu sections while loading a menu file. For the POP1 through POP16 menu sections, it 
constructs a menu bar that contains the titles of those sections. 

The following table shows characters that have a special function when included in a pull-down or cursor menu label.

Special label characters

Character Description

-- Expands to become a separator line in the pull-down and cursor menus when used with no other characters 

+ Continues a macro to the next line if it is the last character 

-> Indicates the pull-down or cursor menu item has a submenu    

<- Indicates the pull-down or cursor menu item is the last in the submenu    

<-<- Indicates the pull-down or cursor menu item is the last in the submenu and terminates the parent menu (one 
<- is required to terminate each parent menu) 

$( Indicates that the pull-down or cursor menu item label can evaluate a DIESEL string macro, if "$(" are the first 
characters    

~ Makes a menu item unavailable 

!c Marks a menu item with the special (nonalphanumeric) character c where c    is the character to be displayed 
on the pull-down or cursor menus; the characters !. (exclamation point period) makes a check mark 

&c Specifies the menu accelerator key in a pull-down or cursor menu label    

The following example illustrates the syntax in the File menu.

**POP1
ID_File [&File] 
ID_New [&New...\tCtrl+N]^C^C_new
ID_Open [&Open...\tCtrl+O]^C^C_open
ID_Save [&Save\tCtrl+S]^C^C_qsave
ID_Saveas [Save &As...]^C^C_saveas

[--]
ID_Print [&Print...\tCtrl+P]^C^C_plot

[--]
ID_Import [&Import...]^C^C_import
ID_Export [&Export...]^C^C_export
ID_Slides [->S&lide]
ID_Sldsav [&Create...]^C^C_mslide
ID_Sldvie [<-&View...]^C^C_vslide

[--]
ID_Mngt [->&Management]
ID_Unlock [&Unlock Files...]^C^C_unlock
ID_Audit [&Audit]^C^C_audit
ID_Recov [<-&Recover...]^C^C_recover

[--]
ID_SendMail [Sen&d...]

[--]
ID_MRU [Drawing History]



[--]
ID_Exit [E&xit]^C^C_quit



Long Menu Labels
Up a Level

Each pull-down menu ordinarily is displayed directly beneath its menu bar title. However, the right-most menus shift to the 
left to accommodate long menu items. The maximum number of items in a pull-down menu is determined by the display 
device and may be as low as 21. Be sure to consider this restriction when designing custom menus. When a cursor menu is 
called from near the right side of the screen, the menu is displayed to the left to accommodate long menu items.



Menu Bar Titles
Up a Level

For pull-down menus, the first label defines the menu bar title; succeeding labels define menu and submenu items. On the 
first line after the ***POP1 section label, the label [File] causes File to appear as a menu bar title. The remaining menu 
item labels enclosed in square brackets, such as [Open...] appear as items on the File pull-down menu and its 
submenus.

Each title in the menu bar can be up to 14 characters long, but many monitors allow a maximum of 80 characters for the 
menu bar, so the average title length should be less than 5 characters if you're going to use all pull-down menu areas. Also, 
to avoid confusion, the titles should not contain embedded blanks. If not all titles fit in the menu bar, AutoCAD LT truncates 
characters from the longest title until they all fit. This can result in some odd titles, so you should attempt to fit everything into
80 columns.

If the first line of a menu section is blank (null), no title is displayed in the menu bar. With blank first lines, you can turn entire 
menu sections on and off with $Pn=xxx swap commands (for more information, see Referencing a Pull-Down or Cursor 
Submenu). However, note that menu titles are always displayed left-justified in the menu bar. If menu section POP3, for 
example, has no title, the titles for sections POP4 through POP16 shift to the left. Turning off a menu section might be 
confusing if it causes the menu to be displayed in a nonstandard way.



Cascading Submenus
Up a Level

Cascading submenus are menus that are displayed to one side of a particular menu item and provide more detailed 
information for that menu item. Pull-down and cursor menus use special characters (such as ->, <-, and <-<-...) to control the
hierarchy of cascading menus. These special characters identify submenus and last items in submenus. They can also 
terminate all parent, or top-level, menus. Each special-character string must be first in an item label.

-> Indicates this item has a submenu

For example, if you pull down the Edit (top-level) menu and choose the External Reference item, the External Reference 
(cascading) submenu is displayed.

<- Indicates this item is the last item in a submenu

<-<- Indicates this item is the last item of a submenu and also of its parent menu

The following example illustrates the use of these special characters to invoke cascading submenus.

[->/xExternal Reference]
ID_Xref [->E&xternal Reference]
ID_XreAtt [&Attach...]^C^C_xref _a
ID_XreBin [&Bind]^C^C_xref _b
ID_XreDet [&Detach]^C^C_xref _d
ID_XreRel [&Reload]^C^C_xref _r
ID_XrePat [&Change Path]^C^C_xref _p
ID_XreLis [&List...]^C^C_xref _?

[--]
ID_VisRet [Retain &Settings]'_visretain

[--]
[->B&ind Symbols]

ID_BinBlo [&Block]^C^C_xbind _b
ID_BinDim [&Dimension Style]^C^C_xbind _d
ID_BinLay [&Layer]^C^C_xbind _la
ID_BinLin [Li&netype]^C^C_xbind _lt
ID_BinTex [<-<-&Text Style]^C^C_xbind _s

[--]



Separation of Menu Item Labels
Up a Level

To create separator lines, use a label of two hyphens:

[--]

Because the longest label determines the width of each pull-down or cursor menu, the separator line automatically fills the 
entire width of the menu. You cannot choose separator lines from the menu, and any menu macro assigned to them is 
ignored.



Display Control of Menu Item Labels
Up a Level

You can control the way menu item labels are displayed in pull-down and cursor menus. You can disable the labels, making 
them appear grayed out and inaccessible to user selection, or you can mark them with a check or some other character. 

Labels can also contain DIESEL string expressions to modify the contents of the label. DIESEL expressions can disable, 
mark, or interactively change the text of the displayed label. To see how these expressions work, see DIESEL Expressions 
in Menus. 

Disabled and marked menu item labels may not remain synchronized with AutoCAD LT system variables. Menu items 
cannot determine whether you've bypassed the menu to change the setting of a system variable or have reloaded the menu 
since the system variable was changed. You might consider using these features only for applications that are accessed 
through the pull-down and/or cursor menus. You should provide a method of resetting the item labels to a known state.

Note: All activation of menu items is based on the location of the menu item in the menu file, not its final location on the 
menu bar or on a specific menu. 

Disabling Labels
Some menu items are not available when a menu is initially used until AutoCAD LT is put in a certain state based on user 
input. A menu item label that begins with a tilde (~) is unavailable to users: it is grayed out, indicating that the item is not a 
valid selection. Any commands associated with the item are not issued, and any submenus are inaccessible.

The following menu labels are grayed out.

[~Line]
[~->Pline]

The child menu—the menu invoked by another menu—of a grayed-out label is inaccessible.

Menu item labels can contain DIESEL string expressions that conditionally disable or enable labels each time they are 
displayed. The DIESEL string expression within the following menu item label disables the label while a command is active.

[$(if,$(getvar,cmdactive),~)MOVE]move

Marking Labels
You can place special characters in front of a menu item label to indicate the state of the function associated with that label. 
One use of these characters is to indicate whether a particular mode is on or off. For example, you can display a check mark
() by including an exclamation point and period (!.) or a specific special (nonalphanumeric) character by including an 
exclamation point and the character at the beginning of the menu item label. Marking a menu item does not affect your 
ability to choose the item, although a marked item can be grayed out.

The format for placing special characters in front of a menu item label is

[!c labeltext]

where

! Marks a menu item

c Specifies the special (nonalphanumeric) character to use as the mark 

labeltext Is the text of the menu item label

In the following example, the period means a check mark (), so the Line menu item is marked with a check mark.

[!.Line]

Menu item labels can contain DIESEL string expressions that conditionally mark labels each time they are displayed. 



The following code places a check mark to the left of menu labels that are currently turned on.

[$(if,$(getvar,orthomode),!.)Ortho]^O
[$(if,$(getvar,snapmode),!.)Snap]^B
[$(if,$(getvar,gridmode),!.)Grid]^G

Disabling and Marking Simultaneously
You can mark and gray-out menu items at the same time to indicate that certain functions are enabled but not currently 
available with the following format.

[~!c labeltext]  or  [!c~ labeltext]

where

~ Grays-out a menu item

! Marks a menu item

c Specifies the special (nonalphanumeric) character to use as the mark

labeltext Is the text of the menu item label

In the following example, the period means a check mark (), so the Line menu item is grayed out and marked with a check 
mark. As shown in the previous examples, a DIESEL expression can be used to simultaneously disable and mark a menu 
item label.

[~!.Line]

Referencing a Pull-Down or Cursor Submenu 

Using a method similar to that used to activate regular submenus, you can activate or deactivate a submenu by using 
$Pn=xxx. Variations specific to POPn menu sections are explained in this section and use the following format.

$Pn.i=xxx 

where 

$ Loads a menu section

Pn Specifies the POPn menu area

i Specifies the menu item number

xxx Specifies a string of grayed-out or mark characters 

The following example grays out menu POP3, item 4.

$P3.4=~ 

The following example adds a check mark to menu POP7, item 1.

$P7.1=!.

The following example removes any grayed-out or marked character from menu POP7, item 1.

$P7.1=

Menu items are referenced by their number so that they can be queried or set. Menu item numbering is consecutive without 
regard to the hierarchy of the menu file. Numbering is assigned according to the item's location in the menu section and is 
not based on the menu's appearance on the screen. Menu item numbering corresponds to its hierarchy when the menu has 
no submenus; however, when it has submenus, its numbering does not correspond to its hierarchy, as shown in the 



following example.

Menu Code

***POP4 
[Title]
[Item 1]
[Item 2]
[->Item 3]

[Item 4]
[Item 5]
[<-Item 6]

[Item 7]
[Item 8]

On-Screen Appearance

-------------------

          Title

-------------------

        Item 1

        Item 2

        Item 3        >

        Item 7

        Item 8

-------------------

To make it easy for an item to address itself without regard to location in the menu hierarchy, the following forms are also 
allowed:

$P@.@=xxx References the current or most recently selected menu item.

$P@.n=xxx References item n in the current or most recently chosen menu.



Pull-Down Menu Swapping
Up a Level

Menu swapping is the ability to activate one menu directly from another menu. Menu swapping is supported for the following
menu sections:

BUTTONS 
AUX 
POP 
IMAGE 
TABLET 

Because AutoCAD LT has cascading pull-down menus, there is little need to swap menus. Also, swapping menus can 
detract from the consistency of the user interface. However, using $ commands, you can swap pull-down menus and 
submenus. 

For menu-swapping purposes, the pull-down menu areas are named P1 through P16. The title that appears in the menu bar 
is the title from the first line of the menu section, so you can change the title by replacing that line of the menu with a $Pn= 
command. You can use the special command $Pn=* from within any menu item to force the menu currently assigned to 
area POPn to pull down on the screen for greater flexibility of pointing device movement.

The syntax for the swapping of partial menus is as follows:

$<section>=<menugroup>.<menuname> 

where

<section> B1-4, A1-4, P1-16,or T1-4

<menugroup> Menu group name in the menu file desired

<menuname> Main label or alias for the section (for an explanation of labels and aliases, see the following section)

To control toolbars across partial menus, use the following syntax at the Toolbar name prompt of the TOOLBAR command.

<menugroup>.<subsection-name>

This syntax accesses the toolbar identified by <menugroup>. <menuname> and allows you to use the full spectrum of 
TOOLBAR command options on that toolbar.

If <menugroup> is left out of any of these commands and/or functions, then AutoCAD LT defaults to the base menu. 

Note: The swapping of POP menus does not conform to the Microsoft user interface guidelines and is not guaranteed to be 
available in future releases of AutoCAD LT.

You should be aware of the following:

It is not possible to swap into the POP0 menu position. However, you can swap a ***POP0 menu into any other 
POP menu position.

IMAGE menus cannot be swapped from external menu files.

You may swap menus only of the same type—one AUX for another, one POP for another, and so on. Trying to 
swap between types may result in unpredictable and undesired behavior. However, within a given type, you can swap any 
menu for any other menu. This can lead to some strange behavior for TABLET menus, because they typically do not all have
the same number of macros.



Restrictions
Up a Level

The menu bar and pull-down and cursor menus are turned off during the following commands:

DTEXT (once the rotation angle has been set)
VPOINT (while the axis tripod and compass are displayed)
DVIEW 



Overview: Image Tile (ICON) menus
Up a Level

You can define an image tile submenu like a screen submenu and give each item a label followed by menu macro text that 
executes when the item is chosen. The ***ICON section in the menu file starts the image tile menu area. As with POPn 
menu sections, the first line of the submenu is its title. The title is displayed at the top of the dialog box. 

AutoCAD LT displays image-tile slides in a dialog box in groups of 20, along with a scrolling list box containing the 
associated slide names or other text. Image tile submenus are unlimited in length. If an image tile submenu contains more 
than 20 slides, AutoCAD LT provides Next and Previous buttons to browse pages of image tiles. 

To learn more about image tile (ICON) menus, see

Using Image Tile Menu Syntax
Creating Image Tile Menus
Preparing Slides for Image Tile Menus



Using Image Tile Menu Syntax
Up a Level

The syntax to address the image tile menu is the command $I=. When creating a new menu, you should include a blank 
line between submenus to clear out items from a previous submenu. 

Menu Item Labels
Labels in an image tile menu generally refer to slide file names instead of text labels that appear on the screen. The slide file
name should appear exactly as you would enter it at the VSLIDE command and must be part of a library. The slide file 
contains the image to show as the image tile for that selection. 

Image tile menu labels are displayed in a scrolling list box with a maximum of 17 characters per label. Typically, the slide file 
name is displayed; however, other image tile menu labeling options are available.

[sldlib
(sldname)]

The slide name sldname is displayed in the list box, and the slide sldname in the slide library sldlib is displayed as an 
image tile.

[sldlib
(sldname,
labeltext)] 

The text labeltext is displayed in the list box, and the slide sldname in the slide library sldlib is displayed as an image 
tile.

Menu Display

The special menu command $I=* displays the current image tile menu so that you can make a selection from it. You can 
place this command in any menu section, but you cannot enter it from the keyboard. The image tile menu is displayed in a 
dialog box with the title from the first line centered at the top. When AutoCAD LT displays an image tile menu, an arrow 
cursor is displayed. If you select one of the text labels, a confirmation box is drawn around the respective image tile. When 
you select an image tile, the associated text is highlighted. If you double-click either of these items (or choose OK), the 
menu commands associated with that image tile are executed.

To exit an image tile menu, you must choose an item or press ESC; all other keyboard input is ignored. AutoCAD LT provides
OK and Cancel buttons by default. 

Menu Item Selection
When you select an item from an image tile menu, the menu macro replaces the $I=* command that activated the menu. 
This enables an image tile menu to supply as much or as little of a command as needed. It's possible, therefore, to construct
hierarchical image tile menus in which a selection displays another image tile menu and so on. Because the activation of 
these menus is sequential rather than nested, there are no limits to the complexity of the structures you can create.



Creating Image Tile Menus
Up a Level

The following example illustrates an image tile menu that is used to insert various electronic parts. Notice the text label in an 
item that swaps to another image tile submenu that contains various fasteners.

***ICON 
**IPARTS
[Electronic Parts]
[cap]^C^Cinsert cap
[res]^C^Cinsert res
[neon]^C^Cinsert neon
[triode]^C^Cinsert triode
[ Fasteners]$I=ifast $I=*

**IFAST
[Fasteners] 
[nut632]...

To activate this image tile menu, choose a menu item from any menu as shown in the following example.

[Electronic parts]$I=iparts $I=*

In the following variation, the image tiles are retrieved from a slide library named elib. Only the slide name is displayed in the
list box.

***ICON
**IPARTS
[Electronic Parts]
[elib(cap)]^C^Cinsert cap
[elib(res)]^C^Cinsert res
[elib(neon)]^C^Cinsert neon
[elib(triode)]^C^Cinsert triode

When successive image tile slides are displayed from the same library, the library file remains open. This significantly 
reduces the time required to display an image tile menu.





Preparing Slides for Image Tile Menus
Up a Level

You can use any slide generated by AutoCAD LT as an image tile. However, optimal use of image tile menus requires care in
preparing slides to serve as image tiles. When making such slides, follow these guidelines.

Keep it simple. When an image tile menu is displayed, the user must wait for all image tiles to be drawn before making a 
selection. If you're using the image tile menu to show the user numerous complex symbols, make the image tiles simple 
versions of the symbols rather than full renditions. An image tile should be no more complex than is required for immediate 
and clear identification. 

Fill the box. Screen space is precious, and image tiles appear in small portions of the full screen. When making a slide for 
an image tile, be sure to fill the screen with the image before entering the MSLIDE command. If the image tile is very wide 
and short or long and thin, the image tile menu looks best if you center the image on the screen with the PAN command 
before making the slide.

Image tiles are displayed with an aspect ratio of 1.5 to 1 (1.5 units wide x 1 unit high). If your graphics area has a different 
aspect ratio, it can be difficult to produce image tile slides centered in the image tile menu. If you work within a viewport that 
has an aspect ratio of 1.5 to 1, you can position the image and be assured that it will look the same when it is displayed in 
the image tile menu.

The following commands set up a viewport with the correct proportions. (This assumes the use of a drawing with no 
viewports and with TILEMODE turned on.)

To set up a correctly proportioned viewport

1 From the View menu, choose Paper Space to set TILEMODE to 0.

2 From the View menu, choose Floating Viewports. Then choose 1 Viewport.

3 Enter 0,0 as the first point (first corner) of the viewport.

4 Enter 3,2 as the other corner of the viewport.

5 From the View menu, choose Zoom. Then choose Extents.

6 From the View menu, choose Model Space [Floating].

The viewport is now the proportion of the tiled image.

Do not fill the solid. Image tile menus do not fill solid areas. Work with Fill mode off when preparing image tile slides to 
determine how they will be drawn.

Remember the main purpose of image tiles. Do not use image tiles unnecessarily. Image tiles are most useful when the 
user must select a graphic symbol. Do not overuse image tiles by encoding abstract concepts as cryptic symbols.



Overview: Tablet menus
Up a Level

With AutoCAD LT you can configure up to four areas of your digitizing tablet as menu areas for command input. The 
sections of the menu file labeled TABLET1 through TABLET4 define the menu macros associated with tablet selections in 
these areas. 

The menu items in TABLETn sections use the same syntax as those in the other sections. Item labels are treated like those 
in the BUTTONSn sections. They can be used as comments, and they are not displayed. 

The tablet menu areas that you define with the Cfg option of the TABLET command are divided into equal-sized menu 
selection boxes, which are determined by the number of columns and rows you specify in each area. These tablet menu 
selection boxes correspond directly to the lines that follow the TABLETn section labels in a left-to-right, top-to-bottom order 
(whether or not they contain text). 

For example, if you configure a menu area for five columns and four rows, the menu item on the line immediately following 
the section label corresponds to the left-most selection box in the top row. Similarly, the menu item on the eighth line 
following the section label corresponds to the third box from the left in the second row. AutoCAD LT can recognize up to 
32,766 menu items in each tablet section.

You can add your own menu macros to the ***TABLET1 section of aclt.mnu. The menu items in this area correspond to the
225 boxes at the top of your tablet template (rows A through I and columns 1 through 25). Customize only the lines that 
contain menu labels.

Locate the line in your menu file that contains ***TABLET1. Notice that the next 225 lines contain menu labels.

***TABLET1
**TABLET1STD
[A-1];
[A-2];
[A-3];
.
.
.
[I-25];

These labels correspond to the template's grid system. You can add your menu macro after the corresponding [row-
column] menu label, using the format described in Overview: Menu item syntax. Modifying any lines following box [I-25] is 
not recommended.



Overview: Toolbars
Up a Level

The TOOLBARS section specifies the default layout and contents of the toolbars. The ***TOOLBARS section contains a 
submenu for each toolbar defined by the menu. In the following example, the **TOOLS1 declaration is a submenu that uses 
the alias TOOLS1 as a label to reference the subsequent toolbar definition.

There are five distinct types of items that can be specified for toolbars. The syntax of each kind is provided in the example 
below. All lines other than the separator begin with a standard name tag, which is used to associate help information with the
item.

***TOOLBARS
**TOOLS1
TAG1 [Toolbar ("tbarname", orient, visible, xval, yval, rows)]
TAG2 [Button ("btnname", id_small, id_large)]macro 
TAG3 [Flyout ("flyname", id_small, id_large, icon, alias)]macro 
TAG4 [Control (element)]
[--]

The first toolbar definition line (TAG1) defines the characteristics of the toolbar definition. It uses the keyword Toolbar 
followed by a series of options contained in parentheses. The options are as follows:

tbarname The string that names the toolbar. The string must be of alphanumeric characters with no punctuation 
other than a dash (-) or an underscore (_). This name, along with the alias, allows the toolbar to be 
referenced programmatically.

orient The orientation keyword. The acceptable values are Floating, Top, Bottom, Left, and Right and 
are not case sensitive.

visible The visibility keyword. The acceptable values are Show and Hide and are not case sensitive.

xval A numeric value specifying the X value of the coordinate in pixels, measured from the left edge of the 
screen to the left side of the toolbar.

yval A numeric value specifying the Y value of the coordinate in pixels, measured from the top edge of the 
screen to the top of the toolbar.

rows A numeric value specifying the number of rows.

The second line (TAG2) defines a button. It uses the keyword Button followed by a series of options contained in 
parentheses. The options are as follows:

btnname The string that names the button. The string must be of alphanumeric characters with no punctuation 
other than a dash (-) or an underscore (_). This string is displayed as a ToolTip when the cursor is placed 
over the button.

id_small The string that names the ID string of the small-image resource (16 x 15 bitmap). The string must be of 
alphanumeric characters with no punctuation other than a dash (-) or an underscore (_). This can also 
specify a user-defined bitmap. 

id_big The string that names the ID string of the large-image resource (24 x 22 bitmap). The string must be of 
alphanumeric characters with no punctuation other than a dash (-) or an underscore (_). This can also 
specify a user-defined bitmap. 

macro A command string that follows the standard menu item syntax for command strings. 

The third line (TAG3) defines a flyout control. It uses the keyword Flyout followed by a series of options contained in 
parentheses. The options are as follows:

flyname The string that names the flyout. The string must be of alphanumeric characters with no punctuation other



than a dash (-) or an underscore (_). This string is displayed as a ToolTip when the cursor is placed over 
the flyout. 

id_small The string that names the ID string of the small-image resource (16 x 15 bitmap). The string must be of 
alphanumeric characters with no punctuation other than a dash (-) or an underscore (_). This can also 
specify a user-defined bitmap. 

id_big The string that names the ID string of the large-image resource (24 x 22 bitmap). The string must be of 
alphanumeric characters with no punctuation other than a dash (-) or an underscore (_). This can also 
specify a user-defined bitmap. 

icon The Boolean keyword that controls whether to always display its own icon or to display the last icon 
selected (other). The acceptable values are OwnIcon and OtherIcon, and they are not case sensitive.

alias The reference to the toolbar to be displayed as the flyout. The alias refers to a toolbar submenu defined 
with the standard **aliasname syntax. 

The fourth line (TAG4) defines a special control element. It uses the keyword Control followed by a name specifying the 
type of control element requested contained in parentheses. 

element A parameter with three possible values. They are not case sensitive. 

Layer specifies the layer control element. This element is a pop-up list box that provides control of the 
current layers in the drawing. 

Linetype specifies the linetype control element. This element is a pop-up list box that provides 
specification of the current linetype. 

Color specifies the color control element. This element is a button that issues the DDCOLOR 
command. 

The fifth line defines a separator (- -). 

User-defined bitmaps can be used in place of the id_small and id_large image resource names. A user-defined bitmap 
must be of the proper size (16 x 15 pixels for the id_small parameter and 24 x 22 pixels for the id_large parameter) and
must reside in the support path. Specify a user-defined bitmap with the file name and .bmp extension as shown in the 
following example. 

TAG34 [Button ("My Command", mycmd16.bmp, mycmd24.bmp)]^C^CMYCMD



Help on Menu Items
Up a Level

To access the online system-level help (Windows Help files), you need only a way to associate a menu item with an index 
and an associated external help file. You use the menu tag as an index to an associated help file.

If the user activates the system-level help for a menu item (by pressing F1 while a menu item is highlighted), the help engine
is called with two arguments. The arguments are the file name of the original menu (or the menu group name it supplied) 
and the menu tag, as shown in the next section. For example, the menu item with the name tag ID_Cancel would call the 
help engine with a value of ID_Cancel and a help file of sample.hlp.



Status-Line Help—Help Strings
Up a Level

The status-line help messages are other portions of native help support. These are the simple, descriptive messages that 
appear in the status line when a menu item is chosen. The HELPSTRINGS menu section provides support for this form of 
help.

*** MENUGROUP=sample
***POP1
ID_Title [/TTitle]
ID_Cancel [Cancel Command]^C^C
ID_Line[/LLine]^C^C_line

***HELPSTRINGS
ID_Title [This is the Title menu]
ID_Cancel [This item cancels the previous command]
ID_Line[This draws a simple line]

The syntax for the HELPSTRINGS section is a name tag followed by a label. When a menu item is selected, the name tag for
that item is queried for a corresponding entry in the HELPSTRINGS section. If such a match occurs, the string contained 
within the label is displayed in the status line.



Overview: Accelerator keys
Up a Level

AutoCAD LT supports user-defined accelerator keys. The following is a short example of an ACCELERATORS section. 

***ACCELERATORS
ID_Line[SHIFT+CONTROL+"L"]
ID_Cancel ["ESCAPE"]

[CONTROL"Q"]^C^C_quit  

The ACCELERATORS section contains items in one of two formats. The first is a name tag (such as ID_Line) followed by a 
label containing modifiers. The modifiers are followed by either a single character or a special virtual-key string (such as 
"ESCAPE") enclosed in quotation marks. This type of item maps a key sequence to a menu item. You can concatenate more
than one modifier with another by using the plus symbol (+), as in the first example. When a special key sequence is 
recognized, the menu item associated with the name tag is executed as if the user had chosen the menu item.

The second method of defining an accelerator uses a label containing a modifier and key string, followed by a command 
sequence. This method maps a key sequence to a command string and does not have a corresponding menu item.

The following table lists the valid modifiers. 

Valid modifiers

String Description 

CONTROL CTRL    key found on most keyboards

SHIFT SHIFT    key, right or left

The following table lists the special virtual keys. (These keys must be enclosed in quotation marks.) 

Special virtual keys

String Description

"F1 " F1 key

"F2 " F2 key

"F3 " F3 key

"F4" F4 key

"F5" F5 key

"F6" F6 key

"F7" F7 key

"F8" F8 key

"F9" F9 key

"F10" F10 key

"F11" F11 key

"F12" F12 key

"HOME" HOME key

"END" END key

"INSERT" INS key

"DELETE" DEL key



"NUMPAD0 " 0 key

"NUMPAD1 " 1 key

"NUMPAD2 " 2 key

"NUMPAD3 " 3 key

"NUMPAD4 " 4 key

"NUMPAD5 " 5 key

"NUMPAD6 " 6 key

"NUMPAD7 " 7 key

"NUMPAD8 " 8 key

"NUMPAD9 " 9 key

"UP " UP ARROW    key

"DOWN " DOWN ARROW    key

"LEFT " LEFT ARROW    key 

"RIGHT " RIGHT ARROW    key 

"ESCAPE " ESC    key



Overview: DIESEL—string expression language
Up a Level

You can use DIESEL programming code in menu items as a macro language. DIESEL takes strings as input and generates 
string results. 

To learn more about DIESEL string expression language, see

DIESEL Expressions in Menus
Debugging of DIESEL Expressions with MACROTRACE
Catalog of DIESEL String Functions
Error Messages



DIESEL Expressions in Menus
Up a Level

You can implement DIESEL string expressions in menu files and use them as an additional method of creating macros. 
These expressions can return, or pass, string values to standard AutoCAD LT commands that request information from 
them. They can also return string values to the menu itself, thereby altering the appearance or content of a menu label. 

When you use a DIESEL expression in a menu item, it must follow the $section=submenu format that is described in 
IMAGE and TOOLBAR Submenus where the section name is M and the submenu is the desired DIESEL expression. 

The following menu macro uses DIESEL to switch between paper space and model space.

TAG34 [Button ("My Command", mycmd16.bmp, mycmd24.bmp)]^C^CMYCMD

You can use DIESEL to evaluate the status of settings and return an appropriate value. 

**symsize 3
[ SIZES ]

[ 3/8" ]$M=$(*,$(getvar,dimscale),0.375)
[ 1/2" ]$M=$(*,$(getvar,dimscale),0.5)
[ 5/8" ]$M=$(*,$(getvar,dimscale),0.625)

The DIESEL expressions in the preceding menu file multiply the current value of DIMSCALE by the desired value in getvar
and return an appropriate scaling factor. 

DIESEL expressions can also return string values to pull-down menu item labels so that you can gray-out or otherwise alter 
the way the menus are displayed. To use a DIESEL expression in a pull-down menu label, you must insert a dollar sign ($) 
as the first character. 

The following menu item is updated whenever the current layer changes. For example, suppose the current layer is set to 
BASE and the label portion of a ***POPn section in a menu file is the following:

[$(eval,"Current layer: "$(getvar,clayer))] 

Then the menu item becomes the following:

Current Layer:    BASE

AutoCAD LT determines the width of pull-down and cursor menus when it loads the menu file. You cannot use trailing 
spaces in a menu label to increase the menu width, because trailing spaces are ignored when the menu is loaded. Any 
spaces used to increase the width of a menu label must be within a DIESEL expression. 

The following example uses the same DIESEL expression as the label and a portion of the menu macro. Use the following 
macro to enter the current day and date into a drawing.

[$(edtime,$(getvar,date),DDD", "D MON YYYY)]^C^Ctext \\\+
$M=$(edtime,$(getvar,date),DDD", "D MON YYYY); 

The following pull-down menu label displays a grayed-out, inaccessible ERASE command while a command is active. If no 
command is active, the menu item is not grayed out.

[$(if,$(getvar,cmdactive),~)ERASE]erase

You can use a similar approach to place a mark beside a pull-down menu item or to change the character used for the mark.



Debugging of DIESEL Expressions with MACROTRACE
Up a Level

MACROTRACE is a debugging tool for DIESEL expressions. By default, MACROTRACE is set to 0 (off). If MACROTRACE is
set to 1 (on), all DIESEL expressions are displayed on the command line. Keep MACROTRACE set to 0 when you are not 
debugging DIESEL expressions. 



Catalog of DIESEL String Functions
Up a Level

DIESEL functions retrieve status and compute and display information on many operations. All functions have a fixed limit of 
10 parameters, including the function name itself. If this limit is exceeded, DIESEL displays an error message. The available 
functions are listed below.

+ (addition)
$(+, val1 [, val2, ... val9] ) 

Returns the sum of the numbers val1, and val2 through val9. If the current thickness is set to 5, this DIESEL string 
returns 15:

$(+,$(getvar,thickness),10)

- (subtraction)
$(-, val1 [, val2, ... val9] )  

Returns the result of subtracting the numbers val2 through val9 from val1.

* (multiplication)
$(*, val1 [, val2, ... val9] )

Returns the result of multiplying the numbers val1 and val2 through val9.

/ (division)
$(/, val1 [, val2, ... val9] )  

Returns the result of dividing the number val1 and val2 through val9.

= (equal)
$(=, val1, val2)  

Returns 1 if the numbers val1 and val2 are equal. Otherwise, it returns 0.

< (less than)
$(< , val1, val2)  

Returns 1 if the number val1 is less than val2. Otherwise, it returns 0.

The following expression retrieves the current value of FILLETRAD. If the value is less than the value stored in the setting 
USERR1, the function returns 1. Assuming the value 10.0 is stored in USERR1 and the current setting of FILLETRAD is 
15.5, the following DIESEL string returns 0:

$(<,$(getvar,filletrad),$(getvar,userr1))

> (greater than)
$(>, val1, val2)  

Returns 1 if the number val1 is greater than val2. Otherwise, it returns 0.

!= (not equal)
$(!=, val1, val2)  

Returns 1 if the numbers val1 and val2 are not equal. Otherwise, it returns 0.



<= (less than or equal)
$(<=, val1, val2)  

Returns 1 if the number val1 is less than or equal to val2. Otherwise, it returns 0.

>= (greater than or equal)
$(>=, val1, val2)  

Returns 1 if the number val1 is greater than or equal to val2. Otherwise, it returns 0.

and
$(and, val1 [, val2,... val9] )  

Returns the bitwise logical AND of the integers val1 through val9.

angtos
$(angtos, value [, mode, precision] )  

Edits the given value as an angle in the format specified by mode and precision. For mode values, see the table below. If 
mode and precision are omitted, angtos uses the current values of the DDUNITS command.

Angular Unit Values 

Mode value String format

0 Degrees 

1 Degrees/minutes/seconds 

2 Grads 

3 Radians 

4 Surveyor's units 

edtime
$(edtime, time, picture)  

Edits the AutoCAD LT Julian date given by time, obtained, for example, from $(getvar, date), according to the given 
picture. The picture consists of format phrases replaced by specific representations of the date and time. Characters 
not interpretable as format phrases are copied literally into the result of edtime. 

The following table defines format phrases. Assume the date and time is Thursday, 2 September 1993, 4:53:17.506.

Edtime format phrases

Format Output

D 2

DD 02

DDD Thu

DDDD Thursday

M 9

MO 09

MON Sep

MONTH September

YY 93

YYYY 1993



H 4

HH 04

MM 53

SS 17

MSEC 506

AM/PM AM

am/pm am

A/P A

a/p a

You must enter the entire AM/PM phrase as shown in the previous table. If AM is used alone, the A is read literally and the M 
returns the current month. 

If you use any AM/PM phrases in picture, the H and HH phrases edit the time according to the 12-hour clock instead of the 
24-hour clock.

The following example uses the date and time from the previous table. The comma must be enclosed in quotes because it is
read as an argument separator. The following DIESEL string returns Thu, 02 Sep 1993 - 4:53am.

$(edtime,$(getvar,date),DDD"," DD MON YYYY - H:MMam/pm)

If time is 0, AutoCAD LT uses the time and date at the moment the outermost macro was executed. The purpose is to avoid
lengthy and time-consuming multiple calls on $(getvar, date). AutoCAD LT thereby guarantees that strings composed 
with multiple edtime macros all use the same time.

eq
$(eq, val1, val2)  

Returns 1 if the strings val1 and val2 are identical. Otherwise, it returns 0.

eval
$(eval, str)  

This function passes the string str to the DIESEL evaluator and returns the result of the evaluation.

fix
$(fix, value)  

Truncates the real number value to an integer by discarding any fractional part.

getenv
$(getenv, varname)  

Returns the value of the environment variable varname. If no variable with that name is defined, returns the null string.

getvar
$(getvar, setname)  

Returns the value of the setting setname.

if
$(if, expr, dotrue [, dofalse] )  

Evaluates and returns dotrue if expr is nonzero. Otherwise, this function evaluates and returns dofalse. 



index
$(index, which, string)  

Returns the which element of string. The index function assumes that the string argument contains one or more 
values delimited by a comma. The which argument selects one of these values to be extracted with the first item numbered 
zero. 

You can use this function to extract X, Y, or Z values from point coordinates returned by getvar. 

nth
$(nth, which, arg0 [, arg1,... arg7] )  

Evaluates and returns the argument selected by which. If which is 0, it returns arg0, and so on. Notice the difference 
between nth and index. The nth function returns one of a series of arguments to the function, while index extracts a 
value from a comma-delimited string passed as a single argument. 

or
$(or, val1 [, val2,... val9] )

Returns the bitwise logical OR of the integers val1 through val9.

rtos
$(rtos, value [, mode, precision] )  

Edits the given value as a real number in the format specified by mode and precision. Without mode and precision 
arguments, rtos uses the current values selected with the DDUNITS command. For valid mode values, see the table 
Angular Unit Values. 

strlen
$(strlen, string)  

Returns the length of string in characters.

substr
$(substr, string, start [, length] )  

Returns the substring of string starting at character start and extending for length characters. Characters in the string 
are numbered from 1. If length is omitted, substr returns the entire remaining length of the string.

upper
$(upper, string)  

Returns string converted to uppercase.

xor
$(xor, val1 [, val2,... val9] ) 

Returns the bitwise logical XOR of the integers val1 through val9.



Error Messages
Up a Level

Depending on the nature of the error, DIESEL embeds an error indication in the output stream.

DIESEL error messages

Error message Meaning

$? Syntax error such as a missing right parenthesis 

$(funcname,??) Incorrect arguments to funcname    

$(funcname)?? Unknown function funcname    

$(++) Output string too long



Angular Unit Values

Mode value String format

0 Degrees 

1 Degrees/minutes/seconds 

2 Grads 

3 Radians 

4 Surveyor's units






